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What's New for April '16
The following new features and enhancements are available for the April 2016 release as of
10 April 2016:

Compensation Features
FEATURE
NAME FROM
RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Employee
Salary
Management
Redesign

Employee
Salary
Management
Redesign

With this enhancement, the
Employee Salary Management
page is redesigned to improve
the look and feel of the page. In
addition, employee salary data
storage is optimized to enable
the system to handle more
robust salary storage
requirements for future salary
management enhancements.

Custom
Reports Additional
Compensation
Fields

Custom Report
- Additional
Compensation
Fields

New Compensation fields are
added to Compensation and
Multi-Module Custom Reports.

Custom
Reports Support
Currency on
Currency Tab
in Summarized
Reports

Custom Report
- Support
Currency on
Currency Tab
in Summarized
Reports

With this enhancement, when
running a Compensation Custom
Report, the currency option
selected on the Currency tab will
be reflected in the report output
of summarized reports. Prior to
this enhancement, the currency
option selected on the Currency
tab was not reflected in
summarized report outputs.
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Connect Features
FEATURE
NAME FROM
RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Search within Search within
Communities Communities

With this enhancement, users can
search for postings from within a
community or topic. The search
returns all available postings within
the current community or topic
that match the user's search
criteria.

Tags in
Communities

With this enhancement, users are
able to create custom tags and add
them to postings in Connect
communities. In addition, users
may be able to search for postings
by tag and filter postings by tag.
When users can search for
postings by tag, they can also click
a tag that is associated with a
posting to initiate a search for
other postings with the same tag.
This enhancement improves a
user's ability to search for and
discover content within Connect.

Tags in
Communities

Core Features
FEATURE NAME
FROM RELEASE
NOTES
Data Load
Wizard Duplicate User
Prevention

FEATURE
NAME FROM
RELEASE
SUMMARY
Data Load
Wizard Duplicate User
Prevention

CONTACT
TO
ENABLE?
See Notes

DESCRIPTION

When an organization using Link
loads new users using the Data
Load Wizard, the system can be
configured to determine
whether the new users are
similar to existing user records.
This is done in order to prevent
the same user from being added
6
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

to the system more than once.
Data Load
Data Load
See Notes
Wizard Wizard Historical
Historical
Effective
Effective
Dating for User Dating for User
Data
Data

With this enhancement, when
loading users into the system
using the Data Load Wizard, an
As of Date can now be
associated with a user record.
By setting an effective date for
a user record, administrators
can set changes that are
effective in the past and in the
future via the Data Load Wizard.

Headcount
Planning

Headcount Planning enables
efficient, enterprise-wide
collaboration to identify the
number and mix of employees
that will be needed to achieve
the organization’s business
objectives in the future.
Headcount Planning controls
access to sensitive information,
includes built-in versioning and
error tracking, and provides a
seamless approval and
consolidation workflow. The
interface is designed specifically
for the headcount planning
process, rather than having to
use a generalized spreadsheet.

Yes

Insights Career Career Mobility Yes
Mobility

The Career Mobility Insight
empowers managers to create
data driven career paths and
development plans for
individuals to realize their
potential. Organizations will gain
insight on internal career paths
and the actions that drove
historically successful
successors along their paths.
7
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Furthermore, this will prescribe
users with development plan
action items to help new
successors mobilize in their
career paths.
Language Pack
Enhancements
- Dutch, Czech,
Slovakia

Language Pack
Enhancements
- Dutch, Czech,
Slovakia

With the April 2016 release,
Cornerstone is revising the
translations for the Dutch,
Czech, and Slovakian language
packs.

Link Duplicate User
Prevention

Link - Duplicate See Notes
User
Prevention

With this enhancement, when
an organization using Link
creates new users, the system
can be configured to evaluate
whether the new users are
similar to existing user records.
If similar records do not exist,
the new users will be created
normally. However, if similar
records do exist, the record
creation is prevented.

Link Historical
Effective
Dating for User
Data

Link - Historical See Notes
Effective
Dating for User
Data

With this enhancement,
organizations using Link can
now backdate user record data
to before the user record was
created. The system now
supports historical effective
dates as long as the date is on
or after January 1, 1901. This
enhancement applies to
modifications that are made via
the User Record or the Data
Load Wizard. This enhancement
enables organizations to more
effectively use Cornerstone as
their system of employee
records.
8
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Link - Manager Link - Manager See Notes
Self-Service
Self-Service

With this enhancement,
Cornerstone Link enables
managers to utilize forms to
update employee information
for their direct reports. In
addition, if configured, form
data can be submitted by a user
within a specified set of criteria
for another user.

Online Help
Ratings and
Feedback

With this enhancement,
administrators now have the
ability to rate topics and provide
descriptive feedback within
Online Help. The ratings and
feedback will be used by
Cornerstone to identify topics
for improvement in Online Help.

Online Help
Ratings and
Feedback

Organizational
Unit Fields in
Forms

With this enhancement,
organizational unit (OU) fields
can now be added to forms so
that OUs can be updated using
forms.

Page Caching
Security
Enhancements

Page Caching
Security
Enhancements

With this enhancement, when a
user logs out of the system,
certain system pages that
potentially contain sensitive
information pertaining to users
and security are automatically
cleared from a browser's cache.
This prevents the information on
these pages from being
retrieved by unauthorized users.

REST Service
Authentication
via SP Initiated
SSO

Web Services - See Notes
REST Service
Authentication
via SP Initiated
SSO

With this enhancement,
organizations can now use SPinitiated single sign on (SSO) to
authenticate their REST service
users.
9
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FEATURE NAME
FROM RELEASE
NOTES
Universal
Profile My
Team
Hierarchy
Navigation

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

Universal
Profile My
Team
Hierarchy
Navigation

With this enhancement,
managers can now navigate
through their direct and indirect
report hierarchy using the My
Team drop-down within
Universal Profile. In addition,
approvers and custom employee
relationships can quickly
navigate through their dotted
line reports using the My Team
drop-down. If the user serves in
multiple roles that are available
within the drop-down, then the
user can select a specific role
and view the reports that are
associated with that role.

Custom
Reports - User
Types and
Statuses

Standard
Reports Support for OU
Localization

View People

DESCRIPTION

With this enhancement, user
type and status fields are now
available for all custom reports
that have a User section. A new
User Status Information section
is added to include these fields.
Standard
Reports Support for
Organizational
Unit (OU)
Localization

With this enhancement,
standard reports that contain
organizational units (OU) will be
updated to display the localized
value for the OU. If there is no
localized value for the OU name,
then the default value displays
for the OU name.
Yes

View People is a new,
interactive visualization suite
that helps managers and
executives use employee
attributes, such as performance
and succession metrics, to
identify high-value assets while
10
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

on the go. View People is
available from tablets and
desktop devices to provide
immediate access to key
employee data.
View People removes the
complexity and time-consuming
process of searching for an
employee or candidate. You no
longer need to run multiple
reports or have specialized
knowledge about the system.
View People enables you to
search across your
organizational units (OU) and
module data by simply adding
and removing filters. The results
of a search can be saved or
shared or can be used to trigger
additional actions, like adding
an employee to a list or talent
pool.

Edge Features
FEATURE
NAME
FROM
RELEASE
NOTES
Edge
Integrate

FEATURE
NAME
FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Cornerstone Edge Integrate enables
organizations to quickly and easily
integrate their Cornerstone system with
other workforce systems. This includes
recruiting tools, such as Broadbean and
Multiposting, learning tools, such as
WebEx and GoToMeeting, and social
11
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FEATURE
NAME
FROM
RELEASE
NOTES

FEATURE
NAME
FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

tools, such as Facebook and Twitter.

Learning Features
FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Course
Course
Recommendations Recommendations
Exclusion Flag
Exclusion Flag

With this enhancement,
the General tab of the
Course Catalog now has
an additional option that
enables administrators to
exclude a learning object
(LO) from being
recommended to users.
Although the ability to
provide course
recommendations is not
widely available, this
option enables
administrators to
proactively exclude
certain LOs from course
recommendations.

Data Load Wizard
- Support Audit
Trail

Data Load Wizard
- Support Audit
Trail for Events,
Sessions and
Transcript Loads

With this enhancement,
an audit trail is available
when an Admin loads
events, sessions or
transcripts through the
Data Load Wizard.

Enhanced
Certification
Transcript Web
Service (SOAP)

Web Services Learning

See Notes

With this enhancement,
the following fields are
now included in the
Certification Transcript
web service response:
o Certification Status 12
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

This returns the user's
status for the
certification.
o Earned Credits (within
Section Item) - This
returns the user's
earned credits for the
certification section.
Enhanced LO Complete Web
Service (SOAP)

Web Services Learning

See Notes

With this enhancement,
the following field is now
included in the LO Complete web service
request for online
courses and tests:
o Score - This field is
used to determine a
pass or fail status for
the learning object
(LO).

Get Details Web
Service (REST)

Web Services Learning

See Notes

With this enhancement, a
new Get Details REST
web service is now
available. This web
service provides standard
and custom field data for
a learning object (LO) via
REST Web Services.

Global Search LO
Web Service
(REST)

Web Services Learning

See Notes

With this enhancement, a
new Global Search (LO)
REST web service is now
available. This web
service provides a list of
training courses based on
specific parameters via
REST Web Services.
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FEATURE NAME
FROM RELEASE
NOTES
Google Calendar
Integration

FEATURE NAME
FROM RELEASE
SUMMARY
Google Calendar
Integration

Increased Video
Size

Learning Rewards
& Recognition

CONTACT
TO
ENABLE?

DESCRIPTION

With this enhancement,
the system now also
supports integration with
Google Calendar.
Administrators can
configure certain email
triggers to include
meeting invitations or
calendar attachments.
When a user using Gmail
receive a meeting
invitations from the
system, their Google
Calendar is automatically
updated with the
appropriate meeting
information.
With this enhancement,
videos viewed on the
Transcript or LO Detailed
page are displayed in a
large frame.

Learning Rewards
& Recognition

With this enhancement,
badges and points can
now be awarded
automatically when a
user completes training.
Also, the points that are
associated with a badge
are now utilized
throughout the system.
For example, a manager
can view a subordinate's
total number of badges
and points within the
Universal Profile
Snapshot, and a
Leaderboard page
displays employees with
14
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

the most points across
the user's organizational
units (OUs).
Offline Player
Enhancements

Offline Player
Enhancements

Yes

With this enhancement,
the new version of Offline
Player is more engaging
and aligned with
Cornerstone's new
interface. Organizations
can brand the Offline
Player application with
their logo and color
theme. The offline
transcript will look similar
to the online transcript.
Learning progress will be
synced automatically.

Tin Can (xAPI)
Support - Learning
Record Store
(LRS)

Tin Can (xAPI)
Yes
Support - Learning
Record Store
(LRS)

With this enhancement,
the system is able to
record external Tin Can
activities on
Cornerstone's Learning
Record Store (LRS).
External Tin Can
activities include but are
not limited to mobile
apps, offline learning,
web application,
collaborative learning,
games, videos, etc. When
an external activity needs
to be recorded, the
application sends secure
statements to the LRS to
record all statements.

Training
Completion

Training
Completion

With this enhancement, a
Training Completion page
can now be enabled for
training. A Training
15
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Completion page is a
page that is available to
a user when they
complete the training.
Depending on the
configuration of the
training and the portal,
the Training Completion
page may display any
points or badges that
were awarded, the
opportunity to rate and
review the training, and
the option to view their
certificate of completion.
Training
Completion
Signature at LO
Level

Training
Completion
Signature at
Learning Object
(LO) Level

With this enhancement,
administrators now
configure whether a
training completion
electronic signature (esignature) is required for
specific learning objects
(LOs). In addition, a new
Default Training
Completion Signature
Preferences page is now
available. This page
enables administrators to
configure the default
setting for requiring
training completion esignature by LO type,
which is set for a LO
when the LO is created.
Once the LO is created,
administrators can
modify this setting at the
LO level via Course
Catalog.
16
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Training Plan
Dynamic Update

Training Plan
Dynamic Update

Transcript and
Task Web Service
(REST)

Web Services Learning

See Notes

With this enhancement, a
new Transcript and Task
REST web service is now
available. This web
service provides
transcript and task data
for users via REST Web
Services. The service can
return all transcript
information for a user or
only information for a
specific learning object
(LO).

Transcript Search
Web Service
(REST)

Web Services Learning

See Notes

With this enhancement, a
new Transcript Search
REST web service is now
available. This web

With this enhancement,
when a training plan is
configured with
managers as Plan
Contributors planning for
their subordinates and a
new manager is identified
for a user on their user
record, then an
automatic workflow
moves the training needs
to the user's new
manager who is acting as
a Plan Contributor. Any
training needs that have
been identified for a
subordinate within a
training plan will remain
associated with the
subordinate even if the
subordinate is moved to
a new plan contributor.

17
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE NAME
FROM RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

service provides
transcript data for users
based on a provided
transcript status within a
specified time period via
REST Web Services.
Custom Reports - Custom Report LO Availability and Additional Learning
Added Fields
Fields

With this enhancement,
Learning fields are added
to multiple sections of
custom reports.

Mobile Features
FEATURE
NAME
FROM
RELEASE
NOTES

FEATURE
NAME
FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Apply with
Mobile Prescreening
Questions

Apply with
Mobile Prescreening
Questions
and Upload
Documents

With this enhancement, pre-screening
questions can now be completed using
the mobile application, which enables
more applicants to complete
applications using the mobile
application.

Apply with
Mobile Upload
Document

Apply with
Mobile Prescreening
Questions
and Upload
Documents

With this enhancement, applicants can
now upload documents to their
application, such as resumes and cover
letters. Users can upload documents
using Box, Dropbox, Google Drive, or
iCloud. Applicants with a Windows
device can upload documents using
OneDrive.

18
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Performance Features
FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

Custom
Employee
Relationships
in Performance

Custom
Employee
Relationships in
Performance

Goals Redesign Goals Redesign
Enhancements Enhancements

CONTACT
TO
ENABLE?

DESCRIPTION

Within the system,
administrators can define
custom employee relationships
such as Dotted Line Manager or
Secondary Manager. These
custom relationships can be
used in various areas of the
system, such as performance
reviews, compensation, and
custom approval workflows for
Learning.
With this enhancement, the
following enhancements have
been made to the redesigned
Goals functionality:
o SMART Goal Wizard - This
wizard is now available for
organizations using the
redesigned Goals
functionality. The
appearance of the wizard is
improved, but the
functionality is not changed.
o Total Goal Weight Administrators can now
configure Goal Preferences
so that the total weight for
all of a user's goals cannot
exceed 100% for the current
goal period.
o View Details for Manager
Goals and Alignable Goals Administrators can now
prevent users from viewing
goal Progress, Comments,
and Attachments of manager
19
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

goals and goals that are
available for alignment.
o Universal Profile: Actions When a user manages a goal
from the Universal Profile:
Actions page, the user is
able to manage the goal
from within the Actions
space. Previously, users
were directed to the
Snapshot space, which was
an issue for organizations
that did not have Snapshot
enabled.
o Copy Details when Aligning When aligning with another
goal, users now have the
option to copy the details of
the goal to their new goal.
o Goal Status Drop-down - If
the Progress field is disabled
and a goal has no tasks or
targets, users can now
update the goal status using
a drop-down menu on the
Manage Goals page.
Goals Redesign Goals Redesign
Auto-Upgrade Auto-Upgrade

With this enhancement, all
portals using Goals are
automatically upgraded with the
new Goals redesign.

Goals Team
View - Excel
Export

With this enhancement,
administrators now have the
option to export all of their
team's goals to an Excel
(Unicode .csv) file for the time
period that is being viewed.

Goals Team
View - Excel
Export

20
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Performance
Features in
Action Items

Performance
Features in
Action Items

With this enhancement, a user
can complete Goal,
Development Plan, Peer, and
Training Form approvals from
the Request tab within Universal
Profile: Actions. Also, a user can
view Observation Checklist and
Training Form tasks in the
Universal Profile: Actions page.
This allows the user to more
efficiently complete tasks and
provide approvals.

Performance
Rewards and
Recognition Leaderboard

Performance
Rewards and
Recognition Leaderboard

As part of the Learning Reward
and Recognition project, users
are now able to track their
Feedback and Learning badges
via a new My Badges page and
engage in competition on a new
Leaderboard page. Rewards and
Recognition gives employees
the opportunity to engage in
competition and for the
organization to motivate their
employees to give and receive
feedback, learn, and develop
through non-competitive
awards. Points need to be
associated with Feedback
Badges for users to be tracked
on the Leaderboard.

Structured
Feedback

Structured
Feedback

Update Goal
Progress from

Update Goal
Progress from

Yes

With this enhancement, users
can add yes/no questions or
rating questions to feedback
requests. This allows users to
receive clear, quick responses in
a more seamless manner.
With this enhancement, Goal
Rating performance review
21
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FEATURE NAME
FROM RELEASE
NOTES
Performance
Review

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

Performance
Review

DESCRIPTION

sections can be configured to
allow reviewers to access the
Manage Goals page directly
from the Goal Rating section.
This enables the reviewer to
quickly update the goal
progress without exiting the
performance review. The
updated goal progress is
reflected in the performance
review.

Custom
Custom Report
Reports - Additional
Added Fields in Performance
Performance
Fields

With this enhancement, fields
are added to the Competency
and Goals sections for custom
reports.

Custom
Reports Performance
Review Signoff Section

With this enhancement, a new
Performance Review Sign-off
section is now available when
creating a Performance Review
custom report. This section
enables administrators to create
custom reports that include
information about the Sign-off
section. This includes the
decline to sign functionality.

Custom Report
- Performance
Review Sign-off
Section

Recruiting Features
FEATURE NAME
FROM RELEASE
NOTES
Broadbean
External
Sourcing

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?
Yes

DESCRIPTION

The Broadbean External
Sourcing integration enables
organizations to source
applicants from external job
boards in Broadbean. The
22
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

applicants can be added to
talent pools and invited to apply
to the job.
Broadbean
Integration Multiple
Language
Support for Job
Postings -

Data Load

Broadbean
Integration Multiple
Language
Support for Job
Postings

With this enhancement, the
following updates are made to
the External Postings tab when
configuring job requisition
postings to Broadbean:
o Language Drop-Down When configuring Broadbean
job postings, recruiters can
now select which language to
post the job in, based on the
languages into which the job
requisition has been
translated. A language dropdown has been added to the
Broadbean posting step to
allow recruiters to choose
the language. The localized
job requisition will render
correctly via Broadbean
posting.
o Posting DateColumn - A
Posting Date column is
added to the Job Boards
section. This column displays
the date on which the job
was posted to Broadbean.
o Language Column - A
Language column is added to
the Job Boards section. This
column displays the
language in which the job
was posted to Broadbean.
Yes

With this enhancement, the
23
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

Wizard Support for
Keyword and
Cost Center OU
Enhanced Job
Requisition
Web Service
(REST)

DESCRIPTION

Data Load Wizard supports two
new fields through the Job
Requisition and Job Requisition
Template data loads, Keyword
and Cost Center OU.
Web Services - See Notes
Job Requisition
REST Service

FADV
Enhancements
and Migrate
FADV from IUP
to Edge
Overview

With this enhancement,
additional fields are now
included in the Job Requisition
web service response.
With this enhancement, First
Advantage (FADV) integration is
migrated to the Edge
Marketplace. This allows
organizations to purchase the
FADV integration directly from
Edge. Prior to this
enhancement, FADV required a
custom integration process that
was managed through Global
Product Support. After the initial
set-up, clients will be able to
make configuration changes to
the integration directly within
the Integration Center, as
opposed to using GPS.
In addition, permissions are also
being added to enable
organizations to restrict and
limit user access to initiating a
background check, viewing
background check results, and
viewing background check
details.

Google
Analytics in
Applicant
Workflow

Google
Analytics in
Applicant
Workflow

Yes

Organizations can now use
Google Analytics or Universal
Analytics to track applicants as
they are going through career
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

sites, job postings, and
application workflows.
Inbound Data
Feeds for
Candidates and
Applicants

Yes

With this enhancement, the
Data Load Wizard now supports
scheduling of inbound data
feeds (IDF or recurring loads)
for Candidates and Applications.

Multiposting
Integration

Yes

The Multiposting integration
enables recruiters to post a
requisition that has multiple
language translations to multiple
job boards that support multiple
languages. Through an
integration with Multiposting,
recruiters can select the desired
job boards from the External
Postings page of the job
requisition and post the job to
more than one job board that
supports multiple languages.
Recruiters will be able to see the
latest statistics for each job
board, as well as take actions
such as edit the job posting,
delete the job posting, and
repost the job when the job
posting expires.

Onboarding
Manager
Usability
Enhancements

Onboarding
Manager
Usability
Enhancements

With this enhancement, many
Onboarding usability
enhancements are made.

Recruiting and
Candidate
Search
Usability
Enhancements

Recruiting and
Candidate
Search
Usability
Enhancements

With this enhancement, many
Recruiting and Candidate Search
usability enhancements are
made.
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

Requisition
Usability
Enhancements

Requisition
Usability
Enhancements

CONTACT
TO
ENABLE?

DESCRIPTION

With this enhancement, the
following requisition
enhancements are made:
o Requisition custom fields on
the requisition and
requisition request can be
set as read-only or editable.
o New custom fields can be
created in Requisition and
Applicant Preferences.
o Cost Center organizational
unit (OU) can now be viewed
on a requisition, requisition
template, and requisition
request.
o Custom field data entered in
the Position OU is copied
over to the requisition
template.

SEO for Career
Sites and Job
Postings

SEO for Career See Notes
Sites and Job
Postings

With this enhancement, career
sites and job postings can now
be optimized in order to
determine whether or not the
career site should be indexed by
search engines. The meta page
title and description for job
postings can also be
customized, which is needed to
optimize career sites for search
engines. Optimizing career sites
can also help the career site
rank higher in search engine
results for potential applicants
that search for jobs through
search engines instead of by
going to an organization's job
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

page on their website.
Static URL
Enhancement

Static URL for
Viewing and
Sharing Career
Site Search
Results and
Applicant
Resumes

Talent Pools

Talent Pools

Custom
Reports Additional
Recruiting
Fields

Custom
Reports Additional
Recruiting
Fieldg

Reports Onboarding
Increase
Custom Report
Character Limit
for Question
User Comment

With this enhancement,
recruiters will be able to share
job search results and lists of
applicant resumes using a static
URL that can be sent via email
or embedded in a button on a
career site. The URL can be
accessed without needing to log
in to the career site.
Yes

With this enhancement, the
Manage Talent Pools
functionality is redesigned with
a new user interface (UI) and
the integration of Recruiting
features. For portals with
Recruiting, talent pools can now
be used to source applicants for
job requisitions. Candidates can
be added from Manage
Applicants and can be added to
job requisitions from within the
Manage Talent Pools page.
With this enhancement, fields
are added to the Requisition and
User sections for Recruiting
Custom Reports.
With this enhancement, when
running Form Management
Custom Reports or Onboarding
Custom Reports, the character
limit for the Question User
Comment field is increased
from 500 to 1200. The field
appears in the Form Template
section of these reports.
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FEATURE NAME
FROM RELEASE
NOTES

FEATURE
NAME FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Reports Onboarding
Onboarding
Custom Report
and Forms in
Multi-Module
Custom Report

With this enhancement,
Onboarding and Forms modules
are added to the Multi-Module
Custom Report.

Reports Onboarding in
Custom
Reports

With this enhancement, an
Onboarding Custom Report is
now available in custom
reporting. This report allows you
to create customized reports on
onboarding data. The
onboarding data can be used to
make informed decisions about
where new hires are having
trouble in the onboarding
process.

Onboarding
Custom Report

Succession Features
FEATURE
NAME FROM
RELEASE
NOTES

FEATURE
NAME
FROM
RELEASE
SUMMARY

CONTACT
TO
ENABLE?

DESCRIPTION

Talent Pools Talent Pools Yes
Redesign
Redesign

With this enhancement, the Manage
Talent Pools functionality is
redesigned with a new user interface
(UI) and the integration of Recruiting
features. For portals with Recruiting,
talent pools can now be used to
source applicants for job requisitions.
Candidates can be added from
Manage Applicants and can be added
to job requisitions from within the
Manage Talent Pools page.

Custom
Reports -

With this enhancement, data for
Succession Management Plan (SMP)

Custom
Report -
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FEATURE
NAME FROM
RELEASE
NOTES
Support
Unlaunched
Tasks

FEATURE
NAME
FROM
RELEASE
SUMMARY
Support
Unlaunched
Tasks

CONTACT
TO
ENABLE?

DESCRIPTION

tasks that have not yet been launched
will be visible in the report output
when running Succession Custom
Reports. Prior to this enhancement,
tasks that were not launched for
respective users were not being
pulled into the report output.
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New and Enhanced Permissions for April '16 Release
The following permissions are new for the April '16 release:
PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

Core

Duplicate User
Management
Preferences Manage

Grants ability to access and
configure management of
duplicate records, including
parameters used to prevent
duplicates. This permission
cannot be constrained. This is
an administrator permission.

Core
Administration

Core

Form
Completion View and Edit
OU and
Employee
Relation Fields

Allow users to view and
Core
modify organizational unit
(OU) and employee relation
fields when completing a form
that contains the fields. The
constraints on this permission
determine which fields the
user can view and edit when
completing a form. This
permission can be constrained
by OU, User's OU, User, User
Self and Subordinates, and
User Subordinates. This is an
end user permission.

Core

Form Proxy
Completion Manage

Allows administrator to
Forms
configure the Proxy Availability Administration
settings for a form. These
settings determine which
users can complete the form
on behalf of other users and
for which users they can
complete the form. This
permission can be constrained
by OU, User's OU, User, and
Employee Relationship. This is
an administrator permission.

Core

Prevent
Duplicate Users

Grants ability to view user
accounts that have been

Core
Administration
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

- Reconcile

identified as potential
duplicates. Administrators can
only view pending user
records that were created by
administrators who are within
the constraints on this
permission. This permission
can be constrained by OU and
User's OU. This is an
administrator permission.

Core

Snapshot Badges

Enables user to view the
Universal Profile
Badges widget and subpage
within the Universal Profile Snapshot page for users
within their permission
constraints. This permission
works in conjunction with the
Snapshot Main - View
permission. This permission
can be constrained by OU,
User's OU, User Self and
Subordinates, User, User's
Self, User's Manager, User's
Superiors, User's
Subordinates, User's Direct
Reports, and Employee
Relationship. Any user with
this permission will always be
able to view their own Badges
widget when the widget is
enabled. Best Practice: For
most users, this permission
should be constrained by User
Self and Subordinates.

Core

Snapshot Leaderboard

Enables user to view the
Leaderboard widget and
subpage within the Universal
Profile - Snapshot page for
users within their permission
constraints. This permission

Universal Profile
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

works in conjunction with the
Snapshot Main - View
permission. This permission
can be constrained by OU,
User's OU, User Self and
Subordinates, User, User's
Self, User's Manager, User's
Superiors, User's
Subordinates, User's Direct
Reports, and Employee
Relationship. Any user with
this permission will always be
able to view their own
Leaderboard widget when the
widget is enabled. Best
Practice: For most users, this
permission should be
constrained by User Self and
Subordinates.
Core

Work Force
Planning Administrator

Grants access to the
Core
Headcount Planning page.
Administration
Users with this permission can
also create new headcount
plans for any part of the
organization, as well as create
subplans that have been
assigned to them.
Administrators can only view
plans that they have created
or to which they were
assigned as a Co-Planner or
Primary Planner This is an
administrator permission.

Core

Work Force
Planning Subplanner

Grants the ability to complete Core
subplans that have been
Administration
assigned to the user. Users
with this permission cannot
create new headcount plans or
view all plans. They can only
view plans that they create
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

and plans in which they are
assigned a role of Owner,
Subplanner, or Co-Planner.
Edge

Edge
Integrations Manage

Grants access to the
Edge
Integrations service for Edge
Integrate where the
administrator can configure,
enable, and disable their thirdparty integrations that are
used within the Cornerstone
system. This permission
cannot be constrained. This is
an administrator permission.

Edge

Edge
Marketplace Manage

Grants access to the
Marketplace service for Edge
Integrate where the
administrator can browse and
purchase third-party
integrations that can be used
to extend the Cornerstone
system. This permission
cannot be constrained. This is
an administrator permission.

Learning

Default Training
Completion
Signature
Preferences

Grants ability to manage
Learning Default Training Completion
Administration
Signature preferences at the
portal level. This enables the
administrator to set the
default setting for whether an
electronic training completion
signature is required. This
permission can be constrained
by OU and User's OU. This is
an administrator permission.

Learning

Learning Badge
- View

Grants ability to view the
Badge field on the LO Details
page and the Training
Completion page. This
permission cannot be

Edge

Learning
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

constrained.
Learning

Learning Points
- View

Grants ability to view the
Points field on the LO Details
page and the Training
Completion page. This
permission cannot be
constrained.

Learning

Learning

Training
Completion
Page
Preferences Manage

Grants ability to access and
Learning edit the Training Completion
Administration
Page Preferences where the
administrator can configure
the default behavior for
training completion pages,
including whether a
completion page is enabled by
default for each learning
object (LO) type and the
default completion message
that appears on the Training
Completion page. This
permission cannot be
constrained. This is an
administrator permission.

Recruiting

Applicants:
Initiate
Background
Check

This permission in the
Recruiting
Recruiting category grants
access to manage background
checks from the Applicant
Profile page. This applies to
background checks that have
been configured in the
Integration Center. This
permission cannot be
constrained. Users who have
this permission will have an
Assign to Applicant link in the
background check status type
panel on the Applicant Profile
page. Once the background
check is assigned, the page
will display "Assigned - [Date
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

Assigned]." Note: This
permission allows users to no
longer need to set background
check status as "Sensitive."
There is no impact to sensitive
statuses that are currently set.
Recruiting

Applicants: View This permission in the
Recruiting
Background
Recruiting category allows
Check Status
users to view the background
check status. The user cannot
view the link to the detailed
report. This permission cannot
be constrained. Note: This
permission allows users to no
longer need to set background
check status as "Sensitive."
There is no impact to sensitive
statuses that are currently set.

Recruiting

Applicants: View
Background
Check Status
and Details Link

Recruiting

External
Grants access to view and
Search: Manage manage the external sourcing
functionality. This permission
cannot be constrained.

Recruiting

Reporting

Custom

Reports -

This permission in the
Recruiting
Recruiting category allows
users to view the background
check status and view a link to
access the background check
report, which can be found in
the background check status
type panel on the Applicant
Profile page. This permission
cannot be constrained. Note:
This permission allows users
to no longer need to set
background check status as
"Sensitive." There is no impact
to sensitive statuses that are
currently set.

Grants ability to create and
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

Onboarding
Report - Create

edit custom Onboarding
Analytics
reports. This permission refers
to creating custom reports for
the Onboarding module. This
permission can be constrained
by OU, User's OU, User Self
and Subordinates, and User's
Subordinates.

Reporting

Custom
Onboarding
Report - View

Reports Grants ability to view results
of custom Onboarding reports Analytics
created by self or shared by
others. This permission refers
to viewing custom reports for
the Onboarding module. This
permission can be constrained
by OU, User's OU, User Self
and Subordinates, and User's
Subordinates.

View

View People
Preferences
Page

Grants access to the View
View
People Preferences page,
which allows administrators to
configure the View People
page according to their needs
per organizational unit (OU).
This permission can be
constrained by OU, User's OU,
User, User Self and
Subordinates, and User's
Subordinates.

View

View People:
Share

Grants access to open View
People to view shared lists.
Can dynamically grant access
to users to only view the lists
that have been shared with
the user. This permission can
be constrained by OU, User's
OU, User, User Self and
Subordinates, User's Direct
Reports, and User's

View
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PRODUCT

PERMISSION
NAME

PERMISSION
DESCRIPTION

PERMISSION
CATEGORY

Subordinates.
View

View People:
View

Grants access to open View
View
People to see results and
share lists. This permission
can be constrained by OU,
User's OU, User, User Self and
Subordinates, and User's
Subordinates.

The following existing permissions are enhanced for the April '16 release:
PRODUCT

PERMISSION
NAME

PERMISSION UPDATE

PERMISSION
CATEGORY

Core

Badge & Point
Preferences Manage

The Badge Preferences Core
Manage permission name is
Administration
changed to Badge & Point
Preferences - Manage. Also, the
permission category is changed
from Universal Profile to Core
Administration.

Core

Feedback - View This permission can now be
and Post
constrained by Employee
Relationship.

Universal Profile

Core

Snapshot Competencies

This permission can now be
constrained by Employee
Relationship.

Universal Profile

Core

Snapshot Development
Plans

This permission can now be
constrained by Employee
Relationship.

Universal Profile

Core

Snapshot Reviews

This permission can now be
constrained by Employee
Relationship.

Universal Profile

Recruiting

Application
The permission description is
Recruiting
Custom Fields - modified to indicate that the
Administration
Manage
permission also grants access to
the Applicant Custom Fields and
Application Custom Fields
sections of the Requisition and
Applicant Preferences page.
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Release Notes Updates
Changes have been made on 19 May 2016, to the release notes for the April '16 release:

Core
ENHANCEMENT
NAME
Insights Career
Mobility

NAME OF
UPDATED TOPIC
This is new
functionality.

PURPOSE OF CHANGE
Include detailed release notes for
Insights Career Mobility.

Changes have been made on 10 May 2016, to the release notes for the April '16 release:

Core
ENHANCEMENT
NAME

NAME OF UPDATED
TOPIC

PURPOSE OF CHANGE

Headcount Planning

This is new functionality.

Introduce Headcount
Planning.

Insights Career
Mobility

This is new functionality.

Introduce Career Mobility.

View People

This is new functionality.

Introduce View People.

Edge
ENHANCEMENT NAME
Edge Integrate

NAME OF UPDATED
TOPIC
This is new functionality.

PURPOSE OF CHANGE
Introduce Edge
Integrate.

Recruiting
ENHANCEMENT NAME

Broadbean External
Sourcing

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

This is new
functionality.

Introduce new Broadbean External
Sourcing functionality.

FADV Enhancements and This is new
Migrate FADV from IUP to functionality.

Introduce new FADV functionality.
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ENHANCEMENT NAME

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Edge
Multiposting Integration

This is new
functionality.

Introduce new Multiposting
Integration.

Recruiting and Candidate
Search Usability
Enhancements

Recruiting
Usability
Enhancements

Clarified the explanation in the
Candidate Search Opt-Out
Prevention bullet.

Changes have been made on 29 April 2016, to the release notes for the April '16 release:

Learning
ENHANCEMENT
NAME

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Increased Video
Size

Increased
Video Size

This is a new enhancement.

Learning Rewards
& Recognition

Rewards and
Recognition
Overview

Updated the constraints on the Badge &
Point Preferences - Manage permission.

Training
Completion

Training
Completion
Overview

Clarified that the Training Completion page
is only available to organizations using the
redesigned Transcript.

Performance
ENHANCEMENT
NAME

NAME OF UPDATED
TOPIC

PURPOSE OF CHANGE

Performance Rewards Performance Rewards Updated the constraints on the
and Recognition and Recognition Badge & Point Preferences Leaderboard
Leaderboard
Manage permission.

Changes have been made on 22 April 2016, to the release notes for the April '16 release:
Note: The changes on 22 April 2016 will only be visible in the release notes that are posted
to the Client Success Center. The changes will be visible in Online Help on 29 April 2016.
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Learning
ENHANCEMENT
NAME
Training
Completion

NAME OF
UPDATED
TOPIC
Training
Completion
Overview
Training
Completion
Page

PURPOSE OF CHANGE

Updated the Training Completion Page
Availability & Redirection section to better
organize scenarios when automatic
redirection will not occur. The content is not
impacted by this change.

Recruiting
ENHANCEMENT
NAME

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Form Management Form
Custom Report
Management
Custom Report

Clarified that the name of the Form
Management Custom Report is changed to
Training Form Management Report.
Previously, the release notes indicated
that Form Management Custom Report
was a field name that was changing to
Training Form Management Report.

Google Analytics in Google
Applicant
Analytics in
Workflow
Applicant
Workflow

An "Organizations that Currently Have
Google Analytics Snippet on ATS Pages"
section is added to clarify this
enhancement for organizations that
already had the Google Analytics code on
their career page footer.

Recruiting and
Candidate Search
Usability
Enhancements

Recruiting
Usability
Enhancements

Added text to the Custom Email Message
bullet to indicate that HTML text editing
features are not available for the Send
Email from Template option on the
Applicant Profile > Summary page.

Recruiting and
Candidate Search
Usability
Enhancements

Recruiting
Usability
Enhancements

Changed the Pre-Screening Questions Screen Out Option bullet to indicate that
marking multiple options correct for
Multiple Choice Single Answer questions
can be done on the Create/Edit Question
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ENHANCEMENT
NAME

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

page when configuring the pre-screening
question. The correct answers cannot be
changed on the Screening Options pop-up.

Succession
ENHANCEMENT
NAME

NAME OF
UPDATED
TOPIC

Custom Report Support
Unlaunched Tasks

Custom
Report Support
Unlaunched
Tasks

PURPOSE OF CHANGE

The name of the enhancement is changed to
Custom Reports - Update to Task Status for
Launched Tasks.
The release notes have been updated to
indicate that Succession Management Plan
(SMP) tasks that have been started will now
accurately reflect in reporting. Text has been
removed that indicated that not started tasks
will be visible in the report output when
running Succession Custom Reports.

Changes have been made on 20 April 2016, to the release notes for the April '16 release:

Learning
ENHANCEMENT
NAME

NAME OF
UPDATED TOPIC

PURPOSE OF CHANGE

Course
Recommendations
Exclusion Flag

Course
Recommendations
Exclusion Flag

Clarified that the list of courses
that are recommended to users is
refreshed every seven days.

Learning Rewards &
Recognition

Badge & Point
Clarified the recommended size for
Preferences - Badges badge images, and added
information for creating badge
images.

Tin Can (xAPI)
Support - Learning
Record Store (LRS)

Tin Can (xAPI)
Support - Learning
Record Store (LRS)

Added an Integration Guidelines
document to the Implementation
section.
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Recruiting
ENHANCEMENT NAME

NAME OF UPDATED
TOPIC

Data Load Wizard - Support for
Data Load Wizard Keyword and Cost Center OU in Job Support for Keyword
Requisition and Job Requisition
and Cost Center OU in
Templates
Job Requisition and Job
Requisition Templates

PURPOSE OF
CHANGE
Clarified that this
enhancement
supports the
Requisition
Usability
Enhancements.

Inbound Data Feeds for Candidates Inbound Data Feeds for This is a new
and Applicants
Candidates and
enhancement.
Applicants
Changes have been made on 15 April 2016, to the release notes for the April '16 release:

Core
ENHANCEMENT
NAME
Language Pack
Enhancements Dutch, Czech,
Slovakia

NAME OF
UPDATED TOPIC
Language Pack
Enhancements Dutch, Czech,
Slovakia

PURPOSE OF CHANGE
Updated some of the new translation
values. Also, removed some
translation values that are not
applicable.

Learning
ENHANCEMENT
NAME
Learning Rewards
& Recognition

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Rewards and Updated the name of the Badge Preferences
- Manage permission to be more clear.
Recognition
Overview
Badge &
Point
Preferences Badges
Badge &
Point
Preferences 42
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ENHANCEMENT
NAME

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Points
Learning Rewards
& Recognition

Badge &
Added the names and descriptions of the
Point
default Learning badges.
Preferences Badges

Learning Rewards
& Recognition

Snapshot
General
Preferences

Updated the navigation instructions for the
Snapshot General Preferences page.

Training
Completion

Training
Completion
Overview

Updated the Training Completion Page
Availability & Redirection section to more
clearly define when the Training Completion
page is available to users.

Training
Completion
Page

More clearly defined when the Training
Completion page is automatically displayed
to users and when users must manually
navigate to the Training Completion page.

Performance
ENHANCEMENT
NAME

NAME OF UPDATED
TOPIC

PURPOSE OF CHANGE

Performance Rewards Performance Rewards Updated the name of the Badge
and Recognition and Recognition Preferences - Manage permission
Leaderboard
Leaderboard
to be more clear.

Recruiting
ENHANCEMENT
NAME
Onboarding
Custom Report

NAME OF
UPDATED
TOPIC
Onboarding
Custom
Report

PURPOSE OF CHANGE

Added the Forms Management - Approval
permission. This permission will now control
the visibility of the Form Approval section.
For users who do not have this permission,
the Form Approval section will not display on
the report.
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ENHANCEMENT
NAME
Onboarding and
Forms in MultiModule Custom
Report

NAME OF
UPDATED
TOPIC

PURPOSE OF CHANGE

Onboarding Removed, as this enhancement was not
and Forms in intended to be part of the April '16 release.
Multi-Module
Custom
Report
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Compensation
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Employee Salary Management Redesign
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Employee Salary Management Redesign
With this enhancement, the Employee Salary Management page is redesigned to improve
the look and feel of the page. In addition, employee salary data storage is optimized to
enable the system to handle more robust salary storage requirements for future salary
management enhancements.
o When editing, adding, or viewing salary details, the Labor Hours column is renamed,
and is now titled Annual Equivalency.
o Previously, the Labor Hours column displayed the number of labor hours
associated with the user's salary or rate. For example, the labor hours for a fulltime employee who worked 40 hours per week would be 2080.
o With this enhancement, the Annual Equivalency displays the equivalent number of
years or hours associated with the selected wage type. For example, for an Hourly
wage type with 40 hours per week and 52 weeks, the Annual Equivalency is 2080
Hours. For an Annual wage type, the Annual Equivalency is 1 Year.
o When editing or adding salary details, an Annual Equivalency table is now available for
each salary or rate entry. This table displays the equivalent annual and hourly rates. For
example, if the rate is Annual, then the table displays the annual rate and the hourly
rate based on 2080 labor hours per year. If the rate is Hourly, then the table displays
the hourly rate and the annual rate based on the number of labor hours that is specified.
This table can be accessed by clicking the Expand arrow to the left of the salary or
rate.
o When editing or adding a salary or rate, the Annual Equivalency information may
be editable. When the Wage Type is set to Annual, this table enables the
administrator to set the number of labor hours that is equivalent to one year.
When the Wage Type is set to Hourly, this table is read-only.
This enhancement does not impact data feeds.

Implementation
Upon release, this functionality is automatically enabled in all portals for organizations using
Compensation or Link. This functionality cannot be disabled.

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Employee Salary
Management

PERMISSION DESCRIPTION

Grants access to the Employee Salary
Management page to edit, add, and view users'
salaries or rates. This permission can be
constrained by OU, User's OU, and User. This is
an administrator permission.

CATEGORY

Compensation Administration

47

Cornerstone April 2016 Release Notes: What's New for April 2016

Employee Salary Management
With this enhancement, the Employee Salary Management page is redesigned to improve
the look and feel of the page. In addition, employee salary data storage is optimized to
enable the system to handle more robust salary storage requirements for future salary
management enhancements.
Only the appearance of this page has changed. All functionality on this page is unchanged,
including the search fields and the information that is displayed in the table.
To access Employee Salary Management, go to ADMIN > TOOLS > COMPENSATION
MANAGEMENT > EMPLOYEE SALARIES.
Permissions
PERMISSION
NAME
Employee Salary
Management

PERMISSION DESCRIPTION

Grants access to the Employee Salary
Management page to edit, add, and view users'
salaries or rates. This permission can be
constrained by OU, User's OU, and User. This is
an administrator permission.

CATEGORY

Compensation Administration
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Employee Salary Management - View Salary Details
With this enhancement, the View Salary Details pop-up is redesigned to improve the look
and feel of the page. Also, the following changes have been made to the pop-up:
o The Labor Hours column is renamed, and is now titled Annual Equivalency.
o Previously, the Labor Hours column displayed the number of labor hours
associated with the user's salary or rate. For example, the labor hours for a fulltime employee who worked 40 hours per week would be 2080.
o With this enhancement, the Annual Equivalency displays the equivalent number of
years or hours associated with the selected wage type. For example, for an Hourly
wage type with 40 hours per week and 52 weeks, the Annual Equivalency is 2080
Hours. For an Annual wage type, the Annual Equivalency is 1 Year.
To view the Salary/Rate Details for a user, go to ADMIN > TOOLS > COMPENSATION
MANAGEMENT > EMPLOYEE SALARIES. Then, click the View icon
column for the appropriate user.
Permissions
PERMISSION
NAME
Employee Salary
Management

PERMISSION DESCRIPTION

Grants access to the Employee Salary
Management page to edit, add, and view users'
salaries or rates. This permission can be
constrained by OU, User's OU, and User. This is
an administrator permission.

in the Actions

CATEGORY

Compensation Administration
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Employee Salary Management - Edit Salary Details
With this enhancement, the Edit Salary Details page is redesigned to improve the look and
feel of the page. Also, the following changes have been made to the page:
o The Add Salary/Rate link is now a button.
o The Labor Hours column is renamed, and is now titled Annual Equivalency.
o Previously, the Labor Hours column displayed the number of labor hours
associated with the user's salary or rate. For example, the labor hours for a fulltime employee who worked 40 hours per week would be 2080.
o With this enhancement, the Annual Equivalency displays the equivalent number of
years or hours associated with the selected wage type. For example, for an Hourly
wage type with 40 hours per week and 52 weeks, the Annual Equivalency is 2080
Hours. For an Annual wage type, the Annual Equivalency is 1 Year.
o An Annual Equivalency table is now available for each salary or rate entry. This table
displays the equivalent annual and hourly rates. For example, if the rate is Annual, then
the table displays the annual rate and the hourly rate based on 2080 labor hours per
year. If the rate is Hourly, then the table displays the hourly rate and the annual rate
based on the number of labor hours that is specified. This table can be accessed by
clicking the Expand arrow to the left of the salary or rate.
o When editing or adding a salary or rate, the Annual Equivalency information may
be editable. When the Wage Type is set to Annual, this table enables the
administrator to set the number of labor hours that is equivalent to one year.
When the Wage Type is set to Hourly, this table is read-only.
To edit the salary details for a user, go to ADMIN > TOOLS > COMPENSATION
MANAGEMENT > EMPLOYEE SALARIES. Then, click the Edit icon
column for the appropriate user.

in the Actions

To add a salary for a user, go to ADMIN > TOOLS > COMPENSATION MANAGEMENT >
EMPLOYEE SALARIES. Click the Edit icon
in the Options column for the appropriate
user. Then, click the ADD SALARY/RATE button.
Permissions
PERMISSION
NAME
Employee Salary
Management

PERMISSION DESCRIPTION

Grants access to the Employee Salary
Management page to edit, add, and view users'
salaries or rates. This permission can be
constrained by OU, User's OU, and User. This is
an administrator permission.

CATEGORY

Compensation Administration
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Edit Salary/Rate
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Add Salary/Rate
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Additional Compensation Fields
New Compensation fields are added to Compensation and Multi-Module Custom Reports.
Permissions
PERMISSION
NAME
Custom
Compensation
Report - Create

PERMISSION DESCRIPTION

Grants ability to create and edit custom
Compensation reports. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, and User's Subordinates.

CATEGORY

Reports Analytics

Custom
Grants ability to view results of custom Compensation Reports Compensation Report reports created by self or shared by others. This
Analytics
- View
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, and User's
Subordinates.

Compensation Fields
FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Currency ID

Currency ID will be listed in the Currency Code output, Text
such as USD. This is found in Employee Salary
Management in the Currency column.

Labor Hours

Labor Hours will be listed in the Labor Hours output.
This is found in Employee Salary Management in the
Labor Hours column.

Numeric

Salary

This is the User's Salary/Rate from the Employee
Salary Management page for the specific user. This
report will display every salary for the user.

Numeric

Salary
Effective
Date

Salary Effective Date is unique for each salary. This is Date
found in Employee Salary Management in the Effective
Date column.

Salary Last
Updated By
Task Name

This indicates the last time the salary was updated by
a task. This is found in Employee Salary Management
in the Last Updated column.

Text

Salary Last
Updated By
User Name

This indicates the last time the salary was updated by
a user. This is found in Employee Salary Management
in the Last Updated column.

Text
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FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Salary Last
This displays the last person that updated the salary.
Updated Date This is found in Employee Salary Management in the
Last Updated by column.

Date

Wage Type

Text

Wage Type will be listed in the Wage Type output.
This is found in Employee Salary Management in the
Wage Type column.
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Support Currency on Currency Tab in Summarized Reports
With this enhancement, when running a Compensation Custom Report, if the User’s
Currency option is selected on the Currency tab, the currency conversion will be correctly
reflected in the report output of summarized reports. Prior to this enhancement, with this
option selected on the Currency tab, the currency conversion was not correctly reflected in
summarized report outputs.

Use Case
1. Sam Smith is an analyst who must run a compensation report for a salary review being
performed at his global company.
2. Sam goes to the Compensation Custom Report and creates a report of users and
salaries.
3. Sam summarizes the report by location.
4. Sam goes to the Currency tab and selects User’s Currency: Convert all currency
fields to their corresponding user’s currency.
5. Sam runs the report and reviews the output. He sees salaries listed in the
corresponding user's currency.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME
Custom
Compensation
Report - Create

Custom

PERMISSION DESCRIPTION

Grants ability to create and edit custom
Compensation reports. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, and User's Subordinates.

CATEGORY

Reports Analytics

Grants ability to view results of custom Compensation Reports 56
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Compensation Report reports created by self or shared by others. This
- View
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, and User's
Subordinates.

Analytics
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Connect
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Search within Communities
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Search within Communities
Prior to this enhancement, users could only search for postings using the Global Search
functionality. This required the user to navigate out of the Connect Communities area.
With this enhancement, users can search for postings from within a community or topic.
The search returns all available postings within the current community or topic that match
the user's search criteria.

Use Cases
Sally is a Release Communications Manager for Cornerstone. She visits the Success
Center on a daily basis. While viewing the Connect community for the current release, Sally
decides to search for postings related to Connect Availability. From the current release's
Connect community, she searches for Connect Availability. The search returns all postings
within the current release's community that match her search terms.

Implementation
Upon release, this functionality is automatically enabled in all portals for organizations using
New Connect. This functionality cannot be disabled.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
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Community Main Tab - Search
Prior to this enhancement, users could only search for postings using the Global Search
functionality. This required the user to navigate out of the Connect Communities area.
With this enhancement, users can search for postings from within a community. The search
returns all available postings within the current community that matches the user's search
criteria.
To access a community, go to CONNECT > COMMUNITIES. Then, click the community
title.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on this
permission are automatically applied to the topic's
availability. This permission can be constrained by OU
and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.

To search for postings within a community, enter your search criteria in the Search within
community field and either click the Search icon or press [Enter]. This opens the
Community Search Results page. See Posting Search Results on page 67 for additional
information.
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Community Topics Tab - Search
Prior to this enhancement, users could only search for postings using the Global Search
functionality. This required the user to navigate out of the Connect Communities area.
With this enhancement, users can search for postings from within a community. The search
returns all available postings within the current community that matches the user's search
criteria.
To access a community, go to CONNECT > COMMUNITIES. Then, click the community
title.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on this
permission are automatically applied to the topic's
availability. This permission can be constrained by OU
and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.

To search for postings within a community, enter your search criteria in the Search within
community field and either click the Search icon or press [Enter]. This opens the
Community Search Results page. See Posting Search Results on page 67 for additional
information.
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Topic Details Page - Search
Prior to this enhancement, users could only search for postings using the Global Search
functionality. This required the user to navigate out of the Connect Communities area.
With this enhancement, users can search for postings from within a topic. The search
returns all available postings within the current topic that matches the user's search criteria.
To view the Topic Details page for a community topic, click the topic title from anywhere in
the community.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on this
permission are automatically applied to the topic's
availability. This permission can be constrained by OU
and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.

To search for postings within a topic and its subtopics, enter your search criteria in the
Search within topic field and either click the Search icon or press [Enter]. This opens
the Community Search Results page. See Posting Search Results on page 67 for
additional information.
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Posting Search Results
Prior to this enhancement, users could only search for postings using the Global Search
functionality. This required the user to navigate out of the Connect Communities area.
With this enhancement, users can search for postings from within a community or topic.
The search returns all available postings within the current community or topic that match
the user's search criteria.
When searching for postings, the following fields may be searched:
o
o
o
o
o
o
o
o
o

Title
Body
Replies
File names for attached files
URL title for attached URLs
Posting author
Community name
Parent topics
Tags

To search for postings within a community or topic, enter your search criteria in the Search
field in the upper-right corner of the community or topic. Then, either click the Search icon
or press [Enter]. This opens the Community Search Results page.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
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Back
Click the Back link to return to the Community page or Topic Details page from which you
initiated the search.

Search
To initiate a new search, enter your search criteria in the Search field and either click the
Search icon or press [Enter]. This refreshes the page with the new search results.

Search Results
In the search results, featured postings are displayed above non-featured postings.
The following information is displayed for each posting that matches your search criteria:
o Posting Icon - An icon is displayed to the left of the posting title. This icon reflects the
posting type.
o Posting Title - This displays the posting title. Click the posting title to view the posting.
o Posting Type
o Author - This displays the posting author's photo and name and the date on which the
original posting was created.
o Parent Topic - This displays the topic that is associated with the posting.
o Body - This displays the posting text, up to two lines.
o Tags - Any tags that are associated with the posting are displayed below the posting
body. System-defined tags are displayed before user-defined tags. User-defined tags
are displayed in chronological order. Up to five total tags are displayed.
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Tags in Communities
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Tags in Communities
Prior to this enhancement, only system-defined tags could be added to postings in Connect
communities. This type of tag is only for display purposes and cannot be added to postings
by end users.
With this enhancement, users are able to create custom tags and add them to postings in
Connect communities. In addition, users may be able to search for postings by tag and filter
postings by tag. When users can search for postings by tag, they can also click a tag that is
associated with a posting to initiate a search for other postings with the same tag. This
enhancement improves a user's ability to search for and discover content within Connect.

Use Cases
Fred is the administrator for a Connect community. Recently, there has been an influx of
new postings within the community which has made it difficult to find relevant postings. Fred
decides to tag postings with relevant tags so that members of the community can quickly
sort postings and find the postings that are relevant to their search.
Harry is a new employee at Acme Co. Harry joined a community, and he is really interested
in postings about Project Management. Harry wants to search for postings about Project
Management. He finds a posting that has the Project Management tag, and he clicks the
tag. This opens a search that displays all of the available postings that have the Project
Management tag.

Considerations
User-defined tags cannot be localized.
Tags are not case-sensitive or accent-sensitive, however the tag is captured as it is
entered. For example, Management is the same as management, and elephant is the same
as élephant.
Tags cannot be added to the posting title or within comments.
Even if a tag is removed from all postings, it still remains in the system and will appear in
the pop-up menu when searching for tags.

Implementation
Upon release, this functionality is automatically enabled in all portals for organizations using
New Connect. This functionality cannot be disabled.

Glossary
o Tag - This is a keyword that can be added to Connect postings. These can be used to
categorize postings, and users can use them to search for other postings with the same
tag.

Security
The following existing permissions apply to this functionality:
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PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Admin Search
Preferences Manage

Grants ability to configure preferences for Global Learning Search and Course Catalog within Search
Administration
Preferences. The constraints of this permission
are inherited from the Global Search Preferences Manage permission. This is an administrator
permission.

Global Search Connect

Grants ability to search for Knowledge Bank and
New
community postings via Global Search. This
Connect
permission cannot be constrained. The user's ability to
view a posting is determined by the user's ability to
view the posting's Knowledge Bank or community
topic. This is an end user permission. The availability
of this permission is controlled by a backend setting.

Global Search
Preferences Manage

Grants ability to configure Global Search
Core
Preferences. This is an administrator permission. Administration
The availability of this permission is controlled by a
backend setting. This permission can be
constrained by OU and User's OU. By default, this
permission is constrained to the organization.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
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Search Preferences - Connect
With this enhancement, users can create and add custom tags to a posting. In order to
support this functionality, administrators can now configure Global Search to allow users to
refine their search by posting tags.
To access the Search Preferences - Connect page, go to ADMIN > TOOLS > CORE
FUNCTIONS > CORE PREFERENCES > SEARCH. Then, click the Connect tab on the left
navigation bar. Note: This tab is not clickable unless it is enabled as a search type on the
General tab.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Admin Search
Preferences Manage

Grants ability to configure preferences for Global Learning Search and Course Catalog within Search
Administration
Preferences. The constraints of this permission
are inherited from the Global Search Preferences Manage permission. This is an administrator
permission.

Global Search
Preferences Manage

Grants ability to configure Global Search
Core
Preferences. This is an administrator permission. Administration
The availability of this permission is controlled by a
backend setting. This permission can be
constrained by OU and User's OU. By default, this
permission is constrained to the organization.

In the Refine Search Options section, the following option is now available:
o Tag - When this option is selected, users are able to search for Connect postings by tag
name. When this option is not selected, users cannot search by tag name. As a result,
users cannot click a posting tag from other areas of the system to initiate a search for
that tag. This includes the Posting view, the Topic Details page, and the Community
Main tab.
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Posting - Create/Edit
With this enhancement, user-defined tags or keywords can now be added to a posting
when creating or editing a posting. Tags can be added to a posting in two ways:
o A new Tags field is now available when creating or editing a posting, which enables
users to add tags or keywords to their posting. Once the posting is saved, the tags
appear below the body of the posting. This also applies when creating postings for a
community template for a program.
o Within the body of the posting, users can place a hashtag before a word. When the
posting is saved, the word is added as a tag, and the tag appears below the body of the
posting.
To create a posting, click the appropriate topic title from anywhere in the Knowledge Bank
or communities. Then, from the Create Posting drop-down menu, select the appropriate
posting type.
Permissions
PERMISSION
NAME
View Knowledge
Bank/Communities

Emails
EMAIL NAME

Knowledge
Bank/Communities
New Posting Created

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
EMAIL DESCRIPTION

This email is triggered when a new Knowledge Bank
or community posting is created. This email can be
sent as a notification to Community Moderator,
Community Members, Follower, or a specific user. A
recipient must match the following criteria to receive
the email:

ACTION
TYPE
New
Connect

o User is within the availability criteria for the
corresponding posting's parent topic.
o User is within the constraints of the posting's
parent topic's creator constraints.
o User is a member of one of the communities with
which the topic is shared.
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Tags
This section enables users to add tags or keywords to their posting. Once the posting is
saved, the tags appears as links on the posting, and users can click a tag to view all
postings that have the same tag. For example, if you add a "Time Management" tag to your
posting, then clicking this tag will display all postings that include the "Time Management"
tag. This is an effective way to categorize your posting. Once the posting is saved, you can
use the tag to find other postings that have similar content.
To add a tag, enter the tag name in the field. Multiple tags can be added by adding a
comma after each tag or by pressing [Enter] after each tag. Users can add new or existing
tags. Tags are not case-sensitive or accent-sensitive, however the tag is captured as it is
entered (e.g., Management is the same as management and elephant is the same as
élephant). Each tag can contain a maximum of 70 characters, and the character limit for all
tags in a posting is 200. Note: If a user enters a tag name that is a system-defined tag such
as Featured, then this is added as a user-defined tag, which behaves differently than a
system-defined tag.
To select a tag from a list of existing tags, click the Add Existing Tags link. This opens a
pop-up, in which all existing user-defined tags are displayed. Note: System-defined tags
cannot be selected. These tags are automatically associated with a posting. See Single
Item Select Pop-up.
To remove a tag, click the Delete icon

to the right of the tag name.

Hashtags
Hashtags can now be used in the body of the posting, and the system will apply the text
after the hashtags as tags once the posting submitted.
Hashtags cannot be used within the posting title or within posting comments.
To add a tag to a posting using hashtags, enter a hashtag "#" within the posting body, and
the text following the hashtag will be converted into a tag once the posting is submitted.
o Hashtags are not affected by accents on characters. Accents on characters are
included in the tag.
o Spaces, new lines, and special characters end a hashtag.
A maximum of 200 tags can be added to a posting. If a posting has reached the maximum
number of tags, then no additional tags are added, even if a hashtag is added to the posting
body.
In order to remove a hashtag tag, the hashtag must be removed from the body of the
posting, and the tag must be removed from the Tags field.
The following are examples of hashtags with spaces and special characters and the
resulting tags:
HASHTAG
#élephant

RESULTING TAG
élephant
76

Cornerstone April 2016 Release Notes: What's New for April 2016

HASHTAG

RESULTING TAG

#Leadership and Responsibility

Leadership

#fish&chips

fish

#web2.0

web2

#isn't

isn

#a-b

a

#*.*
#yay!

yay

Cohorts
Tags can be added to postings when creating a community template for a program.
When a cohort is created, the tags are added to the postings within the new cohort.
When a tag is removed from a posting within a community template, the tag is not removed
from any existing postings within cohorts that have been created from the community
template.
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Posting - View
With this enhancement, users can create and add custom tags to a posting. As with
system-defined tags, any user-defined tags that are associated with the posting are
displayed below the body of the posting. System tags are displayed before user-defined
tags.
Users can click one of the tags to initiate a search within Global Search for all postings that
contain the selected tag. Users can only view postings which they can access. Note: The
ability to click a posting tag to initiate a search is only available if the ability to search for
Connect postings by tag is enabled via Search Preferences.
Hashtags cannot be used to create a tag when commenting on a posting.
To view a posting, click the posting title from anywhere in the Knowledge Bank or
communities.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
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Topic Details Page
With this enhancement, a new Filter by Tag drop-down is now available on the Topic
Details page. In addition, the list of postings now displays all of the tags that are associated
with each posting.
To view the Topic Details page for a community topic, click the topic title from anywhere in
the community.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.

Filter by Tag
The Filter by Tag filter displays the top 10 most popular tags for the topic. This filter is only
available if there is at least one tag used within the topic's postings. The system determines
tag popularity by the number of postings with which the tag is associated.
If there are more than 10 tags used within the topic, then a More Tags option is available
within the drop-down. When this option is selected, a Select Tag pop-up opens, which
displays all of the tags that are used within the topic.
If a tag is selected, then only postings that are associated with the selected tag are
displayed. Users can select system-defined or user-defined tags, and only one tag can be
selected. This filter is only applied to the selected topic and does not include postings within
any subtopics. The selected tag appears to the right of the Filter by Tag filter. To remove
the tag filter, click the Remove icon

to the right of the tag name.
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Tag Display
If a posting is associated with a tag, then the tag is displayed below the posting title. Only
one row of tags are displayed; additional tags are only visible when viewing the posting.
When filtering by tag, the filtered tag is displayed first if the posting is associated with the
tag. Then, system tags are displayed before user-defined tags.
Users can click one of the tags to initiate a search within Global Search for all postings that
contain the selected tag. Users can only view postings which they can access. Note: The
ability to click a posting tag to initiate a search is only available if the ability to search for
Connect postings by tag is enabled via Search Preferences.
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Global Search - Connect Postings
With this enhancement, users can create and add custom tags to a posting. Global Search
can be configured to allow users to refine their search by posting tags. In addition, the
search results now display all of the tags that are associated with each posting.
To access the Global Search Page, Click the magnifying glass icon
corner of any system page.
Permissions
PERMISSION
NAME
Global Search Connect

PERMISSION DESCRIPTION

in the upper-right

CATEGORY

Grants ability to search for Knowledge Bank and
New
community postings via Global Search. This
Connect
permission cannot be constrained. The user's ability to
view a posting is determined by the user's ability to
view the posting's Knowledge Bank or community
topic. This is an end user permission. The availability
of this permission is controlled by a backend setting.

When searching for connect postings, users can enter a posting tag in the search field, and
Global Search will return postings that are associated with the tag.
When enabled, users can click the Tags filter option to open a pop-up window, in which
users can select a system-defined or user-defined tag. When a tag is selected and a search
is initiated, only postings that are associated with the selected tag are displayed.
When viewing a Connect posting in the search results, up to five of the tags associated with
a posting are displayed below the posting details. When filtering by tag, the filtered tag is
displayed first if the posting is associated with the tag. Then, system tags are displayed
before user-defined tags. Users can click one of the tags to initiate a search within Global
Search for all postings that contain the selected tag. Users can only view postings which
they can access. Note: The ability to click a posting tag to initiate a search is only available
if the ability to search for Connect postings by tag is enabled via Search Preferences.
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Community Main Tab - Popular Tags
Within a community, a Popular Tags panel is now available on the Main tab. This panel is
only available when tags are enabled. Also, this panel is not displayed if there are no tags
within a community.
To access a community, go to CONNECT > COMMUNITIES. Then, click the community
title.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.

Popular Tags Panel
The Popular Tags panel displays the most popular tags that are being used within the
community. The system determines tag popularity by the number of times any posting that
contains the tag is viewed within the community. System-defined tags are not included in
the panel. This panel is updated every three hours. This panel is only available when tags
are enabled, and this panel is not displayed if there are no tags within a community.
Below each tag, the total number of times a posting that contains the tag has been viewed
across the entire community. This calculation includes all postings in the community, even if
the user is not able to view the posting.
Click a tag to initiate a search within Global Search for all postings that contain the selected
tag. Users can only view postings which they can access. Note: The ability to click a
posting tag to initiate a search is only available if the ability to search for Connect postings
by tag is enabled via Search Preferences.
85

Cornerstone April 2016 Release Notes: What's New for April 2016

86

Cornerstone April 2016 Release Notes: What's New for April 2016

Learning Community Main Tab - Course Ratings
Prior to this enhancement, the Course Ratings panel was displayed on the Main tab of a
learning community even if no course ratings were available for members of the learning
community.
With this enhancement, the Course Ratings panel is only displayed on the Main tab of a
learning community if there is at least one course rating available to the user.
To access a community, go to CONNECT > COMMUNITIES. Then, click the community
title.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Manage Knowledge
Bank/Communities
Administration

Grants ability to view the New Knowledge Bank
New
Administration page. Based on permission
Connect
constraints, administrators with this permission can
create and delete topics and subtopics.
Administrators with this permission can view all
communities, topics, sub-topics and postings,
regardless of permission constraints. In addition,
administrators can add a posting to the Course
Catalog. When creating a topic, the constraints on
this permission are automatically applied to the topic's
availability. This permission can be constrained by
OU and User's OU. This permission is assigned to the
default Administrator role by default.

View Knowledge
Bank/Communities

Grants ability to view the Knowledge Bank and
New
Communities pages. This permission can be
Connect
constrained by OU and User's OU. This permission is
assigned to the default Administrator role by default.
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Data Load Wizard - Duplicate User Prevention
This enhancement to the Data Load Wizard provides identification of duplicate user records
for the Link - Duplicate User Prevention enhancement. See Link - Duplicate User
Prevention on page 122 for additional information.
When an organization using Link loads new users using the Data Load Wizard, the system
can be configured to determine whether the new users are similar to existing user records.
This is done in order to prevent the same user from being added to the system more than
once.
When loading user using the Data Load Wizard - User Load for Link, the system now
determines whether the user record is potentially a duplicate user record:
o If the user record is determined to be unique, then the user is added as a new user.
o If the user record is determined to be a potentially duplicate user record, then the user
record is created in a pending state.
o The user record information is added to the Pending User Records page. See
Pending User Records on page 130 for additional information.
o The following error description is displayed in the Excel Error Report for the
pending user record: This user was found to be a potential duplicate of an existing
user record. As a result, the user was added in a pending state. This user will not
have access to Cornerstone until they are reconciled, which can be done by a
system administrator from the 'Admin > Core Functions > Pending User Records'
page.
If pending user records are identified, administrators should navigate to the Pending User
Records page to take action on the prevented duplicate users.
To start the Data Load Wizard, go to ADMIN > TOOLS > CORE FUNCTIONS > DATA
LOAD WIZARD, and then click Load Data. The Data Load Wizard opens.
Permissions
PERMISSION NAME
Data Load Wizard Users

PERMISSION DESCRIPTION

CATEGORY

Enables administrator to load users. This permission Data Load
also enables administrators to track data loads and
Wizard
manage data load templates. This is an administrator
permission.

Implementation
This functionality is only available to organizations using Link and the Data Load Wizard.
This functionality is controlled by a backend setting, which is disabled by default.
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Data Load Wizard - Historical Effective Dating
This enhancement to the Data Load Wizard provides support for loading users into the
system with an effective date. See Link - Historical Effective Dating for User Data on
page 133 for additional information.
With this enhancement, when loading users into the system using the Data Load Wizard,
an As of Date can now be associated with a user record. By setting an effective date for a
user record, administrators can set changes that are effective in the past and in the future
via the Data Load Wizard.
Effective dating is applied to the entire record. It cannot be applied on a field-by-field basis
when loading data using the Data Load Wizard.
The As of Date field is now available in the template when loading user data. This field
accepts date values.
Backdating user data before 1901 is not supported.
Currently, the Data Load Wizard does not support adding a user with multiple effective
dated records within the same load file. If a user has multiple effective dated records, the
records must be loaded in separate files.
To start the Data Load Wizard, go to ADMIN > TOOLS > CORE FUNCTIONS > DATA
LOAD WIZARD, and then click Load Data. The Data Load Wizard opens. Select the Users
option and click NEXT.
Permissions
PERMISSION NAME
Data Load Wizard Users

PERMISSION DESCRIPTION

CATEGORY

Enables administrator to load users. This permission Data Load
also enables administrators to track data loads and
Wizard
manage data load templates. This is an administrator
permission.

Implementation
Upon release, this functionality is automatically enabled for all organizations using Link and
the Data Load Wizard.
In order to purchase Link or the Data Load Wizard, please contact Sales or your Client
Executive.
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Headcount Planning Overview
Headcount Planning enables efficient, enterprise-wide collaboration to identify the number
and mix of employees that will be needed to achieve the organization’s business objectives
in the future. Headcount Planning controls access to sensitive information, includes built-in
versioning and error tracking, and provides a seamless approval and consolidation
workflow. The interface is designed specifically for the headcount planning process, rather
than having to use a generalized spreadsheet.

Use Cases
Finance requires headcount plans from business managers to account for their talent
requirements and to prepare accurate budget forecasts. It is a logistical challenge to
coordinate so many business managers, and also to consolidate their responses into one
single headcount plan. Traditionally, Finance has created, shared, and collected
spreadsheets for each business manager, which is a tedious and error-prone way of
gathering this information.
The Talent/Human Resources (HR) Department uses headcount plans to strategize how to
best meet the organization’s projected talented needs. With visibility into expected talent
gaps, HR can decide when and how to develop talent internally and/or hire talent externally.

Considerations
Headcount Planning utilizes Position Management and requires accurate position instance
data about the organization, including all active position instances and any relationships
between those position instances, as well as all position instance attributes and any
relationships between those attributes. This data will represent the baseline on which plans
are created. Any changes to position instance data can be updated via a scheduled data
feed or a data load.

Implementation
The availability of this functionality is controlled by backend settings, which are disabled by
default and require a work order to enable. Contact Global Product Support to enable this
functionality. This product also requires technical projects. Please contact your Client
Success Manager for details.

Glossary
o Attribute - A characteristic of a position instance, such as its location, cost center, or
grade.
o Co-Planners - For a given plan or subplan, a co-planner can take planning actions and
submit the plan. But the co-planner cannot add or remove co-planners or change the
primary planner. There can be unlimited co-planners for a given plan.
o Full-Time Equivalent - The percentage of full-time that each position instance requires.
o Headcount - Headcount is the intention to fill a position instance with an employee
and/or assign a cost to that position instance, depending on configuration. Headcount is
not equivalent to a position instance.
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o Headcount Planning - The process of estimating headcount needs for the future.
Factors in the business needs, costs, and constraints, such as budget.
o Position - A “Job Type”, such as Truck Driver, Plant Operator, Engineer, etc.
o Position Instance - One specific “Job” within the “Job Type”. For example, an
organization may have the position of Truck Driver, and then have 50 position instances
of that Truck Driver comprising its Trucking division. Position instance is not equivalent
to headcount.
o Primary Planner - For a given plan or subplan, the primary planner can take planning
actions, submit plans, add or remove co-planners, and change the primary planner.
There can only be one primary planner per plan.
o Subplan - One part of a larger headcount plan. A subplan, along with other subplans,
rolls up into one larger plan in a headcount planning approval workflow. Subplans are
assigned in a top-down direction and are completed/approved in a bottom-up direction.

Security
The following new permission applies to this functionality.
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Core
Work Force Planning Grants access to the Headcount Planning page.
Administration
- Administrator
Users with this permission can also create new
headcount plans for any part of the organization,
as well as create subplans that have been
assigned to them. Administrators can only view
plans that they have created or to which they were
assigned as a Co-Planner or Primary Planner This
is an administrator permission.
Work Force Planning Grants the ability to complete subplans that have Core
Administration
- Subplanner
been assigned to the user. Users with this
permission cannot create new headcount plans or
view all plans. They can only view plans that they
create and plans in which they are assigned a role
of Owner, Subplanner, or Co-Planner.
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Headcount Planning Page - Overview
The Headcount Planning page is a dashboard that allows you to view a snapshot of
headcount plans that are in progress or completed. You can also create new plans from this
page.
To access the Headcount Planning page, go to PLANNING > HEADCOUNT PLANNING.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Core
Work Force Planning Grants access to the Headcount Planning page.
Administratio
- Administrator
Users with this permission can also create new
n
headcount plans for any part of the organization, as
well as create subplans that have been assigned to
them. Administrators can only view plans that they
have created or to which they were assigned as a CoPlanner or Primary Planner This is an administrator
permission.
Core
Work Force Planning Grants the ability to complete subplans that have
- Subplanner
been assigned to the user. Users with this permission Administratio
cannot create new headcount plans or view all plans. n
They can only view plans that they create and plans
in which they are assigned a role of Owner,
Subplanner, or Co-Planner.
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Create New Plan
Click CREATE NEW PLAN to create a new headcount plan. This opens the Create a Plan
page. See Create Plan - Create a Plan Page on page 97 for additional information.
Note: The CREATE NEW PLAN option is only available for users with permission to be
plan administrators.

Active Plans
This section displays plans that are currently active. If you have more than two active plans,
you can scroll to the right to view additional plans.
The following information displays for each plan:
o Plan Name - This displays the title of the plan, which is defined when the plan is
created.
o Primary Planner - This displays the name of the user who is designated by the plan
creator to be the primary planner. For the user that is the primary planner, the name of
the primary planner will be clickable and can be edited. Co-planners will not be able to
click and edit the primary planner.
o Co-Planners - This displays the name of the co-planner. For the user that is the primary
planner, the name will be clickable and can be edited. For users that are co-planners,
they will not be able to click and edit the co-planners
o Plan Horizon - This displays the amount of time that is being planned.
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o Headcount in Your Plan - This displays the total headcount value in your organization
at the time of plan creation. This number is a baseline and does not change when you
add or subtract headcount in the plan itself.
o Due Date - This displays the date on which your plan is due. This date is for
informational purposes only, and the plan will not be rescinded or closed automatically
when this date is reached.
To open the plan, click GO TO PLANNING.

Completed Plans
This section displays details about your completed plans. Plans are sorted by default by the
date completed, with the most recently completed at the top.
The following information displays for completed plans:
o
o
o
o
o
o

Name - This displays the title of the plan.
Date Completed - This displays the date on which the plan was completed.
Primary Planner - This displays the primary planner of the plan.
Plan Horizon - This displays the plan horizon period in years.
Headcount - This displays the total headcount value in your plan.
Actions - The following actions are available:
o Review - Click REVIEW to open a brief summary of the submitted plan. The
summary displays the primary planner and the total headcount in the plan.
o Export - Click EXPORT to export the plan to a .csv file. The rows of the table will
be all position instances for each time increment in the plan in separate rows. The
columns will be the attributes of the position instance in each time increment.
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Create Plan - Create a Plan Page
The Create a Plan page is the first step in creating a headcount plan. From this page, you
will define general information about the plan, such as the name and due date. You will also
define the time scope of the plan.

General
The following fields display in the General section:
o Name of your Plan - Enter the plan name. There is no character limit.
o Primary Planner - Select the primary planner from the users in the drop-down, which
include the plan creator, the user who occupies the top most position instance in the
plan, and possibly position instances at that highest level, depending on configuration.
There can only be one primary planner per plan. This field is required and by default is
the plan creator.
o Co-Planners - You can select any user in the portal. Select the user from the dropdown, and then click the plus icon to add the user as a co-planner. There can be
unlimited co-planners per plan. This field is not required and, by default, there are no
co-planners assigned.
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o Due Date of your Plan - Click the Select a Date field to enter a due date. With the April
'16 release, the due date is not recognized as a date that will trigger any actions, such
as closing the plan. This field is not required.

Show Advanced Settings
The Instructions and Description fields will be visible in the Advanced Settings section for
the April '16 release but will have no functionality for the plan. Any instructions or
description entered in the fields will not appear in the plan.

Scope
The following fields display in the Scope section:
o What is the Time Horizon of this plan in years? - The time horizon is the total period
of time for which the user intends to plan. Select one of the time horizon options. The
options are in yearly increments, with 0.5 being six months.
o On what Time Increment are you planning? - This defines how the time horizon is
broken up or segmented for planning purposes. Currently, the time increment is
automatically defined as monthly. Additional options to define the increment as quarterly
or annually may be added in a future release.
o What is the Start Date of the plan period? - This field allows you to define the start
date of the time horizon. Click the Select a Date field to enter a start date. The date can
be a current, future, or past date. For example, you select three years in the Time
Horizon field. Then, you set the start date of the time horizon for June 2017. This would
mean that the headcount plan would run from June 2017 to May 2020.

Start Planning/Cancel
Click START PLANNING to create your headcount plan. This saves the plan to the Active
Plans section on the Headcount Planning homepage and opens the planning page.
Important Note: Only click the START PLANNING button once. If you click it more than
once, you will create a new plan each time you click the button.
Click CANCEL to cancel creating the plan.
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Create Plan - Planning Page
From the planning page, you can create and modify your headcount plan by predicting
headcount needs for the plan period.
To access the planning page, click START PLANNING from the Create a Plan page. Or,
click GO TO PLANNING from the Headcount Planning page.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Core
Work Force Planning Grants access to the Headcount Planning page.
Administration
- Administrator
Users with this permission can also create new
headcount plans for any part of the organization,
as well as create subplans that have been
assigned to them. Administrators can only view
plans that they have created or to which they were
assigned as a Co-Planner or Primary Planner This
is an administrator permission.
Work Force Planning Grants the ability to complete subplans that have Core
Administration
- Subplanner
been assigned to the user. Users with this
permission cannot create new headcount plans or
view all plans. They can only view plans that they
create and plans in which they are assigned a role
of Owner, Subplanner, or Co-Planner.
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General Plan Information
The name of the plan and the plan due date displays at the top of the page. If a due date is
not configured for the plan, then "Due Date Not Specified" displays.

Details
Click Details to view a pop-up that displays the plan due date and plan period.
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Plan Year Tabs
The time horizon is separated into tabs. A separate tab displays for each year in the plan.
Click a plan tab to view the headcount, FTE, and cost for the selected year.

Show
The following display options are available in the upper-left of the plan table:
o Headcount/FTE/Cost - The first button to the right of Show allows you to determine
which values display in the table. Select one of the following options:
o Headcount - This option is selected by default. When this option is selected, you
can view the projected headcount for each position instance.
o FTE - When this option is selected, you can view the FTE value for each position
instance and for each role.
o Cost - When this option is selected, you can view the cost associated with each
position instance. The cost fields cannot be modified directly. Cost is adjusted
based on changes to headcount, FTE, or other attributes configured by the
costing model uploaded during implementation.
o Currency - This option allows you to view the plan in the selected currency. For the
April '16 release, only one currency can be imported and displayed.

Add Position (Instance)
You can add position instances to the plan. Position instances that are added cannot be
deleted from the plan. Once the position instance is added, even if all position instances are
changed to 0, the position instance will still appear as a row in the table.
To add a position instance:
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1. Click ADD POSITION. This opens the New Headcount panel to the right of the plan
table.
2. Complete the following required and optional fields:
o Job Title - By default, the job title is the highest level position in the organization.
You can select a different job title from the drop-down. The options that are
available are the Position OUs in the portal or the options that were defined during
implementation of Headcount Planning. This is a required field.
o Start Date - By default, the start date is the first month in the planning period. You
can select a different date as the start date. This is a required field.
o FTE - Enter the FTE value. This is a required field. The acceptable values are 0 and
1 and any value in between within two decimal points. Decimal points round up. To
enter a decimal, enter 0.[decimal number].
o Headcount - Enter the headcount value, either 1 or 0. This is a required field.
o Location - Select the location from the drop-down. The options that are available
are the Location OUs in the portal or the options that were defined during
implementation of Headcount Planning.
o Division - Select the division from the drop-down. The options that are available are
the Division OUs in the portal or the options that were defined during
implementation of Headcount Planning.
o Cost Center - Select the cost center from the drop-down. The options that are
available are the Cost Center OUs in the portal or the options that were defined
during implementation of Headcount Planning.
o Grade - Select the grade from the drop-down. The options that are available are the
Grade OUs in the portal or the options that were defined during implementation of
Headcount Planning.
o Manager - Select the position that will be the manager for the position. The options
that are available are the Position OUs in the portal or the options that were defined
during implementation of Headcount Planning.
3. Click SAVE to add the position instance to the plan. The new position instance will
appear in the plan under the Direct Reports section for the option selected in the
Manager field.
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Plan Table
The plan table allows you to create the headcount plan for each position instance. The
information that displays in the plan table depends on the option selected in the Show
option. The following views are available:
o Headcount - This option is selected by default. When this option is selected, you can
view the projected headcount for each position instance.
o FTE - When this option is selected, you can view the FTE values for each position
instance.
o Cost - When this option is selected, you can view the cost associated with a position or
position instance. The cost fields cannot be modified directly. Cost is adjusted based on
changes to headcount or FTE. The FTE cost is calculated by multiplying the cost of a
full-time position. For example, if FTE is changed to 0.5, then cost is halved.
Primary planners and co-planners see all position instances within the area of the
organization in the plan that was assigned to them or in the plan they created themselves.
By default, all values in the starting increment are assumed to carry forward to all future
increments in the plan.
Each time the plan is opened, the table displays the top level position instance, with the first
level below expanded.
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Org/Position
This section displays the hierarchy of the position instance. The direct reports are the group
of positions that report directly to the position above it. Indirect reports display below direct
report grouping and are considered direct and indirect reports of a direct report. You cannot
edit values in the rows for "Direct Reports" or "Indirect Reports."

Position Instances - Headcount
When viewing Headcount from the Show option, the table displays each segment of the
time horizon as a separate column. You can only edit the position instance rows. Any
values in the "Entire Organization" and "Direct Reports" rows cannot be modified. Any value
in a row with the word "Reports" in it cannot be changed. Headcount can only be changed
for a specific position instance.
To modify the position instance value:
1. Click the desired cell in the corresponding position instance row and time horizon
column.
2. Delete the value or backspace over the value.
3. Enter the new value of either 1 or 0. The value and color of the current and all
subsequent cells in the row changes to green if the value is 1, and it changes to red if
the value is 0. Note: If the headcount value is changed to 0, then FTE and cost are also
changed to 0. The FTE cannot be edited when the headcount value is 0.
4. Click away from the cell to automatically update the table with the new value.

Position Instances - FTE
When viewing FTE from the Show option, the table displays each segment of the time
horizon as a separate column. You can only edit the position instance rows. These rows are
colored in red or green. The values in the "Direct Reports" or "Indirect Reports" rows cannot
be modified.
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To modify the FTE value:
1. Click the desired cell in the corresponding FTE row and time horizon column.
2. Delete the value or backspace over the value.
3. Enter the new value. The acceptable values are 0 and 1 and any value in between
within two decimal points. Decimal points round up. To enter a decimal, enter 0.[decimal
number]. The value and color of the current and all subsequent cells in the row changes
to green if the value is 0.01 or greater, and it changes to red if the value is 0.
4. Click away from the cell to automatically update the table with the new value.

Annual Cost
This column displays the sum of the cost of the position instances for all increments in the
year displayed. The cost will adjust based on changes to headcount and FTE or other
position attributes as defined by the costing model that you uploaded. For example, if you
change the headcount from 1 to 0 for a position instance, then the cost will decrease (likely
to 0 but is dependent upon how costing is configured) based on the removal of headcount.

Edit Existing Position (Instance) Attributes
You can change the attributes for existing positions by clicking within a position instance or
FTE. This opens the attributes panel to the right of the table. The position title and place in
the time horizon displays at the top.
The following additional fields and information displays for existing position instances:
o FTE - The FTE value is the percentage of full-time that each position instance requires..
This is a required field. The acceptable values are 0 and 1 and any value in between
within two decimal points. Decimal points round up. To enter a decimal, enter 0.[decimal
number].
o Headcount - Enter a value of 1 or 0. The value and color of the current and all
subsequent cells in the row changes to green if the value is 1, and it changes to red if
the value is 0. Note: If the headcount value is changed to 0, then FTE and cost are also
changed to 0. Position attributes, including FTE, cannot be edited when the headcount
value is 0.
o Location - Select a location from the drop-down. The options that are available are the
Location OUs in the portal or the options that were defined during implementation of
Headcount Planning. The selected location will apply to the selected increment and all
subsequent position increments in the plan. For example, if you change the location to
Los Angeles in the second month of a 2-year plan, then months 2-24 will have the
location of Los Angeles.
o Division - Select the division from the drop-down. The options that are available are the
Division OUs in the portal or the options that were defined during implementation of
Headcount Planning.
o Cost Center - Select the cost center from the drop-down. The options that are available
are the Cost Center OUs in the portal or the options that were defined during
implementation of Headcount Planning.
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o Grade - Select the grade from the drop-down. The options that are available are the
Grade OUs in the portal or the options that were defined during implementation of
Headcount Planning.
o Cost - This displays the cost value for the position instance or FTE. The cost will adjust
based on changes to headcount and FTE. For example, if you change the headcount
from 1 to 0 for a position instance, then the cost will decrease (likely to 0 but is
dependent upon how costing is configured) based on the removal of headcount.

Co-Planners
Click CO-PLANNERS to edit the co-planners for the plan. Co-planners will have access to
Headcount Planning in order to view and edit the plan.

Review/Submit Plan
Click REVIEW PLAN to review and submit the plan. This opens the Plan Summary page.
From here, you can view the primary planner and the total headcount at the time of the plan
creation.
To submit the headcount plan, click SUBMIT. This moves the plan from the Active Plans
section on the Headcount Planning page to the Completed Plans section. Once a plan is
submitted, it cannot be re-opened or modified. The plan can still be exported to a .csv file
by clicking EXPORT from the Headcount Planning page.

Concurrent Editing of Plan
When more than one planner is editing a plan, the most recently saved updates overwrite
any existing value.
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Insights Career Mobility
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Career Mobility Overview
The Career Mobility Insight empowers managers to create data driven career paths and
development plans for individuals to realize their potential. Organizations will gain insight on
internal career paths and the actions that drove historically successful successors along
their paths. Furthermore, this will prescribe users with development plan action items that
may help new successors mobilize in their career paths.

Use Cases
o An organization has high attrition for a particular position. Since lack of career mobility
typically drives employees out of a company, you want to see all career paths that have
started from that position. Then, you can generate the data you need to solve the
attrition problem with support to generate career mobility for employees in that position.
You can then output that data and share it with the appropriate internal stakeholders,
such as managers of the starting position.
o An organization wants to understand all career paths between two particular positions.
They use a start and end point to analyze all the paths that have taken place between
both points and the actions necessary to mobilize talent from the starting position to the
goal position. Then, they output the data and share it with the appropriate internal
stakeholders, such as managers of the starting position.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME
Insights Dashboard

PERMISSION DESCRIPTION

Allows user to access Insights Dashboard. This
permission cannot be constrained.

CATEGORY

Core
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Insights Main Dashboard
The Career Mobility Insight is accessed from the Insights Main Dashboard. The Career
Mobility Insight empowers managers to create data driven career paths and development
plans for individuals to realize their potential. Organizations will gain insight on internal
career paths and the actions that drove historically successful successors along their paths.
Furthermore, this will prescribe users with development plan action items that may help
new successors mobilize in their career paths.
To access the Career Mobility Insight, click the Career Mobility card on the Insights Main
Dashboard. This opens the position search page.
Permissions
PERMISSION
NAME
Insights Dashboard

PERMISSION DESCRIPTION

Allows user to access Insights Dashboard. This
permission cannot be constrained.

CATEGORY

Core
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Position Search Page
The position search page allows you to select the starting position and the goal position for
the career path.
The user may select a start position and no goal position if they want to search for all career
paths stemming off of a single position. Or, a user may select a start and goal position to
search for all career paths that stream between two positions. A user cannot, however, just
select a goal position by itself to conduct a search.
o Starting Position - The position at the beginning of the career path.
o Goal Position - The position at the end of the career path.
To access the position search page, click the Career Mobility card on the Insights Main
Dashboard.
Permissions
PERMISSION
NAME
Insights Dashboard

PERMISSION DESCRIPTION

Allows user to access Insights Dashboard. This
permission cannot be constrained.

CATEGORY

Core

To select the positions:
1. Enter text in the Start field. Predictive search results appear as you type.
2. Select the starting position from the list. Positions that do not have enough data to
suggest a potential path cannot be selected.
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3. Enter text in the Goal field. Predictive search results appear as you type, displaying the
positions the most relevant positions in descending order.
4. Select the goal position from the list. Positions that do not have enough data to suggest
potential actions to take to succeed to the goal position cannot be selected.
5. Click SEARCH. This opens the career path search results page.
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Career Path Search Results Page
The search results page displays the career path, from the starting position to the goal
position. Additional positions may display between the Start and Goal positions to indicate
the historical transition jobs that led to the next and goal steps in the career path.
To access the career path search results page, click START on the position search page.
Permissions
PERMISSION
NAME
Insights Dashboard

PERMISSION DESCRIPTION

Allows user to access Insights Dashboard. This
permission cannot be constrained.

CATEGORY

Core

Number of Results
This displays the number of career paths.

112

Cornerstone April 2016 Release Notes: What's New for April 2016

Sorting
The Show option allows you to sort the search results by popularity or years.
o Popularity - The search results are sorted by popularity by default. This displays the
career paths in order of the highest number of times employees have been transitioned
into the next position in the career path from the previous position in the career path. In
the image, the goal position of Regional Sales Manager has been reached the most
number of times by employees who were in the Account Manager position and then the
Enterprise Sales Rep position.
o Year - Displays the career path results in descending order by the number of years to
succession.

Career Paths
The career paths display in the left panel. They indicate the various positions through which
the goal position has been reached. For example, "Through Account Manager and
Enterprise Sales Rep" indicates that the goal position of Regional Sales Manager has been
achieved through the career path of Account Manager as the starting position, and then the
successive position of Enterprise Sales Rep. Or, the starting position has also been
Enterprise Sales Rep, which led to Regional Sales Manager.
Note: If there is only a starting position entered on the position search page, then the goal
position will be any succession end position that has been reached from the starting
position. If there is only a goal position entered on the position search page, then the
starting position will be any position that was started from to reach the goal position.
Transition Steps
The transition steps display to the right of each career path. The steps display with an arrow
between them, indicating that these are the starting and transition positions that have led to
the goal position.
Successors
This indicates the total number of historic successors that took the career path.
Years
This is the measure of years of all successors that transitioned through the career path.

Start Over
Click START OVER to return to the position search page. The previously selected positions
display in the Start and Goal fields.

Analyze
Click ANALYZE to open the career path details page.
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Career Path Details Page
From the career path details page, you can learn more about the historical successions of
that career path and the recommended development actions for that career path to take
place for a potential successor. See the number of successors and how long it has
historically taken to reach the goal position. Find the training and competencies needed
throughout the career path, as well as certifications and the total number of expected
training hours.
To access the career path details page, click the ANALYZE button on the career path
search results page.
Permissions
PERMISSION
NAME
Insights Dashboard

PERMISSION DESCRIPTION

Allows user to access Insights Dashboard. This
permission cannot be constrained.

CATEGORY

Core
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Start/Goal Position
The starting position and the goal position display at the top of the page.

Return to Previous Page
Click the back button to return to the career path search results page.

Number of Past Successors
This is the total number of past successors in the goal position. You can view the details for
all successors by clicking the number of successors. This opens a pop-up that displays the
successors and the number of years it took to reach the goal position. The list displays in
order of the shortest amount of time to succession.
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Years to Succession
This is the average number of years to succession to the goal position based on the total
successors.

Successors Chart
The bar chart at the top shows a historical view of all past successors that made the
transition from the starting position to the end position in the career path.
Axes
The x axis represents the number of past successors. The y axis groups the data by how
many years it took successors to succeed from the starting position to the goal position.
View Successors in Each Group
Click a bar on the chart to view the successors within that group. A pop-up opens to display
the past successors, their current position, and the total number of years to succession. If a
successor is no longer with the company, then "Inactive Employee" displays in place of the
current position name.

Total Development Actions
This section displays the total development actions in each category for all of the transition
positions. Click the linked actions to view a pop-up with details of the actions, such as
training and certification titles.
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Position-Specific Development Actions
The positions in the career path display in ascending order from starting position to goal
position and include the actions that need to be taken in order to get to that position.
To view the development actions for each position, expand the position. Types of
development actions may be online courses, events, certifications, competencies to
achieve.
The number of training items, certifications, competencies, and total training hours appears
above the detailed development actions. You can scroll through the actions to view each
action.
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Export or Print Career Path Details
The information on the career path details page can be exported or printed.

Export
You can export the information on the career path details page by clicking the Export link in
the export button in the upper-right corner of the page. This allows you to open a PDF of
the information.
The PDF displays the successors chart, successors and their current role, and the
development actions for each transition position.
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Language Pack Enhancements - Dutch, Czech, Slovakia
With the April 2016 release, Cornerstone is revising the translations for the Dutch, Czech,
and Slovakian language packs. Some of the more popular updated translated terms include
the following:
ENGLISH TERM

PREVIOUS TRANSLATION
(DUTCH)

NEW TRANSLATION
(DUTCH)

Learning

Learning

Leren

Goal

Doel

doelstelling

Development Plan

Ontwikkelingsplan

Ontwikkelplan

Helicopter View

Vogelvluchtperspectief

Helicopter View

Recruiting

Werven

Recruiting

Requisition Request

Verzoeken voor aanvraag

Vacature-aanvragen

Manage Requisition

Aanvraag beheren

Vacature-overzicht

Interview Manager

Interview Manager' and
'Manager
sollicitatiegesprekken'

Manager
sollicitatiegesprekken

Interview Event

Solicitatiegespreksactiviteiten

Sollicitatiegespreksevent

Recruiting Dashboard Wervingsdashboard

Recruitingdashboard

Recruiting Manager
Dashboard

Wervingsmanagerdashboard

Manager Recruiting
Dashboard

Test Engine

Testprogramma

Toetsprogramma

Question Bank

Vragendatabase

Vragenbank

Asset Importer

Asses Importeren

Media importeren

Help

Hulp

Help

Succession

Opvolging

Successie

Proxy Enrolment

Automatische inschrijving

inschrijving per volmacht

Implementation
This functionality is automatically enabled for all organizations using the Dutch, Czech, or
Slovakian language packs.
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Link - Duplicate User Prevention
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Link - Duplicate User Prevention
Prior to this enhancement, when user records were added to the Cornerstone system, there
was no check to see if the user may have an existing record in the system. This meant that,
in some cases, the same employee could have multiple user records. In these scenarios,
one employee with multiple user records results in the same user having multiple
transcripts and employee histories, which fragments the employee data.
With this enhancement, when an organization using Link creates new users, the system
can be configured to evaluate whether the new users are similar to existing user records. If
similar records do not exist, the new users will be created normally. However, if similar
records do exist, the record creation is prevented.
If configured, the system evaluates whether new users are duplicates of existing users
when new users are added to the system from the Admin > Users page and the Data Load
Wizard.
By ensuring duplicate records are not created, user record management is simpler and
more effective.

Best Practice
When performing your initial load of users, be sure duplicate prevention is off.

Use Cases
1. An organization has multiple HRIS systems feeding data into the Cornerstone system.
All employees in United States are managed in one HRIS system, and all employees in
France are managed in another HRIS system.
2. Sally moves to a new position in the organization which causes her to move from New
York, US to Paris, France.
3. As a result of Sally's move, her information is now managed in a second HRIS system.
4. When Sally's information is fed into the Cornerstone system from the second HRIS
system, Cornerstone's duplicate prevention engine identifies Sally's user record as
potentially being the same as an existing user record.
5. The administrator views Sally's pending record and determines whether it is the same
user as an existing user record or if Sally is a unique new user.

Considerations
The system currently only checks for duplicate users when users are added to the system
from the Admin > Users page or the Data Load Wizard.
When duplicate checking is enabled and creation of a new user record is prevented
because it is a suspected duplicate, this pending user will not have access to the
Cornerstone system. The user will only gain access once the pending user record is
reconciled.
Currently, there are no email triggers that fire when a new user is prevented as a likely
duplicate. When duplicate prevention is enabled, clients are encouraged to check pending
user records on a regular basis.
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When a pending user record is identified as a valid new user and a new user record is
created for the pending user, the following is true:
o Any password previously defined for the user is not copied to the new user record.
o If there is a top-level corporate password defined in the preferences, this password will
be set for the new user.
o If there is not a top-level corporate password, and the organization does not use SSO,
there are two options for setting the password:
o Upon attempting to log in, the user should go through the “Forgot Password”
workflow to define a password for themselves.
o If desired, the administrator can take action by manually resetting the password on
the Admin > Users page.

Implementation
This functionality is only available to organizations using Link. This functionality is controlled
by a backend setting, which is disabled by default.
Upon release, the Prevent Duplicate Users - Reconcile permission and the Duplicate User
Management Preferences - Manage permission are automatically added to the default
System Administrator role.

Security
The following new permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Duplicate User
Management
Preferences Manage

Grants ability to access and configure
management of duplicate records, including
parameters used to prevent duplicates. This
permission cannot be constrained. This is an
administrator permission.

Core
Administration

Prevent Duplicate
Users - Reconcile

Grants ability to view user accounts that have
Core
been identified as potential duplicates.
Administration
Administrators can only view pending user records
that were created by administrators who are within
the constraints on this permission. This permission
can be constrained by OU and User's OU. This is
an administrator permission.

The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY
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Data Load Wizard Users

Enables administrator to load users. This permission
also enables administrators to track data loads and
manage data load templates. This is an administrator
permission.

Data Load
Wizard

Users - View

Grants ability to search for and view summary
Core
information about users in the portal, via the
Administration
Admin/Users screen. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and Users. This is an administrator
permission.
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Duplicate User Management Preferences
When an organization using Link creates new users, the system can be configured to
evaluate whether the new users are similar to existing user records. This is done in order to
prevent the same user from being added to the system more than once.
The Duplicate User Management Preferences page enables administrators to configure
which standard and custom fields are used to identify potential duplicate users. The system
uses the selected fields to compare the user being added to all existing users.
This functionality is only available to organizations using Link.
To manage Duplicate User Management Preferences, go to ADMIN > TOOLS > CORE
FUNCTIONS > CORE PREFERENCES > DUPLICATE USER MANAGEMENT
PREFERENCES.
Permissions
PERMISSION
NAME
Duplicate User
Management
Preferences Manage

PERMISSION DESCRIPTION

Grants ability to access and configure
management of duplicate records, including
parameters used to prevent duplicates. This
permission cannot be constrained. This is an
administrator permission.

CATEGORY

Core
Administration

Prevent Duplicate Users
Select this option to enable the system to compare new users with existing users to
determine if they are potentially the same as a user who already exists within the system.

Duplicate Prevention Threshold
When a new user record is added that has multiple fields that are an exact match with an
existing user record, the weights of those fields, which are specified in the table below, are
added together.
Enter the number of points above which new users are flagged as potential duplicates. This
field is required when the Prevent Duplicate Users option is selected. The maximum value
for this field is 999. Also, this value must be less than the sum of the Weighting values for
all added fields.

Fields
This section determines which fields are used to determine whether a new user record is
potentially the same as an existing user record.
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Add Field
To add a field, click the Add Field link. Standard and custom user fields are available. The
following field types cannot be selected: Organizational unit, employee relations, encrypted
custom fields, multi-select checkbox, branched drop-down, and hierarchy.
A maximum of eight fields can be added. Also, at least one field must be added when the
Prevent Duplicate Users option is selected.

Weighting
Enter the number of points that are associated with this field. When a field matches that of
an existing user, then the points associated with the field are counted towards the duplicate
prevention threshold. This field is required. The maximum value for this field is 999.

Remove Field
To remove a field from the duplicate user criteria, click the Trash Can icon to the right of
the user. This opens a pop-up that displays available standard and custom user fields.

Save/Cancel
Select the SAVE button to commit any unsaved changes, including fields that are added or
removed and any changes to the duplicate prevention threshold or field weighting.
Select the CANCEL button to discard any unsaved changes.
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Users - Potential Duplicate User
When an organization using Link creates new users, the system can be configured to
evaluate whether the new users are similar to existing user records. This is done in order to
prevent the same user from being added to the system more than once. If similar records
do not exist, the new users will be created normally. However, if similar records do exist,
the record creation is prevented. A message is displayed to alert administrators that a
potential duplicate user has been identified.
Administrators who have the Prevent Duplicate Records - Reconcile permission can click
the link within the message to view and manage pending user records.
To access the User Records Administration page, go to ADMIN > TOOLS > CORE
FUNCTIONS > USERS.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Prevent Duplicate
Users - Reconcile

Grants ability to view user accounts that have
Core
been identified as potential duplicates.
Administration
Administrators can only view pending user records
that were created by administrators who are within
the constraints on this permission. This permission
can be constrained by OU and User's OU. This is
an administrator permission.

Users - View

Grants ability to search for and view summary
Core
information about users in the portal, via the
Administration
Admin/Users screen. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and Users. This is an administrator
permission.
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Pending User Records
When an organization using Link creates new users, the system can be configured to
evaluate whether the new users are similar to existing user records. This is done in order to
prevent the same user from being added to the system more than once.
The Pending User Records page enables administrators to view all of the pending user
records that have been identified as likely duplicates of existing user records. These
records have not yet been created in the system. For each pending user record,
administrators can view each of the existing user records that are similar to the pending
user record.
This functionality is only available to organizations using Link.
To manage Pending User Records, go to ADMIN > TOOLS > CORE FUNCTIONS >
PENDING USER RECORDS.
Permissions
PERMISSION
NAME
Prevent Duplicate
Users - Reconcile

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view user accounts that have
Core
been identified as potential duplicates.
Administration
Administrators can only view pending user records
that were created by administrators who are within
the constraints on this permission. This permission
can be constrained by OU and User's OU. This is
an administrator permission.

Pending User Records
This section displays the user records that have been identified as likely duplicates of
existing user records. The system only displays pending user records that were created by
administrators who are within the administrator's permission constraints. For example, if an
administrator is constrained to the Technology division, then the administrator can only view
pending user records that were created by administrators in the Technology division.
User records are displayed in the order in which they were created with the most recently
created user record displayed first.
The following information is displayed for each pending user record:
o Name
o Created - This displays the date on which the pending user record was created.
o Created By - This displays the name of the administrator who created the pending user
record.
o Number of Matches - This displays the number of existing user records that have been
identified as a potential match to the pending user record.
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View Similar Records
To view the existing user records that are similar to the pending user record, select the
VIEW SIMILAR RECORDS button to the right of the pending user record. All records that
are matches with the pending user record, above the duplicate matching threshold, are
displayed. The similar record that most closely matches the pending user record is
displayed first. The following information is displayed for each similar record:
o Name
o Matching Points - This displays the sum of the points associated with all of the fields
that match the pending user record, as of the time when the attempted creation of
pending user record occurred. This number is used to indicate how closely the existing
record matches the pending user record. The higher the total matching points, the more
likely it is that the pending user record is the same user as the existing user record.
o Created - This displays the date on which the user record was created.
o Created By - This displays the name of the administrator who created the user record.
o Status - This displays the status of the user record.
o Similar Fields - This displays all of the fields that were similar between the pending user
record and the user record.

Hide Similar Records
To hide the existing user records that are similar to the pending user record, select the
HIDE SIMILAR RECORDS button to the right of the pending user record.

Delete Pending Record
If the pending user should be deleted from the ‘pending’ state, then click the DELETE
PENDING RECORD button. After this button is clicked, no further action can be taken with
the user.

Create Pending Record as New
If the pending user record is a valid new user, click the CREATE PENDING RECORD AS
NEW button.
o Any password previously defined for the user is not copied to the new user record.
o If there is a top-level corporate password defined in the preferences, this password will
be set for the new user.
o If there is not a top-level corporate password, and the organization does not use SSO,
there are two options for setting the password:
o Upon attempting to log in, the user should go through the “Forgot Password”
workflow to define a password for themselves.
o If desired, the administrator can take action by manually resetting the password on
the Admin > Users page.
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Overwrite Selected Record with Pending Record
To overwrite the selected existing user record with the corresponding pending user record,
select the Overwrite radio button to the left of the appropriate existing user record. Then,
click the OVERWRITE SELECTED RECORD WITH PENDING RECORD button.
When this button is clicked, the selected existing user record is updated with the
information from the pending user record. The effective date for all updated data is the date
on which two user records were reconciled. Also, the user record reflects that the fields
were changed by the administrator who reconciled the user records.

Done
Select this button to return to the previous page.
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Link - Historical Effective Dating for User Data
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Link - Historical Effective Dating for User Data
Prior to this enhancement, organizations using Link could not backdate user record data to
before the user record was created. That is, when setting an effective date for a
modification to a user record, the effective date had to be on or after the date on which the
user record was created. As a result, organizations could not migrate legacy employee
records to Cornerstone from before the organization began using Cornerstone as an
employee data management system.
With this enhancement, organizations using Link can now backdate user record data to
before the user record was created. The system now supports historical effective dates as
long as the date is on or after January 1, 1901. This enhancement applies to modifications
that are made via the User Record or the Data Load Wizard. This enhancement enables
organizations to more effectively use Cornerstone as their system of employee records.
The Data Load Wizard is enhanced to support past and future dating of user record fields.

Considerations
Backdating user data before 1901 is not supported.
Backdating is only supported via the User Record and Data Load Wizard.
Currently the Data Load Wizard does not support adding a user with multiple effective
dated records within the same load file. If a user has multiple effective dated records, the
records must be loaded in separate files.

Implementation
Upon release, this functionality is automatically enabled for all organizations using Link and
the Data Load Wizard.
In order to purchase Link or the Data Load Wizard, please contact Sales or your Client
Executive.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Data Load Wizard Users

Enables administrator to load users. This permission
also enables administrators to track data loads and
manage data load templates. This is an administrator
permission.

Data Load
Wizard

Users - Edit Core
Information

Grants ability to add users and edit core
Core
information on a user record, including first name, Administration
last name, username, assigned OUs, and custom
relationships. This permission works in
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conjunction with the Users - View and Users View Core and Edit Custom Fields permissions.
This permission cannot be constrained. This is an
administrator permission.
Users - Effective
Dating: Manage

Enables administrator to make effective dated
changes to the user record. This permission only
works when used in conjunction with the Users Edit permission. This permission cannot be
constrained. This is an administrator permission.

Core
Administration

Users - View

Grants ability to search for and view summary
Core
information about users in the portal, via the
Administration
Admin/Users screen. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and Users. This is an administrator
permission.

Users – View Core
and Edit Custom
Fields

Grants ability to view core information on a user
Core
record, including first name, last name, username, Administration
assigned OUs, custom relationships, and custom
fields. This permission also includes the ability to
edit any custom fields that are visible to the
administrator. This permission works in
conjunction with the Users - View permission. This
permission can be constrained by OU, User's OU,
User Self and Subordinates, and User. This is an
administrator permission.
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User Record - Set Effective Date
With this enhancement, when editing a user, administrators can now set an effective date
that is before the user record was created. The effective date can now be any date in the
past that is on or after January 1, 1901.
To add a new user record, go to ADMIN > TOOLS > CORE FUNCTIONS > USERS. Then,
click the Add User link.
To edit a user record, go to ADMIN > TOOLS > CORE FUNCTIONS > USERS. Search for
the appropriate user. Then, click the user's name in the Search Results table.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Users - Edit Core
Information

Grants ability to add users and edit core
Core
information on a user record, including first name, Administration
last name, username, assigned OUs, and custom
relationships. This permission works in
conjunction with the Users - View and Users View Core and Edit Custom Fields permissions.
This permission cannot be constrained. This is an
administrator permission.

Users - Effective
Dating: Manage

Enables administrator to make effective dated
changes to the user record. This permission only
works when used in conjunction with the Users Edit permission. This permission cannot be
constrained. This is an administrator permission.

Users - View

Grants ability to search for and view summary
Core
information about users in the portal, via the
Administration
Admin/Users screen. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and Users. This is an administrator
permission.

Users – View Core
and Edit Custom
Fields

Grants ability to view core information on a user
Core
record, including first name, last name, username, Administration
assigned OUs, custom relationships, and custom
fields. This permission also includes the ability to
edit any custom fields that are visible to the
administrator. This permission works in
conjunction with the Users - View permission. This
permission can be constrained by OU, User's OU,

Core
Administration
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User Self and Subordinates, and User. This is an
administrator permission.
Additional permissions are required to view and edit the various fields on the user record.
See User Record Permissions for additional information.
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Link - Manager Self-Service
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Link - Manager Self-Service
Prior to this enhancement, Cornerstone Link enabled users to update their own employee
information through forms. However, managers, dotted line managers, and other
stakeholders were not able to utilize forms to update employee information for their direct
reports.
With this enhancement, Cornerstone Link enables managers to utilize forms to update
employee information for their direct reports. In addition, if configured, form data can be
submitted by a user within a specified set of criteria for another user.
This enhancement enables organizations using Link to extend the responsibility for
updating employee data beyond HR administrators to managers and other roles within the
organization.

Implementation
This functionality is only available to organizations using Link. This functionality is
automatically enabled for organizations using both Effective Dating and Self-service Forms.
Upon release, when this functionality is enabled, the Form Proxy Completion - Manage
permission is automatically added to the default System Administrator role.

Glossary
o Self-service Form - A form or document that a user, manager, or other employee
relationship may be able to access on demand. A self-service form may be completed
to provide information about yourself or another user.

Security
The following new permission applies to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Form Proxy
Allows administrator to configure the Proxy
Forms
Completion - Manage Availability settings for a form. These settings
Administration
determine which users can complete the form on
behalf of other users and for which users they can
complete the form. This permission can be
constrained by OU, User's OU, User, and
Employee Relationship. This is an administrator
permission.
The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

139

Cornerstone April 2016 Release Notes: What's New for April 2016

Forms - Manage

Grants access to the Manage Forms functionality. Forms
Management
This permission can be constrained by OU and
Administration
User's OU. This is an administrator permission.
Note: This permission enables access to the Form
Management functionality that is part of Core
functionality and the Onboarding module. This
permission does not grant access to the Training
Forms Management functionality.

Global Search Forms

Grants ability to search for Forms in Global
Search. This permission cannot be constrained.
This is an administrator permission.

Forms
Management
Administration
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Form - Create - Access
Prior to this enhancement, Cornerstone Link enabled users to update their own employee
information through forms. However, managers, dotted line managers, and other
stakeholders were not able to utilize forms to update employee information for their direct
reports.
With this enhancement, Cornerstone Link enables managers to utilize forms to update
employee information for their direct reports. In addition, if configured, form data can be
submitted by a user within a specified set of criteria for another user.
The Self-service settings are only available to admins with Form Self-Service - Manage
permission. Self-service functionality is only available to organizations using Link.
To create a form, go to ADMIN > TOOLS > CORE FUNCTIONS > FORM MANAGEMENT
> MANAGE FORMS. Then, select the CREATE FORM button.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Form Proxy
Allows administrator to configure the Proxy
Forms
Completion - Manage Availability settings for a form. These settings
Administration
determine which users can complete the form on
behalf of other users and for which users they can
complete the form. This permission can be
constrained by OU, User's OU, User, and
Employee Relationship. This is an administrator
permission.
Forms - Manage

Grants access to the Manage Forms functionality. Forms
Management
This permission can be constrained by OU and
Administration
User's OU. This is an administrator permission.
Note: This permission enables access to the Form
Management functionality that is part of Core
functionality and the Onboarding module. This
permission does not grant access to the Training
Forms Management functionality.

Copy Form
When a form is copied, none of the settings on the Access page are copied. This is existing
behavior.

Availability
The description in the Availability section is updated. The following is the new section
description:
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o Determine the users that have the ability to Assign this form, configured in the Assign
Task column. Additionally, configure whether users have the ability to complete this
form by Self Service, in the Self Service column.
Note: The second sentence of the section description is only displayed to organizations
using Link. Also, this sentence is only displayed to administrators who have permission to
manage self-service forms.
The following options are now available in the table for each OU or user that is added:
o Assign Task - This option is selected by default. When this option is selected, users
who are in the selected criterion are able to assign the form to other users.
o Self Service - This option is only available to administrators who have permission to
manage self-service forms, and it is selected by default. When this option is selected,
users who are in the selected criterion are able to access this form on demand and
complete the form for themselves or other users. The settings in the Proxy Availability
section are used to configure the self-service functionality.
Implementation Note: Upon release, the Self Service option is automatically selected for
any OUs and users that were previously added to the Availability section if the previously
existing Enable Self-Service checkbox was selected.

Proxy Availability
Form completion by proxy enables users to complete forms on behalf of other users. This
section enables administrators to determine which users can complete the form and for
which users they can complete the form.
This section is only available to administrators who have permission to manage form proxy
completion.

Proxy Availability Sections
Proxy availability can be configured using multiple segments, which enables administrators
to configure different proxy completion settings. For example, within the United States, you
may allow managers or Human Resources Business Partners (HRBPs) to complete a
Position Change form on behalf of a user. However, within France, you may only allow
HRBPs to complete a Position Change form on behalf of a user.
Sections can be expanded or collapsed by clicking the section's arrow icon. This enables
administrators to manage how much information is displayed on the page.

Add Section
To add an additional Proxy Availability section, click the ADD SECTION button. A new
section is added to the bottom of the page.
When a new section is added, the section header displays "New Criteria." Once the page is
saved, the section header displays the section's availability settings. Displaying a relevant
section header enables administrators to quickly identify a section when editing the section.
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Remove Section
To remove a Proxy Availability section, click the Remove icon
of the section.

in the upper-right corner

Removing a section removes all availability and proxy completion settings within the
section. Users who are affected by the change in availability and proxy completion settings
will notice the change as soon as the page is saved. When Proxy Availability sections are
removed, any completed forms are not affected.

Proxy Availability - Availability
The Availability settings determine for which users the self-service form can be completed.
If a form is available to an organizational unit (OU), this means that the self-service form
can be completed on behalf of users in the selected OU. Availability, in this instance, does
not dictate who can access the form; the ability to access the form for the set of users
defined in the Availability section is defined in the Proxy Completion section. For more
clarity, see the Use Case section below.
To add users to the form's availability, select the appropriate option from the drop-down
menu. Then, click the Select icon to select the appropriate organizational unit (OU),
group, or user. Alternatively, administrators can also enter the OU, group, or user name in
the field.
The constraints on the administrator's Form Manage Forms - Manage permission restrict
which OUs, groups, and users are available to be selected. For example, if an
administrator's permission is constrained by the West division and they select "All users in
Corporation," then only the users in the West division are included in the selection.
Select the Include Subordinates option to include any subordinate OUs, groups, or users
in the availability.
To remove a selection from the Availability section, click the Remove icon
the selection.

to the left of

Proxy Availability - Proxy Completion
The Proxy Completion settings determine which users are able to launch and submit selfservice forms for the set of users who are selected in the Availability criteria for this section.
Note: The proxy completion settings are always enforced, even if a link to a self-service
form is shared with another user.
Proxy Completion can be configured by employee relationship (e.g., Manager, Indirect
Manager, Subordinates) or OU criteria (i.e., OU, group, or user). From the drop-down
menu, select whether you are selecting an employee relationship or an OU, group, or user.
o When selecting an employee relationship, click the Select icon to select the
appropriate relationship. Alternatively, administrators can also enter the relationship
name in the field.
o When selecting an OU, group, or user, select the appropriate option from the drop-down
menu. Then, click the Select icon to select the appropriate OU, group, or user.
Alternatively, administrators can also enter the OU, group, or user name in the field.
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The constraints on the administrator's Form Manage Forms - Manage permission restrict
which OUs, groups, and users are available to be selected. For example, if an
administrator's permission is constrained by the West division and they select "All users in
Corporation," then only the users in the West division are included in the selection.
Select the Include Subordinates option to include any subordinate OUs, groups, or users
in the criterion.
To remove a selection from the Proxy Completion section, click the Remove icon
left of the selection.

to the

Availability and Proxy Completion Use Case
1. A Change of Address form is created. This form can be completed on behalf of all users
in the system. Only managers should be able to complete this form on behalf of their
direct reports.
2. The Availability can be set to All Employees.
3. The Manager employee relationship is added to the Proxy Completion section so that
managers can access and complete the form on behalf of their direct reports in order to
change their address.

Self Service Completion Link
The Launch Forms from Links section is renamed and is now titled Self Service Completion
Link.
This section is only available to administrators who have permission to manage self-service
forms.
The previously existing Enable Self-Service checkbox functionality has been migrated to
be controlled in the Availability grid. As a result, the checkbox is no longer displayed in this
section.
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Form - Complete for Another User
With this enhancement, a form can be configured so that managers and other employee
relationships can complete a form on behalf of another user.
When a user is completing a form on behalf of another user, the form title indicates that the
form is being completed for another user.
To complete a form on behalf of another user, navigate to the user's Universal Profile page.
When viewing the user's Universal Profile page, select the Options drop-down menu, and
then select the Complete Form option. Note: This option is only available if there is at least
one form that is configured to allow the user who is logged in to complete the form for the
user whose Universal Profile is being viewed.

From the Select Form pop-up, select the appropriate form. Note: The pop-up only displays
forms that are configured to allow the user who is logged in to complete the form for the
user whose Universal Profile is being viewed.
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The selected form opens, and the form title indicates that the form is being completed for
the selected user. All of the information that is displayed or added in the form pertains to the
user for whom the form is being completed.
When the form is submitted, any approval workflows that are configured are initiated. When
the form is approved, the information that is provided in the form is saved for the user. Also,
the form is saved in the user's Snapshot: Documents folder.
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Online Help Ratings and Feedback
With this enhancement, administrators now have the ability to rate topics and provide
descriptive feedback within Online Help. The ratings and feedback will be used by
Cornerstone to identify topics for improvement in Online Help.

Use Cases
o Marie is a system administrator, and she is having trouble with a field on the Course
Catalog - General page. She clicks the Help link and is immediately navigated to the
Course Catalog topic in Online Help. She quickly finds the information she needs. She
rates the topic with a high rating and explains in the Was this topic helpful? section at
the bottom of the page why she gave the topic a high rating.
o Sam is a system administrator, and he is configuring a new security role. He is not sure
what a specific permission controls, so he clicks the Help link. He is immediately
navigated to the Security Role topic in Online Help. Since he is looking for information
on a particular permission, he clicks the Security Permissions topic, which is in the
same section as the Security Role topic. There, he locates the permission and reviews
the permission description, but he feels the permission description is not very clear. He
rates the topic with an average rating and explains in the Was this topic helpful? section
at the bottom of the page why he gave the topic an average rating.

Considerations
This functionality is only available to administrators.

Implementation
This functionality is not available for testing during UAT, but will be automatic upon release
across environments for organizations that have Online Help enabled for administrators.

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Help Link - System
Administrator

PERMISSION DESCRIPTION

Provides access to view the User, Manager and
System Administrator topics in online help. This is an
administrator permission.

CATEGORY

Core

150

Cornerstone April 2016 Release Notes: What's New for April 2016

Rate Topic and Provide Feedback
Administrators are able to provide direct feedback on each topic within Online Help.
Administrators can rate a topic out of five stars to provide an overall assessment of the
topic. Administrators can also enter specific feedback on a topic using the commenting
functionality at the bottom of the page. Using the commenting functionality, administrators
can provide more detailed feedback on why a topic was or was not helpful. This feature can
be used to identify areas that were particularly helpful or to provide suggestions on how to
improve a topic. This feedback enables Cornerstone to continue to improve the Online Help
system.
The ability to rate a topic and provide feedback is only available to system administrators.
Access Online Help by clicking the Settings icon in the upper-right corner of any page in
your portal. Then, select the Help option. The Help option is also available from every page
in Success Center.
Permissions
PERMISSION
NAME
Help Link - System
Administrator

PERMISSION DESCRIPTION

Provides access to view the User, Manager and
System Administrator topics in online help. This is an
administrator permission.

CATEGORY

Core

Rate an Online Help Topic
The rating system enables administrators to assess the overall quality and accuracy of the
topic. If you have specific feedback that you would like to provide for the topic, please add
your feedback at the bottom of the topic.
To rate a topic within Online Help, click the appropriate number of stars in the Online Help
toolbar.

If the topic has already been rated, then the topic's average rating is displayed. The topic's
average rating is always displayed, even if the administrator's rating differs from the
average rating.
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Provide Feedback on a Topic
The feedback system enables administrators to provide specific suggestions, criticisms, or
praise for a topic. This allows the Cornerstone team to identify specific items or areas of a
topic that need improvement or are especially helpful.
To provide specific feedback for a topic, enter the following information in the Was this topic
helpful? section at the bottom of the topic:
o Name
o Company
o Please explain - In this field, enter an explanation as to why this topic was or was not
helpful. Please be as specific as possible so that we are able to effectively utilize your
feedback.
After entering the necessary information, select SUBMIT.
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Organizational Unit Fields in Forms
With this enhancement, organizational unit (OU) fields can now be added to forms so that
OUs can be updated using forms.

Considerations
Employee Relationship fields cannot be added to forms. Support for this feature is planned
for the July '16 release.
Effective dated modifications are not supported when using forms. Support for this feature
is planned for the July '16 release.

Implementation
This functionality is only available to organizations using Onboarding or Link.
Upon release, when this functionality is enabled, the Form Completion - View and Edit OU
and Employee Relation Fields permission is automatically added to the default System
Administrator role and the default security role for all users.

Security
The following new permission applies to this functionality:
PERMISSION
NAME
Form Completion View and Edit OU
and Employee
Relation Fields

PERMISSION DESCRIPTION

CATEGORY

Allow users to view and modify organizational unit
Core
(OU) and employee relation fields when completing a
form that contains the fields. The constraints on this
permission determine which fields the user can view
and edit when completing a form. This permission can
be constrained by OU, User's OU, User, User Self and
Subordinates, and User Subordinates. This is an end
user permission.

The following existing permissions apply to this functionality:
PERMISSION
NAME
Forms - Manage

PERMISSION DESCRIPTION

CATEGORY

Grants access to the Manage Forms functionality. Forms
Management
This permission can be constrained by OU and
Administration
User's OU. This is an administrator permission.
Note: This permission enables access to the Form
Management functionality that is part of Core
functionality and the Onboarding module. This
permission does not grant access to the Training
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Forms Management functionality.
Global Search Forms

Grants ability to search for Forms in Global
Search. This permission cannot be constrained.
This is an administrator permission.

Forms
Management
Administration
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Form - Create - Build - Organizational Unit Fields
With this enhancement, administrators can now add organizational unit (OU) fields to a
form. This enables OU information to be changed through a form.
To create a form, go to ADMIN > TOOLS > CORE FUNCTIONS > FORM MANAGEMENT
> MANAGE FORMS. Then, select the CREATE FORM button.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Form Completion View and Edit OU
and Employee
Relation Fields

Allow users to view and modify organizational unit
Core
(OU) and employee relation fields when completing a
form that contains the fields. The constraints on this
permission determine which fields the user can view
and edit when completing a form. This permission can
be constrained by OU, User's OU, User, User Self and
Subordinates, and User Subordinates. This is an end
user permission.

Forms - Manage

Grants access to the Manage Forms functionality. Forms
Management
This permission can be constrained by OU and
Administration
User's OU. This is an administrator permission.
Note: This permission enables access to the Form
Management functionality that is part of Core
functionality and the Onboarding module. This
permission does not grant access to the Training
Forms Management functionality.

Grades - View

Grants ability to view the Grade Organizational
Core
Unit throughout the system, such as in availability Administration
drop down selectors, when editing users, etc.
Those without this permission do not see the
Grade OU on any screen. This is primarily an
administrator permission, although organizational
policy should determine whether the Grade OU
should be visible to end users on reporting
screens, etc.

When building a form, the System Fields tab now includes an Organizational Units section.
The Organizational Units section contains all active OU types, including custom OUs.
Groups cannot be added to a form. To add a field, drag and drop the field into the form or
click the plus icon to the right of the field title. This adds the field to the form, and the field
no longer appears in the list.
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Once an OU is added to a form, the OU will remain on the form even if it is made inactive.
As a result, users may view or provide information for inactive OUs on a form.
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Form - Organizational Unit Fields
With this enhancement, organizational unit (OU) fields can be included in a form.
If OU fields are added to a form, users can only view and edit these fields if they have the
Form Completion - View and Edit OU and Employee Relation Fields permission. The
constraints on this permission determine which values are selectable in the Select OU
control.
Permissions
PERMISSION
NAME
Form Completion View and Edit OU
and Employee
Relation Fields

PERMISSION DESCRIPTION

CATEGORY

Allow users to view and modify organizational unit
Core
(OU) and employee relation fields when completing a
form that contains the fields. The constraints on this
permission determine which fields the user can view
and edit when completing a form. This permission can
be constrained by OU, User's OU, User, User Self and
Subordinates, and User Subordinates. This is an end
user permission.
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Page Caching Security Enhancements
With this enhancement, when a user logs out of the system, certain system pages that
potentially contain sensitive information pertaining to users and security are automatically
cleared from a browser's cache. This prevents the information on these pages from being
retrieved by unauthorized users.
One page where users may notice a symptom of the enhanced security while still logged in
to the application is on the Search Users administrator page. If a user has navigated away
from this page and uses the browser's Back button to return to the page, they may
experience a "Webpage has expired" message. User's can avoid this behavior by using the
Back, Save, or Cancel buttons within the application or by using the breadcrumbs to return
to a previous page. If a user does receive the "Webpage has expired" message, they can
simply refresh the page and the application will reload without using information from the
browser's cache.

Use Case
An administrator is updating user records and then logs out of the system. Upon logging out
of the system, the browser's cache is cleared of any potentially sensitive information related
to the User Record page, and the Login page is displayed. If the user selects the browser's
Back button, the browser refreshes and continues to display the Login page.

Implementation
This functionality is automatically enabled for all organizations.
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REST Service Authentication via SP-initiated SSO
With this enhancement, organizations can now use SP-initiated single sign on (SSO) to
authenticate their REST service users.

Implementation
Organizations must have an existing SP-initiated SSO.
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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Universal Profile My Team Hierarchy Navigation
Prior to this enhancement, managers only had the ability to view and navigate between
their direct reports using the My Team drop-down within Universal Profile. Managers could
not view and navigate across their indirect reports. Additionally, dotted line managers,
including approvers and custom relationship managers, could not use the My Team dropdown to navigate between their dotted line reports.
With this enhancement, managers can now navigate through their direct and indirect report
hierarchy using the My Team drop-down within Universal Profile. In addition, approvers and
custom employee relationships can quickly navigate through their dotted line reports using
the My Team drop-down. If the user serves in multiple roles that are available within the
drop-down, then the user can select a specific role and view the reports that are associated
with that role.

Use Cases
Andy Smith at ABC Company plays multiple roles in the ABC Company portal. He is a
manager to several employees, and he is also an approver for another select group of
employees. Using the new My Team functionality in Universal Profile, Andy is able to toggle
between his different system roles to manage both sets of employees.
If he clicks on the drop-down arrow attached to the My Team button, he can select a
desired set of users, such as My Direct Reports, My Approvees, and other custom
relationships configured by administrators in the ABC Company portal. He is interested in
managing users for whom he has been designated as an Approver, so he clicks the My
Approvees option in the drop-down.
This will bring up a list of people whose user records specify Andy Smith as their approver.
Andy is able to click any of these users' names to view their Universal Profile pages.
Using the new My Team functionality from Universal Profile, Andy is able to manage not
only his direct reports, but also other sets of users he is responsible for managing.

Considerations
The ability to view all team members within all relationships in a single view is not currently
supported.

Implementation
This functionality is automatically available for all organizations using the Universal Profile
functionality. The My Team drop-down can be enabled through Universal Profile General
Preferences.
Additional roles must be added to the My Team drop-down menu via Universal Profile
General Preference before they are available to managers in the My Team drop-down.
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Glossary
o Approvees - Users for whom another user is designated as an approver. The users for
whom an approver is responsible for making approvals on behalf of are referred to as
“approvees.”
o Direct Reports - Users for whom another user is designated as a manager. The
manager’s subordinates are referred to as “direct reports.”

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Universal Profile
Preferences Manage

PERMISSION DESCRIPTION

CATEGORY

Enables administrator to access and edit the Universal Universal
Profile General Preferences page. This permission
Profile
can be constrained by OU and User's OU. This is an
administrator permission.
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Universal Profile General Preferences
Prior to this enhancement, the My Team drop-down only displayed a manager's direct
reports.
With this enhancement, the My Team drop-down can be configured so that additional roles,
such as approvers and custom employee relationships can use the My Team drop-down to
view their dotted line reports.
To access Universal Profile General Preferences, go to ADMIN > TOOLS > CORE
FUNCTIONS > UNIVERSAL PROFILE. Then, click the Universal Profile General link in
the General Preferences section.
Permissions
PERMISSION
NAME
Universal Profile
Preferences Manage

PERMISSION DESCRIPTION

CATEGORY

Enables administrator to access and edit the Universal Universal
Profile General Preferences page. This permission
Profile
can be constrained by OU and User's OU. This is an
administrator permission.

Add Relationship
The My Team drop-down can be used by managers, approvers, and active custom
employee relationships to quickly view and navigate to their direct and indirect reports
within Universal Profile.
When an employee relationship is added to the My Team drop-down, the relationship will
have access to the My Team drop-down. By default, only the Manager relationship is
configured to use the My Team drop-down.
To enable additional relationships to use the My Team drop-down, select the appropriate
relationship from the drop-down. Then, select the ADD button. If the My Team drop-down is
enabled, at least one relationship must be added to the drop-down.

Employee Relationship Table
The Employee Relationship table displays all of the employee relationships that are able to
use the My Team drop-down to view their team.
o Dropdown Display Title - This field enables administrators to configure the text that
displays on the My Team drop-down if the drop-down is enabled for the OU. This field is
required for each relationship, and the character limit for this field is 50. If multiple
languages are enabled for your portal, click the Translate icon to translate the field into
other available languages.
o Remove from Dropdown - Select this icon to remove the role from the My Team dropdown.
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Employee Relationship Order
If the user serves in multiple roles that are available within the My Team drop-down, then
the user can select a specific role and view the reports that are associated with that role.
Within the Employee Relationship table, the administrator can drag and drop the employee
relationships to determine the order in which the relationships appear in the drop-down
menu when the user is selecting a role. The first relationship that is available to the user is
the role that is selected by default in the My Team drop-down.
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Universal Profile - My Team Drop-down
Prior to this enhancement, managers only had the ability to view and navigate between
their direct reports using the My Team drop-down within Universal Profile. Managers could
not view and navigate across their indirect reports. Additionally, dotted line managers,
including approvers and custom relationship managers, could not use the My Team dropdown to navigate between their dotted line reports.
With this enhancement, managers can now search and navigate through their direct and
indirect report hierarchy using the My Team drop-down within Universal Profile. In addition,
approvers and custom employee relationships can quickly navigate through their dotted line
reports using the My Team drop-down. If the user serves in multiple roles that are available
within the drop-down, then the user can select a specific role and view the reports that are
associated with that role.
When enabled, the My Team drop-down is available to managers and dotted line managers
on all pages of their Universal Profile and the Universal Profile of their direct, indirect, and
dotted line reports.
To access Universal Profile, click your photo in the upper-right corner of any system page.
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Change Role
If the user serves in multiple roles that are available within the drop-down, then the user can
choose to view a specific set of reports based on a particular role. Depending on the role
that is selected, the reports that are associated with the selected role are displayed in the
drop-down.
To select a different set of direct reports, click the arrow
on the right side of the dropdown and select the appropriate role. The drop-down menu displays only the reports that
are associated with the selected role.
When selecting a role, the drop-down displays all of the roles in which the user is currently
serving. Note: A role is only available if the My Team drop-down is configured to include
the role and if the manager has reports that are associated with the role. For example, if a
user is currently not set as the approver for any users, then the Approver role is not
available in the drop-down.

View Indirect Reports
When a manager clicks the My Team drop-down, the manager and the manager's direct
reports are displayed within the drop-down.
If a direct or indirect report also has direct reports, a Team icon
is displayed to the right
of the user's information. To view the user's direct reports, select the Team icon. The My
Team drop-down is updated to display the selected user's direct reports, and the selected
user is displayed as the manager at the top of the drop-down menu. Availability Note: The
Team icon is only available when the manager relationship is selected. The Team icon is
never available when an approver or custom relationship manager is viewing their reports.
To return to the previous drop-down view, within the drop-down, select the Return to User
link below the Search field. This link displays the name of the direct manager of the
manager whose team is currently displayed in the drop-down menu.
The selected view is maintained in the drop-down as long as the manager remains on the
current user's Universal Profile or navigates to another user's Universal Profile using the
My Team drop-down menu.
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Select Report
When a manager clicks a report or their own photograph within the My Team drop-down
from a particular page within the Universal Profile, the manager is navigated to the
corresponding Universal Profile page of the selected user, provided that the manager has
access to that page for the user. For example, if a manager is viewing their own Snapshot
page and selects a direct report from the My Team drop-down, the manager is navigated to
the selected user's Snapshot page.
If the manager does not have permission to view the corresponding Universal Profile page
for the user or if the corresponding page does not exist for the user, then the manager is
navigated to a different Universal Page:
1. If the manager was attempting to navigate to a sub-page (e.g., Snapshot - Goals, Bio Resume), then the manager is navigated to the corresponding main page (e.g.,
Snapshot, Bio - About), provided that the manager has access to that page for the user.
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2. If the manager was attempting to navigate to a main page (e.g., Snapshot, Actions),
then the manager is navigated to the default Universal Profile page.
3. If the manager does not have permission to view a direct report's Universal Profile, then
the user's photograph and name are not linked.
When a user is directed to a different page, an alert is displayed at the top of the page that
informs the manager that they do not have permission to view the selected page for the
selected user. The specific page and user name are displayed in the message.

Search Direct and Indirect Reports
If the manager has more than six reports, then only the first six are displayed on the first
page of the drop-down. A Search field is available at the top of the drop-down and
pagination options are available at the bottom of the drop-down.
o When the Manager relationship is selected, managers are able to search all direct and
indirect reports.
o When a non-Manager relationship is selected, such as Approver or a custom
relationship, then the user can search for dotted line reports within the selected
relationship.
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View People
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View People Overview
View People is a new, interactive visualization suite that helps managers and executives
use employee attributes, such as performance and succession metrics, to identify highvalue assets while on the go. View People is available from tablets and desktop devices to
provide immediate access to key employee data.
View People removes the complexity and time-consuming process of searching for an
employee or candidate. You no longer need to run multiple reports or have specialized
knowledge about the system. View People enables you to search across your
organizational units (OU) and module data by simply adding and removing filters. The
results of a search can be saved or shared or can be used to trigger additional actions, like
adding an employee to a list or talent pool.

Use Cases
Filter by OU, Compensation amd Performance
1. Francis, Acme's CEO, was just notified that a top sales executive is leaving the
company. Francis would like to search for both internal and external candidates. In
order to find internal candidates, her first task is to identify employees that meet the
following criteria:
A. Experience selling Enterprise software.
B. Classified as high-potential and high-performing based on succession planning
metrics.
C. Must be located in the United States (US), preferably at the headquarters office.
2. She accesses View People from the View navigation tab. Since she is using View
People for the first time, she sees a list of her direct reports. The next time she
accesses View People, she will see the results of her most recent search.
3. She begins a new search that will be limited to employees that are her subordinates and
are part of her OU.
4. Her first step is to use the OU filter to narrow the scope of her search.
A. She uses the filter accordion for Division to limit the results to employees from the
Americas Sales Division. She knows that she could also use the Location filter and
limit the results to Los Angeles Headquarters, but this would narrow the results too
much for her initial search.
5. She can see an entry for the filter criteria she applied. Each time she applies a new
filter, the list is updates.
6. She proceeds to limit the list to high-potential and high-performing employees. To do
this:
A. Under Performance, she navigates to the Potential filter and selects only "HighPotential Employee."
B. Still under Performance, she navigates to Performance (SMP) and limits the results
to "High-Performer."
7. The list has been narrowed to high performers of high potential that reside in the US.
8. Lastly, she wants to narrow the search by skills.
A. She filters the list by Employee Attributes.
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B. Under Skills, she selects Enterprise Software from the multi-select list.
9. The Screen displays a total of 50 matches, which are sorted by last name by default.
She re-sorts the list by tenure and proceeds to color the results by goal completion. This
lets her see which employees are hitting their goals, have a high tenure, and meet the
other criteria.
A. Results can be sorted by any of the fields available as filters.
B. Results can also be sorted in ascending or descending order.
10. She is able to narrow down the list to 30 Candidates.
11. She closes View People and knows that the results of her most recent search will greet
her next time she uses View People.
Save and Share Results
1. Francis identified 30 employees who might be a good fit for the Western Region Sales
Executive role, but the list is too large. Her immediate goal is to narrow down the list to
10 candidates. She will now focus on adding the following new criteria:
A. Goal Completion
B. Readiness
2. Once the list is finalized, she would like to share the list with the sales management
team and hand off the candidate selection task to the Vice President of Sales.
3. Francis opens View People. She sees the results of her previous search and the filter
criteria she applied.
A. Users are always greeted by the results of their most recent search.
B. First time users will either see their top 200 subordinates or the first 200 employees
in their Division organizational unit (OU).
4. She adds the Readiness for Promotion.
5. She adds criteria for employees deemed ready for the next role based on the readiness
metric.
6. The filters have narrowed down the list to 15 employees. She is now ready to take a
closer look at each candidate. Each user card is linked to the employee's user profile,
which is a set of components from their Universal Profile > Bio page.
7. She looks at the detailed profile of each candidate to learn more about them.
A. She examines their career preferences, skills, and interests.
B. She finds that four of the matches have expressed interest in moving away from
sales and into training and marketing roles. Francis makes a point of passing their
names to the Director of Talent.
8. She concludes that she has a good starting point. She selects the desired user cards
and creates a list.
A. The list includes all of the individuals selected and can be shared with other users
who have access to View People.
B. The list resides in the list window.
9. She shares the list with the sales management team. All of but one member of the team
have access to View People. She prints the list for the sales manager who does not
have access to View People and asks the administrator to secure him access to View
People.
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10. The sales management team reviews the list and makes additions. They share the
updates with Francis.
11. Francis shares the final list with the Vice President of Sales.
12. The Vice President of Sales adds the candidates to an existing talent pool.
A. The hiring and interview process begins.
13. Francis requests updates three weeks later and is happy to discover that the new hire
was sourced from the talent pool that was generated from View People.
Take Actions Based on the Results
1. The Vice President of sales, Jason, receives a notification via email that a list of 11
candidates, who might be a good fit for the Western Region Sales Executive role, was
shared with him. The list was previously reviewed by the sales management team and
the Chief Executive Officer.
2. Jason logs in to View People on his iPad.
3. He taps the List button to view the candidate list that has been shared with him.
4. He begins a deep dive into the list. His goals are as follows:
A. Identify the candidates that could benefit from additional training.
B. Review development plans and/or create a development plan, if needed.
C. Add the best matches to a talent pool to begin the interview process.
5. Jason reviews each profile.
6. He decides that three of the candidates can benefit from further development and
training.
A. He makes a note to share this with their managers and instructs them to create a
development plan that includes additional training.
7. He identifies five candidates that will be considered for the role and adds them to the
talent pool.
8. The candidates are added to the talent pool, and the Hiring Manager for the role can
proceed to the hiring process.

Considerations
View People is the first component in the View suite. Upcoming components will include
View Data and View Dashboards.

Implementation
The availability of this functionality is controlled by a backend setting that is disabled by
default. To enable this functionality, contact Global Product Support. For more information
about this functionality, contact your Client Success Manager.

Security
The following new permission applies to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY
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View People
Preferences Page

Grants access to the View People Preferences page,
which allows administrators to configure the View
People page according to their needs per
organizational unit (OU). This permission can be
constrained by OU, User's OU, User, User Self and
Subordinates, and User's Subordinates.

View

View People: Share

Grants access to open View People to view shared
lists. Can dynamically grant access to users to only
view the lists that have been shared with the user.
This permission can be constrained by OU, User's
OU, User, User Self and Subordinates, User's Direct
Reports, and User's Subordinates.

View

View People: View

Grants access to open View People to see results and View
share lists. This permission can be constrained by
OU, User's OU, User, User Self and Subordinates,
and User's Subordinates.
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View People Preferences
The View People Preferences page allows you to configure the following preferences for
View People:
o
o
o
o
o

Define organizational unit (OU) filters
Define succession metrics filters
Define employee attributes filters
Define the OUs that will display for each user in their employee card
Determine whether or not permission constraints should apply for users when viewing a
shared list

To access View People Preferences, go to ADMIN > PREFERENCES > VIEW PEOPLE.
Permissions
PERMISSION
NAME
View People
Preferences Page

PERMISSION DESCRIPTION

Grants access to the View People Preferences page,
which allows administrators to configure the View
People page according to their needs per
organizational unit (OU). This permission can be
constrained by OU, User's OU, User, User Self and
Subordinates, and User's Subordinates.

CATEGORY

View
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Organization Filters
This section allows you to select the OU options that will display in the Organization filter.
By default, up to five system OUs display in the Organization filter on the View People
page: Division, Position, Grade, Cost Center, and Location. You can use the Organization
Filters section in View People Preferences to determine if you would like different or
additional OUs to display, such as custom OUs.
To define the OU filter options:
1. Click ADD OU TYPE. This opens the Select OU Type to Add pop-up.
2. Select an OU from the drop-down. The OUs that display are the active system and
custom OUs for the portal. Group OUs and multi-type OUs are not available to select.
3. Click ADD. This adds the OU to the list of filters.
You can add more OUs by repeating the steps. Up to seven OUs can be added.
Reorder OU Position
You can change the order in which the OUs appear in the filter by clicking Move Up or
Move Down from the drop-down in the Options column.

Performance Filters
Note: This section only displays for portals with Performance or Succession.
This section allows you to configure Performance and Succession metrics.

Succession Metrics
By default, the Performance filter on the View People page displays the first five allowable
succession metrics. You can modify the metrics that display by adding metrics in this
section. The allowable metric types are rating scale, metric grid, formula metrics, and
numeric fields. There are no metrics selected by default to display in the Performance filter
on the View People page. The metrics must be added in this section in order to appear as
filters.
To add succession metrics:
1. Click the ADD SMP METRIC button. This opens the Select Succession Metric to Add
pop-up.
2. Select an SMP metric from the SMP Metric drop-down. The metrics that display are the
active system and custom OUs for the portal. Group OUs and multi-type OUs are not
available to select.
3. Click ADD. This adds the OU to the list of filters.
You can add more metrics by repeating the steps. Up to five metrics can be added.
Once succession metrics are added, they display in a table below the metrics. The following
information displays in the table:
o Order - This column displays the order in which the metrics display in the Performance
filter.
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o Succession Metric Title - This column displays the name of the metric.
o Metric Type - This column displays the type of metric field.
o Color Assignment - This column indicates whether or not colors have been assigned to
the ratings to aid in comparison. The following values display:
o Complete
o Incomplete
o Not Assigned
o Options - The following options display in the options drop-down:
o Delete - Click this option to delete the metric from the filter.
o Move Up - Click this option to move the metric up one position.
o Move Down - Click this option to move the metric down one position.

Performance Options
The Display Overall Ratings option allows you to hide the Overall Performance filter on
the View People page. Check the box to hide the filter. Uncheck the box to show the filter.

Attribute Filters
Note: This section only displays for portals with Compensation or Succession.
If the resume section of Universal Profile is enabled, then the Attribute Filters section allows
you to select up to five employee attributes that will display as filters.
To add attributes:
1. Click the ADD ATTRIBUTE button. This opens the Select Resume Attribute to Add popup.
2. Select an attribute from the Resume Attributes drop-down. The attribute types that
display are attributes that contain an attribute list or numeric field.
3. Click ADD. This adds the attribute to the list of filters.
You can add more attribute by repeating the steps. Up to five attribute can be added.

Attributes Metrics Table
Once attributes are added, they display in the table. The following information displays in
the table:
o Order - This column displays the order in which the metrics display in the Performance
filter.
o Employee Attribute - This column displays the name of the attribute.
o Field Type - This column displays the type of attribute field.
o Options - The following options display in the options drop-down:
o Delete - Click this option to delete the metric from the filter.
o Move Up - Click this option to move the metric up one position.
o Move Down - Click this option to move the metric down one position.
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Compensation Options
Note: This section only displays for portals with Compensation.
You can configure the following compensation filter options:
o Display Compensation - This option is only available for portals with a single currency.
When this option is selected, it displays a sliding Compensation filter in the Attributes
section of the Performance filter, which allows users to filter by a compensation range.
o Display Compa-Ratio - Including this option displays a sliding Compa-Ratio filter in the
Attributes section of the Performance filter, which allows users to filter by a compa-ratio
range.
o Display Tenure - Including this option displays a sliding Tenure filter in the Attributes
section of the Performance filter, which allows users to filter by a tenure range.

Employee Card Configuration
This section allows you to define the OUs that will appear in a user's employee card on the
View People page. By default, the Position OU and Location OU display for each user on
the View People page. If the Position OU and/or Location OU are inactive, then an active
system OU displays for users on the View People page.
You can select up to two OUs. The OU options that are available to select are dependent
on the OUs that you added in the Organization Filters section. If there are no OUs added to
the Organization Filters section, then no OU options will be available to select in the dropdowns in the Employee Card Configuration section.
To select the OUs:
1. Click the drop-down below the user name "John Doe."
2. Select the OU from the drop-down. The options that are available to select are
dependent on the OUs that you added in the Organization Filters section.

Share List Settings
The system dynamically manages permissions to ensure all recipients of a shared list will
see the contents in full, just as the sender would. If you disable this feature, User
constraints could prevent the recipient from seeing the full list.

Save Preferences
Click SAVE to save the preference settings.

Overwrite Settings
Choose whether or not to overwrite custom settings for child division OUs. If you choose to
overwrite custom settings for child division OUs, the selected settings are applied to both
new and existing child OUs. Any previously customized child OUs are updated with the
selected settings.
If this option is unselected, then only the child OUs that do not have customized settings will
be updated, as well as any OUs that are added in the future.
179

Cornerstone April 2016 Release Notes: What's New for April 2016

A child OU that has not been customized always inherits from the parent, regardless of
whether this option is selected.
An OU is considered customized if its preferences or settings have been changed.
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Navigation Tabs and Links
With this enhancement, a View People sublink is added to Navigation Tabs and Links
Preferences. The View People sublink must be added to a navigation tab, such as the
View tab, in order for users to be able to access View People.
To access Navigation Tabs and Links, go to Admin > Tools > Core Functions > Core
Preferences > Navigation Tabs and Links.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Navigation Tabs and Grants ability to manage Navigation Tabs and
Links - Manage
Links for the portal. This is an administrator
permission.

CATEGORY

Core
Administration
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View People Page - Overview
The View People page is a dashboard that allows managers and executives to use
employee attributes, such as performance and succession metrics, to identify high-value
assets while on the go. View People is available from mobile and desktop devices to
provide immediate access to key employee data.
To access the View People page, go to the associated navigation tab and click View
People. The location of the View People link is dependent upon the configuration by the
administrator.

See the following for detailed information about the features available on the View People
page and the actions you can take to create lists and talent pools that identify targeted
performance levels of employees:
o View People Page - Actions Bar - See View People Page - Actions Bar on page 183
for additional information.
o View People Page - Search Results Panel - See View People Page - Results List
Panel on page 192 for additional information.
o View People Page - Filters - See View People Page - Filters on page 185 for additional
information.
o View People Page - Selected Employees Page - See View People Page - Selected
Employees Page on page 193 for additional information.
o View People Page - View Employee Details - See View People Page - View Employee
Profile on page 201 for additional information.
o View People Page - My Lists - See View People Page - My Lists on page 194 for
additional information.
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View People Page - Actions Bar
The action bar displays above the list of results and enables users to order the employee
results, switch between the available views, and take actions on the results.

The following features are available on the actions bar:
o Filters - Click Filters to open the Filters panel. The panel opens to the left of the
employee results.
o Filters Mode - Click the Filters Mode
opened.

icon to view the page with the Filters panel

icon to view your lists. The page will update to
o List Mode - Click the List Mode
display your lists.
o Selected Employees Thumbnails - When you select an employee in the results, their
image displays in the upper-right corner of the actions bar. If you have more than four
employees selected, the additional number displays to the right of the fourth image. The
thumbnails update to display the most recently selected employees. Click any image to
view the Selected page, which displays only the employees you have selected. You can
remove a thumbnail by deselecting the employee in the results.
o Add to List - This option is only enabled when at least one employee is selected. Click
ADD TO LIST to add the selected employees to a list. This opens the Add to List popup. You can create a new list or select an existing list if there is at least one list created.
For new lists, you can name the list up to 100 characters. Click SAVE to add the
employees to the list.
o Number of Results - The number of employees in the search displays in the upper-left
corner of the results page. The number changes depending on whether or not you are
viewing all employees in the results, a selected number of employees, or the employees
in a list.
o Sort By - You can sort the list by last name or first name. If tenure is enabled by the
administrator in View People Preferences, then you can also sort by tenure. The list is
sorted by last name by default.
o Order Ascending/Descending - You can sort the list in ascending or descending
order. The order is based on the Sort By option you have selected. For example, if
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Last Name is selected, then the list is sorted in ascending or descending order by last
name.
o Color by - For portals with Succession, you can identify employees by a succession
metric. The metrics that display are the default metrics defined by the administrator in
View People Preferences. When a metric is selected, the results are colorized to
identify each employee by their rating for the metric. If the selected metric does not
have any colors assigned to it, then the metric will appear grayed out and not
selectable. If an employee is not rated, then they display with gray diagonal stripes in
the color bar. Note: As with existing functionality, the colors for succession metrics are
defined in Custom Field Administration when configuring the Succession custom
field.
o Color Legend - The legend displays to the right of the Color by filter. The legend
identifies the ratings and their assigned colors that are associated with the selected
metric. If there are more than three ratings for the metric, then you can click the ellipses
to view the additional ratings and colors.
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View People Page - Filters
The filter options allow you to refine the list of results. The filter options that are available
are configured by the administrator in View People Preferences.

Open/Close Filters Panel
To view the filters, click Filters in the actions bar. This opens the Filters panel.
To close the filters, click the X in the upper-right corner of the panel.

Home Button
The Home icon
in the upper-left corner of the panel returns you to the root level of the
filters. Clicking the icon does not reset the filters.

Organization
This filter allows you to filter by up to seven different parent organizational units (OU) and
child OUs. The OUs that are available are configured by the administrator in View People
Preferences.
To filter by OU:
1. Click the Organization filter. This opens the list of parent OUs.
2. Click the parent OU to view the child OUs.
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3. Check the box to the left of the child OU name to select the child OU as a filter.
4. Or, click the child OU to view the additional child OUs. Then, click the name of the
additional child OU to set it as a filter.
The page updates automatically to display matching employees. Repeat these steps to set
additional filters. The selected filters display at the bottom of the Filters panel.
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Performance
Note: This section only displays for portals with Performance or Succession. Performance
filters are only visible to portals with Performance. Succession filters are only available for
portals with Succession.
This filter allows you to filter by up to five different succession metrics. The metrics that are
available are configured by the administrator in View People Preferences.
You can also filter by overall performance rating. The rating that displays is the rating for
the user's most recently completed review.
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To filter by succession metric:
1. Click the Performance filter. This opens the list of succession metrics and displays the
Overall Performance rating filter.
2. Click the metric to view the available ratings.
3. Click a rating to select it as a filter.
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To filter by overall Performance:
1. Slide the rating scale from the left to set the minimum rating.
2. Slide the rating scale from the right to set the maximum rating.
The page updates automatically to display matching employees. Repeat these steps to set
additional filters. The selected filters display at the bottom of the Filters panel.

Attributes
This filter allows you to filter by employee attributes. You can also filter by tenure, which is
the total time elapsed since the user's hire date. You can filter by compa-ratio, which is a
numeric value with two decimal points of accuracy and is used to indicate whether or not an
employee is underpaid. You can filter by compensation by setting a minimum and maximum
annual salary range.
The filter options that are available are configured by the administrator in View People
Preferences.
Note: For portals with multiple currencies, Compensation will not be available as a filter for
the April '16 release. The Compensation filter will only be available for portals that have a
single currency.
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To filter by employee attributes:
1. Click the Attributes filter. This opens the list of parent attributes.
2. Click a parent attribute to view the child attributes.
3. Click the child attribute to set it as a filter. Up to four attributes can be selected.
To filter by compensation options:
1. Slide the bar from the left to set the minimum tenure, compa-ratio, or compensation
(annual salary).
2. Slide the bar from the right to set the maximum tenure, compa-ratio, or compensation
(annual salary).
The page updates automatically to display matching employees. Repeat these steps to set
additional filters. The selected filters display at the bottom of the Filters panel.
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Note: The compa-ratio is used to indicate whether or not an employee is underpaid. This is
a numeric value with two decimal points of accuracy.

Selected Filters List
The filters you have selected display at the bottom of the Filters panel.

Delete Filter
You can remove a filter by clicking the X to the right of the filter.

Clear Filters Group
You can remove all filters in a group by clicking Clear.
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View People Page - Results List Panel
The main section of the View People page displays the results list of employees. The
employees display in individual cards from left to right and can be selected to add to a list.
The employees that display are the employees that are available for the user to view based
on permission constraints and who match the filter criteria that has been applied. Up to 200
employees display.

Employee Cards
The following information displays in the employee cards:
o Photo
o Name
o [Organizational Unit 1] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
o [Organizational Unit 2] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
o Checkbox - The checkbox allows you to select the employee to add to a list or talent
pool. When checked, the employee's thumbnail image displays in the upper-right of the
page. The thumbnails update to display the most recently selected employees.
Deselecting the checkbox removes the thumbnail, and the employee can only be added
to a list or talent pool if the box is checked again.
o Tenure - The tenure displays in the lower-right corner of the card. The tenure displays
as a number of years and is calculated from the user's hire date to the current date.
o Color Bar - If the Color by filter is set, then a color displays on the right side of the card.
The color that displays corresponds to the employee's metric rating for the succession
metric that is selected in the Color by filter.

View Employee Profile Page
You can view the employee's profile page by clicking anywhere in the card except for the
checkbox. This opens the profile page for the employee.
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View People Page - Selected Employees Page
The Selected page displays only the employees that you have selected. From this page,
you can apply the filters from the actions bar, as well as add the employees to a list.
You can also click REMOVAL ALL to deselect all the employees, which opens a
confirmation pop-up. Click OK to deselect all employees. This refreshes the page to display
your most recent list of results.
You can also access the employee's profile page by clicking anywhere in the employee's
card, except on the Remove icon

.
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View People Page - My Lists
The My Lists page displays the lists that you have created and the lists that have been
shared with you. From this page, you can:
o
o
o
o
o

Create a new list
Share an existing list
Delete a list
View a shared list
Add a list of employees to a talent pool

Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Talent Pools Manage

Grants ability to create and manage Talent Pools.
This permission also grants access the ability to add
candidates to a job requisition. This permission can
be constrained by OU and User's OU. This is an
administrator permission.

View People: View

Grants access to open View People to see results
View
and share lists. This permission can be constrained
by OU, User's OU, User, User Self and Subordinates,
and User's Subordinates.

To access the My Lists page, click the List Mode

Talent/Succ
ession Administratio
n

icon.

New List
You can create a new list directly from the My Lists page. This allows you to develop a
collection of lists so that you can add employees to the list from other areas of View People.
To create a new list:
1. Click NEW LIST to create a new list. This opens the Create New List pop-up.
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2. Enter a name for the list, up to 100 characters.
3. Click SAVE to save the list.
Once the list is saved, it will not contain any employees. You can add employees from other
areas of View People.

Sorting Options
The following sorting options are available:
o Sort By - By default, the lists display in order of most to least recently modified. The
following sorting options are available:
o Last Modified Date - This allows you to sort by the date on which the lists were
most recently modified.
o Title - This allows you to sort by list title.
o Order Ascending/Descending - You can sort the lists in ascending or descending
order. The order is based on the Sort By option you have selected. For example, if
Title is selected, then the list is sorted in ascending or descending order by list title.

Lists
Each list displays in a separate row. The following information displays for the lists:
o List Title - This displays the name of the list.
o Shared Status - A Shared icon
displays to the right of the list title. Click the icon to
view the users with whom you shared the list. If the list was shared with you, then you
can click the icon to view who shared the list.
o Employee Thumbnails - Up to four thumbnails appear. If you have more than four
employees in the list, then the number of additional employees displays to the right of
the fourth image. Clicking a thumbnail opens the list details page.
o Modified - This displays the date on which the list was most recently modified.
o Options - The following options are available in the drop-down:
o Share - Click Share to share the list. This opens the Share List with Others popup. Select the users with whom to share the list. Enter a message that will display
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to the users with whom the list is shared. Note: You can only share lists that you
own. You cannot share a list that was shared with you.

o Delete - Click Delete to delete the list. If this is a list that you have shared, then
the list is also deleted from the users with whom the list was shared.

View List Details
The details of the list can be viewed by clicking the list name. This opens the details page
for the list. The list details shows the name of the list, the last updated date, and options for
adding to a talent pool and sharing the list. You can also apply filters and access an
employee's profile page.
Click Back to return to the My Lists page.
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Updated Date
The date that the list was most recently updated displays to the right of the list title. If this is
a shared list, it will show the date on which the list was shared and the user that shared the
list.

Sorting/Succession Options
The following sorting options are available:
o Sort By - You can sort the list by last name or first name. If tenure is enabled by the
administrator in View People Preferences, then you can also sort by tenure. The list is
sorted by last name by default.
o Order Ascending/Descending - You can sort the lists in ascending or descending
order. The order is based on the Sort By option you have selected. For example, if
Title is selected, then the list is sorted in ascending or descending order by list title.
o Color by - For portals with Succession, you can identify employees by a succession
metric. The metrics that display are the default metrics defined by the administrator in
View People Preferences. When a metric is selected, the results are colorized to
identify each employee by their rating for the metric. If an employee is not rated, then
they display with gray diagonal stripes in the color bar. Note: As with existing
functionality, the colors for succession metrics are defined in Custom Field
Administration when configuring the Succession custom field.

Add to Talent Pool
This option allows you to add the employees in the list to a talent pool. You must have
permission to manage talent pools in order to add employees to a talent pool.
Note: Before adding employees to the talent pool, you can remove any employees that you
do not want to include on the list by clicking the Remove icon in the upper-right corner of
their employee card.
To add to a talent pool:
1. Click ADD TO TALENT POOL. This opens the Add to Talent Pool pop-up.
2. Select an existing talent pool from the Select Talent Pool drop-down, if there is at least
one talent pool created.
3. Or, click Create New Talent Pool to create a new talent pool. Enter a title for your
talent pool in the title text box, up to 100 characters.
4. Click SAVE to add the employees to the talent pool.
Note: Once a talent pool is created or users are added to a talent pool, you can view the
talent pool from the Manage Talent Pools page. This page can be accessed from the
associated navigation tab, which is configured by an administrator.
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Share List
This option allows you to share the list with other users. You must have permission to view
View People in order to share lists.
To share a list:
1. Click SHARE LIST. This opens the Share List with Others pop-up. If the list has been
shared before, then the users with whom the list has been shared displays at the top of
the pop-up, and you can click View All to view all the users with whom the list has been
shared.
2. Select the users to add by entering key words into the predictive search field and
selecting the users. Or, search for and select users from the Select A User pop-up.
Users must be added to the recipient list one at a time. Note: The users that are
available to select are the users that are within your permission constraints.
3. Check the Notify All box to send the email to all users with whom you are currently
sharing the list and have previously shared the list. If you do not check the box, then the
email is only sent to the users with whom you have just selected to share the list. Note:
This option only displays if a list has already been shared.
4. Enter a message in the Share List Message field. This is optional.
5. Click SHARE to share the list. An email is sent to the users in the shared list. If you
included a message, then the message displays in the email. The subject of the email is
hard-coded as "I Shared [Name of List] on View People." A link to the shared list is
automatically included in the email. Recipients cannot modify the list. Recipients can
view the employee profile page of the employees in the list, as well as any succession
metrics and the team hierarchy.
Lists can be shared multiple times. Follow the steps above to share the list again.
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Once a list is shared, a Shared with icon
displays on the My Lists page. Hover over the
link to view the users with whom the list has been shared.

Remove Shared Users
You can remove users with whom you have shared the list by clicking the View All link in
the pop-up. Then, click the X to the right of the user's name. This removes the shared user
from list.

Delete Shared List
If you delete the list, then the list is also removed from any users with whom you have
shared the list.

Employee Cards
Each employee in the list displays on the page. The following information displays in the
employee cards:
o Photo
o Name
o [Organizational Unit 1] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
o [Organizational Unit 2] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
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o Remove - The X option in the upper-right corner allows you to remove the employee
from the list.
o Tenure - The tenure displays in the lower-right corner of the card. The tenure displays
as a number of years and is calculated from the user's hire date to the current date.
o Color Bar - If the Color by filter is set, then a color displays on the right side of the card.
The color that displays corresponds to the employee's metric rating for the succession
metric that is selected in the Color by filter.

View Employee Profile Page
You can view the employee's profile page by clicking anywhere in the card except for on the
remove option. This opens the profile page for the employee. See View People Page View Employee Profile on page 201 for additional information.
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View People Page - View Employee Profile
To view an employee's details page, click any employee's card. From the profile page, you
can do the following:
o
o
o
o
o
o

View succession metric ratings
View overall current performance rating
View the employee's team organization, such as their manager's name and position
Add the employee to a talent pool
Add the employee to another list
Create a new list and add the employee to the new list

Permissions
PERMISSION
NAME
Talent Pools Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to create and manage Talent
Talent/Succession Pools. This permission also grants access the Administration
ability to add candidates to a job requisition.
This permission can be constrained by OU
and User's OU. This is an administrator
permission.
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General Employee Details
This section displays the following information from the employee card:
o Photo
o Name
o [Organizational Unit 1] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
o [Organizational Unit 2] - This displays if an organizational unit (OU) is configured to
display by the administrator in View People Preferences. The OU will be an active OU
for the portal.
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Options
The OPTIONS drop-down allows you to add the employee to a talent pool or to a list.

Add to Talent Pool
This option allows you to add the employee to a talent pool. You must have permission to
manage talent pools in order to add employees to a talent pool.
To add to a talent pool:
1. Click Add to Talent Pool. This opens the Add to Talent Pool pop-up.
2. Select an existing talent pool from the Select Talent Pool drop-down, if there is at least
one talent pool created.
3. Or, click Create New Talent Pool to create a new talent pool. Enter a title for your
talent pool in the title text box, up to 100 characters.
4. Click SAVE to add the employee to the talent pool.
Note: Once a talent pool is created or the user is added to a talent pool, you can view the
talent pool from the Manage Talent Pools page. This page can be accessed from the
associated navigation tab, which is configured by an administrator.

Add to List
Click Add to List to add the employee to a list. This opens the Add to List pop-up. You can
create a new list or select an existing list if there is at least one list created. For new lists,
you can name the list up to 100 characters. Click SAVE to add the employee to the list.

Succession Metric Ratings
This section displays the employee's data from the succession metric filters, if available.
The metric rating displays to the right of a color-coded circle. The color of the circle is
determined by the value of the metric rating.

Overall Performance Rating
This section displays the employee's most current performance review rating, as well as the
second most recent review rating.

Team Details
This section displays the team hierarchy for the employee. This information is obtained from
the Universal Profile > Bio > About page.
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Master List of New Report Fields
This page provides the master list of new report fields for the April '16 release.
Compensation
FIELD NAME

SECTION

CUSTOM REPORT NAME

Currency ID

Compensation

Compensation Custom Report

Labor Hours

Compensation

Compensation Custom Report

Salary

Compensation

Compensation Custom Report

Salary Effective Date

Compensation

Compensation Custom Report

Salary Last Updated By Task
Name

Compensation

Compensation Custom Report

Salary Last Updated By User
Name

Compensation

Compensation Custom Report

Salary Last Updated Date

Compensation

Compensation Custom Report

Wage Type
Core

Compensation

Compensation Custom Report

FIELD NAME

SECTION

CUSTOM REPORT NAME

Badge Status

User

All custom reports with User section

User Creation Date

User

All custom reports with User section

User GUID
Learning

User

All custom reports with User section

FIELD NAME

SECTION

CUSTOM REPORT NAME

Ability to Select Session Admins
and Managers

Transcript

All custom reports with
Transcript section

Ability to Select Sessions End
Users

Transcript

All custom reports with
Transcript section

Availability Type

Training

All custom reports with
Training section

Curriculum Completion Percentage Transcript

All custom reports with
Transcript section

Electronic Signature Message

Training

All custom reports with
Training section

Electronic Signature Required

Training

All custom reports with
Training section
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FIELD NAME

SECTION

CUSTOM REPORT NAME

Latest Version

Transcript

All custom reports with
Transcript section

LO Possible Credit

Certifications

All custom reports with
Certifications section

Secondary Last Name

Transaction

All custom reports with
Transaction section

Secondary First Name

Transaction

All custom reports with
Transaction section

Session Roster Comments

Training

All custom reports with
Training section

Training Availability

Training

All custom reports with
Training section

Training Availability Include
Subordinates

Training

All custom reports with
Training section

Training Availability Pre-Approved

Training

All custom reports with
Training section

Training Availability Register Upon
Approval

Training

All custom reports with
Training section

Training Deactivation Date

Training

All custom reports with
Training section

Training Purpose

Training

All custom reports with
Training section

Training Request Form

Training

All custom reports with
Training section

Training Version Comments

Training

All custom reports with
Training section

Training Version Effective Date

Training

All custom reports with
Training section

Training Version End Date

Training

All custom reports with
Training section

Training Version Start Date

Training

All custom reports with
Training section

User Course Review Desc

Transcript

All custom reports with
Transcript section

User Course Review Title

Transcript

All custom reports with
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FIELD NAME

SECTION

CUSTOM REPORT NAME
Transcript section

User Part Attendance

Transcript

All custom reports with
Transcript section

Onboarding
FIELD NAME

SECTION

CUSTOM REPORT
NAME

Document Folder Name

Form

Onboarding Custom
Report

Employer Assignee Email

Onboarding

Onboarding Custom
Report

Employer Assignee ID

Onboarding

Onboarding Custom
Report

Employer Assignee Name

Onboarding

Onboarding Custom
Report

Form Active

Form

Onboarding Custom
Report

Form Approval Comment

Form
Approval

Onboarding Custom
Report

Form Approval Request Completed
Date

Form
Approval

Onboarding Custom
Report

Form Approval Request Received Date Form
Approval

Onboarding Custom
Report

Form Approval Request Title

Form
Approval

Onboarding Custom
Report

Form Approval Status

Form
Approval

Onboarding Custom
Report

Form Approver Email

Form
Approval

Onboarding Custom
Report

Form Approver ID

Form
Approval

Onboarding Custom
Report

Form Approver Name

Form
Approval

Onboarding Custom
Report

Form Description

Form

Onboarding Custom
Report

Form E-Signature Date

Form

Onboarding Custom
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FIELD NAME

SECTION

CUSTOM REPORT
NAME
Report

Form E-Signature Location

Form

Onboarding Custom
Report

Form E-Signature ID

Form

Onboarding Custom
Report

Form E-Signature Name

Form

Onboarding Custom
Report

Form ID

Form

Onboarding Custom
Report

Form Question

Form

Onboarding Custom
Report

Form Question ID

Form

Onboarding Custom
Report

Form Question Response

Form

Onboarding Custom
Report

Form Submit Date

Form

Onboarding Custom
Report

Form Task ID

Form

Onboarding Custom
Report

Form Task Instructions

Form

Onboarding Custom
Report

Form Task Title

Form

Onboarding Custom
Report

Form Title

Form

Onboarding Custom
Report

Integration Provider

Onboarding

Onboarding Custom
Report

Navigation Tab Extension

Onboarding

Onboarding Custom
Report

Onboarding Future Manager Email

Onboarding

Onboarding Custom
Report

Onboarding Future Manager ID

Onboarding

Onboarding Custom
Report

Onboarding Future Manager Name

Onboarding

Onboarding Custom
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FIELD NAME

SECTION

CUSTOM REPORT
NAME
Report

Onboarding Future Approver Email

Onboarding

Onboarding Custom
Report

Onboarding Future Approver ID

Onboarding

Onboarding Custom
Report

Onboarding Future Approver Name

Onboarding

Onboarding Custom
Report

Onboarding Progress

Onboarding

Onboarding Custom
Report

Onboarding Status

Onboarding

Onboarding Custom
Report

Onboarding Task Assignee Email

Onboarding

Onboarding Custom
Report

Onboarding Task Assignee ID

Onboarding

Onboarding Custom
Report

Onboarding Task Assignee Name

Onboarding

Onboarding Custom
Report

Onboarding Task Assignment Date

Onboarding

Onboarding Custom
Report

Onboarding Task Due Date

Onboarding

Onboarding Custom
Report

Onboarding Task ID

Onboarding

Onboarding Custom
Report

Onboarding Task Status

Onboarding

Onboarding Custom
Report

Onboarding Task Title

Onboarding

Onboarding Custom
Report

Onboarding Task Type

Onboarding

Onboarding Custom
Report

Onboarding Type

Onboarding

Onboarding Custom
Report

Onboarding User Future Division

Onboarding

Onboarding Custom
Report

Onboarding User Future Location

Onboarding

Onboarding Custom
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FIELD NAME

SECTION

CUSTOM REPORT
NAME
Report

Onboarding User Future Position

Onboarding

Onboarding Custom
Report

Onboarding Workflow Active

Onboarding

Onboarding Custom
Report

Onboarding Workflow Title

Onboarding

Onboarding Custom
Report

Start Date

Onboarding

Onboarding Custom
Report

Performance
FIELD NAME
[Name of Category]
(Category)

SECTION

CUSTOM REPORT NAME

Competency

All custom reports with
Competency section

Competency Description Competency

All custom reports with
Competency section

Marked As Final

Goals

All custom reports with Goals
section

Marked As Final - Date

Goals

All custom reports with Goals
section

Success Descriptors
Title

Goals

All custom reports with Goals
section

Success Descriptors
Description
Recruiting

Goals

All custom reports with Goals
section

FIELD NAME

SECTION

CUSTOM REPORT NAME

Requisition Cost Center

Requisition

Recruiting Custom Report

Requisition Keywords

Requisition

Recruiting Custom Report
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User Fields in Custom Reporting
With this enhancement, the following fields are added to the User section in all custom
reports that include a User section:
FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Badge Status

The status of the badge (Active, Inactive,
Deleted).

Text

User Creation
Date

The date the user record was created.

Date

User GUID

The User GUID used for converting new hires to
users.

Text

210

Cornerstone April 2016 Release Notes: What's New for April 2016

Support for OU Localization in Standard Reports
With this enhancement, standard reports that contain organizational units (OU) will be
updated to display the localized value for the OU. If there is no localized value for the OU
name, then the default value displays for the OU name.

Impacted Reports
The following standard reports are impacted by this enhancement, as they contain OUs in
the report output:
Billing Reports
o Library Registrations Report
o Processing Fees Report
Compensation Reports
o Compensation EEO Report
o Compensation Modeling Report
o Compensation Promotion Report
o Deferral Payments Report
o Employee Salary Range Report
o Individual Targets Report
Connect Reports
o Connect Community Report
o Connect Profile Comments Report
o Connect Topic Expert Report
o Connect Topic Moderator Report
Instructor Led Training Reports
o Reservation Summary
o Session Withdrawal Report
Performance Reports
o Development Plan Exception Report
o Development Plan Status Report
o Goal Exception Report
o Goal Progress Report
o Goal Status Report
o Performance Review Details Report
o Performance Review Report
o Task User Status Report

211

Cornerstone April 2016 Release Notes: What's New for April 2016

Recruitment Reports
o Applicant Compliance Report
o Cost per Hire Report
o Recruiting Agency Statistics Report
o Referral Statistics Report
o Requisition Detail Report
o Scheduled Interviews Report
Succession Reports
o Job Pool Task Report
o Resume and Career Preferences Report
o Resume Section Details Report
o SMP External Candidate Report
o SMP PowerPoint Template Report
o SMP Resume/Feedback Report
o SMP Succession Report
o SMP Survey Step Report
o Succession Details by Incumbent Report
o Succession Details by Successor Report
o Succession Management Plan Report
o Succession Metric Ratings Report
o Talent Pool Details Report
System Reports
o OU Hierarchy Report
o User OUs and Groups Report
o User Record as of a Date Report
o User Record Audit Report
o User Transcript Audit Report
Track Employees Reports
o Custom Form Data Report
o Employee No Show Details Report
o Employee Transcripts Report
o Past Due Report
o Past Requests Report
o Pending Requests Report
o Records Report
o Session Withdrawal Report
Training Reports
o Acknowledgement Report
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o
o
o
o
o
o
o
o
o
o
o

Certification (old certification model)
Certification Details (new certification model)
Certification Summary Report (new certification model)
Curriculum Report
Divisional Training Report
Enterprise Past Due Training Report
Enterprise Training Report
Required/Suggested Training Report
SCORM 2004 Course Progress Chart
Training Unit Redemption Report
Training Registration Details Report
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Edge
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Edge Integrate
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Cornerstone Edge Integrate Overview
Cornerstone Edge Integrate enables organizations to quickly and easily integrate their
Cornerstone system with other workforce systems. This includes recruiting tools, such as
Broadbean and Multiposting, learning tools, such as WebEx and GoToMeeting, and social
tools, such as Facebook and Twitter.
Cornerstone Edge Integrate has two components:
o Marketplace - The Marketplace service enables administrators to conveniently browse
and discover all available third-party integrations and purchase or try the desired
integrations.
o Integrations - Once an integration is purchased or a trial is initiated for the integration,
the Integrations service enables administrators to configure, enable, and disable their
third-party integrations. This greatly simplifies the implementation process by reducing
implementation times and enabling administrators to enable and configure the
integrations.

Available Integrations
There are two types of integrations that are available for the Cornerstone system, Edge
Ready and Packaged.
o Edge Ready integrations can be purchased, installed, and configured by administrators
within Edge Integrate. On the Marketplace page, integrations that are Edge Ready have
the Edge icon
displayed next to their name.
o Packaged integrations must be purchased, installed, and configured through the
previously existing channels, such as Client Executives and Global Product Support
(GPS).

Edge Ready Integrations
1. Virtual Instructor Led Training
A. WebEx Meeting
B. WebEx Training
C. Adobe Connect/Meeting
D. Adobe Seminar Room
E. Citrix Go-To-Meeting
2. Recruiting
A. Multiposting
B. Broadbean External Sourcing
C. CIC Plus
D. FADV Background Check and Drug Screening
3. Social/Connect
A. Twitter
B. Facebook
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Packaged Integrations
1. Core
A. Workday
2. Virtual Instructor Led Training
A. Skype for Business (formerly called Microsoft Lync)
3. Extended Enterprise
A. CyberSource
4. Recruiting
A. Broadbean Job Posting
B. HireRight
C. HireVue
D. SHL Talent Measurement
5. Onboarding
A. Tracker I-9 and E-Verify

Workflow

Use Cases
1. Michael is an administrator at Acme Corp. He accesses the Marketplace from his Pilot
portal to view which integrations are available.
2. Michael notices that an integration is available for a third-party tool that Acme Corp
currently uses. He views the details of the integration and realized that this integration
will add extremely valuable functionality to his Cornerstone portal.
3. Michael decides to enable a free 30-day trial of the integration in the Pilot portal. He
accesses the Integrations page and quickly configures and enables the integration.
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4. After a week of using the integration in non-production environments, Michael decides
that this integration is valuable to Acme Corp. He accesses the Marketplace from his
Production portal and quickly purchases the integration.
5. Michael accesses the Integrations page and configures the integration by choosing to
copy the configuration settings from the Pilot portal.
6. After configuring the integration, Michael enables the integration, and it is automatically
available in his production portal.

Considerations
In order to support the use of Edge Integrate, a new user is added to the system in the
Cornerstone Administrator security role. The Username and User ID for this user is
edgeuser, and this user is available when searching users from the Admin > Users page. In
order for the Edge Integrate service to function properly, this user must remain active.
The Marketplace displays all available integrations, including integrations that are
associated with Cornerstone modules that the organization may not have purchased.
Administrators can initiate a 30-day trial period for an integration in all non-production
environments.
o During a trial period, the integration can only be enabled in non-production
environments.
o Only one trial period is permitted for each integration.
o Trial periods cannot be extended.
o At the end of the trial period, the functionality is disabled until the integration is
purchased.
When a free trial is initiated or when an integration is purchased, the integrations must be
configured and enabled before the functionality is available within the portal. Even though
an integration may be installed in multiple environments, the integration must be configured
and enabled in each environment in order for the functionality to be available in the
environment.
All integration fees are charged annually.

Implementation
Edge Integrate is only available for organizations whose portals are supported by
Cornerstone. For these portals, Edge Integrate is automatically enabled. For organizations
that are supported by a Cornerstone reseller, Edge Integrate is disabled and it is not
available.
Upon release, the Edge Marketplace - Manage and Edge Integrations - Manage
permissions are automatically added to the default System Administrator role.
For organizations that have a previous integration that is now offered as an Edge Ready
integration, such as WebEx or Adobe Connect, the integration appears as Purchased in the
Marketplace, and administrators can update the integration settings via Integrations. When
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the organization's contract ends, the organization must accept the new recurring fee for the
integration in order to continue using it.

Glossary
o Marketplace (Edge) - The Marketplace service enables administrators to conveniently
browse and discover all available third-party integrations and purchase or try the
desired integrations.
o Integrations (Edge) - Once an integration is purchased or a trial is initiated for the
integration, the Integrations service enables administrators to configure, enable, and
disable their third-party integrations. This greatly simplifies the implementation process
by reducing implementation times and enabling administrators to enable and configure
the integrations.

Security
The following new permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Edge Integrations Manage

Grants access to the Integrations service for Edge
Integrate where the administrator can configure,
enable, and disable their third-party integrations that
are used within the Cornerstone system. This
permission cannot be constrained. This is an
administrator permission.

Edge

Edge Marketplace Manage

Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

Edge
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Admin > Users - EdgeUser
In order to support the use of Edge Integrate, a new user is added to the system in the
Cornerstone Administrator security role. The Username and User ID for this user is
edgeuser, and this user is available when searching users from the Admin > Users page. In
order for the Edge Integrate service to function properly, this user must remain active.
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Marketplace
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Marketplace - Browse Edge Integrations
The Marketplace service enables administrators to conveniently browse and discover all
available third-party integrations and purchase or try the desired integrations.
To browse all available third-party integrations, go to ADMIN > TOOLS > EDGE >
MARKETPLACE. The Marketplace opens in a new browser tab.
When using any of the Edge services, such as Marketplace or Integrations, administrators
can navigate between the services by clicking the Menu icon
in the upper-right corner of
the page and selecting the desired service:
o Marketplace - See Marketplace on page 221 for additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Marketplace Manage

PERMISSION DESCRIPTION
Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

CATEGORY
Edge

Filter by Category
By default, the Marketplace displays all of the available integrations. This includes
integrations from all of Cornerstone's modules.
To filter the integrations to only display integrations from a specific category, such as Virtual
Classroom or Job Posting, click the appropriate category. When multiple filters are
selected, the page displays integrations that match any of the selected filters.
To remove a category filter that you have selected, click the Remove icon to the right of
the selected filter. To remove all selected category filters, click the All link at the top of the
Categories section.

Filter by Type
There are two types of integrations that are available for the Cornerstone system, Edge
Ready and Packaged.
o Edge Ready integrations can be purchased, installed, and configured by administrators
within Edge Integrate. On the Marketplace page, integrations that are Edge Ready have
the Edge icon
displayed next to their name.
o Packaged integrations must be purchased, installed, and configured through the
previously existing channels, such as Client Executives and Global Product Support
(GPS).
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By default, the Marketplace displays both types of integrations so that administrators can
view all of the integrations that are available. This includes integrations that cannot be
purchased directly from the Marketplace.
To filter the integrations to only display a specific type of integration, such as Edge Ready,
click the appropriate type. When multiple filters are selected, the page displays integrations
that match any of the selected filters.
To remove a type filter that you have selected, click the Remove icon
selected filter.

to the right of the

Trial/Purchased
If the integration has been purchased or if a trial of the integration has been initiated for the
portal, then a Purchased or Trial banner is displayed on the integration tile.

View Integration Details
To view a brief overview of an integration, hover the computer cursor over the integration
tile.
To view the details of an integration, select the integration tile. This opens the Integration
Details page, which displays all of the details of the integration and enables the
administrator to enable a trial of the integration or purchase the integration. See
Marketplace - View Edge Integration Details on page 224 for additional information.
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Marketplace - View Edge Integration Details
The Integration Details page displays information about the integration, including
information about the vendor, an overview of the functionality provided by the integration,
pricing and setup information, and an opportunity to purchase or try the integration.
To view the details of an Edge integration, go to ADMIN > TOOLS > EDGE >
MARKETPLACE. Then from the Marketplace page, select the appropriate Edge integration.
When using any of the Edge services, such as Marketplace or Integrations, administrators
can navigate between the services by clicking the Menu icon
in the upper-right corner of
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Marketplace Manage

PERMISSION DESCRIPTION
Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

CATEGORY
Edge

Integration Header
At the top of the page, an overview of the integration is displayed, including the following
information:
o Title
o Price per year
o Vendor - The company that is associated with the integration is displayed below the
integration title.
o Categories - The categories associated with the integration are displayed below the
integration provider.

Purchase/Try it Free
Depending on the environment from which Marketplace is being accessed (i.e., Pilot,
Stage, Live), administrators can purchase the integration or initiate a free 30-day trial.
o PURCHASE (Production Environment) - When accessing Marketplace from a
Production portal, administrators have the option to purchase an Edge Ready
integration. Once the Edge Ready integration is purchased, administrators must then
configure and enable the integration from the Integrations configuration center. Note:
The Purchase option is displayed and administrators must complete the Purchase
224

Cornerstone April 2016 Release Notes: What's New for April 2016

process even if there is no cost associated with the integration. This is because the
Purchase action enables the integration to be configured and enabled in the
Integrations configuration center.
o If a trial has been enabled for the portal, then the system displays the number of
days remaining in the trial. This is displayed above the PURCHASE button.
o See Edge Integration - Purchase on page 231 for additional information.
o TRY IT FREE (Non-production Environment) - When accessing Marketplace from a
non-production environment, such as a Pilot or Stage portal, administrators have the
option to initiate a free 30-day trial of an Edge Ready integration. Once the trial of the
Edge Ready integration is enabled, the trial is available in all non-production
environments. However, the integration must be configured and enabled in each
environment from the Integrations configuration center. Note: Although an integration
must be configured and enabled in each environment, administrators are able to import
configuration settings from another environment.
o See Edge Integration - Try it Free on page 227 for additional information.
o CONTACT US (Production or Non-production Environment) - When accessing
Marketplace from any production or non-production environment, administrators have
the option to contact their Client Executive to learn more about a Packaged (non-Edge
Ready) integration. This enables the Client Executive to discuss the integration with the
administrator and assist them in configuring and enabling the integration via backend
settings.
o See Edge Integration - Contact Us on page 235 for additional information.

Integration Preview
A preview of the integration is displayed below the Integration Header. This preview
displays sample images of how the integration will be used within the system. Select the
Arrow icons to the left or right of the preview image to view additional images.

Integration Details
In depth information about the integration is displayed below the Integration Preview. The
Integration Details are separated into four sections. To view a different section, click the
appropriate tab. The following sections are available:
o Vendor - This section provides general information about the vendor with which the
Cornerstone system is integrating. Additional resources may be provided at the bottom
of the page.
o Integration - This section provides an overview of the functionality that is added with the
integration.
o Pricing - This section provides the cost of the integration and frequently asked questions
related to purchasing or trying the integration.
o Setup - This section provides an overview of what is required to configure and utilize the
integration.
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Edge Integration - Try it Free
The Marketplace service enables administrators to conveniently browse and discover all
available third-party integrations and purchase or try the desired integrations.
When accessing Marketplace from a non-production environment, such as a Pilot or Stage
portal, administrators have the option to initiate a free 30-day trial of an Edge Ready
integration. Once the trial of the Edge Ready integration is enabled, the trial is available in
all non-production environments. However, the integration must be configured and enabled
in each environment from the Integrations configuration center.
To enable a free trial for an Edge Ready integration, go to ADMIN > TOOLS > EDGE >
MARKETPLACE. From the Marketplace page, select the appropriate Edge integration.
Then, from the Integration Details page, select the TRY IT FREE button. This button is only
available when accessing Marketplace from a non-production portal and when viewing an
Edge Ready integration that has not been trialed or purchased in the past.
When using any of the Edge services, such as Marketplace or Integrations, administrators
in the upper-right corner of
can navigate between the services by clicking the Menu icon
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Marketplace Manage

PERMISSION DESCRIPTION
Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

CATEGORY
Edge

There are two types of integrations that are available for the Cornerstone system, Edge
Ready and Packaged.
o Edge Ready integrations can be purchased, installed, and configured by administrators
within Edge Integrate. On the Marketplace page, integrations that are Edge Ready have
the Edge icon
displayed next to their name.
o Packaged integrations must be purchased, installed, and configured through the
previously existing channels, such as Client Executives and Global Product Support
(GPS).
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Prerequisites
This section displays the components that are required for using the integration. A free trial
should not be enabled unless all of the prerequisites are satisfied.

Terms and Conditions
This section displays the terms and conditions for the trial period.
Select the Acknowledgment option to agree to the terms and conditions of the trial.

Try it Free/Not Now
Select the TRY IT FREE button to initiate the trial period for the integration. The
Acknowledgment option must be selected before selecting this button. The trial period is
available for up to 30 days in all non-production environments, and only one trial period is
permitted for each integration. Integrations must be configured and enabled before the
functionality is available within the non-production portal. After activating the trial period, a
Confirmation pop-up opens with the following options:
o CONFIGURE NOW - Select this option to navigate to the Integrations page in order to
configure and enable the integration. See Integrations - Configure My Edge
Integrations on page 237 for additional information.
o LATER - Select this option to return to the Marketplace page without configuring the
integration.
Select the NOT NOW button to cancel the trial period and return to the Integrations page.
See Marketplace - Browse Edge Integrations on page 221 for additional information.
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Edge Integration - Purchase
The Marketplace service enables administrators to conveniently browse and discover all
available third-party integrations and purchase or try the desired integrations.
When accessing Marketplace from a Production portal, administrators have the option to
purchase an Edge Ready integration. Once the Edge Ready integration is purchased,
administrators must then configure and enable the integration from the Integrations
configuration center.
To purchase an Edge Ready integration, go to ADMIN > TOOLS > EDGE >
MARKETPLACE. From the Marketplace page, select the appropriate Edge integration.
Then, from the Integration Details page, select the PURCHASE button. This button is only
available when accessing Marketplace from a production portal and when viewing an Edge
Ready integration that has not already been purchased.
Note: The Purchase option is displayed and administrators must complete the Purchase
process even if there is no cost associated with the integration. This is because the
Purchase action enables the integration to be configured and enabled in the Integrations
configuration center.
When using any of the Edge services, such as Marketplace or Integrations, administrators
in the upper-right corner of
can navigate between the services by clicking the Menu icon
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Marketplace Manage

PERMISSION DESCRIPTION
Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

CATEGORY
Edge

There are two types of integrations that are available for the Cornerstone system, Edge
Ready and Packaged.
o Edge Ready integrations can be purchased, installed, and configured by administrators
within Edge Integrate. On the Marketplace page, integrations that are Edge Ready have
the Edge icon
displayed next to their name.
o Packaged integrations must be purchased, installed, and configured through the
previously existing channels, such as Client Executives and Global Product Support
(GPS).
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Purchase Edge Ready Integration
When the PURCHASE button is selected, the purchase process is initiated. This process is
separated into three steps:
1. Billing - On this page, enter information about the billing contact and address for the
purchase.
2. Company - On this page, enter the address for your organization's headquarters.
3. Confirm - On this page, review the information that has been entered and confirm the
purchase.
Once the purchase is confirmed, Cornerstone will send a purchase order to the specified
billing contact to complete the transaction. However, the integration is immediately available
to be configured and enabled.

Prerequisites
On the Confirm page, this section displays the components that are required for using the
integration. An integration should not be purchased unless all of the prerequisites are
satisfied.

Terms and Conditions
On the Confirm page, this section displays the terms and conditions for the integration
purchase.
Select the Acknowledgment option to agree to the terms and conditions of the purchase.

Purchase/Not Now/Back
On the Confirm page, the following options are available:
o PURCHASE - An integration should not be purchased unless all of the prerequisites
are satisfied. Select this option to submit the purchase order. The Acknowledgment
option must be selected before selecting this button. A purchased integration is
automatically installed in all environments. However, the integration must be configured
and enabled within each portal before the functionality is available within the portal.
After purchasing the integration, a Confirmation pop-up opens with the following
options:
o CONFIGURE NOW - Select this option to navigate to the Integrations page in
order to configure and enable the integration. See Integrations - Configure My
Edge Integrations on page 237 for additional information.
o LATER - Select this option to return to the Marketplace page without configuring
the integration. See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o NOT NOW - Select this option to cancel the purchase and return to the Marketplace
page. See Marketplace - Browse Edge Integrations on page 221 for additional
information.
o BACK - Select this option to return to the previous page of the Purchase process.
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Edge Integration - Contact Us
The Marketplace service enables administrators to conveniently browse and discover all
available third-party integrations and purchase or try the desired integrations.
When accessing Marketplace from any production or non-production environment,
administrators have the option to contact their Client Executive to learn more about a
Packaged (non-Edge Ready) integration. This enables the Client Executive to discuss the
integration with the administrator and assist them in configuring and enabling the integration
via backend settings.
To contact Cornerstone regarding a Packaged integration, go to ADMIN > TOOLS > EDGE
> MARKETPLACE. From the Marketplace page, select the appropriate Edge integration.
Then, from the Integration Details page, select the CONTACT US button. This button is
only available when viewing a Packaged integration.
When using any of the Edge services, such as Marketplace or Integrations, administrators
in the upper-right corner of
can navigate between the services by clicking the Menu icon
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Marketplace Manage

PERMISSION DESCRIPTION
Grants access to the Marketplace service for Edge
Integrate where the administrator can browse and
purchase third-party integrations that can be used to
extend the Cornerstone system. This permission
cannot be constrained. This is an administrator
permission.

CATEGORY
Edge

There are two types of integrations that are available for the Cornerstone system, Edge
Ready and Packaged.
o Edge Ready integrations can be purchased, installed, and configured by administrators
within Edge Integrate. On the Marketplace page, integrations that are Edge Ready have
the Edge icon
displayed next to their name.
o Packaged integrations must be purchased, installed, and configured through the
previously existing channels, such as Client Executives and Global Product Support
(GPS).
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Contact Information
When the CONTACT US button is selected, the Contact Us pop-up opens. In the pop-up,
provide your contact information and enter any necessary comments that will be sent to the
organization's Client Executive.

Try it Free/Not Now
Select the SEND button to send the contact information to the organization's Client
Executive. The Client Executive will assist in purchasing, configuring, and enabling the
Packaged integration.
Select the CLOSE button to close the pop-up without contacting the Client Executive.
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Integrations - Configure My Edge Integrations
Once an integration is purchased or a trial is initiated for the integration, the Integrations
service enables administrators to configure, enable, and disable their third-party
integrations. This greatly simplifies the implementation process by reducing implementation
times and enabling administrators to enable and configure the integrations.
To configure and enable the Edge integrations that have been purchased for your portal, go
to ADMIN > TOOLS > EDGE > INTEGRATIONS. The Integrations page opens in a new
browser tab.
When using any of the Edge services, such as Marketplace or Integrations, administrators
can navigate between the services by clicking the Menu icon
in the upper-right corner of
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations on page 237 for additional information.
Permissions
PERMISSION NAME
Edge Integrations Manage

PERMISSION DESCRIPTION
Grants access to the Integrations service for Edge
Integrate where the administrator can configure,
enable, and disable their third-party integrations that
are used within the Cornerstone system. This
permission cannot be constrained. This is an
administrator permission.

CATEGORY
Edge

Available Integrations
The Integrations page displays all of the integrations that have been purchased or are
within a trial period.
To the right of the My Integrations tab, the portal type is displayed. The portal type
determines which integrations are available:
o Production Environment - When accessing Integrations from a Production portal,
administrators can configure and enable Edge integrations that have been purchased
from the Marketplace.
o Non-production Environment - When accessing Integrations from a non-production
environment, such as a Pilot or Stage portal, administrators can configure and enable
Edge integrations that have been purchased or are within a trial period. Once the trial
period has expired, the integration is no longer available to be configured until it is
purchased.
Prior to configuring an integration, the integration must be purchased or a trial period must
be initiated for the integration. This is done from the Marketplace. See Marketplace Browse Edge Integrations on page 221 for additional information.
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Configure
If an Edge integration has configuration settings, then the integration cannot be enabled
until it is configured. In addition, the option to enable or disable the configuration is only
available after the integration is configured.
To configure an integration, select the CONFIGURE button. See Edge Integration Configure on page 241 for additional information.

Edit Configuration
After an integration is configured, the CONFIGURE button is hidden and an Enable/Disable
toggle switch is available.
To edit the configuration settings for an integration that has already been configured, select
the integration title. This opens the Configuration page. See Edge Integration - Configure
on page 241 for additional information.

Enable or Disable
An Edge integration can be enabled or disabled from the Integrations page in the following
scenarios:
o The integration has already been configured. After an integration is configured, the
CONFIGURE button is hidden and an Enable/Disable toggle switch is available.
o The integration does not have configuration settings.
If an integration has configuration settings, then the Enable/Disable toggle switch is not
available until the integration is configured.
To enable or disable an integration for the current portal, select the toggle switch to the right
of the integration. Note: Enabling or disabling an integration only impacts the current portal.
If the integration should be enabled or disabled in all portals, than this must be done
separately within each portal. The current portal type is displayed at the top of the page.
- The integration is enabled when the slider is positioned on the right
o Enabled
side of the toggle switch.
o Disabled
- The integration is disabled when the slider is positioned on the left
side of the toggle switch.
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Edge Integration - Configure
Once an integration is purchased or a trial is initiated for the integration, the Integrations
service enables administrators to configure, enable, and disable their third-party
integrations. This greatly simplifies the implementation process by reducing implementation
times and enabling administrators to enable and configure the integrations.
To configure an Edge integration, go to ADMIN > TOOLS > EDGE > INTEGRATIONS.
Then from the Integrations page, select the CONFIGURE button to the right of the
appropriate Edge integration.
When using any of the Edge services, such as Marketplace or Integrations, administrators
can navigate between the services by clicking the Menu icon
in the upper-right corner of
the page and selecting the desired service:
o Marketplace - See Marketplace - Browse Edge Integrations on page 221 for
additional information.
o Integrations - See Integrations - Configure My Edge Integrations on page 237 for
additional information.
Permissions
PERMISSION NAME
Edge Integrations Manage

PERMISSION DESCRIPTION
Grants access to the Integrations service for Edge
Integrate where the administrator can configure,
enable, and disable their third-party integrations that
are used within the Cornerstone system. This
permission cannot be constrained. This is an
administrator permission.

CATEGORY
Edge

Copy Settings from Another Portal
If the integration you are configuring has been configured in another environment, then
administrators can copy the configuration settings from the configured environment.
o Use Case: An administrator enables a 30-day trial in their Pilot portal and configures the
integration in the Pilot portal. The administrator later decided to purchase the integration
and begins to configure the integration in the Production portal. The administrator
copies the integration's configuration settings from the Pilot environment to the
environment they are currently configuring.
To copy the integration's configuration settings from another environment, select the Copy
from drop-down menu and select the appropriate environment. After copying the settings,
administrators may modify the settings prior to saving them. The Copy from drop-down
menu only displays environments in which the selected integration has been configured.
Important: Copying settings from another environment will overwrite any settings that may
have been configured for the integration in the current environment.
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Setup Instructions
The Setup Instruction section contains detailed information regarding how to configure the
integration.
To view the setup instructions, click the Setup Instructions link. The section expands to
display the instructions.

Configuration Settings
Complete all of the fields to configure the integration. For information on the configuration
fields, click the Setup Instructions link.
Important: The configuration settings only apply to the current portal. If the integration is
used in multiple portals, then the integration must be configured and enabled in each portal.
The current portal type is displayed at the top of the page.

Save Settings
After completing the configuration fields or copying the configuration settings from another
environment, click the SAVE SETTINGS button at the bottom of the page to save any
changes to the settings.
Important: After saving the configuration settings, the integration must be enabled on the
Integrations page before the functionality is available in the portal. See Integrations Configure My Edge Integrations on page 237 for additional information.
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Adobe Connect Meeting Room Integration
The Adobe Connect Meeting Room integration allows for seamless creation of virtual
meetings that can host up to 100 meeting participants. The integration gives users the
ability ot execute on all phases of the meeting setup and execution from within
Cornerstone's Learning Management System (LMS). This vILT integration allows Learning
Administrators to add instructors, create and manage sessions, and track attendance from
within Cornerstone. Adobe Connect sessions can be launched from Cornerstone directly
into Adobe Connect.
When an instructor is selected for an Adobe Connect vILT session, the instructor is
automatically designated as a host for the Adobe Connect session.

Use Case
1. An administrator working inside the LMS is setting up webinar training that will be
attended by the entire company. She creates the session inside the LMS and assigns
an instructor. The assigned instructor is automatically designated as a host for the
session.
2. Because there will be less than 100 attendees, she decides to use one of her
company's licensed Meeting Rooms with Adobe Connect.
3. One of the facilities inside of the LMS is mapped to the appropriate Meeting Room in
Adobe Connect. The administrator makes sure that the location of the session is using
a location with that facility so that the meeting will be held inside the Meeting Room.
4. The webinar is assigned to the entire company and when it comes time for the session
to start, the attendees launch the webinar directly from their transcripts and are taken
directly into the Meeting Room inside of Adobe Connect.

Implementation
The Adobe Connect Meeting Room integration requires Cornerstone Learning and an
Adobe Connect Meeting Room account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
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Adobe Connect Seminar Room
The Adobe Connect Seminar Room integration allows for seamless creation of virtual
meetings from within Cornerstone Learning using the Adobe Connect API. This vILT
integration allows Learning Administrators to add instructors, and create and manage
sessions from within Cornerstone. Adobe Connect sessions can be launched from
Cornerstone directly into Adobe Connect.
When an instructor is selected for an Adobe Connect vILT session, the instructor is
automatically designated as a host for the Adobe Connect session.

Use Case
1. An administrator working inside the Learning Management System (LMS) is setting up
webinar training that will be attended by the entire company. She creates the session
inside the LMS and assigns an instructor. The assigned instructor is automatically
designated as a host for the session.
2. Because there will be over 1,000 attendees, she decides to use one of her company's
licensed Seminar Rooms with Adobe Connect.
3. One of the facilities inside of the LMS is mapped to the appropriate Seminar Room in
Adobe Connect. The administrator makes sure that the location of the session is using
a location with that facility so that the meeting will be held inside the Seminar Room.
4. The webinar is assigned to the entire company and when it comes time for the session
to start, the attendees launch the webinar directly from their transcripts and are taken
directly into the Seminar Room inside of Adobe Connect.

Considerations
The Adobe Connect API does not support the passing back of attendance data from Adobe
Connect to the LMS.
The system enables administrators to move an ILT session into a seminar room. However,
seminar rooms must be created and managed within Adobe Connect.

Implementation
The Adobe Connect Seminar Room integration requires Cornerstone Learning and an
Adobe Connect Seminar Room account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
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Move Session to Adobe Connect Seminar Room
The system enables administrators to move an ILT session into an Adobe Connect seminar
room. However, seminar rooms must be created and managed within Adobe Connect.
To move an ILT session into a seminar room, first, create an ILT Facility that matches the
name or ID of the shared seminar room in Adobe Connect. Second, create an ILT session.
On the Parts Schedule page for the session, set the session location as the facility that
corresponds to the Adobe Connect seminar room. This ensures the session is associated
with the correct seminar room in Adobe Connect.

Create Seminar Room Facility
To create a seminar room facility, go to ILT > Facilities and Resources. Then, click the
Add Facility link.
The following information must be entered for the seminar room facility in order to map it to
the seminar room in Adobe Connect:
o
o
o
o
o
o

Name - Enter the Adobe Connect Seminar Room name. This is required.
ID - Enter the Adobe Connect Seminar Room ID. This is required.
Description - Enter an optional description for the seminar room facility.
Active - Select this option to make facility active.
Facility Type - Select the appropriate facility type from the drop-down list.
In the address fields, enter the address of the seminar room, if applicable.

Create Session with Seminar Room Facility
To create an ILT Event Session, go to ILT > Manage Events & Sessions. Search for the
appropriate event and in the Options column next to the event, click the View Sessions icon
. To create a new session, you can do so via one of the following options:
o Click Create New Session to create a new session.
o Click Copy icon to create a copy of an existing session which can be changed or edited
and saved as a new session.
o Click Edit icon to modify an existing session.
The following information must be entered for the session on the Parts Schedule page in
order to utilize the Adobe Connect seminar room facility:
o Name - Enter the session name.
o Description - Enter the session description.
o Location - Select the Seminar Room Facility.
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Broadbean External Sourcing Overview
The Broadbean External Sourcing integration enables organizations to source applicants
from external job boards in Broadbean. The applicants can be added to talent pools and
invited to apply to the job.

Use Cases
o Sourcing Candidates - Lauren the Recruiter needs to find more candidates to apply for
the requisitions she is responsible for. She wants to source candidates from different
job board platforms.
o Adding to Talent Pools and Inviting to Apply - Once Lauren performs searches and
finds candidates that could potentially fit the open positions, she wants to add those
candidates to talent pools and/or invite them to apply to the requisitions.

Implementation
The Broadbean External Sourcing integration requires Cornerstone Learning and a
Broadbean account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.

Glossary
o External Sourcing - Sourcing applicants from external job boards.

Security
The following new permission applies to this functionality:
PERMISSION
NAME
External Search:
Manage

PERMISSION DESCRIPTION

Grants access to view and manage the external
sourcing functionality. This permission cannot be
constrained.

CATEGORY

Recruiting

The following existing permissions apply to this functionality:
PERMISSION
NAME
Global Email
Administration -

PERMISSION DESCRIPTION

Grants ability to manage email trigger templates
across all active modules in the portal. Enables

CATEGORY

Core
Administration
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Manage

creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.

Global Email
Grants view only access to email
Administration - View templates/triggers and email logs at the global
level for the portal. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User. This is an administrator
permission.

Core
Administration

Recruiting: Search
Candidates

Grants ability to access Candidate Search page
Recruiting
for recruiting, which enables searching for internal Administration
candidates and external candidates who have
applied for open positions. This permission also
enables the Invite to Apply action item to appear in
the Actions drop-down on the Search Candidates Search Results page. This permission can be
constrained by OU and User's OU.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
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Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
Requisition
Template - Manage

Grants ability to access and view Requisition
Recruiting
Templates. This permission cannot be constrained. Administration
This is an administrator permission.

Requisition
Template - View

Grants ability to access and view Requisition
Templates. This is an administrator permission.

Recruiting
Administration

Roles
The following permission is added to the Recruiting - Manager role:
o External Search: Manage
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Requisition Templates - Keywords
With this enhancement, a Keywords field is added to the Description and Qualifications
section for requisition templates. The keywords that are added to the field are used when
the recruiter is accessing Broadbean from the Manage Requisitions page.
Note: The External Sourcing option allows recruiters to search for applicants from
external job boards in Broadbean. The External Sourcing option can be accessed from the
Manage Job Requisitions page and the Candidate Search Query page.
To create requisition templates, go to Admin > Tools > Recruit > Requisition Templates.
In the Options column to the right of the appropriate Position organizational unit (OU), click
the Manage Requisition Template icon .
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition Template Grants ability to access and view Requisition
Recruiting
- Manage
Templates. This permission cannot be constrained. Administration
This is an administrator permission.
Requisition
Template - View

Grants ability to access and view Requisition
Templates. This is an administrator permission.

Recruiting
Administration

OU Hierarchy Manage

Grants ability to create and update/edit
organizational units and custom groups. This
permission grants access to all OU types, both
standard and custom. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

Core
Administration
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Keywords
Enter keywords into the Keywords field, up to 1000 characters. Separate each keyword by
a comma, and then a space.
The keywords can be localized by selecting the desired language from the language dropdown in the upper-right corner of the Description and Qualifications section. Then, enter the
translated keywords in the Keywords field.
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Create Job Requisition - Keywords
With this enhancement, a Keywords field is added to the Description and Qualifications
section for requisition templates. The keywords that are added to the field are used when
the recruiter is accessing Broadbean from the Manage Requisitions page.
to automatically populate the search criteria when searching for applicants through the
External Sourcing option.
Note: The External Sourcing option allows recruiters to search for applicants from
external job boards in Broadbean. The External Sourcing option can be accessed from the
Manage Job Requisitions page and the Candidate Search Query page.
To create job requisitions, go to Recruit > Manage Requisition.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Description

Grants ability to edit the internal and external
Recruiting
descriptions for requisitions. This permission cannot
be constrained. This permission must be used in
conjunction with the Requisition: Manage
permission. Note: For requisition owners and
managers who do not have this permission, when
editing a job requisition, the requisition description
section is read-only.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
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cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.

256

Cornerstone April 2016 Release Notes: What's New for April 2016

Keywords
Enter keywords into the Keywords field, up to 1000 characters. Separate each keyword by
a comma, and then a space.
The keywords can be localized by selecting the desired language from the View In dropdown. Then, enter the translated keywords in the Keywords field.
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Manage Job Requisitions - External Sourcing Option
An External Sourcing option is added to the options drop-down on the Manage Job
Requisitions page. This option allows recruiters to open the Broadbean search page and
search for applicants to add to a talent pool or invite to apply to the job.
Error Note: If your Broadbean account is not active, a message displays directing you to
My Account > My Social Profiles in order to activate your Broadbean account.
To manage job requisitions, go to Recruit > Manage Requisition.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting).
This permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a

Recruiting
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reviewer. This permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.

259

Cornerstone April 2016 Release Notes: What's New for April 2016

Candidate Search Query - External Sourcing Option
An External Sourcing option is added to the upper-right corner of the Candidate Search
Query page. This applies to the Quick Search and Advanced Search tabs. This option
allows recruiters to open the Broadbean search page and search for applicants to add to a
talent pool or invite to apply to the job.
In addition, when searching for candidates, the system will also use the resume submitted
by external candidates as part of the search.
To access the Candidate Search Query, go to Recruit > Candidate Search Query.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Recruiting: Search
Candidates

Grants ability to access Candidate Search page
Recruiting
for recruiting, which enables searching for internal Administration
candidates and external candidates who have
applied for open positions. This permission also
enables the Invite to Apply action item to appear in
the Actions drop-down on the Search Candidates Search Results page. This permission can be
constrained by OU and User's OU.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting
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Job Boards - Search for Applicants
Recruiters can search for applicants on external job boards in Broadbean. See the following
for the steps necessary to search for applicants via Broadbean:
GO TO

STEP
1

2

STEP DESCRIPTION

Manage Job
Requisitions
> Create Job
Requisition

Enter keywords in the Keywords field.

Recruit >
Manage Job
Requisitions

Click the External Sources option in the options dropdown. This opens the Broadbean search page.

The keywords are USED to automatically populate the
search criteria in Broadbean.

or
Recruit >
Candidate
Search Query
3

Broadbean
Search Page

Select the job boards from which to search for
applicants.
The keywords and job title from the job requisition will
be pre-populated so that you do not need to enter search
criteria.

4

Broadbean
Search Page

Search for applicants from the Broadbean search page.

5

Broadbean
Search
Results Page

Click the Add to Talent Pool option to add the desired
applicants to the talent pool. The talent pools that
display in Broadbean for recruiters are the talent pools to
which they have access to view and edit in the portal.
Note: If an applicant currently has an Applicant Profile
page in the portal, then the applicant is automatically
added to the talent pool.
Note: External applicants can still create a profile on the
career site if the talent pool to which they are added is
deleted before the applicant creates their profile.

Broadbean Account Requirements
You must have an account with Broadbean in order to use the External Sourcing feature.
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Email Administration
With this enhancement, a Create Profile Invitation email is added to the Recruitment action
type in Email Administration:
Permissions
PERMISSION
NAME
Global Email
Administration Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage email trigger templates
Core
across all active modules in the portal. Enables
Administration
creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.

Global Email
Grants view only access to email
Administration - View templates/triggers and email logs at the global
level for the portal. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User. This is an administrator
permission.

Core
Administration

Create Profile Invitation
ACTION
Create
Profile
Invitation

DESCRIPTION/TRIGGER
This email is triggered when an external applicant is added to a
talent pool via Broadbean. The email should include the
INVITATION.TO.CREATE.PROFILE tag so that applicants can click
the link to create a profile. The email should also include the
DELETE. CANDIDATE.INFORMATION tag so that applicants can
delete their temporarily stored data from the database.
The email can be sent to external candidates that were added to
the talent pool and have created a profile with a valid email
address. This email can be configured as a Notification type email.
This email is active by default and can be found in the Recruitment
action type section of Email Administration.
Use Case: This trigger invites an external applicant to create a
profile on the career site. The email is triggered when the applicant
is added to a talent pool via Broadbean.
Note: This email is not sent to applicants who currently have a
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ACTION

DESCRIPTION/TRIGGER
user record in the portal. However, the email is sent to applicants
who are added to a talent pool for a different requisition but have
already created a profile on the career site. In such cases the
applicant will be directed to a page that indicates an account (which
is created using the applicant's email address) currently exists for
the applicant.

Email Tags
The following email tags are available for the Create Profile Invitation email (new tags
appear in red):
TAG NAME

DESCRIPTION

ACTION.DATE

Date that the action took place that
triggers the email.

INVITATION.TO.CREATE.PROFILE

Link to the default career site.

DELETE.CANDIDATE.INFORMATION

Link to delete temporary profile data.
Applicant can click the link and choose
to remove their temporary profile data
from the organization. When the user
clicks YES to delete, a confirmation
appears. Click YES to confirm the
deletion, or click NO to cancel the
deletion. If you click YES, the
candidate is directed to the job search
page of the career site.

COMPANY.NAME

Name of the company that sent the
email. (This is your company's name.)

RECIPIENT.FIRST.NAME

Recipient's first name.

RECIPIENT.LAST.NAME

Recipient's last name.
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Applicant Profile - Snapshot
When external applicants create a profile on the career site from the email invitation, their
resume is saved on the Applicant Profile > Snapshot page.
With this enhancement, when a resume is sourced from Broadbean, the Title column
displays as "External Sourcing/[Job Board Name - Resume." The Requisition column
displays as "N/A."
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Career Site Profiles

Contact Information and Resume
When applicants are invited to create a career site profile as a result of the ADD TO
TALENT POOL action on Broadbean, the applicant's contact information is automatically
entered on the career site. This saves the applicant from having to re-enter this information
when creating a career site profile.

Creating a Profile
Applicants can create a profile using their email address. This reduces the possibility of
duplicate applicants.
Note: Applicants are required to create a profile if enabled by a backend setting. If the
backend setting is disabled, then applicants are added to the talent pool without needing to
create a profile on the career site.

Delete Temporary Profile
When applicants are invited to create a career site profile as a result of the ADD TO
TALENT POOL action on Broadbean, the applicant can choose not to create the profile
and instead to delete their information from the organization's database.
In the Create Profile Invitation email, if the DELETE.CANDIDATE.INFORMATION tag is
included by the administrator in the email, the tag displays as a link in the email. Applicants
can click the link and choose to remove their temporary profile data from the organization.
This opens a page where the applicant can click YES to delete or CANCEL to keep their
information stored on the database. If they click YES, they are directed to the job search
page of the career site.

Auto-Deletion of Temporary Profile
The external applicant's resume and data will be deleted from the Applicant Profile >
Snapshot page after the set number of days, as defined by the administrator via a backend
setting.
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Career Site Management
With this enhancement, a Set as Default option is added to the Career Site Management
page. This option allows administrators to select which career site they would like to be the
default career site.
To manage career site pages, go to Admin > Tools > Recruit >Career Sites.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Career Site - Manage Grants ability to access and manage Career Site Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
Career Site - View

Grants ability to access and view Career Site
Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.

Set as Default
The Set as Default icon
displays as the far right option in the Options column. Click the
icon to set the selected career site as the default site. This opens a confirmation pop-up.
Click YES to set the career site as the default, or click NO to cancel the action.
The default career site is linked to from the DEFAULT.CAREER.SITE email tag.
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Deactivate Default Career Site
When a career site is defined as the default site, it cannot be deactivated. Only career sites
that are not the default can be deactivated.

Inactive Career Sites
Careers sites that are inactive cannot be defined as the default.

Auto-Designation as Default Career Site
For career sites created after implementation of this enhancement, if the career site created
is the first career site created for the portal in Career Site Management and the career site
is defined as active, then that career site is automatically the default career site.
For current and future career sites, if the portal has no career sites defined as active, then
the first career site created that is defined as active will be the default career site.
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CIC Plus Integration
Through integration with CIC Plus, employers can assign electronic tax withholding forms
(W-4 forms) to new hires as part of the Onboarding workflow. New hires can then complete
all applicable ho can then electronically complete tax withholding paperwork as part of their
onboarding process. Employers are able to track tax withholding form completion, along
with other onboarding tasks. This integration provides users access to the forms through a
secure, self-service site.

Considerations
A future enhancement to the integration features may include the ability for employees to
update existing W-4 forms.

Implementation & Configuration
The CID Plus integration requires Cornerstone Onboarding and a CIC Plus account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
When configuring the integration, the following applies:
o Provide User Refs as unique identifier for users. This helps to ensure that data syncs
across Cornerstone, CIC Plus, and their other systems. If this information is not
provided, then internal user IDs will be used.
o The target Location OUs for onboarding users must have complete address data, which
includes a street address, city, state, ZIP code, and country.
o A parent form task that is assigned to the onboarding employee for the purpose of
collecting the employee’s home address information must be configured prior to adding
an integration task for completing W-4 forms.
o The W-4 Form (CIC Plus) integration task must be added to Onboarding Workflows as a
child task of parent form tasks.
o A setting to collect the user's social security number and date of birth must be
configured in CIC Plus.

Use Case
1. Prior to issuing a new employee's first paycheck, an employer needs to know how much
they need to withhold from an employee's paycheck for taxes. A task to complete the
necessary W-4 form(s) needs to be assigned to new hires as an onboarding task.
2. Amanda, an administrator, is configuring onboarding workflow tasks for new hire
onboarding. She needs to add an integration task for W-4 forms to the onboarding tasks
for the new hire. However, as a prerequisite to completing W-4 forms, Amanda needs to
ensure that the employer has the most recent address information for the new hire.
Amanda configures a form task as a parent task and assigns it to onboarding
employees to collect their home address information. She then configures a form task
as a child task and assigns it to Mark, a Human Resources (HR) representative, to
collect the new hire's work location address. Finally as a child task to the two form
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3.
4.
5.

6.

tasks, Amanda configures an integration task for W-4 forms though integration partner
CIC Plus to be assigned to onboarding employees.
Vincent has just been hired and has started the onboarding process. He launches and
completes a form task and fills out his home address.
Mark launches and completes a form task to fill out Vincent's work address.
Vincent is assigned an integration task to complete his W-4 forms. He clicks on his
action item in Universal Profile to complete his W-4 forms. Through Single Sign-On
(SSO), he is automatically signed into Paperless Employee, a CIC Plus Product, where
he sees the W-4 forms he needs to complete. If Vincent still has more forms to
complete after he submits a form, he receives a notification telling him how many
pending forms he still has to complete. He can access and complete those forms
through his original W-4 form action item. After Vincent completes all his pending forms,
his W-4 form action items is automatically completed and removed from his list of action
items.
Esther, the HR Director, monitors the progress of onboarding employees. As new hires
and HR representatives complete their respective tasks, she can see the completion
progress for the new hire when it is updated. In the result column of the W-4 task,
Esther can see how many W-4 forms are still pending for the new hire if they have not
yet completed all the W-4 forms required for them.

Security
The following permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Action Items - View

Grants ability to view action items on the Action Items Universal
page and in the Your Action Items widget. Users
Profile
without this permission cannot access the Action
Items page. This permission can be constrained by
Employee Relationship, OU, User's OU, User's Self
and Subordinates, and User's Self. This is an end user
permission.

Applicants: Manage
Onboarding

Allows user to launch the onboarding process from
Employee
applicant to employee and view onboarding progress Onboarding
from the Applicant Profile. This permission can be
constrained by OU and User's OU.

Action Items Employee
Onboarding

Grants ability to view Onboarding actions via the
Universal
Universal Profile - Actions page or the
Profile
Welcome/Custom page Actions widget. This
permission cannot be constrained. This is an end user
permission.
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Onboarding Manage

Grants ability to manage user onboarding in the
Onboarding Dashboard and the Onboarding tab on
the Universal Profile. This permission can be
constrained by OU and User's OU.

Employee
Onboarding

Onboarding - View

Grants ability to view the Onboarding Dashboard and Employee
the Onboarding tab on the Universal Profile. This
Onboarding
permission can be constrained by OU and User's
OU.

Onboarding
Grants ability to access and manage Onboarding Employee
Workflows - Manage Workflows. This permission cannot be constrained. Onboarding This is an administrator permission.
Administration
Onboarding
Integrations Manage

Grants administrator ability to manage Recruiting
and Onboarding Integrations. This permission
cannot be constrained. This is an administrator
permission.

Employee
Onboarding Administration

Recruiting
Integrations Manage

Grants ability to access and manage the Recruiting Recruiting
Integrations Preferences page. This is an
Administration
administrator permission. This permission cannot
be constrained.
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Facebook
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Facebook Integration Overview
The integration between Cornerstone and Facebook allows users to share posts directly
from their Cornerstone Connect Live Feed to Facebook. This is useful for users who wish to
share interesting company updates with family and friends.

Use Cases
Troy is a Marketing Coordinator for a package delivery service at their office in New York.
He sees a post on his Live Feed from a colleague stating "The Brooklyn Bridge has been
completely shut down. Plan your commute accordingly!" Knowing that the delivery trucks
use Facebook to broadcast traffic conditions, Troy re-posts this to Facebook so that the
delivery drivers can complete their routes on time.

Considerations
Only updates that the user manually posts to the Connect Live Feed can be shared to
Facebook.
Only text from user updates is shared to Facebook. Links and files are not shared.

Implementation
The Facebook integration requires New Connect. Also, users must have a Facebook
account to utilize this integration.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is enabled via Edge
Integrations.
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Share Live Feed Posting to Facebook
When the Facebook integration is enabled, users who have a Facebook account can share
any updates that any user in their feed has manually posted to the Connect Live Feed to
their Facebook feed.
To share an update from the Connect Live Feed to Facebook, click the SHARE button in
the lower-right corner of the update. Then, select Facebook. If you are logged in to
Facebook and have authorized Cornerstone to post to Facebook, then the selected update
is posted to your Facebook page.

Log in to Facebook
When you attempt to share a posting to Facebook, the system checks your Internet
browser's cookies to see if you are currently logged in to Facebook. If you are not currently
logged in to Facebook, you are prompted to enter your Facebook credentials and log in.
Enter your Facebook credentials, and select LOG IN.
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Authorize Cornerstone to Post to Facebook
When you attempt to share a posting to Facebook, Facebook checks to see if you have
authorized Cornerstone to post to Facebook. If you have not already authorized
Cornerstone to post to Facebook, you are prompted for the authorization.
From the drop-down, select the users with whom you will share posts from Cornerstone.
Then, select OKAY.
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First Advantage Integration
The First Advantage Background Checks and Drug Screening integration allows recruiters
to easily submit background checks and drug screenings for job applicants from with
Cornerstone Recruiting.

Implementation
The First Advantage integration requires Cornerstone Recruiting and a First Advantage
account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
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GoToMeeting Integration
The GoToMeeting integration allows Cornerstone's Learning administrators add instructors,
create and manage sessions, and track attendance from within Cornerstone. Citrix
GoToMeeting sessions can be launched from Cornerstone directly into GoToMeeting.

Implementation
The GoToMeeting integration requires Cornerstone Learning and an GoToMeeting account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.

276

Cornerstone April 2016 Release Notes: What's New for April 2016

Multiposting Job Posting
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Multiposting Integration Overview
The Multiposting integration enables recruiters to post a requisition that has multiple
language translations to multiple job boards that support multiple languages. Through an
integration with Multiposting, recruiters can select the desired job boards from the External
Postings page of the job requisition and post the job to more than one job board that
supports multiple languages.
Recruiters will be able to see the latest statistics for each job board, as well as take actions
such as edit the job posting, delete the job posting, and repost the job when the job posting
expires.

Use Case
1. Peter is a Recruiter at a global organization and needs to recruit Sales Representatives
in Mexico so that the company can expand in Mexico.
2. Peter has created a Sales Representative requisition that has already been translated
into Spanish.
3. Peter needs to post this job to as many job boards as possible so that he can get
maximum exposure to get the best Spanish-speaking sales representatives in Mexico.
4. Peter posts the job to five well-known Mexican job boards, making sure that the
postings are available in English and Spanish.
5. Peter can see the status of his job postings on each of the job boards.
6. Peter can take actions like editing, deleting, or reposting the job depending on how the
job posting does on each of the job boards.

Implementation
The Multiposting Job Posting integration requires Cornerstone Learning and a Multiposting
account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME
Requisition: Edit
Postings

PERMISSION DESCRIPTION

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing

CATEGORY

Recruiting
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information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.
Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
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External Postings Page - Updates to Job Boards Section
With this enhancement, a Job Board Vendor drop-down is added to the Job Boards
section on the External Postings page to enable recruiters to select the job board vendor,
such as Multiposting.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
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editing a requisition.

Job Board Vendor Drop-Down
The Job Board Vendor drop-down displays the active job board integrations that are
available to post the requisition. To select a vendor, click the drop-down and select the
vendor from the list.
Once the vendor is selected, the options in the Job Boards section and the columns in the
job boards table will change based on the vendor selected.
Note: The Job Board Vendor drop-down only displays if there is at least one active job
board integration, as configured.
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Multiposting Job Board Postings
The Multiposting integration allows recruiters to post a requisition that has multiple
language translations to multiple job boards that support multiple languages. Through the
integration, recruiters can select the desired job boards from the External Postings page of
the job requisition and post the job to more than one job board that supports multiple
languages.
Note: For requisitions that have an approval workflow, postings cannot be made through
Multiposting until the requisition is approved.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
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the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Post Job
To post a job through Multiposting:
1. Select a default career site in the Career Sites section. This is required in order to post
the job via Multiposting so that the posted jobs will be linked to the default career site.
2. Select Multiposting from the Job Board Vendor drop-down. This updates the options
in the Job Boards section and the columns in the job boards table.
3. Click the CREATE NEW POSTING button. This opens a Multiposting window from
which you can select the job boards and configure the posting. You must have a
Multiposting account in order to post through Multiposting.
Once the job postings are configured, you can submit the requisition on the External
Posting page.

Repost Job
The REPOST JOB button allows recruiters to repost a job posting. The button only displays
if the active postings are in a Deleted, Error, or Expired status or is no longer active on any
job boards.
To repost the job:
1. Click the REPOST JOB button. This opens a Multiposting window.
2. In the Multiposting window, you can edit any of the job details before reposting the job.
Once you have finished making the changes in Multiposting, you will need to manually
close the Multiposting window.
3. Then, click REFRESH on the External Postings page. This updates the job boards table
to display the job boards to which the posting has been reposted. The status of the job
boards changes to Pending or Active, and this enables the EDIT POSTING and
DELETE ALL buttons to display. the REPOST JOB button will no longer display.

Job Boards Table
The following columns display in the job boards table when Multiposting is selected in the
Job Board Vendor drop-down:
o Job Board Posting - This column displays the name of the job board to which the
requisition is posted.
o Status - The following statuses of the job board display in the Status column:
o Active
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o
o
o
o

o

o Deleted
o Error
o Expired
o Pending
Date Posted - This column displays the effective date of the job posting.
Expiration Date - This column displays the date on which the requisition expires on the
job board.
Clicks - This column displays the number of clicks that the job board has received.
Amount - This column matches the data in Multiposting and displays the correct amount
type for the posting cost type entity. The amount displays in the user's language, if
available.
o Credits - This shows the remaining credits for the job board.
o Slots - This shows the remaining/total slots for the job board.
Options - The following options are available in the Options column:
o Delete - You can delete a job posting that is in a Pending or Active status by
clicking Delete from the options drop-down in the Options column. This opens a
confirmation pop-up. Click YES to delete the posting, or click NO to cancel the
delete action. Once the posting is deleted, click REFRESH. This updates the job
board status to Deleted. The options drop-down is hidden when a job board is in a
Deleted status.

Edit Posting
The EDIT POSTING button allows you to edit the posting in Multiposting. When clicked, the
Multiposting window opens, where you can edit the posting. Once the updates are made,
the job boards table on the External Postings page updates to display the latest data.
This button only displays once a job is posted via Multiposting.
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Refresh
The REFRESH button updates the job boards table to display the latest data from the job
boards to which the job is posted.

Delete All
The DELETE ALL button allows you to delete all postings that are still pending and active
on job boards. A confirmation pop-up opens. Click YES to delete the posting, or click NO to
cancel the delete action.
The status for the job boards will change to Deleted when the REFRESH button is clicked.
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Twitter
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Twitter Integration Overview
The integration between Cornerstone and Twitter allows users to share posts directly from
their Cornerstone Connect Live Feed to their Twitter feed. This is useful for users who wish
to share interesting company updates with family and friends.

Use Cases
Troy is a Marketing Coordinator for a package delivery service at their office in New York.
He sees a post on his Live Feed from a colleague stating "The Brooklyn Bridge has been
completely shut down. Plan your commute accordingly!" Knowing that the delivery trucks
use Twitter to broadcast traffic conditions, Troy re-posts this to Twitter so that the delivery
drivers can complete their routes on time.

Considerations
Only updates that the user manually posts to the Connect Live Feed can be shared to
Twitter.
Only text from user updates is shared to Twitter. Links and files are not shared.

Implementation
The Twitter integration requires New Connect. Also, users must have a Twitter account to
utilize this integration.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is enabled via Edge
Integrations.
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Share Live Feed Posting to Twitter
When the Twitter integration is enabled, users who have a Twitter account can share any
updates that any user in their feed has manually posted to the Connect Live Feed to their
Twitter feed.
To share an update from the Connect Live Feed to Twitter, click the SHARE button in the
lower-right corner of the update. Then, select Twitter. If you are logged in to Twitter, then
you can modify the update and post it to your Twitter feed.

Log in to Twitter
When you attempt to share a posting to Twitter, the system checks your Internet browser's
cookies to see if you are currently logged in to Twitter. If you are not currently logged in to
Twitter, you are prompted to enter your Twitter credentials and log in.
Enter your Twitter credentials, and select LOG IN AND TWEET. You can also modify the
posting text before
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Tweet Posting
When you attempt to share a posting to Twitter, Twitter allows you to modify the posting
text before sharing it to Twitter.
Modify the update text, as needed. Then, select TWEET.
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WebEx Meeting Center Integration
The WebEx Meeting Center integration allows users and administrators to seamlessly
navigate between Cornerstone's Learning Management System (LMS) and Cisco WebEx
through WebEx's Single Sign On (SSO) functionality. This gives users and administrators
one place to set up and launch WebEx meetings, including the ability to create and edit
meeting instructors.

Implementation
The WebEx Meeting Center integration requires Cornerstone Learning and an WebEx
Meeting Center account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
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WebEx Training Center Integration
The WebEx Training Center integration allows users and administrators to seamlessly
navigate between Cornerstone's Learning Management System (LMS) and Cisco WebEx
through WebEx's Single Sign On (SSO) functionality. This virtual instructor-led training
(vILT) integration gives Learning administrators the ability to add instructors, create and
manage sessions, and track attendance from within Cornerstone. Cisco WebEx sessions
can be launched from Cornerstone directly into WebEx.

Implementation
The WebEx Training Center integration requires Cornerstone Learning and an WebEx
Training Center account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.
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Course Recommendations Exclusion Flag
With the April '16 release, administrators now have the ability to enable a Training
Completion page. In addition, a Course Recommendations Preview Program is being
conducted, which provides course recommendations to users on the Training Completion
page.
With this enhancement, the General tab of the Course Catalog now has an additional option
that enables administrators to exclude a learning object (LO) from being recommended to
users. Although the ability to provide course recommendations is not widely available, this
option enables administrators to proactively exclude certain LOs from course
recommendations.
To support this enhancement, the General tab of the Course Catalog now has an additional
option that enables administrators to exclude a learning object (LO) from being
recommended to users.
o Exclude from Course Recommendations - When this option is selected, the course
will not be included in the list of recommended courses that is displayed on the Training
Completion page when a user completes a course. Note: The list of courses that are
recommended to users is refreshed every seven days.
This field can be edited when batch editing LOs via the Course Catalog.

Use Cases
Lauren is an administrator at Acme Corporation. She does not currently have Course
Recommendations enabled for her portal, but she wants to begin the process of identifying
and excluding training that should not be included in recommendations once Course
Recommendations is enabled.
Lauren navigates to the Course Catalog and searches for specific training that she knows
should never be recommended to users, such as compliance training. She checks the
'Exclude from Course Recommendations' check box and saves the learning object. She is
also able to batch edit the check box for multiple learning objects.
Lauren is now confident that when Course Recommendations are enabled, the Training
Completion page will display course recommendations that will actually encourage users to
continue their professional growth and development.

Considerations
The list of courses that are recommended to users is refreshed every seven days.
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Implementation
This functionality is only available for organizations using the Learning module.

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Course Catalog Update

PERMISSION DESCRIPTION

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

CATEGORY

Learning Administration

294

Cornerstone April 2016 Release Notes: What's New for April 2016

Data Load Wizard - Support Audit Trail for Event, Session,
and Transcript Loads
With this enhancement, an audit trail is available when an Admin loads events, sessions or
transcripts through the Data Load Wizard.
The following fields in each load are audited:
Events
o
o
o
o
o

Title
Description
Provider
Event custom fields
LO active status

Sessions
o
o
o
o

Title
Description
Provide (vendor)
Session custom fields

Transcripts
o Transcript custom fields
o Credit

Implementation
This functionality is automatically enabled for all organizations using the Event, Session, or
Transcript load.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Data Load Wizard Events

Enables administrator to load event data via the Data
Load Wizard. This permission also enables
administrators to track data loads and manage data
load templates. This is an administrator permission.

Data Load
Wizard

Data Load Wizard Learning

Enables administrator to load learning data via the
Data Load Wizard. This permission also enables

Data Load
Wizard
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administrators to track data loads and manage data
load templates. This is an administrator permission.
Data Load Wizard Load Sessions

Enables administrator to load session LO data via the Data Load
Data Load Wizard. This permission also enables
Wizard
administrators to track data loads and manage data
load templates. This is an administrator permission.

Data Load Wizard Load Transcripts

Enables administrator to load transcript data via the
Data Load Wizard. This permission also enables
administrators to track data loads and manage data
load templates. This is an administrator permission.

Data Load
Wizard
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Google Calendar Integration
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Google Calendar Integration
Prior to this enhancement, the system supported integration with Outlook, including meeting
invitations and calendar attachments.
With this enhancement, the system now also supports integration with Google Calendar.
Administrators can configure certain email triggers to include meeting invitations or
calendar attachments. When a user using Gmail receive a meeting invitations from the
system, their Google Calendar is automatically updated with the appropriate meeting
information.

Workflow

Use Cases
Lauren is an employee at Acme Corporation, which utilizes Google applications for their
email and calendar tools. Lauren has registered for an instructor-led training session on
Executive Presence. The session consists of one part.
Lauren's manager approves the session and Lauren receives a registration meeting
invitation from the Acme portal. This meeting invite contains information on the session.
The invite displays directly on Lauren's Google calendar even though she has not accepted
the invite. In addition, the invitation automatically blocks the time on her calendar as Busy.
The next day, Lauren receives a new meeting invite from the Acme portal with an updated
start time. Her Google calendar is automatically updated with the new start time of the
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session. The next week, Lauren receives a Cancelled meeting invite indicating that the
session has been cancelled. The event is automatically removed from her Google calendar.

Considerations
When a meeting invite is sent, the event is automatically added to the user's calendar and
set to busy even if no response is provided. The meeting responses do not affect the user's
registration status in the system.
The event description displays the body of the email trigger. The maximum number of
characters that will be displayed in the event description is 8,192. Any additional characters
are removed.
Sessions that use a combination of meeting invites and calendar attachments for the same
event are not supported.

Implementation
This functionality is automatically enabled for all organizations using the Learning module.

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Global Email
Administration Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage email trigger templates
Core
across all active modules in the portal. Enables
Administration
creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.
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Email - Create/Edit - Calendar Options
With this enhancement, the system now supports integration with Google Calendar.
Administrators can configure certain session-related email triggers to include meeting
invitations or calendar attachments.
The Calendar Options are available when creating or editing an email via Email
Management or when configuring custom emails for a learning object (LO).
To create an email, go to ADMIN > TOOLS > CORE FUNCTIONS > EMAIL
in the Options column of the email
MANAGEMENT. Then, click the Add Email icon
action for which you would like to create an email. This opens the Create New Email page.
Permissions
PERMISSION
NAME
Global Email
Administration Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage email trigger templates
Core
across all active modules in the portal. Enables
Administration
creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.

The following fields and options have been renamed:
o Outlook Options - This field is now titled Calendar Options.
o Outlook meeting invite - This option is now titled "Meeting invite."
o Reminder - This option is now titled "Reminder (Outlook only)."
o Outlook calendar attachment - This option is now titled "Calendar attachment."
The following options are available in the Calendar Options field:
o Meeting invite - This option sends the email as a meeting invite with the standard
meeting options. For Google Calendar meeting invites, the event is automatically added
to the user's calendar and set to busy even if no response is provided. The meeting
responses do not affect the user's registration status in the system. The event
description displays the body of the email trigger. The maximum number of characters
that will be displayed in the event description is 8,192. Any additional characters are
removed. Any users in the CC field also receive a meeting invite.
o Yes - Selecting this option keeps the event on the user's calendar with a Yes
status.
o Maybe - Selecting this option keeps the event on the user's calendar with a Maybe
status.
o No - Selecting this response removes the event from the user's calendar. This
does not affect the user's registration status.
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o Calendar attachment - Selecting this option sends the email with a calendar
attachment. When the attachment is opened and saved, the session is automatically
added to the user's calendar.
o None - This option is selected by default. Selecting this option sends the email without
calendar features.
o Reminder (Outlook only) - The reminder functionality only applies to Outlook
meetings.

Multi-part Sessions
When configuring meeting invites for multi-part sessions, each session part triggers an
individual email.

Emails Triggered When Editing a Session Part
When editing a session part, the following updates trigger a new email:
o A new session part is added.
o A session part is cancelled.
o The time, name, or location of a session part is modified.

Training Details Link Email Tag
When creating or editing an email based on the email triggers that are listed below, a new
TRAINING.DETAILS.LINK email tag is now available. This tag displays a link to the training
details for an ILT session.

Emails Triggers
The Calendar Options are only available for the following email triggers:
EMAIL NAME

EMAIL DESCRIPTION

ACTION
TYPE

Approve ILT Session Approval settings can be set within the Event/Session Instructor
or within the user details page. If approval is required, Led Training
the requested training will remain in pending approval
status until the approver approves, defers, or denies
the request. This email is fired when an Approver
approves a request for an ILT session. This email can
be used to notify the student that the request has
been approved or to notify a particular approver in the
approval workflow (e.g., Cost center approver or
User's manager).
Cancel Registration
(with withdrawal
penalty)

In the Event/Session Details step, there is a Penalty
for Withdrawal column. There is an Add Withdrawal
Penalty link that opens up text boxes to apply a

Instructor
Led Training
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percentage or dollar amount, and the amount of days
prior to the Session date when the user cancels,
where these would be applied. Once a user withdraws
from a Session, the selected recipients will receive
this email, and the withdrawal penalty is applied.
Cancel Registration
(without withdrawal
penalty)

In the Event/Session Details step, there is a Penalty
Instructor
for Withdrawal column. If the Add Withdrawal Penalty Led Training
is not selected, and the user withdraws from a
Session, the selected recipients will receive this email
stating that no withdrawal penalty has been applied.

Cancel Session

ILT Session is cancelled.
REASON.CANCEL.SESSION tag is available for
the Cancel Session email so that the reason
entered by the administrators when the Session
was cancelled can be included in the email. This
tag will display the reason selected in the dropdown by the administrator who cancelled the
Session.

Grant Waitlist
Request

ILT
Administration

Once a user has submitted a Waitlist Request, they
Instructor
will remain in Waitlisted status until an administrator
Led Training
makes the decision to grant or deny the request. If the
ILT administrator grants a user's request to attend a
session, this email will be triggered.

ILT Session Register Once a user Registers for an ILT session, this email
can be sent to the student, approvers, assignors,
instructors, and anyone else who would need
information about the registered session.
Session Changed

The Session Changed email is triggered if the
following Session fields were changed: Advanced
Registration Settings, Instructor, Location, No
Show Penalty, Pre-work/Post-work/Prerequisite
Details, Session Charge Date, Start or End Dates
and Times, and Waitlist Deadlines.

Instructor
Led Training

ILT
Administration

An email tag called COMMENT appears as an
option for this email. This tag will display the
comments entered by the Session administrator or
instructor when the changes for this Session were
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saved.
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Training Details - Session Details Table - Add to Calendar
With this enhancement, the system now supports integration with Google Calendar.
When a user views the Training Details page for a session in which they are registered, the
Session Details table displays information for each part of the session. The Add to
Calendar link enables the user to add the event to their Google calendar or Outlook
calendar.
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Increased Video Size
Prior to this enhancement, videos viewed on the Transcript or Learning Object (LO) Details
page were displayed in a medium frame.
With this enhancement, videos viewed on the Transcript or LO Detailed page are displayed
in a large frame.

Considerations
The Curricula Player and Cohort Player are not impacted by this enhancement. Videos
displayed in these players will continue to be displayed in a large frame.

Implementation
This functionality is automatically enabled for all organizations using the Learning module.
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Learning Rewards & Recognition
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Rewards and Recognition Overview
Prior to this enhancement, badges were only used when providing feedback for users via
Universal Profile.
With this enhancement, badges and points can now be awarded automatically when a user
completes training. Also, the points that are associated with a badge are now utilized
throughout the system. For example, a manager can view a subordinate's total number of
badges and points within the Universal Profile Snapshot, and a Leaderboard page displays
employees with the most points across the user's organizational units (OUs).
Administrators can now create Learning badges that are only awarded when a user
completes training. Administrators can associate points and a badge to learning objects
(LOs) via the Course Catalog so that users can be awarded a specific number of points and
a badge when they complete the LO. Administrators can also enable widgets in the
Universal Profile - Snapshot that display a user's total number of badges and points. These
widgets can be clicked to display all of the user's badges or to view the points leaderboard.
Organizations can use rewards and recognition to make the learning experience more
engaging and encourage employees to complete training.

Workflow

Use Cases
1. Lauren is a new employee at Acme Corporation. As part of her new hire training, she is
required to watch a video about the company and read a compliance document about
office policies.
2. She completes her compliance document and is brought to the Training Completion
page where she sees that she has received 50 points for completing the training.
Lauren watches the video on Acme Corporation and receives a New Hire Badge for
completing the training.
3. Lauren is able to view all of the Performance and Learning badges that she has
accumulated over time via the new My Badges page. She is also able to view a new
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Leaderboard page where she sees the employees in her Department who have the
most points.
4. Lauren continues to complete new training to receive more points and badges.

Considerations
o Points and badges can only be associated with a LO via the Course Catalog. As a
result, any LO that cannot be edited via the Course Catalog cannot have points or
badges associated with it. Points and badges cannot be associated with certifications.
As a result, users will not receive points or badges when they complete a certification.
o For LOs that are comprised of other LOs, such as curricula, libraries, and programs, the
user receives points for the larger LO (e.g., curricula, library) and any LOs that the user
completed within the structure of the larger LO.
o When a LO that is comprised of other LOs is completed, the Training Completion
page only displays the badge and points that are associated with the larger LO. It
does not display any badges or points that were awarded by completing the LOs
within the structure of larger LO.
o For tests, points and badges are only awarded if the user passes the test.
o The user is not awarded a badge or points for a LO if the user completes an equivalent
LO, is marked Exempt, is granted an exception, or is proxy enrolled in a Completed
status.
o Reporting is not currently available for points or badges.
o The Data Load Wizard does not currently support points or badges.

Implementation
This functionality is automatically available to all organizations using the Performance or
Learning module. However, the Learning Badges and Points are only available to
organizations using the Learning module.
o For portals using the Learning and Performance modules, the Badges widget is driven
by a combination of Learning and Feedback badges. The Leaderboard widget is driven
by a combination of Learning points and points associated with Learning and Feedback
badges.
o For portals using the Learning module and not the Performance module, the Badges
widget is driven by Learning badges. The Leaderboard widget is driven by a
combination of Learning points and points associated with Learning badges.
o For portals using the Performance module and not the Learning module, the Badges
widget is driven by Feedback badges. The Leaderboard widget is driven by points
associated with Feedback badges.
o Portals that are not using the Performance or Learning module cannot use the Badges
or Leaderboard functionality.
By default, the Learning Badge - View and Learning Points - View permissions are only
available to the default System Administrator role. As a result, the Points and Badges fields
are not displayed on the LO Details and Training Completion pages by default. In order to
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enable these fields for end users, the Learning Badge - View and Learning Points - View
permissions must be granted to the appropriate users.
With regards to the Badges Widget on the Snapshot page, this widget is disabled by
default, and must be enabled via Snapshot General Preferences. Also, the Snapshot Badges permission is automatically added to the default System Administrator role and
must be granted to the appropriate users.
With regards to the Leaderboard Widget on the Snapshot page, this widget is disabled by
default, and must be enabled via Snapshot General Preferences. Also, the Snapshot Leaderboard permission is automatically added to the default System Administrator role
and must be granted to the appropriate users.
The Badge Preferences - Manage permission is renamed and is now titled Badge & Point
Preferences. Any users who previously had this permission are not affected. However, the
Badge & Point Preferences permission must be granted to administrators who need the
ability to create and manage badges and configure the Leaderboard.
By default, all LOs have zero points and no badge assigned to them. These must be
configured via the Course Catalog.

Glossary
o Badge - A form of employee recognition that can be awarded when a user receives
positive feedback or when a user completes training. Badges may have an associated
point value. Depending on the portal configuration, users may be able to view their
badges via a widget on the Universal Profile - Snapshot page.
o Leaderboard - A user may receive points for completing training. Also, a user may be
awarded a badge by completing training or receiving positive feedback from another
user. When a user receives a badge, they are also awarded any points that are
associated with the badge. The Leaderboard is a page within the Universal Profile Snapshot that enables users to view their total number of points, their overall points
ranking within the organization, and the top 10 users who have the most points.
o Point - A user may receive points for completing training. Also, a user may be awarded
a badge by completing training or receiving positive feedback from another user. When
a user receives a badge, they are also awarded any points that are associated with the
badge. Depending on the portal configuration, users may be able to view their points
and a points leaderboard via a widget on the Universal Profile - Snapshot page.

Security
The following new permissions apply to this functionality:
PERMISSION
NAME
Learning Badge View

PERMISSION DESCRIPTION

Grants ability to view the Badge field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

CATEGORY

Learning
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Learning Points View

Grants ability to view the Points field on the LO Details Learning
page and the Training Completion page. This
permission cannot be constrained.

Snapshot - Badges

Enables user to view the Badges widget and subpage Universal
within the Universal Profile - Snapshot page for users Profile
within their permission constraints. This permission
works in conjunction with the Snapshot Main - View
permission. This permission can be constrained by
OU, User's OU, User Self and Subordinates, User,
User's Self, User's Manager, User's Superiors, User's
Subordinates, User's Direct Reports, and Employee
Relationship. Any user with this permission will always
be able to view their own Badges widget when the
widget is enabled. Best Practice: For most users, this
permission should be constrained by User Self and
Subordinates.

Snapshot Leaderboard

Enables user to view the Leaderboard widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

The Badge Preferences - Manage permission is renamed and is now titled Badge & Point
Preferences - Manage. This permission is now in the Core Administration category. Also,
the page to which this permission controls access, the Badge Preferences page, is
renamed and is now titled Badge & Point Preferences.
These changes will be reflected throughout Online Help when this functionality is released.
PERMISSION
NAME
Badge & Point
Preferences Manage

PERMISSION DESCRIPTION

Enables user to access and edit preferences on
the Badge & Point Preferences page. The
availability of this permission is controlled by a

CATEGORY

Core
Administration.
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backend setting. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
The following existing permissions apply to this functionality:
PERMISSION
NAME
Course Catalog Update

PERMISSION DESCRIPTION

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

CATEGORY

Learning Administration

Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile

Snapshot
Preferences Manage

Universal
Profile

Enables administrator to access and edit the
Snapshot Preferences page. This permission can be
constrained by Employee Relationship, OU, and
User's OU. This is an administrator permission.
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Badge & Point Preferences - Badges
Prior to this enhancement, badges were only used when providing feedback for users via
the Universal Profile.
With this enhancement, badges can now be awarded automatically when a user completes
training. Also, the points that are associated with a badge are now utilized throughout the
system. For example, a manager can view a subordinate's total number of badges and
points within the Universal Profile Snapshot and a Leaderboard page displays employees
with the most amount of points across the user's organizational units (OUs).
In order to support this enhancement, the Badge Preferences page is renamed and is now
titled Badge & Point Preferences. This page is accessible via Core Preferences and
Learning Preferences. Also, the Badge & Point Preferences page is divided into two tabs,
Badges and Points.
The Badges tab contains all of the functionality from the previously existing Badge
Preferences page.
To manage Badges and Points:
o Go to ADMIN > TOOLS > CORE FUNCTIONS > CORE PREFERENCES > BADGES &
POINTS.
o Go to ADMIN > TOOLS > LEARNING > LEARNING PREFERENCES > BADGES &
POINTS.
Permissions
PERMISSION
NAME
Badge & Point
Preferences Manage

PERMISSION DESCRIPTION

Enables user to access and edit preferences on
the Badge & Point Preferences page. The
availability of this permission is controlled by a
backend setting. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

CATEGORY

Core
Administration.

Default Learning Badges
Default Learning badges are automatically available. These badges have a Badge Type of
Learning and are active by default so that administrators can associate them to LOs via the
Course Catalog.
The following default Learning badges are available:
o
o
o
o

Curriculum Leader - Successfully completed a curriculum course.
Onboarded - Recognizing a new hire that has been successfully onboarded.
Presentation Expert - Successfully completed a presentation course.
Safety First - Successfully completed a safety course.
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o Video Master - Successfully completed a video course.

Copying Badges
When copying a badge, a Copy Badge pop-up is now opened, in which the administrator
can edit the badge details prior to saving the badge.

Adding Badges
When adding a badge, the following fields are new or updated:
o Title - When editing a badge, modifications to the badge title are reflected on the
Training Completion page and Badges sub-page for users who have already completed
training and earned the badge.
o Badge Type - From the drop-down, select the purpose of the badge. This will determine
in which scenarios the badge can be awarded. When editing a badge, the badge type
cannot be modified.
o Feedback - Select this type when the badge should only be used when awarding
feedback.
o Learning - Select this type when the badge should only be used when a user
completes training.
o Badge Image - When editing a badge, modifications to the badge image are reflected
on the Training Completion page and Badges sub-page for users who have already
completed training and earned the badge.
o Points - With this enhancement, a user's badge points are now visible on the Universal
Profile Snapshot page and on the Points Leaderboard. When editing a badge, changes
to this field only impact future instances of this badge. The points that are associated
with badges that have already been awarded will not be changed.
o Manager Only - This option is only available when the Badge Type is set to Feedback.
As with Feedback badges, badge images should be square with a recommended size of
100 x 100 pixels. To have a square badge image display properly on the My Badges page,
use a 66 x 66 pixel image centered on a white square that is 100 x 100 pixels.
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Deleting or Deactivating Badges
Administrators are able to delete badges or make them inactive.
Learning Badges:
o Deactivate Badge:
o The badge will still display on LO Details or the Course Catalog (if already
associated to an existing LO).
o The badge will no longer display in the Badge Search Results (admins cannot
associate to LOs via the Course Catalog).
o Any users who completed training (and were awarded the badge) will not be
impacted; the badge will still display on the Training Completion page and on the
Badges widget.
o Any users who have not yet completed the training (with the badge associated to
it) will still be awarded the badge when they complete the training.
o Delete Badge:
o The badge will no longer display on LO Details or the Course Catalog (if already
associated to an existing LO).
o Any users who completed training (and were awarded the badge) will not be
impacted; the badge will still display on the Training Completion page and on the
Badges widget.
o Any users who have not yet completed the training (with the badge associated to
it) will not be awarded the badge when they complete the training.
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Feedback Badges (existing functionality)
o The functionality associated with deleting and deactivating a feedback badge is
unchanged.
o The badge no longer displays in the results when attempting to award a badge via
Feedback (i.e., users cannot award that badge to other users).
o The badge will continue to display in Feedback and the Badges widget (if it was
already awarded to a user).
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Badge & Point Preferences - Points
With this enhancement, a new Leaderboard page is now available within Universal Profile:
Snapshot.
In order to support this enhancement, the Badge & Point Preferences page is divided into
two tabs, Badges and Points.
The Points tab of the Badge & Point Preferences page enables administrators to configure
the Leaderboard page that exists within Universal Profile: Snapshot.
To manage Badges and Points:
o Go to ADMIN > TOOLS > CORE FUNCTIONS > CORE PREFERENCES > BADGES &
POINTS.
o Go to ADMIN > TOOLS > LEARNING > LEARNING PREFERENCES > BADGES &
POINTS.
Permissions
PERMISSION
NAME
Badge & Point
Preferences Manage

PERMISSION DESCRIPTION

Enables user to access and edit preferences on
the Badge & Point Preferences page. The
availability of this permission is controlled by a
backend setting. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

CATEGORY

Core
Administration.

Leaderboard
This section enables administrators to define which filter options are available to the user
when viewing the Leaderboard. When an option is selected, the corresponding filter option
is able to select on the Leaderboard page. The various organizational unit (OU) filter
options enable the user to compare their points totals with other users from the same OU.
The following options are available:
o
o
o
o

User's Division
User's Position
User's Location
User's All Custom OU Type - If a user has more than one custom OU type configured
for their user record, then all applicable custom OU types are available in the filter.

By default, User's Division is selected, and all other options are not selected. At least one
option must be selected.

Overwrite Settings
Choose whether or not to overwrite custom settings for child division OUs. If you choose to
overwrite custom settings for child division OUs, the selected settings are applied to both
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new and existing child OUs. Any previously customized child OUs are updated with the
selected settings.
If this option is unselected, then only the child OUs that do not have customized settings will
be updated, as well as any OUs that are added in the future.
A child OU that has not been customized always inherits from the parent, regardless of
whether this option is selected.
An OU is considered customized if its preferences or settings have been changed.
Note: This option only applies to the Points tab.

Save/Cancel
Click SAVE to commit any unsaved changes. Or, click CANCEL to discard any unsaved
changes.
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Snapshot General Preferences
With this enhancement, the points that are associated with a badge are now utilized
throughout the system. For example, a manager can view a subordinate's total number of
badges and points within the Universal Profile Snapshot and a Leaderboard page displays
employees with the most amount of badge points across the user's organizational units
(OUs).
In order to support this enhancement, administrators can now configure whether or not a
Badges and Leaderboard widget are available on the Snapshot page.
To access the Snapshot General Preferences page, go to ADMIN > TOOLS > CORE
FUNCTIONS > UNIVERSAL PROFILE > SNAPSHOT GENERAL.
Permissions
PERMISSION
NAME
Snapshot
Preferences Manage

PERMISSION DESCRIPTION

Enables administrator to access and edit the
Snapshot Preferences page. This permission can be
constrained by Employee Relationship, OU, and
User's OU. This is an administrator permission.

CATEGORY

Universal
Profile

The following widgets can now be enabled and configured on the Snapshot General
Preferences page:
o Badges - This widget displays the number of badges the user has been awarded. This
includes all types of badges (e.g., Feedback and Learning). The My Badges subpage
enables users, managers, and administrators to view all of the badges that the user has
been awarded. This page displays all types of badges.
o Leaderboard - This widget displays the number of points the user has been awarded
from completing training, receiving training badges, and receiving positive feedback
badges. The Leaderboard subpage displays a full leaderboard of users and their point
totals.
The following options are available for both widgets:
o Widget Title - In this field, enter the title that should appear at the top of the widget on
the Universal Profile - Snapshot page. This field is required and the character limit is 50.
If multiple languages are enabled for your portal, click the Translate icon to translate the
field into other available languages.
o SubPage Title - In this field enter the title that should appear at the top of the subpage
when the corresponding widget is clicked. For example, when the Badges widget is
clicked, the Badges subpage opens. This field is required and the character limit is 50. If
multiple languages are enabled for your portal, click the Translate icon to translate the
field into other available languages.
o Display Widget - This option determines whether the widget should appear on the
Universal Profile - Snapshot page. Select this option to display the widget, or deselect
this option to hide the widget.
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Course Catalog - General - Points and Badge
With this enhancement, badges can now be awarded automatically when a user completes
training. Also, the points that are associated with a badge are now utilized throughout the
system. For example, a manager can view a subordinate's total number of badges and
points within the Universal Profile Snapshot and a Leaderboard page displays employees
with the most amount of badge points across the user's organizational units (OUs).
In order to support this enhancement, administrators can now associate a badge with a
learning object (LO) via the Course Catalog. Administrators can also set the number of
points the user will receive when they complete the training. If there are points associated
with the badge, then the user receives the points from the badge as well.
To access the Course Catalog, go to ADMIN > TOOLS > LEARNING > CATALOG
MANAGEMENT > COURSE CATALOG.
Permissions
PERMISSION NAME
Course Catalog Update

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage/edit learning objects listed in Learning the Course Catalog. This permission can be
Administratio
constrained by OU, User's OU, Training Type,
n
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

The following options are now available on the General tab of the Course Catalog:
o Points - This field enables administrators to assign points to the training, which will be
awarded to the user when they complete the training. This is intended to encourage and
motivate the user to complete more training and earn more points. Enter the number of
points a user will receive when they complete the training. This field accepts whole
numbers between 0 and 1,000.
o For LOs that are comprised of other LOs, such as curricula, libraries, and
programs, the user receives points for the larger LO (e.g., curricula, library) and
any LOs that the user completed within the structure of the larger LO.
o For tests, points are only awarded if the user passes the test.
o When editing a program, the new points are only applied to cohorts that are
created after the changes are made.
o Note: The user is not awarded a badge or points for a LO if the user completes an
equivalent LO, is marked Exempt, is granted an exception, or is proxy enrolled in
a Completed status.
o Badge - This field enables administrators to assign a Learning badge to the training,
which will be awarded to the user when they complete the training. This is intended to
encourage and motivate the user to complete more training and earn more badges.
Click the Add Badge link to select one of the Learning badges. Within the Select Badge
pop-up, administrators can search for badges by title and description. Only active
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Learning badges that are available to the administrator can be selected, and badges
must be configured via Badge & Point Preferences before they are available to be
selected. See Badge & Point Preferences - Badges on page 312 for additional
information.
o Once the badge is selected, it appears below the Add Badge link. To disassociate
the selected badge from the LO, click the Remove icon
to the right of the
badge.
o For tests, badges are only awarded if the user passes the test.
o When editing a program, the new badge is only applied to cohorts that are created
after the changes are made.
o Note: The user is not awarded a badge or points for a LO if the user completes an
equivalent LO, is marked Exempt, is granted an exception, or is proxy enrolled in
a Completed status.
Both fields can be edited when batch editing LOs via the Course Catalog.
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LO Details - Points and Badges
With this enhancement, administrators can now associate a badge with a learning object
(LO) via the Course Catalog. Administrators can also set the number of points the user will
receive by completing the training.
The following additional fields may now be available on the Details tab of the LO Details
page:
o Points - This displays the total number of points the user will receive by completing the
LO. If the LO has an associated badge, then this includes the points associated with the
LO and the LO's badge. If there are no points associated with the LO, then this field is
hidden. Also, this field is only visible if the user has permission to view Learning Points.
o Badge - This displays the badge associated with the LO. If there is no badge associated
with the LO, then this field is hidden. Also, this field is only visible if the user has
permission to view Learning Badges.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Learning Badge View

Grants ability to view the Badge field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Learning Points View

Grants ability to view the Points field on the LO Details Learning
page and the Training Completion page. This
permission cannot be constrained.
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Training Completion Page - Points and Badges
With this enhancement, administrators can now associate a badge with a learning object
(LO) via the Course Catalog. Administrators can also set the number of points the user will
receive by completing the training.
With the April 2016 release, a new Course Completion page is now available.
The following additional information may now be displayed on the Course Completion page:
o Badge - If the user is awarded a new badge by completing the training, then this badge
is displayed. If the user has the Snapshot - Badges permission, the user can click the
badge title to view the Snapshot - My Badges page. See Snapshot - My Badges on
page 329 for additional information.
o If there is no badge associated with the LO, then this information is hidden. Also,
this information is only visible if the user has permission to view Learning Badges.
o Points - If the user earned points by completing the training, then the number of points
that were earned is displayed. If the user has the Snapshot - Leaderboard permission,
the user can click the View Leaderboard link to view the Snapshot - Leaderboard
page. See Snapshot - Leaderboard on page 331 for additional information.
o If no points were earned, then this information is hidden. Also, this information is
only visible if the user has permission to view Learning Points.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Learning Badge View

Grants ability to view the Badge field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Learning Points View

Grants ability to view the Points field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Snapshot - Badges

Enables user to view the Badges widget and subpage Universal
within the Universal Profile - Snapshot page for users Profile
within their permission constraints. This permission
works in conjunction with the Snapshot Main - View
permission. This permission can be constrained by
OU, User's OU, User Self and Subordinates, User,
User's Self, User's Manager, User's Superiors, User's
Subordinates, User's Direct Reports, and Employee
Relationship. Any user with this permission will always
be able to view their own Badges widget when the
widget is enabled. Best Practice: For most users, this
permission should be constrained by User Self and
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Subordinates.
Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile
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Snapshot - Badges and Leaderboard Widgets
With this enhancement, a Badges and Leaderboard widget can be enabled for the
Snapshot page.
To access the Snapshot page, go to HOME > UNIVERSAL PROFILE. Then, click the
Snapshot tab.
To access another user's Universal Profile - Bio page, click the user's photograph from any
page within Universal Profile or from Global Search. From there, you can access the user's
Snapshot page by clicking the Snapshot tab. Users can view the Snapshot page of other
users who are within their Snapshot permission constraints.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Bio About - View

Enables user to view the Bio page for users within
Universal
their permission constraints. This permission must be Profile
enabled to view the Transcript page within Universal
Profile. If a user does not have this permission and
they click a person's name or user photo within the
Universal Profile, then the Bio page will not open. This
permission can be constrained by Employee
Relationship, OU, User's OU, User's Direct Reports,
User Self and Subordinates, and User.

Snapshot - Badges

Enables user to view the Badges widget and subpage Universal
within the Universal Profile - Snapshot page for users Profile
within their permission constraints. This permission
works in conjunction with the Snapshot Main - View
permission. This permission can be constrained by
OU, User's OU, User Self and Subordinates, User,
User's Self, User's Manager, User's Superiors, User's
Subordinates, User's Direct Reports, and Employee
Relationship. Any user with this permission will always
be able to view their own Badges widget when the
widget is enabled. Best Practice: For most users, this
permission should be constrained by User Self and
Subordinates.

Snapshot Leaderboard

Enables user to view the Leaderboard widget and
subpage within the Universal Profile - Snapshot page
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,

Universal
Profile
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User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.
Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile

Badges
This widget is only available when enabled by the administrator in Snapshot General
Preferences. Also, this widget is only available to users who have the Snapshot - Badges
permission. This widget displays the number of badges the user has been awarded. This
includes all types of badges (e.g., Feedback and Learning). Click the widget to open the
user's My Badges page. See Snapshot - My Badges on page 329 for additional
information.

Leaderboard
This widget is only available when enabled by the administrator in Snapshot General
Preferences. Also, this widget is only available to users who have the Snapshot Leaderboard permission. This widget displays the number of points the user has been
awarded from completing training, receiving training badges, and receiving positive
feedback badges. Click the widget to view a full leaderboard of users and their point totals.
See Snapshot - Leaderboard on page 331 for additional information.
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Snapshot - My Badges
The My Badges page enables users, managers, and administrators to view all of the
badges that the user has been awarded. This page displays all types of badges such as
Feedback and Learning badges. This page can be filtered by badge type.
To access the My Badges page, click the Badges widget on the Universal Profile Snapshot page.
Permissions
PERMISSION
NAME
Snapshot - Badges

PERMISSION DESCRIPTION

CATEGORY

Enables user to view the Badges widget and subpage Universal
within the Universal Profile - Snapshot page for users Profile
within their permission constraints. This permission
works in conjunction with the Snapshot Main - View
permission. This permission can be constrained by
OU, User's OU, User Self and Subordinates, User,
User's Self, User's Manager, User's Superiors, User's
Subordinates, User's Direct Reports, and Employee
Relationship. Any user with this permission will always
be able to view their own Badges widget when the
widget is enabled. Best Practice: For most users, this
permission should be constrained by User Self and
Subordinates.

Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile

My Team
The My Team drop-down is designed to allow managers, approvers, and custom
relationships to quickly navigate between direct reports and dotted-line reports. When
enabled, the My Team drop-down is available to managers and dotted line managers on all
pages of their Universal Profile and the Universal Profile of their direct, indirect, and dotted
line reports. This drop-down displays the manager's reports visually. Managers of large
teams are able to search for a report from within the drop-down. If the user serves in
multiple roles that are available within the drop-down, then the user can select a specific
role and view the reports that are associated with that role. When the manager selects a
report from the My Team drop-down menu, the manager is directed to a consistent page
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within Universal Profile. For example, if a report is selected when viewing the Transcript
page, the manager is directed to the Transcript page of the selected report. The My Team
drop-down enables managers to more effectively manage their teams from within Universal
Profile. See Universal Profile - My Team Drop-down for additional information.

Filter Badges
By default, all types of badges are displayed. To filter the badges by type, select the
appropriate badge type from the drop-down menu, such as Feedback or Learning.

Total Number of Badges
In the upper-right corner of the page, the total number of times a user has been awarded a
badge is displayed. If the user has been awarded the same badge multiple times, then each
time is counted as a separate occurrence in this total.

Earned Badges
This page displays all of the badges the user has been awarded. A number is displayed in
the lower-right corner of the badge which indicates the number of times the user has
received this badge.
This page displays all types of badges such as Feedback and Learning badges. Badges
are displayed in the order in which they were awarded, with the most recently awarded
badge displayed first.
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Snapshot - Leaderboard
A user may receive points for completing training. Also, a user may be awarded a badge by
completing training or receiving positive feedback from another user. When a user receives
a badge, they are also awarded any points that are associated with the badge.
The Leaderboard page enables users to view their total number of points, their overall
points ranking within their organizational unit, and the top 10 users who have the most
points. Also, if the user is not in the top 10 ranking, then the user is displayed at the bottom
of the page with the user who ranks above them and the user who ranks below them.
This page can be filtered by organizational unit (OU) and by time frame.
To access the Leaderboard page, click the Leaderboard widget on the Universal Profile Snapshot page.
Permissions
PERMISSION
NAME
Snapshot Leaderboard

PERMISSION DESCRIPTION

CATEGORY

Enables user to view the Leaderboard widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile

My Team
The My Team drop-down is designed to allow managers, approvers, and custom
relationships to quickly navigate between direct reports and dotted-line reports. When
enabled, the My Team drop-down is available to managers and dotted line managers on all
pages of their Universal Profile and the Universal Profile of their direct, indirect, and dotted
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line reports. This drop-down displays the manager's reports visually. Managers of large
teams are able to search for a report from within the drop-down. If the user serves in
multiple roles that are available within the drop-down, then the user can select a specific
role and view the reports that are associated with that role. When the manager selects a
report from the My Team drop-down menu, the manager is directed to a consistent page
within Universal Profile. For example, if a report is selected when viewing the Transcript
page, the manager is directed to the Transcript page of the selected report. The My Team
drop-down enables managers to more effectively manage their teams from within Universal
Profile. See Universal Profile - My Team Drop-down for additional information.

Filter by User's OUs
By default, the Leaderboard includes all users within the user's division. However, the user
can also filter the Leaderboard by their Position, Location, or custom OU type. This enables
the user to see how they rank within each of these OUs. Note: Only the user's OUs are
available in the drop-down. The user cannot select an OU to which they do not belong.
Also, the administrator can configure which filter options are available.
To filter the Leaderboard by a particular OU, select the appropriate OU type from the dropdown menu.

Filter by Time
By default, the Leaderboard includes points that have been awarded within the calendar
month. For example, on April 15, this only includes points that have been awarded from
April 1 through April 15. However, the user can filter the Leaderboard by calendar year or
include all historical points. This enables the user to see how they rank over different
periods of time. Note: The time filter follows UTC (Coordinated Universal Time).
To filter the Leaderboard by a particular time frame, select the appropriate option from the
drop-down menu.

Overall Points and Rank
In the upper-right corner of the page, the user's total number of points and their overall
ranking is displayed based on the selected time and OU filter.

Top 10 Ranking
The top 10 users who have the most amount of points are displayed based on the selected
time and OU filter. Also, the top three users are displayed more prominently at the top of
the list.
The user whose Snapshot is being viewed is always displayed in the Leaderboard. If the
user is not in the top 10 ranking, then the user is displayed below the top 10 with the user
who ranks above them and the user who ranks below them.
Users can click another user's photo or name within the Leaderboard to view the user's
Universal Profile: Bio page.
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Universal Profile - Feedback
With this enhancement, badges can now be awarded automatically when a user completes
training.
When giving badges via the Universal Profile - Feedback page, users can only give active
Feedback badges. Learning badges are not available to be selected on the Feedback page.
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Offline Player Enhancements
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Offline Player Enhancements
With this enhancement, the new version of Offline Player is more engaging and aligned with
Cornerstone's new interface. Organizations can brand the Offline Player application with
their logo and color theme. The offline transcript will look similar to the online transcript.
Learning progress will be synced automatically.
The new version of the Offline Player includes Windows 10 support.

Use Cases
Andrew is the IT Manager at ABC Corporation. The company wants to brand the Offline
Player and make it more engaging to end users. Andrew uses the Branding Configuration
application and defines the company logo and color theme. When the configuration is done,
Andrew distributes the Offline Player application to end users.
Michelle is a sales person at ABC Corporation. Every day, she takes the subway to get to
work. Michelle wants to take training during this time. In the office, she accesses the Offline
Player and downloads a course that she wants to complete offline. On the subway, she
accesses the Offline Player, launches the course, and completes it. While in the office,
Michelle accesses the Offline Player and sees that the application is synching her offline
learning to the online portal.

Considerations
Versioning and course updates are not supported by the Offline Player.

Implementation
Upon release, this functionality is available to organizations that have purchased Offline
Player. To get the new version of Offline Player, contact Cornerstone through a Global
Product Support (GPS) case.
To purchase Offline Player, contact Sales or your Client Executive.
Prior to upgrading to the new version of the Offline Player, all of the existing data must be
synched to the online portal.
To upgrade to the new version of the Offline Player, remove the existing application from
the machine and install the new version provided by GPS.

Security
The following existing permission applies to this functionality:
PERMISSION
NAME
Offline Content

PERMISSION DESCRIPTION

CATEGORY

Grants ability to download and complete training items Mobile
offline via a mobile device or the new Offline Player.
This permission cannot be constrained. This is an end
user permission.
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Offline Learning Branding
With this enhancement, a new Branding application is available for the Offline Player.
The Offline Learning Branding application enables organizations to brand the Offline Player
to match their organization's branding. The Branding application enables administrators to
configure the application logo, theme color, login method, and window title.
The Branding application is included in the Offline Player installation folder.
Permissions
PERMISSION
NAME
Offline Content

PERMISSION DESCRIPTION

CATEGORY

Grants ability to download and complete training items Mobile
offline via a mobile device or the new Offline Player.
This permission cannot be constrained. This is an end
user permission.

Branding Options
The following options are available within the Branding application:
o Logo - This option determines the logo image that is displayed within the Offline Player.
Only .png files can be used for the logo image. The Cornerstone logo is used by default.
o Theme Color - This option determines the main color for the Offline Player. The theme
color is used as the main color on the Login page, the button color, and the titles on the
Transcript page. To select a theme color, click the SELECT COLOR button. Then,
select one of the basic colors, or click the DEFINE CUSTOM COLORS button to specify
the hex color code for a specific color. Once a color is selected, it is displayed in the
field to the right of this field.
o Login Method - Using the radio buttons, select which login methods are available to
users. The following options are available:
o Sign in with portal credentials - When this option is selected, only the Sign In
option is available to users on the Login page.
o Log in with PIN - When this option is selected, only the Log In with Pin option is
available to users on the Login page.
o Enable both options - When this option is selected, both login options are
available to users on the Login page.
o Window Title - Enter the text that should appear at the top of the Offline Player window.
The default value is Offline Learning.

Save Changes
Click this button to save any changes to the branding settings. The changes will be
reflected in the Offline Player the next time the application is launched.
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Troubleshooting
In order to use the Branding application, administrators must have read and write access to
the following files on the computer on which the Offline Player is being installed:
o \PlayerSettings.ini
o www\resources\images\csod_logo.png
It is advised that administrators remove the Read-only attribute for these files.
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Offline Player Log In Redesign
With this enhancement, the login pages are redesigned. The application title is changed
from "Offline Player" to "Offline Learning." The functionality on these pages is unchanged.
Permissions
PERMISSION
NAME
Offline Content

PERMISSION DESCRIPTION

CATEGORY

Grants ability to download and complete training items Mobile
offline via a mobile device or the new Offline Player.
This permission cannot be constrained. This is an end
user permission.

Login Page
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Sign In Page
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Offline Player Transcript Redesign
With this enhancement, the Offline Transcript page is redesigned to match the Transcript
functionality within the online system.
Permissions
PERMISSION NAME
Offline Content

PERMISSION DESCRIPTION

CATEGORY

Grants ability to download and complete training
Mobile
items offline via a mobile device or the new Offline
Player. This permission cannot be constrained. This is
an end user permission.

The following changes have been made to the Transcript page:
o Status Filter - A new filter is now available which enables users to filter their courses by
status. The following filter options are available:
o Active - This option is selected by default. This option displays courses that are
not yet completed.
o Completed - This option displays only completed courses.
o Refresh List - This button is removed.
o Sync All - This button initiates a synchronization with the online system. See Offline
Player Synchronization on page 345 for additional information.
o Search for Training - Users can now search for courses within their Transcript. The
search functionality only searches within the selected Status. For example, if the
Completed status is selected, then the search functionality only searches within
Completed LOs.
o Transcript Item Details - The following information is displayed for each item in the
Transcript:
o Color Strip - The left edge of the LO is color coded to represent the proximity to
the due date of the LO. For example, if the LO due date is past due, then the color
strip is red to indicate that LO is due immediately. If a LO due date is not eminent,
then the color strip is green to indicate that LO is not due immediately. See the
Color Strip Key section below for additional information.
o LO icon - The icon that is displayed corresponds with the LO type (e.g., online
course).
o LO title - The LO title is displayed to the right of the LO icon.
o LO Due Date or Completion Date - For training that is active, the LO due date is
displayed, if available. For training that is completed, the LO completion date is
displayed.
o Status - The LO status is displayed.
o Status - The Status column is removed, and the LO status is now displayed below the
LO title.
o Actions - The Actions drop-down is removed. Only one action is available for each LO.
The following actions may be available:
o Download - This action is available when the course has not been downloaded to
the local computer.
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o Launch - This action is available when the course has been downloaded to the
local computer.
o When the course is locked or completed, the Launch button is disabled and
no action is available.

Statuses
The statuses within the Offline Player are updated.
o Downloaded - This status is removed. Courses that were previously in this status now
display the status from their online Transcript.
o Unsynced - This status is renamed. The new status name is Waiting for Sync.
o Synced - This status is removed. Courses that were previously in this status now
display the status from their online Transcript.
o Available to Download - This status is removed. Courses that were previously in this
status now display the status from their online Transcript.
o Locked - This status is unchanged.
o Unlocked from Web - This status is removed. Courses that were previously in this status
now display the status from their online Transcript.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Offline Player Synchronization
With this enhancement, the system now automatically syncs the user's progress to the
online portal when the user logs in to the Offline Player and when the user exits a course if
Internet connectivity is available. Users are also able to initiate a synchronization by
selecting the SYNC ALL button from their Transcript page.
When the synchronization is occurring, the Offline Player displays the Transcript
Synchronization screen to indicate that the Offline Player is synching with the online
system.
If the synchronization fails, the Offline Player will attempt to sync with the online system the
next time the user logs in to the Offline Player or exits a course.
Permissions
PERMISSION
NAME
Offline Content

PERMISSION DESCRIPTION

CATEGORY

Grants ability to download and complete training items Mobile
offline via a mobile device or the new Offline Player.
This permission cannot be constrained. This is an end
user permission.
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Offline Player Windows 10 Support
With this enhancement, the Offline Player can now be used with the Windows 10 operating
system.
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Tin Can (xAPI) Support - Learning Record Store (LRS)
Tin Can is a new eLearning protocol that enables recording of a wide range of learning
experiences, including native mobile applications and team-based e-learning.
With this enhancement, the system is able to record external Tin Can activities on
Cornerstone's Learning Record Store (LRS). External Tin Can activities include but are not
limited to mobile apps, offline learning, web application, collaborative learning, games,
videos, etc. When an external activity needs to be recorded, the application sends secure
statements to the LRS to record all statements.
With this release, data sent to the LRS is only available on the backend. Availability on a
user's Transcript and Reporting will be available at a future release.

Implementation
Organizations must configure their content based on Cornerstone's xAPI integration
guidelines. Once content is properly configured, contact Cornerstone through a Global
Product Support (GPS) Request Service case to receive an Access Key.

Glossary
o Tin Can (xAPI) - A new eLearning protocol that enables recording of a wide range of
learning experiences, including native mobile applications and team-based e-learning.
o Learning Record Store (LRS) - A data system that stores xAPI learning records.
o Statement - This term relates to Tin Can (xAPI). A statement is a simple construct to
track an aspect of a learning experience. A set of several statements may be used to
track complete details about a learning experience. A statement consists of the
following: <actor (learner)> <verb> <object>, with <result>, in <context>
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Training Completion
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Training Completion Overview
Prior to this enhancement, upon completing training, users were returned to their Transcript
with no confirmation that the training was completed. Post-completion workflows, such as
printing a Completion certification or rating the training, were difficult to locate and required
users to follow a multi-step process, which often resulted in users not being able to
complete these actions.
With this enhancement, a Training Completion page can now be enabled for training. A
Training Completion page is a page that is available to a user when they complete the
training. Depending on the configuration of the training and the portal, the Training
Completion page may display any points or badges that were awarded, the opportunity to
rate and review the training, and the option to view their certificate of completion.
Administrators can configure the following aspects of the Training Completion page:
o
o
o
o
o

Completion message
Training badges
Training points
Ability to rate and review the training
Training completion certificate

Administrators can enable or disable the Training Completion page by training type and for
each individual learning object (LO). Administrators can configure a default completion
message for all training. Also, administrators can create a custom completion message for
individual LOs.

Use Cases
Michelle is a new Account Manager at Express Shop. To stay up to date on the state of the
company and new products, Michelle engages in several training offerings throughout the
year. These trainings ensure that she is certified to evangelize the company's products to
prospects and improve her skills as an Account Manager.
Upon completing a training that certifies her to talk about the products, she is immediately
be redirected to a training completion page that recaps her accomplishments. Beyond
confirming the training is complete, Michelle can view the badges and points she has
earned. She can also easily view and print her new certificate to put up for display at her
desk.
After reviewing her accomplishments, she is presented with an opportunity to rate and
review the training that she has just taken so she can provide feedback for others who may
consume this training while it is still fresh in her mind.
These features offer Michelle gratification for completing her training, keep her engaged,
and encourage her to continue her professional growth and development.
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Considerations
If all content is disabled on the Training Completion page and the Training Completion
Message is blank for the LO, then a default message is displayed on the Training
Completion page to prevent a blank page from being displayed.
This functionality is only available to organizations using the redesigned Transcript.

Training Completion Page Availability & Redirection
If a Training Completion page is available for a LO, then users can always manually
navigate to the page via the Transcript Details page once the LO is completed. Automatic
redirection to the Training Completion page only occurs for select LO types in certain
scenarios.

Automatic Redirection
Automatic redirection only applies to the following LO types:
o
o
o
o

Online Course
Material
Test
Video

Automatic redirection occurs for the specified LO types in the following scenarios:
o
o
o
o
o
o

User completes the LO (see exceptions below)
User marks the LO Complete from their Transcript
User marks the LO Complete from their Action Items
User completes a recurrence of the LO
User completes another version of the LO
Test Only: The test is submitted and passed

Automatic redirection does NOT occur for the specified LO types in the following scenarios:
o Admin marks the LO Complete from the Transcript Details Page
o Admin marks the user Exempt from the LO from the Transcript Details page
o User completes the LO as an associated LO in the following scenarios:
o Prerequisite
o Pre-work
o Post-work
o Within cohort structure
o Within curriculum structure
o Within library structure
o LO is a Training Equivalent or Language Equivalent - Only the LO that is completed will
redirect
o When a LO is in a pre-completion status due to a required action:
o Pending Signature
o Pending Evaluation
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o

o

o
o

o Pending Acknowledge
o Pending Post Work
Upon completing required pre-completion work:
o Pending Signature
o Pending Evaluation
o Pending Acknowledge
o Pending Post Work
When completing a LO launched from the following:
o Welcome Page Widget
o Deep Link
o LO DetailsPage - This only applies to Online Courses
The system is in Low Bandwidth mode - This is controlled by a backend setting.
Test Only:
o Test is submitted and failed
o Test contains free-form questions

Manual Redirection
User's can manually navigate to the Training Completion page from the Transcript Details
page for the following LO types:
o
o
o
o
o
o
o
o
o

Online Course
Event
Quick Course
Curriculum
Test
Library
Materials
Video
Cohort

From within the Curriculum Player and Cohort Player, can select the View Completion
Page option from the Options drop down to manually navigate to the Completion Page
once the LO is in the Completed status.

Implementation
This functionality is automatically enabled for all organizations using the Learning module.
Note: This functionality is only available to organizations using the redesigned Transcript.
By default, the Training Completion Page Preferences permission is only available to the
default System Administrator role.
By default, the Training Completion page is disabled for all learning objects. The Training
Completion page can be enabled or disabled by default by LO type via the Training
Completion Page Preferences. The Training Completion page can be enabled or disabled
for individual LOs via the Course Catalog.
351

Cornerstone April 2016 Release Notes: What's New for April 2016

Glossary
o Training Completion Page - A page that is available for a user when they complete the
training. Depending on the configuration of the training and the portal, the Training
Completion page may display any points or badges that were awarded, the opportunity
to rate and review the training, and the option to view a certificate of completion.
o Completion Message - A note or message that is displayed on the Training Completion
Page that may be presented to users when they complete training. This is intended to
inform the user that they have successfully completed the training. This message can
also provide the user a directive regarding next steps, such as how to rate the course or
print a certificate of completion.

Security
The following new permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Learning Badge View

Grants ability to view the Badge field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Learning Points View

Grants ability to view the Points field on the LO Details Learning
page and the Training Completion page. This
permission cannot be constrained.

Snapshot Leaderboard

Enables user to view the Leaderboard widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Training Completion
Page Preferences Manage

Grants ability to access and edit the Training
Learning Completion Page Preferences where the
Administration
administrator can configure the default behavior
for training completion pages, including whether a
completion page is enabled by default for each
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learning object (LO) type and the default
completion message that appears on the Training
Completion page. This permission cannot be
constrained. This is an administrator permission.
The following existing permissions apply to this functionality:
PERMISSION
NAME
Course Catalog Update

Course Reviews
and Ratings
Preference Manage

PERMISSION DESCRIPTION

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.
Grants ability to configure course reviews and
ratings functionality by division. This is an
administrator permission.

CATEGORY

Learning Administration

eCommerce Administration

Snapshot Main - View Enables user to view the Snapshot page for users
within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Universal
Profile
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Training Completion Page Preferences
With this enhancement, administrators now have the ability to enable a Completion page,
which will be available for a user once they have completed the training.
The Training Completion Page Preferences page enables administrators to configure the
default behavior for training completion pages, including whether a completion page is
enabled by default for each learning object (LO) type and the default completion message
that appears on the Training Completion page.
To manage Training Completion Page Preferences, go to ADMIN > TOOLS > LEARNING >
LEARNING PREFERENCES > TRAINING COMPLETION PAGE.
Permissions
PERMISSION
NAME
Training Completion
Page Preferences Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to access and edit the Training
Learning Completion Page Preferences where the
Administration
administrator can configure the default behavior
for training completion pages, including whether a
completion page is enabled by default for each
learning object (LO) type and the default
completion message that appears on the Training
Completion page. This permission cannot be
constrained. This is an administrator permission.

Settings by Learning Object Type
This section enables administrators to set the default behaviors for each LO type that can
be configured in the Course Catalog. The following options can be set for each available LO
type:
o Enable Training Completion Page - A Training Completion page is a page that is
available for a user when they complete the training. Depending on the configuration of
the training and the portal, the Training Completion page may display any points or
badges that were awarded, the opportunity to rate and review the training, and the
option to view their certificate of completion. When this option is selected, the Training
Completion page is enabled by default for the corresponding training type.
Administrators can choose to enable or disable the Training Completion page for each
individual LO via the Course Catalog. This setting only determines the default
configuration.

Completion Message
This section enables administrators to configure the default completion message that is
displayed to users on the Training Completion page when they complete a LO. When
editing a LO via the Course Catalog, administrators can choose to utilize the default
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completion message or they can create a custom completion message for the LO. This
setting only determines the default completion message.
To view a list of all of the tags that can be used in the default completion message, click the
List of Available Tags link. To use one of the tags, copy the tag from the pop-up and paste
it into the custom message editor. Be sure to copy the brackets on both sides of the tag
name.
To edit the default completion message, click the Gear icon in the upper-right corner of
the Preview panel. This opens an HTML editor, in which a custom message can be
configured using HTML. See HTML Whitelist.
The Preview panel displays a preview of the message as it is currently configured. If tags
are used in the message, then the tag is displayed with brackets in the preview.

Overwrite Custom Completion Page Settings
Choose whether or not to overwrite custom training completion page settings for all LOs. If
you choose to overwrite custom settings for all LOs, the selected settings are applied to
both new and existing LOs. Any previously customized LOs are updated with the selected
settings.
If this option is unselected, then only the LOs that do not have customized settings will be
updated, as well as any LOs that are created in the future.
A LO that has not been customized always inherits from the default settings, regardless of
whether this option is selected.
A LO is considered customized if its settings have been changed via the Course Catalog.

Save/Cancel
Click SAVE to commit any unsaved changes, or click CANCEL to discard any unsaved
changes.
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Course Catalog - General - Completion Page
With this enhancement, administrators now have the ability to enable a Completion page,
which will be displayed to a user once they have completed the training.
To support this enhancement, the General tab of the Course Catalog now has additional
options that enable administrators to configure the Completion page for each learning
object (LO).
To access the Course Catalog, go to ADMIN > TOOLS > LEARNING > CATALOG
MANAGEMENT > COURSE CATALOG.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Course Catalog Update

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

Learning Administration

Training Completion
Page Preferences Manage

Grants ability to access and edit the Training
Learning Completion Page Preferences where the
Administration
administrator can configure the default behavior
for training completion pages, including whether a
completion page is enabled by default for each
learning object (LO) type and the default
completion message that appears on the Training
Completion page. This permission cannot be
constrained. This is an administrator permission.

The following new options are now available in the General tab of the Course Catalog:

Training Completion Page Settings
A Training Completion page is a page that is available to a user when they complete the
training. Depending on the configuration of the training and the portal, the Training
Completion page may display any points or badges that were awarded, the opportunity to
rate and review the training, and the option to view their certificate of completion.
The following settings enable administrators to configure the Training Completion page for
the LO. These settings are only available to administrators who have permission to manage
Training Completion Page Preferences.
o Enable Completion Page - When this option is selected, the Training Completion page
is displayed when the user completes the training. When this option is not selected, the
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user does not receive a notification that they have completed the training. The default
setting for this option is determined in Training Completion Page Preferences.
o Use Case: A Training Completion page may be enabled for a LO to encourage
users to rate the LO, encourage users to take additional training by displaying
their awarded badge and training points, or to enable users to quickly access their
certification.
o Use Case: A Training Completion page may be disabled for a LO if the LO does
not have any post-completion workflows, such as Compliance training.
o Enable Default Completion Message - This option is only available when the Enable
Completion Page option is selected. When this option is selected, the Training
Completion page displays the default completion message that is defined in Training
Completion Page Preferences. When this option is not selected, the Training
Completion Message field is enabled, which allows the administrator to customize the
message that is displayed to users when they complete this LO.
o Training Completion Message - This field is only available when the Enable Default
Completion Message option is not selected, and it is only available to administrators
who have permission to manage Training Completion Page Preferences. This field
allows the administrator to customize the message that is displayed to users when they
complete this LO. This is useful if the LO requires specific completion instructions.
o The Preview panel displays a preview of the message as it is currently configured.
If tags are used in the message, then the tag is displayed with brackets in the
preview.
o To edit the completion message, click the Gear icon in the upper-right corner of
the Preview panel. This opens an HTML editor, in which a custom message can
be configured using HTML. Administrators can also localize the message within
the HTML editor. See HTML Whitelist.
o To view a list of all of the tags that can be used in the custom message, click the
List of Available Tags link. To use one of the tags, copy the tag from the pop-up
and paste it into the custom message editor. Be sure to copy the brackets on both
sides of the tag name.
o Note: If all content is disabled on the Training Completion page and the Training
Completion Message is blank for the LO, then a default message is displayed on
the Training Completion page to prevent a blank page from being displayed.
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Course Ratings Preferences
Prior to this enhancement, when providing a rating for a course, users were always required
to provide a review for the course, including a review title and review text.
With this enhancement, a new option is now available, which allows administrators to
configure whether or not users are required to provide a review title and review text when
rating a course.
To manage Course Ratings Preferences, go to ADMIN > TOOLS > LEARNING >
LEARNING PREFERENCES > COURSE RATINGS.
Permissions
PERMISSION
NAME
Course Reviews
and Ratings
Preference Manage

PERMISSION DESCRIPTION

Grants ability to configure course reviews and
ratings functionality by division. This is an
administrator permission.

CATEGORY

eCommerce Administration

The following new option is now available in the General section of the Course Ratings
Preferences page:
o Require Title and Review fields - This option enables administrators to configure
whether or not users are required to provide a review title and review text when rating a
course. This option is selected by default.
o When this option is not selected, users can provide a rating for the course without
providing a review.
o When this option is selected, users are required to provide a review when rating
the course, including a review title and review text.
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Training Completion Page
Prior to this enhancement, upon completing training, users were returned to their Transcript
with no confirmation that the training was completed. Post-completion workflows, such as
printing a Completion certification or providing a rating, were difficult to locate and required
users to follow a multi-step process, which often resulted in users not being able to
complete the actions.
With this enhancement, a Training Completion page can now be enabled for training.
A Training Completion page is a page that is available to a user when they complete the
training. Depending on the configuration of the training and the portal, the Training
Completion page may display any points or badges that were awarded, the opportunity to
rate and review the training, and the option to view their certificate of completion.
If a Training Completion page is available for a LO, then users can always manually
navigate to the page via the Transcript Details page once the LO is completed. Automatic
redirection to the Training Completion page only occurs for select LO types in certain
scenarios. See the Training Completion Page Availability & Redirection section below for
additional information.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Learning Badge View

Grants ability to view the Badge field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Learning Points View

Grants ability to view the Points field on the LO
Details page and the Training Completion page. This
permission cannot be constrained.

Learning

Snapshot Leaderboard

Enables user to view the Leaderboard widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

362

Cornerstone April 2016 Release Notes: What's New for April 2016

Completion Message
A completion message is displayed at the top of the Training Completion Page. This is
intended to inform the user that they have successfully completed the training. This
message may also provide the user a directive regarding next steps, such as how to rate
the course or print a certificate of completion.
If the training title is included in the completion message, then the Training Completion
page always displays the training's title at the time the training was completed. If the
training title is updated in the future, the Training Completion page is not impacted.

Earned Badges and Points
The user may be awarded a badge and training points by completing the training:
o Badge - If the user is awarded a badge by completing the training, then this badge is
displayed. If the user has the Snapshot - Badges permission, they can click the badge
title to view the Snapshot - My Badges page. See Snapshot - My Badges on page 329
for additional information.
o If there is no badge associated with the LO, then this information is hidden. Also,
this information is only visible if the user has permission to view Learning Badges.
o Points - If the user earned points by completing the training, then the number of points
that were earned is displayed. If the user has the Snapshot - Leaderboard permission,
they can the View Leaderboard link to view the Snapshot - Leaderboard page. See
Snapshot - Leaderboard on page 331 for additional information.
o If no points were earned, then this information is hidden. Also, this information is
only visible if the user has permission to view Learning Points.

Rate and Review the Training
To rate the training, click the Rate this Training link. This opens a pop-up, in which the
user is able to assign a star rating and provide a review of the training.
The option to rate the training is available if the following are true:
o Course ratings are enabled
o The user is able to view and apply course ratings for the selected LO

Edit/Delete My Review
If the user has already rated the training, then the user's rating is displayed and an Edit My
Review link is displayed. Users can click this link to edit their rating and review.
Also, an Options drop-down
is available in the upper-right corner of the widget. The
following options are available:
o Edit - Select this option to edit your review, including the rating and review text.
o Delete - Select this option to delete your review. The review will no longer be available
on the Training Completion page or the LO Details page.
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View Certificate of Completion
The user may be awarded a certificate of completion if the following are true:
o A certificate is associated with the training via Course Catalog or Default Certificate
Preferences.
o The training has a status of Complete or Exempt.
To view and print the certificate of completion, click the View My Certificate link. This
enables the user to instantly view their certificate, and they can choose to print it if
necessary.

Training Completion Page Availability & Redirection
If a Training Completion page is available for a LO, then users can always manually
navigate to the page via the Transcript Details page once the LO is completed. Automatic
redirection to the Training Completion page only occurs for select LO types in certain
scenarios.

Automatic Redirection
Automatic redirection only applies to the following LO types:
o
o
o
o

Online Course
Material
Test
Video

Automatic redirection occurs for the specified LO types in the following scenarios:
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o
o
o
o
o
o

User completes the LO (see exceptions below)
User marks the LO Complete from their Transcript
User marks the LO Complete from their Action Items
User completes a recurrence of the LO
User completes another version of the LO
Test Only: The test is submitted and passed

Automatic redirection does NOT occur for the specified LO types in the following scenarios:
o Admin marks the LO Complete from the Transcript Details Page
o Admin marks the user Exempt from the LO from the Transcript Details page
o User completes the LO as an associated LO in the following scenarios:
o Prerequisite
o Pre-work
o Post-work
o Within cohort structure
o Within curriculum structure
o Within library structure
o LO is a Training Equivalent or Language Equivalent - Only the LO that is completed will
redirect
o When a LO is in a pre-completion status due to a required action:
o Pending Signature
o Pending Evaluation
o Pending Acknowledge
o Pending Post Work
o Upon completing required pre-completion work:
o Pending Signature
o Pending Evaluation
o Pending Acknowledge
o Pending Post Work
o When completing a LO launched from the following:
o Welcome Page Widget
o Deep Link
o LO DetailsPage - This only applies to Online Courses
o The system is in Low Bandwidth mode - This is controlled by a backend setting.
o Test Only:
o Test is submitted and failed
o Test contains free-form questions

Manual Redirection
User's can manually navigate to the Training Completion page from the Transcript Details
page for the following LO types:
o Online Course
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o
o
o
o
o
o
o
o

Event
Quick Course
Curriculum
Test
Library
Materials
Video
Cohort

From within the Curriculum Player and Cohort Player, can select the View Completion
Page option from the Options drop down to manually navigate to the Completion Page
once the LO is in the Completed status.
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Training Completion Page - Rate This Training
Prior to this enhancement, when providing a rating for a course, users were always required
to provide a review for the course, including a review title and review text.
With this enhancement, administrators are able to configure whether or not users are
required to provide a review title and review text when rating a course. When a review title
and review text are not required, then the Title and Review fields are available, but they
are not required when rating the training. When these fields are not required, then a red
asterisk is not displayed next to the field names.
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Transcript Details Page - View Completion Page
With this enhancement, a Training Completion page can now be enabled for training. If a
user has completed a learning object (LO), and the LO has a Training Completion page
enabled, then users can view their Training Completion page from their Transcript Details
page.
A View Completion Page link is now available to the right of the Status field when the LO
is in a Completed status and the LO has a Training Completion page available. See
Training Completion Page on page 362 for additional information.

368

Cornerstone April 2016 Release Notes: What's New for April 2016

Curriculum Player - Options Drop-down
With this enhancement, a Training Completion page can now be enabled for training. In
order to support this enhancement, the Curriculum Player is enhanced to allow users to
view their Training Completion page for the curriculum.
The TRAINING DETAILS button is removed from the Curriculum Player, and an Options
drop-down is now available. This drop-down contains the following options:
o View Completion Page - This opens the Training Completion page for the curriculum.
This option is only available once the user has completed all of the required LOs for the
curriculum. Also, this option is only available if a Training Completion page is enabled
for the curriculum.
o Training Details - This is the same as the previously existing TRAINING DETAILS
button.
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Cohort Community - Learning Tab - Options Drop-down
With this enhancement, a Training Completion page can now be enabled for training. In
order to support this enhancement, the Learning tab of cohort communities is enhanced to
allow users to view their Training Completion page for the cohort.
The TRAINING DETAILS button is removed from the Learning tab of the cohort
community, and an Options drop-down is now available. This drop-down contains the
following options:
o View Completion Page - This opens the Training Completion page for the cohort. This
option is only available once the user has completed all of the required LOs for the
cohort. Also, this option is only available if a Training Completion page is enabled for
the cohort and if the cohort End Date has passed.
o Training Details - This is the same as the previously existing TRAINING DETAILS
button.
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Transcript Options - View Certificate
With this enhancement, if a user has completed a learning object (LO), and the LO has a
certificate of completion, then users can now view their certificate when viewing completed
training on their Transcript. The primary action for completed LO is View Certificate if the
LO has an available certificate. The certificate is opened in a pop-up window.
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Training Completion Signature at LO Level
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Training Completion Signature at LO Level
An electronic signature (e-signature) is a signature that is provided electronically via the
system. A training completion e-signature is provided by a user to confirm or indicate that
they have completed the training. Users may be required to provide a training completion esignature before a learning object (LO) is completed.
Prior to this enhancement, administrators could require training completion e-signatures by
organizational unit (OU) and they could require this signature for certain LO types.
With this enhancement, administrators now configure whether a training completion
electronic signature (e-signature) is required for specific learning objects (LOs). In addition,
a new Default Training Completion Signature Preferences page is now available. This page
enables administrators to configure the default setting for requiring training completion esignature by LO type, which is set for a LO when the LO is created. Once the LO is created,
administrators can modify this setting at the LO level via Course Catalog.

Use Cases
Jeff Miller is a Global LMS Administrator at ACME Corp. In this organization, there is only
one Compliance Curriculum in the Course Catalog that requires e-signature for training
completion. Previously, to enable e-signature, Jeff would enable it for all curricula even
though only one curriculum needed it. With this enhancement, Jeff can choose to only
enable e-signature for the Compliance Curriculum.
Jeff Miller is a Global LMS Administrator at ACME Corp. To ensure that the compliance in
his organization is respected for the necessary LOs and to avoid any disruption in the esignature workflows, Jeff sets the default e-signature requirement for all appropriate LO
types. With this configuration, all LOs have a default e-signature requirement value when
they are created. All ACME Corp local LMS Administrators can modify the value at the LO
level via Course Catalog.

Considerations
The e-signature requirement can be configured at the LO level via Course Catalog for all
LOs except for external training and postings. For these LO types, the default settings are
applied to all instances, which are configured via Default Training Completion Electronic
Signature Preferences.

Implementation
This functionality is only available to organizations using the Learning module and Training
Completion Signature functionality.
In order to avoid any disruption to an organization's Training Completion Signature
workflow, this functionality must be activated directly by administrators via Default Training
Completion Signature Preferences.
Upon release, the previously existing e-signature functionality is not impacted, and the
previous configuration remains active. To use the new functionality, administrators
immediately have the ability to begin configuring their portal before activating the new
functionality. The following steps should be taken prior to activating this functionality:
374

Cornerstone April 2016 Release Notes: What's New for April 2016

1. Course Catalog - Configure the Required Electronic Signature option for all learning
objects via the Course Catalog. This can be done by editing individual LOs or by batch
editing LOs.
2. Training Completion Electronic Signature Preferences - Configure the Electronic
Signature option for all OUs via the Training Completion Electronic Signature
Preferences page.
3. Default Training Completion Signature Preferences - Configure the default settings for
the Required Electronic Signature option by LO type. This setting only impacts LOs
that are created after this functionality is activated.
Because e-signatures play a significant role in certain compliance workflows, administrators
must ensure that the e-signature settings are properly configured for all of their LOs within
the Course Catalog prior to enabling this functionality.
After configuring these options, administrators can activate this functionality on the Default
Training Completion Signature Preferences page. Once this functionality is activated, then
the e-signature requirement settings are managed at the LO level via Course Catalog. An
e-signature is only required for training completion if the following is true:
o The Electronic Signature option is selected for the user's OU within Training
Completion Electronic Signature Preferences.
o The Required Electronic Signature option is selected for the LO within Course
Catalog.
Note: With the July 2016 release, all organizations that have Electronic Signature enabled
will be automatically transitioned to managing e-signature requirements at the LO level via
Course Catalog. This will occur even if the organization has not yet activated this transition.
With the July 2016 release, the Change Default to Course Catalog section will be removed
from the Default Training Completion Signature Preferences page.

Security
The following new permission applies to this functionality:
PERMISSION
NAME
Default Training
Completion
Signature
Preferences

PERMISSION DESCRIPTION

Grants ability to manage Default Training
Completion Signature preferences at the portal
level. This enables the administrator to set the
default setting for whether an electronic training
completion signature is required. This permission
can be constrained by OU and User's OU. This is
an administrator permission.

CATEGORY

Learning Administration

The following existing permissions apply to this functionality:
PERMISSION

PERMISSION DESCRIPTION

CATEGORY
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NAME
Course Catalog Update

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

Learning Administration

Training Completion
Signature
Preferences

Grants ability to manage Training Completion
Learning Signature preferences, to configure a required
Administration
electronic training completion signature. This
permission works in conjunction with the Learning
Preferences permission. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
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Training Completion Electronic Signature Preferences
With this enhancement, administrators can now require a training completion electronic
signature (e-signature) for specific learning objects (LOs). In addition, a new Default
Training Completion Signature Preferences page is now available, which enables
administrators to set the default setting for requiring training completion e-signature by LO
type.
Before the system transitions from managing e-signature requirements at the OU level to
controlling e-signature requirements at the LO level, an administrator must manually
activate the transition via the Default Training Completion Signature Preferences page. See
Default Training Completion Signature Preferences on page 379 for additional
information.
o Before the transition is activated, the system utilizes the e-signature settings within
Training Completion Electronic Signature Preferences. These settings are visible on the
Training Completion Electronic Signature Preferences page, but they are disabled and
cannot be modified. These settings control e-signature requirements by LO type at the
OU level.
o After the transition is activated, the system utilizes the e-signature setting within the
Course Catalog. This setting controls e-signature requirements at the LO level. The OUlevel settings on the Training Completion Electronic Signature Preferences page are no
longer visible.
When e-signature requirements are controlled at the LO level, then electronic signature is
only required for a user when completing a LO if the following are both true:
o The Electronic Signature option is selected for the user's OU within Training
Completion Electronic Signature Preferences.
o The Required Electronic Signature option is selected for the LO within Course
Catalog.
On this page, when the Electronic Signature option is unselected, all other options on the
page are hidden. As previously implemented, when the Electronic Signature is selected
after being unselected, the Signature Type and Signature Font settings are reset to their
default values, but the User Authentication, Action Name, and Message fields retain their
previous values.
To manage Training Completion Signature Preferences, go to ADMIN > TOOLS >
LEARNING > LEARNING PREFERENCES > TRAINING COMPLETION SIGNATURE.
Permissions
PERMISSION NAME
Training Completion
Signature
Preferences

PERMISSION DESCRIPTION
Grants ability to manage Training Completion
Signature preferences, to configure a required
electronic training completion signature. This

CATEGORY
Learning Administratio
n
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permission works in conjunction with the Learning
Preferences permission. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
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Default Training Completion Signature Preferences
An electronic signature (e-signature) is a signature that is provided electronically via the
system. A training completion e-signature is provided by a user to confirm or indicate that
they have completed the training. Users may be required to provide a training completion esignature before a learning object (LO) is completed.
Prior to this enhancement, administrators could require training completion e-signatures by
organizational unit (OU) and they could require this signature for certain LO types.
With this enhancement, administrators can now require a training completion e-signature
for specific LOs.
When e-signature is enabled via Training Completion Electronic Signature Preferences, this
page enables administrators to configure the default setting for requiring training completion
e-signatures by LO type. In addition, this page enables administrators to choose when their
portal switches from controlling e-signature requirements at the OU level to controlling them
at the LO level.
To manage Default Training Completion Signature Preferences, go to ADMIN > TOOLS >
LEARNING > LEARNING PREFERENCES > DEFAULT TRAINING COMPLETION
SIGNATURE.
Permissions
PERMISSION
NAME
Default Training
Completion
Signature
Preferences

PERMISSION DESCRIPTION

Grants ability to manage Default Training
Completion Signature preferences at the portal
level. This enables the administrator to set the
default setting for whether an electronic training
completion signature is required. This permission
can be constrained by OU and User's OU. This is
an administrator permission.

CATEGORY

Learning Administration

Require Training Completion E-signature by LO Type
Training completion e-signatures can be required at the LO level, and this is configured in
the Course Catalog.
When e-signature is enabled via Training Completion Electronic Signature Preferences, this
section enables the administrator to configure the default setting for requiring training
completion e-signature by LO type. For example, if the Curriculum option is selected, then
when a new curriculum is created, the Required Electronic Signature option is selected
by default for the curriculum on the General page of the Course Catalog.
Select which LO types require the e-signature for completion by default. All LO types are
unselected by default. Administrators can choose to enable or disable the e-signature
requirement for each individual LO via the Course Catalog. This setting only determines the
default configuration.
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o For online courses, the default setting is applied when the course is published.
o For events, the default setting is applied to the event when the event is created. Any
changes to this setting do not impact existing events. When a session is created for an
event, the session inherits the signature requirement directly from the event.
o For programs, the default setting is applied to the program when the program is created.
Any changes to this setting do not impact existing programs. When a cohort is created
for a program, the cohort inherits the signature requirement directly from the program.
o For external training, any external training that is added throughout the system will
inherit this setting. This setting cannot be changed for the external training once it is
created.
Any changes to these default settings only impact newly created LOs. Any existing LOs are
not impacted by changes to these settings.

Change Default to Course Catalog
Prior to the April 2016 release, e-signature settings were managed by LO type. With the
April 2016 release, e-signature settings are now managed at the LO level.
This section enables administrators to choose when their portal switches from controlling esignature requirements by LO type to controlling them at the LO level.
Because e-signatures play a significant role in certain compliance workflows, it is important
that organizations configure all of their LOs within the Course Catalog prior to enabling this
functionality to ensure that there are no compliance issues or disruptions to existing
workflows.
To enable the system to transition from managing e-signature requirements by LO type to
controlling e-signature requirements at the LO level, click the ACTIVATE button. This
opens a confirmation pop-up that explains the implications of activating this functionality. To
confirm the activation, click the ACTIVATE button within the pop-up. This action cannot be
undone.
o Before Activation - The system utilizes the e-signature settings within the Training
Completion Electronic Signature Preferences. These settings are visible on the Training
Completion Electronic Signature Preferences page, but they are disabled and cannot be
modified. These settings control e-signature requirements by LO type at the OU level.
o After Activation - The system utilizes the e-signature setting within the Course Catalog.
This setting controls e-signature requirements at the LO level. The settings by LO type
on the Training Completion Electronic Signature Preferences page are no longer visible.
Note: With the July 2016 release, all organizations that have Electronic Signature enabled
will be automatically transitioned to managing e-signature requirements at the LO level via
Course Catalog. This will occur even if the organization has not yet activated this transition.
With the July 2016 release, the Change Default to Course Catalog section will be removed
from the Default Training Completion Signature Preferences page.
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Save/Cancel
Click SAVE to commit any unsaved changes. Or, click CANCEL to discard any unsaved
changes. Note: Activating the transition to managing e-signature requirements via Course
Catalog is automatically implemented as soon as it is activated. This occurs regardless of
whether the SAVE button is clicked.
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Course Catalog - General - Required Electronic Signature
With this enhancement, administrators now have the ability to require a training completion
signature for each individual learning object (LO).
To support this enhancement, the General tab of the Course Catalog now has an additional
option that enables administrators to elect to require a training completion signature for the
LO.
To access the Course Catalog, go to ADMIN > TOOLS > LEARNING > CATALOG
MANAGEMENT > COURSE CATALOG.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Course Catalog Update

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

Learning Administration

Training Completion
Signature
Preferences

Grants ability to manage Training Completion
Learning Signature preferences, to configure a required
Administration
electronic training completion signature. This
permission works in conjunction with the Learning
Preferences permission. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

General Tab
The following options are now available on the General tab of the Course Catalog:
o Required Electronic Signature - Implementation Note: This option is not enforced
until this functionality is activated via Default Training Completion Signature
Preferences. However, it is critical that administrators configure this option for all LOs
prior to activating this functionality. When this option is selected, a user who has
completed the training must provide an electronic training completion signature in order
for the training to be considered Completed. In order for a user to be required to provide
an electronic completion signature, the Electronic Signature functionality must also be
enabled for the user's OU via Training Completion Electronic Signature Preferences.
When a LO is created, the default setting for this option is determined in Default
Training Completion Signature Preferences.
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When a new version of a LO is created, the new version inherits the previous version's
value for this field.

Batch Editing - Edit Signature
When batch editing LOs via the Course Catalog, this field can be edited via the Edit
Signature option. The following options are available:
o Required Electronic Signature - Implementation Note: This option is not enforced
until this functionality is activated via Default Training Completion Signature
Preferences. However, it is critical that administrators configure this option for all LOs
prior to activating this functionality. When this option is selected, a user who has
completed the training must provide an electronic training completion signature in order
for the training to be considered Completed. In order for a user to be required to provide
an electronic completion signature, the Electronic Signature functionality must also be
enabled for the user's OU via Training Completion Electronic Signature Preferences. .
When a LO is created, the default setting for this option is determined in Default
Training Completion Signature Preferences.
o Configure Signature Message - This option is unselected by default. When this option
is unselected, the Signature Message is not impacted. Select this option to set the
same Signature Message for all of the selected LOs. The following options are only
available when this option is selected:
o Message - In this field, enter the message that is displayed to users when they
are providing an electronic training completion signature. This message is applied
to all of the selected LOs. The character limit for this field is 500. If multiple
languages are enabled for your portal, click the Translate icon to translate the field
into other available languages. By default, the administrator is modifying the
message for their preferred language. Note: This field is only available if you have
permission to manage Training Completion Signature preferences.
o The following options are only available if multiple languages are enabled for your
portal:
o Apply changes to the signature message for only fields that have been
updated - This option is selected by default. When this option is selected,
then any localized messages that the administrator adds are applied to all of
the selected LOs. However, if the administrator does not add a message for
a particular language, then the message for that language is not updated for
any of the selected LOs. For example, if a localized message is provided for
English and French then any existing English and French messages are
overwritten, and all other previously existing translations are not impacted.
o Overwrite all existing signature message configurations - Use caution
when selecting this option. When this option is selected, then all
localizations of the message are overwritten with the values specified during
the batch edit. This applies even if one or more of the messages are blank.
For example, if a localized message is provided for English and French and
all other localizations are blank, then the English and French messages are
applied to all selected LOs, and the messages for all other available
languages are removed.
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Transcript - Completion Signature
Prior to this enhancement, users could only provide a completion signature from the
training's Transcript Details page.
With this enhancement, users are now able to provide a completion signature from their
Transcript.
A Sign option is available for a training item on the Transcript page if the user has
completed the training and a completion signature is required for the training. When this
option is selected, the user is navigated to the Transcript Details page for the training,
where the user can provide a completion signature.
The Acknowledgment Title and Message can be configured at the organizational unit (OU)
level via Training Completion Signature Preferences Also, the Message can be configured
at the learning object (LO) level via Course Catalog. The settings at the LO level override
any settings at the OU level.
Training completion signature is required for a LO if the following is true:
o The Required Electronic Signature option is selected within Course Catalog for the
LO.
o The Electronic Signature option is selected for the user's OU within Training
Completion Signature Preferences.
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Training Plan Dynamic Update
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Training Plan Dynamic Update
Training plans are tasks in Cornerstone functionality where Plan Contributors identify
training needs for a particular group of users for a specific period of time. The Plan
Contributor then adds these needs to the training plan as requests, which are reviewed by
the Plan Managers. Plan Managers review the training requests and approves or denies the
requests.
Prior to this enhancement, Plan Contributors were defined when the training plan task was
defined. When a Plan Contributor moved to a different position or department within the
organization, the training needs that the Plan Contributor identified for users were removed
from the training plan and were lost. For example, if a plan contributor identified training
needs for a user, and then the Plan Contributor moved to a different department, the
training needs that had been identified for the user would be removed. The new Plan
Contributor would need to redo the planning efforts that had previously been done.
With this enhancement, when a training plan is configured with managers as Plan
Contributors planning for their subordinates and a new manager is identified for a user on
their user record, then an automatic workflow moves the training needs to the user's new
manager who is acting as a Plan Contributor. Any training needs that have been identified
for a subordinate within a training plan will remain associated with the subordinate even if
the subordinate is moved to a new plan contributor. This enables organizations that are
using training plans with Plan Contributors planning for their subordinates to more
effectively identify training needs without having to worry about plan contributors changing.
If a user who has training needs added by a previous Plan Contributor does not have a
Plan Contributor (i.e., no manager identified on their User Record) for an extended period of
time, the training needs for any impacted users is placed on hold and can be reviewed by
administrators on the new On-Hold Training Needs page.
This enhancement also targets scenarios in which managers plan training needs for users
who are not yet in the manager's scope. For example, a set of future hires may be set up as
organizational units (OUs) within a training plan. For training needs that are identified for an
OU within a training plan, if the Plan Contributor (Manager) is removed from a training plan,
then the training needs that have been identified for the OU are visible on the On-Hold
Training Needs page. However, when a new Plan Contributor (Manager) is identified for the
OU, the training needs do not remain associated with the OU, and the new Plan Contributor
must manually enter the training needs for the OU with the information provided by the
Training Plan Administrator.
A user may be removed from the plan contributor role in the following scenarios:
o The Plan Contributor (Manager) is deactivated in the system because they are no
longer with the organization.
o The Plan Contributor (Manager) moves to a new position and no longer meets the plan
contributor criteria.
o The user (manager) is no longer a manager.
When a user is removed from the Plan Contributor role, any training plan needs that they
have identified are stored and are visible on a new On-Hold Training Needs page.
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o If the training plan is expired before the Plan Contributor is removed, then the training
needs are not stored and they are not visible on the On-Hold Training Needs page.
When a user moves into a Plan Contributor (Manager) role in which a previous Plan
Contributor (Manager) had identified training needs, the new Plan Contributor inherits the
previous Plan Contributor's training need information. This enables the new Plan
Contributor (Manager) to continue completing the training plan without needing to redo the
previous Plan Contributor's efforts.

Workflow

Use Cases
The following personas are used within the use cases:
o Jeff (Training Manager) - Jeff manages the company trainings. He will validate and
arbitrate the training plan needs. He is the Plan Manager.
o Vicky (Manager of Product Management) - Vicky manages the Learning Management
System (LMS) Product Management team. AK is her direct subordinate. Vicky will plan
training needs for her and any new members who will join her as direct reports
(anonymous users). She is a Plan Contributor.
o AK (Product Management Lead) - AK is Vicky's direct subordinate. AK manages Sara
and Laurence. She will plan training needs for them and any new members who will join
them as direct reports (anonymous users). She is a Plan Contributor.
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o Sarah and Laurence (Product Managers) - Sarah and Laurence are direct subordinates
of AK.

Use Case 1: Employee Transfer
Jeff is a Plan Manager, and he has set up the training plan with managers (Plan
Contributors) to forecast training needs for their direct subordinates. When he set up the
plan, Laurence was Vicky's direct report, but now she reports to the newly promoted Lead
Manager, AK. Vicky has already added training needs for Laurence, and AK should retrieve
all of the training needs that have been identified for Laurence.

Use Case 2: Manager Leaves
Jeff is a Plan Manager, and he has set up the training plan with managers (Plan
Contributors) to forecast training needs for their direct subordinates. When he set up the
plan, AK's direct reports were Sarah and Laurence. AK has left the company and is now
replaced by Susan. As AK is deactivated in the system, all training needs she has already
identified for Sarah and Laurence should be maintained and visible to Susan.

Use Case 3: Manager Leaves and is not Replaced Immediately
Jeff is a Plan Manager, and he has set up the training plan with managers (Plan
Contributors) to forecast training needs for their direct subordinates. When he set up the
plan, AK's direct reports were Sarah and Laurence. AK has left the company and Sarah and
Laurence have no new manager. Until a new manager is added for those users, all training
needs that AK has identified for Sarah and Laurence are put on hold and will be visible to
the new manager when one is assigned.

Use Case 4: Employee Leaves
AK is a plan contributor, and she has identified training needs for Sarah and Laurence.
Sarah moves to a new position, and her new position is not included in the training plan.
The training needs that have been identified for Sarah are removed from the training plan,
and they cannot be restored.

Implementation
This functionality is automatically enabled for all organizations using Training Plans within
the Learning module. This applies only to Training Plan configuration where Plan
Contributors are managers who are planning for their direct subordinates (User’s
Subordinates) and their OUs (User’s OU).

Glossary
o On-hold - This status refers to a user or OU within a training plan who does not currently
have a training plan contributor.
o Plan Contributor - Within a training plan, Plan Contributors are responsible for
identifying training needs and adding training requests to the training plan for the group
for which they are planning.
o For this enhancement, Plan Contributors are managers who have subordinates
identified in their User Records.
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o Plan Manager - Within a training plan, Plan Managers are responsible for reviewing
training plans created by plan contributors.
o Training Demand Forecasting - This enables an organization to forecast training
demand by collecting and reviewing training needs and requests. Collection of these
needs enables the organization to plan, budget, assess, and implement an effective
training program. Also, reporting tools enable the organization to view the needs for a
segment of the organization and compare those needs across the broader organization.
o Training Plan - A task in which Plan Contributors identify training needs for a particular
group of users. The Plan Contributor then adds these needs to the training plan as
requests, which are reviewed by the Plan Managers. Plan Managers review and
arbitrate the training requests and approve or deny the requests.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME
Training Forecast
Administration

Training Plan CoOwner

PERMISSION DESCRIPTION

Grants access to create and edit training plans.
This permission can be constrained by OU and
User's OU. This is an administrator permission.

CATEGORY

Learning Administration

This permission is not visible within the system
because it is a dynamically assigned permission that
is assigned to a user when they are designated as a
co-owner for a training plan. Users with this
permission can access the Training Forecast
Administration page and can only access training
plans for which they are a co-owner.

Learning
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Training Plan Details - View On-hold Users
With this enhancement, users with training needs who currently do not have a Plan
Contributor are listed on the new On-hold page. This enables the system to store any
training needs that have been identified by a previous Plan Contributor so that they can be
automatically added to the next Plan Contributor (Manager) by adding a manager in the
user record. Or, the Training Plan Administrator can manage those needs separately.
In order to support this enhancement, administrators can now access a list of all on-hold
users from the Training Plan Details page. If the training plan has users who are in an Onhold status, then a View On-Hold Users/OUs link is available below the Expiration field.
See Training Plan - On-Hold Training Needs on page 394 for additional information.
To access the Training Plan Details page, go to ADMIN > TOOLS > LEARNING >
TRAINING PLANS. Then, click the View Details icon for the training plan.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Training Forecast
Administration

Grants access to create and edit training plans. This Learning permission can be constrained by OU and User's OU. Administratio
This is an administrator permission.
n

Training Plan CoOwner

This permission is not visible within the system
because it is a dynamically assigned permission that
is assigned to a user when they are designated as a
co-owner for a training plan. Users with this
permission can access the Training Forecast
Administration page and can only access training
plans for which they are a co-owner.

Learning
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Training Plan - On-Hold Training Needs
Users and organizational units (OUs) within a training plan who do not currently have a
Plan Contributor (Manager) are in an On-hold status. While users and OUs are in an Onhold status, the system maintains any training needs that were identified by their previous
Plan Contributor (Manager) so that the training needs can be used by their next Plan
Contributor (Manager).
The On-Hold Training Needs page displays all On-hold users and organizational units
(OUs) within the Training Plan and all of the training needs that have already been
identified for those users and OUs. Only active users are displayed.
This page is only available if the training plan has users or OUs in an On-hold status.
If a training plan has on-hold users or OUs, then this page remains accessible even if the
training plan period has expired. However, no organizational modification (manager
modification) will be handled after the Training Plan period has expired so that the Training
Plan remains at the state that it was when it was validated.
To access the On-Hold Training Needs page for a training plan, go to ADMIN > TOOLS >
LEARNING > TRAINING PLANS. Click the View Details icon for the training plan. Then,
click the View On-hold Users link to the right of the Assigned Users field.
Permissions
PERMISSION
NAME
Training Forecast
Administration

Training Plan CoOwner

PERMISSION DESCRIPTION

Grants access to create and edit training plans.
This permission can be constrained by OU and
User's OU. This is an administrator permission.

CATEGORY

Learning Administration

This permission is not visible within the system
because it is a dynamically assigned permission that
is assigned to a user when they are designated as a
co-owner for a training plan. Users with this
permission can access the Training Forecast
Administration page and can only access training
plans for which they are a co-owner.

Learning

The following information is displayed for each on-hold user or OU:
o Previous Plan Contributor - This displays the manager who was previously serving as
the Plan Contributor for the user or OU. This user is displayed even if the user is
deactivated within the system.
o Users/OUs - This displays the name of the user or OU who currently does not have a
Plan Contributor (Manager). When planning for an OU, only the OU name is displayed.
The users within the OU are not displayed.
o ID - This displays the ID for the user or OU.
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o Estimated Users - This displays the estimated number of users in the corresponding
OU. For individual users, this is always 1. However, for OUs, this is the current
estimated number of users who require the training. This indicates the number of
instances of the training that are required.
o Training - This displays the name of the training that has been identified as a need for
the corresponding user or OU.
o Training Type - This displays the training type that corresponds with the training need
(e.g., Material, Subject, and External Training) depending on the Training Plan
configuration.
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Training Plan - Plan Contributor and User Changes
When a Plan Contributor (Manager) is removed from the Plan Contributor (Manager) role,
any training plan needs that they have identified are stored and are visible on a new OnHold Training Needs page.
o If the Training Plan is expired before the contributor is removed, then the training needs
are not stored and they are not visible on the On-Hold Training Needs page.
When a user moves into a Plan Contributor (Manager) role in which a previous Plan
Contributor (Manager) had identified training needs, the new plan contributor inherits the
previous Plan Contributor's training need information. This enables the new Plan
Contributor (Manager) to continue completing the training plan without needing to redo the
previous Plan Contributor's efforts.

Inherited Information
All training plan information is inherited by the new Plan Contributor, including the following
information:
o
o
o
o
o

User or Organizational Unit (OU) Name
Estimated Users
Approval Status
Denial Comments
Custom Field Data

If the new Plan Contributor (Manager) already has existing training needs, then the newly
inherited users and their training needs are automatically added to the existing training
plan. The total costs and hours are automatically updated to include the inherited training
needs.

User Moves to New Training Plan
If a user within a training plan moves into a new OU that is not included in the Training Plan
Availability, then any training needs that have been identified for the user are deleted and
cannot be restored. For example, if a user moves to a new position for which training needs
are not planned or are planned in a separate training plan, then the user's existing training
needs are deleted and they are not transferred to another training plan.
When a new user is created in the system and is automatically added to an existing training
plan, the user is not added to any existing training needs. However, the plan contributor can
choose to add the new user to existing or new training needs.
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On-hold Training Needs Considerations
o If a user is deactivated, all of their training plan needs are deleted. If a user is deleted
and added again, the needs are deleted and cannot be restored.
o The custom fields always save the value from the previous Plan Contributor (Manager).
o After the Plan Expiration date, the on-hold training needs are no longer restored. The
page is accessible and non-modifiable.

Restoring Considerations
o The new Plan Contributor (Manager) should initially exist in the Training Plan/Plan
Contributor Segment to be able to receive the on-hold needs.
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o OUs needs are not restored. This requires manual action from the Training Plan
Administrator.
o After the Plan Expiration date, no automatic movements occur anymore.
o The Training Hours and Costs are always updated with the new Plan Contributor
(Manager) LO details availability (including currency).
o The OU's default number of users is not recalculated after new users have been added
to new Plan Contributors (Managers). This is only applicable if planning for OUs.
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Web Services - Learning
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Enhanced Certification Transcript Web Service (SOAP)
With this enhancement, the following fields are now included in the Certification Transcript
web service response:
o Certification Status - This returns the user's status for the certification.
o Earned Credits (within Section Item) - This returns the user's earned credits for the
certification section.
The status element within the CertSection element is now represented as null "<Status />"
instead of <status> Not Completed<status>. This is because there is not a status within a
certification section.
The Web Service Definition Language (WSDL) is updated to reflect this new element in the
request.
An administrator must have permission to view the user and the user's transcript.

Implementation
This Web Service is automatically available to all portals that have purchased it.
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Users - View

Grants ability to search for and view summary
Core
information about users in the portal, via the
Administration
Admin/Users screen. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and Users. This is an administrator
permission.

View Transcript Item

Grants ability to view details of learning objects
Learning that appear on the transcript (training record), by Administration
clicking on the name of the learning object. This
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, or User's Self.
This is an end user permission.

400

Cornerstone April 2016 Release Notes: What's New for April 2016

Enhanced LO - Complete Web Service (SOAP)
With this enhancement, the following field is now included in the LO - Complete web service
request for online courses and tests:
o Score - This field is used to determine a pass or fail status for the learning object (LO).
The Web Service Definition Language (WSDL) is updated to reflect this new element in the
request.

Implementation
This Web Service is automatically available to all portals that have purchased it.
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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Get Details Web Service (REST)
With this enhancement, a new Get Details REST web service is now available. This web
service provides standard and custom field data for a learning object (LO) via REST Web
Services.

Input Parameters
This web service has the following input parameters:
DATA
FIELD

TYPE

DESCRIPTION

Actor ID

String

This is optional. This is the User ID of the administrator who
is requesting the data.

Object
ID

String

This is required. This is the ID of the LO for which the
administrator is requesting data.

Implementation
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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Global Search (LO) Web Service (REST)
With this enhancement, a new Global Search (LO) REST web service is now available. This
web service provides a list of training courses based on specific parameters via REST Web
Services.
An administrator must have permission to view and update the Course Catalog.

Input Parameters
This web service has the following input parameters:
DATA FIELD

TYPE

DESCRIPTION

Title

String

This is optional. This field enables the web service
to retrieve learning objects by title.

Description

String

This is optional. This field enables the web service
to retrieve learning objects by description.

Training Type

Enum

This is optional. This field enables the web service
to retrieve learning objects by training type.
Multiple LO types should be separated by commas.
The following options are available:
o
o
o
o
o
o
o
o
o

Course - This refers to online classes
SCO - This refers to quick courses
Curriculum
Library
Material
Test
Event
Video
SocialLearningProgram - This refers to
programs

Subject

String

This is optional. This field enables the web service
to retrieve learning objects by subject.

Provider

String

This is optional. This field enables the web service
to retrieve learning objects by provider.

Languages

String

This is optional. This field enables the web service
to retrieve learning objects by language.

Skills

String

This is optional. This field enables the web service
to retrieve learning objects by skill.

Location

String

This is optional. This field enables the web service
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DATA FIELD

TYPE

DESCRIPTION
to retrieve learning objects by location.

Competency

String

This is optional. This field enables the web service
to retrieve learning objects by competency.

Instructor

String

This is optional. This field enables the web service
to retrieve learning objects by instructor ID.

From Date

Date/Time

This is optional. This is the start of the time frame
during training items may start. The required
format is YYYY-MM-DD

To Date

Date/Time

This is optional. This is the end of the time frame
during training items may start. The required
format is YYYY-MM-DD

OU ID

String

This is optional. This field enables the web service
to retrieve learning objects by OU ID.

OU Type

String

This is optional. This field enables the web service
to retrieve learning objects by OU type.

User ID

String

This is optional. This field enables the web service
to retrieve learning objects by user ID.

Page Number

Number

This is optional. Each page number represents a
batch of up to 25 records. If this value is not
present or if it is set to 1, then the first 25 records
are returned. If this is set to 2, then the next 25
transcript records are returned (26-50).

Implementation
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.

Security
The following existing permissions apply to this functionality:
PERMISSION
NAME
Course Catalog Update

PERMISSION DESCRIPTION

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,

CATEGORY

Learning Administration
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Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.
Course Catalog View

Grants access to view the learning objects in the
course catalog. This permission can be
constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, and User's LO Availability. This is an
administrator permission.

Learning Administration
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Transcript and Task Web Service (REST)
With this enhancement, a new Transcript and Task REST web service is now available.
This web service provides transcript and task data for users via REST Web Services. The
service can return all transcript information for a user or only information for a specific
learning object (LO).

Input Parameters
This web service has the following input parameters:
DATA
FIELD

TYPE

DESCRIPTION

User ID String

This is required. This is the user ID of the user whose
transcript information is being requested.

LO ID

This is optional. This is the ID of a specific LO. When this is
specified, the web service returns information on a specific LO.

Enum

Implementation
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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Transcript Search Web Service (REST)
With this enhancement, a new Transcript Search REST web service is now available. This
web service provides transcript data for users based on a provided transcript status within a
specified time period via REST Web Services.

Input Parameters
This web service has the following input parameters:
DATA FIELD

TYPE

DESCRIPTION

LO Type

String

This is optional. This field enables the web service to
retrieve learning objects by type.

Modification
Start Date

String

This is optional. This is the start of the time frame
during which transcript modifications are retrieved. A
maximum time frame of 24 hours can be specified. The
required format is YYYY-MM-DDTHH:MM:SS

Modification
End Date

String

This is optional. This is the end of the time frame during
which transcript modifications are retrieved. A
maximum time frame of 24 hours can be specified. The
required format is YYYY-MM-DDTHH:MM:SS

Status

String

This is required. This field enables the web service to
retrieve learning objects by status.

User ID

String

This is optional. This is the User ID of the user for
whom the transcript data is being retrieved.

Page Number

String

This is optional. Each page number represents a batch
of up to 50 transcript records. If this value is not
present or if it is set to 1, then the first 50 records are
returned. If this is set to 2, then the next 50 transcript
records are returned (51-100).

Implementation
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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Increase Character Limit for Question User Comment
With this enhancement, when running Form Management Custom Reports or Onboarding
Custom Reports, the character limit for the Question User Comment field is increased
from 500 to 1200. The field appears in the Form Template section of these reports.
Prior to this enhancement, any part of a user's responses that went over 500 characters did
not display in the report output.
Related April '16 Enhancement Note: As part of a separate enhancement for the April '16
release, the name of the Form Template section is changing to Training Form Template. In
addition, the permission names are changing. See Form Management Custom Report on
page 524 for additional information.

Security
The following existing permissions apply to this functionality:
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY
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(missing or bad snippet)(missing or bad snippet)LO

Availability and Added

Fields in Learning
With this enhancement, Learning fields are added to multiple sections of custom reports.
In addition, the availability criteria defined on the Availability tab in the Course Catalog can
now be reported on in custom reports. The following fields are added to the Training section
to report on availability in custom reports:
o
o
o
o
o
o

Availability Type
Training Availability
Training Availability Include Subordinates
Training Availability Pre-Approved
Training Availability Register Upon Approval
Training Request Form

Certifications Fields
The following field is added to the Certifications section:
In addition, certification fields are updated to display current and past versions of the
certification for a user, as well as the status.

Training Fields
The following fields are added to the Training section:

Transaction Fields
The following fields are added to the Transaction section:

Transcript Fields
The following fields are added to the Transcript section:
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Mobile
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Apply with Mobile - Pre-screening Questions
Prior to this enhancement, if pre-screening questions were included in an application
process, applicants could not fully complete the application using the mobile application. As
a result, applicants were required to finished the application using the web application.
With this enhancement, pre-screening questions can now be completed using the mobile
application, which enables more applicants to complete applications using the mobile
application.
All pre-screening questions that are supported on the web application are supported on
mobile devices, including True/False, Yes/No, Multiple choice, text input, and essay.
If a user completes and saves a section, such as the Pre-screening section, within the
application workflow on the web application or on a mobile device, the applicant can return
and complete the application on a different device.

Use Cases
1. John wants to apply for a job at a retail store. While he is at the store, he sees a link to
their career site.
2. When he accesses the career site, it is mobile enabled. John finds the position to which
he wants to apply and starts the application.
3. John is prompted to complete some multiple choice pre-screening questions.
4. After answering the questions, John adds his resume and then submits his application.
5. The application is now visible to the recruiter at the retail store.

Considerations
Applicants must complete all of the pre-screening questions within the application in order
for their responses to be saved. If the applicant exits the application before answering all of
the questions, then their responses will not be saved.
Forms and assessments cannot be completed using the mobile application. As a result,
mobile users cannot fully complete an application that includes forms or assessments.

Implementation
This functionality is automatically enabled for career sites that have enabled a mobile site.
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Apply with Mobile - Upload Document
Prior to this enhancement, applicants could not upload documents when applying for a
position using the mobile application. As a result, applicants were required to manually
enter their resume or cover letter information using their mobile device.
With this enhancement, applicants can now upload documents to their application, such as
resumes and cover letters. Users can upload documents using Box, Dropbox, Google
Drive, or iCloud. Applicants with a Windows device can upload documents using OneDrive.
The file size limit is 5MB, and the following file types are supported:
o
o
o
o

.pdf
.doc
.docx
.txt

Workflow

Use Cases
1. Sandra visited a career fair. While at the career fair, she decided to apply for a position
using her mobile device.
2. Sandra visits the career site and clicks the URL for the position. She sees a section to
upload a resume and a cover letter.
3. Because she already has an up-to-date resume and cover letter on her Dropbox
account, she is able to quickly upload these documents from Dropbox to her
application.
4. After uploading the documents, she completes and submits the application from her
mobile device.
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Considerations
Applicants must have the latest operating system (OS) installed on their mobile device.
Because applicants are uploading documents from a file management tool (e.g., Dropbox,
Google Drive), applicants must have a file management tool installed on their mobile device
in order to use this functionality.
Documents that are uploaded via a mobile device are not parsed.
Additional attachments beyond a resume and cover page cannot be uploaded.

Implementation
This functionality is automatically enabled for career sites that have enabled a mobile site.
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Performance
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Custom Employee Relationships in Performance
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Custom Employee Relationships in Performance
Within the system, administrators can define custom employee relationships such as Dotted
Line Manager or Secondary Manager. These custom relationships can be used in various
areas of the system, such as performance reviews, compensation, and custom approval
workflows for Learning.
With this enhancement, custom relationships can constrain the Snapshot - Development
Plans, Snapshot - Reviews, Snapshot - Competencies, and Feedback - View and Post
permissions using the custom employee relationships defined in their portal. These
constraints can be applied to either individual permissions or as general constraints within a
security role.

Use Case
Lisa is a Quality Manager at a manufacturing plant, and she is looking to identify and
improve performance issues with employees at her manufacturing plant. She is able to view
the Snapshot: Reviews page for employees at her manufacturing plant, which enables her
to review users' performance reviews scores. She is also able to view the Snapshot:
Development Plans page to view the progress of employees' development plans to see how
they are progressing in their development.

Considerations
Custom relationships are not displayed in the Team section of the Universal Profile - Bio About page.

Implementation
Upon release, this functionality is automatically enabled for organizations using
Performance, Universal Profile: Snapshot, and custom employee relationships. The
availability of the Employee Relationships functionality is controlled by a backend setting.
To enable this functionality, contact Global Product Support. For more information about
this functionality, contact your Client Success Manager.

Glossary
o Employee Relationship - This refers to any custom relationship that is defined within the
system. These employee relationships enable organizations to customize workflows in
the system to match their organizational needs. Examples of custom employee
relationships are Human Resources Business Partners or Tertiary Managers.

Security
The following existing permissions apply to this functionality and can now be constrained by
Employee Relationship. The permission descriptions will be updated when this functionality
is released to Live portals.

416

Cornerstone April 2016 Release Notes: What's New for April 2016

Goals Redesign Enhancements
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Goals Redesign Enhancements
With this enhancement, the following enhancements have been made to the redesigned
Goals functionality:
o SMART Goal Wizard - This wizard is now available for organizations using the
redesigned Goals functionality. The appearance of the wizard is improved, but the
functionality is not changed.
o Total Goal Weight - Administrators can now configure Goal Preferences so that the total
weight for all of a user's goals cannot exceed 100% for the current goal period.
o View Details for Manager Goals and Alignable Goals - Administrators can now prevent
users from viewing goal Progress, Comments, and Attachments of manager goals and
goals that are available for alignment.
o Universal Profile: Actions - When a user manages a goal from the Universal Profile:
Actions page, the user is able to manage the goal from within the Actions space.
Previously, users were directed to the Snapshot space, which was an issue for
organizations that did not have Snapshot enabled.
o Copy Details when Aligning - When aligning with another goal, users now have the
option to copy the details of the goal to their new goal.
o Goal Status Drop-down - If the Progress field is disabled and a goal has no tasks or
targets, users can now update the goal status using a drop-down menu on the Manage
Goals page.

Implementation
Upon release, this functionality is automatically enabled in Stage portals.
All organizations using the Goals functionality will be automatically upgraded to the
redesigned Goals functionality with the April 2016 Release.

Security
The following existing permissions apply to this functionality:
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Goal Preferences - General
With this enhancement, an additional option is now available in the General section of the
Goal Preferences page.
This enhancement is only available to organizations using Redesigned Goals functionality.
To manage Goal Preferences, go to ADMIN > TOOLS > PERFORMANCE MANAGEMENT
> GOAL PREFERENCES.
Permissions
PERMISSION
NAME
Goal Preferences Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage Goal Preferences, where Performance various goal features can be enabled or disabled Administration
according to the needs of the organization. This
permission can be constrained by OU and User's
OU. This is an administrator permission.

Allow users to see Progress, Comments and Attachments of manager goals
and alignable goals
This option is unselected by default. Select this option to allow users to view Progress,
Comments, and Attachments for any of the user's manager's goals and all goals with which
the user can align. For example, an organization may choose to prevent users from viewing
this information in order to preserve privacy in some higher-level objectives as well as any
private status comments that may be added to a goal.
When this option is not selected, users are not able to view goal progress and any
comments or attachments that are added to their manager's goals and any available goal
with which the user is able to align.
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Goal Preferences - Time Periods
With this enhancement, an additional option is now available in the Time Periods section of
the Goal Preferences page.
This enhancement is only available to organizations using Redesigned Goals functionality.
To manage Goal Preferences, go to ADMIN > TOOLS > PERFORMANCE MANAGEMENT
> GOAL PREFERENCES.
Permissions
PERMISSION
NAME
Goal Preferences Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage Goal Preferences, where Performance various goal features can be enabled or disabled Administration
according to the needs of the organization. This
permission can be constrained by OU and User's
OU. This is an administrator permission.

The following option is now available within the Default current goal period on Goals
page option:
o Total weight of goals in current period cannot exceed 100% - This option is
unchecked by default. When this option is selected, users cannot set goal weights so
that the total weight of all goals for the current period cannot be more than 100%. By
limiting total goal weight for the current period, administrators can ensure goal weights
are aligned with employee review processes where stretch goals are not common.
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Goal - Create - Wizard
When creating a goal, the SMART Wizard guides users through the goal creation process,
helping them to create specific, measurable, actionable, relevant, and timely goals.
Prior to this enhancement, the SMART Wizard was not available to organizations using the
redesigned Goals functionality.
With this enhancement, the SMART Wizard is now available to organizations using the
redesigned Goals functionality.
A WIZARD button is now available in the upper-right corner of the Create Goals page.
Note: The SMART Wizard is only available to users if it is enabled by the administrator in
Goal Preferences.
To create a goal, go to PERFORMANCE > GOALS. Then click the CREATE button.
To edit a goal, go to PERFORMANCE > GOALS. Click the Actions menu icon
right of the appropriate goal and select Edit.
Permissions
PERMISSION
NAME
Goals - Create

PERMISSION DESCRIPTION

to the

CATEGORY

Grants ability for user to create goals for self (and
Performance
direct and indirect reports if a manager). The
permission constraints determine for whom the user
can create goals. This permission can be
constrained by Employee Relationship, OU, User's
OU, and User Self and Subordinates. This is an end
user permission.
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Goal - Create Using SMART Wizard
With this enhancement, the appearance of the wizard is improved, but the functionality of
the wizard is unchanged.
The SMART Wizard guides users through the goal creation process, helping them to create
specific, measurable, actionable, relevant, and timely goals. The SMART Wizard contains
five sections that cover the different aspects of the goal. Each section must be completed in
order.
If any information is entered on the Create Goal page before opening the SMART Wizard,
then that information is automatically pre-populated in the SMART Wizard.
To create a goal, go to PERFORMANCE > GOALS. Then click the CREATE button.
To create a goal using the SMART Wizard, click the WIZARD button in the upper-right
corner of the Create Goals page.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Create Employee
Goals - Align

When creating a goal for users other than self or
Performance subordinates, this permission allows
Administration
administrators to align the goal with other goals.
The constraints on this permission determine with
which employees the administrator can align the
goal. This permission works in conjunction with
the Create Employee Goals permission. This
permission can be constrained by OU, User's OU,
and User. This is an administrator permission.

Goals - Create

Grants ability for user to create goals for self (and
Performance
direct and indirect reports if a manager). The
permission constraints determine for whom the user
can create goals. This permission can be
constrained by Employee Relationship, OU, User's
OU, and User Self and Subordinates. This is an end
user permission.

Specific
In this section, you will enter a clear and meaningful title and description for your goal.
o Title - Enter the title for your goal that will appear on the My Goals page as well as
anywhere else your goal is visible. This field is limited to 1,000 characters.
o Description - Enter an overview of the goal, including any objectives or parameters.
This field can be formatted using the text formatting buttons and is limited to 10,000
characters.
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Measurable
In this section, you will make your goal measurable by adding quantifiable targets, which
will help to make sure your goal remains on track for completion.
To add a target to the goal, click the ADD TARGETS button. See Goal - Create/Edit - Add
Task Target (New Design).

To edit a target, click the Edit icon

to the right of the appropriate target.
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To delete a target, click the Delete icon

to the right of the appropriate target.

Actionable
In this section, you will make your goal actionable by adding tasks, which will help to make
sure you are taking the right steps to complete your goal.
To add a task to the goal, click the ADD TASKS button. See Goal - Create/Edit - Add Task
Target (New Design).
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To edit a task, click the Edit icon

to the right of the appropriate task.

To delete a task, click the Delete icon

to the right of the appropriate task.

Relevant
In this section, you will associate your goal with certain aspects of the company and weigh
its importance.
o Perspective - From the drop-down menu, select a perspective. The perspective is used
to specify to which aspect of the organization your goal relates. A goal can only be
associated with one perspective. Perspectives are defined by system administrators.
o Category - From the drop-down menu, select all categories that are appropriate for
your goal. Categories are used to further define the type of goal you are creating. A goal
can have multiple categories. Categories are defined by system administrators.
o Weight - Enter a weight for your goal between 0 and 100. Weighting allows you to place
a greater value on certain goals. For example, if you have four goals for a review period
and they are valued equally, you should assign them each a weight of 25%. Similarly, if
one goal is more important than the others, you may give that goal a weight of 40% and
assign the other three a weight of 20%. The heavier weighted goal will count more
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towards your overall goal progress than the other three. Depending on a backend
setting, the weight percentage field may accept up to two decimal places.

Timely
In this section, you will specify a time frame for achieving your goal.
o Start Date and Due Date - Click the Calendar icon to select the date on which the
goal should be started and the date by which the goal should be completed. The Start
Date must be before the goal Due Date. If this goal is being aligned to another goal,
these dates must be within the Start and Due Date of the parent goal. When you view
your goals or run goal related reports, the Start Date and Due Date are used to
determine which goals are included. If any part of a goal falls within the specified time
frame, the goal will display.
Click DONE to finish the Wizard and create the goal. The information you added is now
included in the Create/Edit Goal screen. See Goal - Create/Edit (New Design).
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Universal Profile - Actions - Manage Goal
Prior to this enhancement, when a user selected the Manage option for a goal within the
Universal Profile - Actions page, the user was directed to the Manage Goals page within the
Universal Profile - Snapshot page. For organizations that did not have Snapshot enabled,
the Manage option was not available on the Actions page.
With this enhancement, when a user selects the Manage option for a goal within the
Universal Profile - Actions page, the user is directed to a Manage Goals page that exists
within the Actions page. This enables users to manage their goals from the Universal
Profile if Snapshot is not enabled.
This functionality applies to all organizations using the redesigned Goals functionality,
including those that have Snapshot enabled.
To access the Action Items, go to HOME > UNIVERSAL PROFILE. Then, click the Actions
tab.
To access another user's Universal Profile - Bio page, click the user's photograph from any
page within Universal Profile or from Global Search. From there, you can access the user's
Action Items page by clicking the Action Items tab. Users can view the Action Items page of
other users who are within their permission to view the Action Items page.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Action Items - EPM

Grants ability to view and take action upon
Universal
Performance (EPM) items on the Action Items page
Profile
and in the Your Action Items widget. This permission
can be constrained by OU, User's OU, User's Self,
and User's Self and Subordinates. This is an end user
permission.

View Goals

Grants ability to view own goals and (depending on Performance
role and settings) goals of others (manager's visible
goals, direct subordinate's goals, company goals,
division goals). This permission can be constrained
by Employee Relationship, OU, User's OU, and
User Self and Subordinates. This is an end user
permission.

When a user selects the Manage option for a goal on the Universal Profile - Actions page,
they are directed to a Manage Goals page.
The functionality on this page is unchanged from other Manage Goals pages.
When the user clicks the DONE button, they are returned to the Actions page.
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Goal - Create - Align with Another Goal
Prior to this enhancement, administrators could configure whether or not tasks and targets
were automatically inherited when a user aligned their goal with another goal. Once the
user inherited the tasks and targets, they were able to edit or delete them within their own
goal.
With this enhancement, users now have the option to copy certain additional details from
the goal with which they are aligning to the goal they are creating or editing. When users
choose to copy the goal's information, the copied information overwrites any information
that may have been in the fields.
To create a goal, go to PERFORMANCE > GOALS. Then click the CREATE button.
To edit a goal, go to PERFORMANCE > GOALS. Click the Actions menu icon
right of the appropriate goal and select Edit.

to the

To align a goal with another goal, click the ALIGN GOAL button within the Alignment
widget.
To edit the goal alignment, click the Edit link above the Alignment widget.
Permissions
PERMISSION
NAME
Create Employee
Goals - Align

PERMISSION DESCRIPTION

CATEGORY

When creating a goal for users other than self or
Performance subordinates, this permission allows
Administration
administrators to align the goal with other goals.
The constraints on this permission determine with
which employees the administrator can align the
goal. This permission works in conjunction with
the Create Employee Goals permission. This
permission can be constrained by OU, User's OU,
and User. This is an administrator permission.

The following option is now available within the Alignment pop-up:
Overwrite the following fields when aligning: Title, Description, Success Descriptors,
Weight - When this option is selected, the Title, Description, Success Descriptors, and
Weight of the selected goal will overwrite the information that you have entered for your
goal once you align with the selected goal. Also, the Start Date, Due Date, and Goal
Perspective are overwritten by the information from the selected goal.
o Category - The Category field is appended with categories from the aligned goal.
o Visibility - The Visibility settings are not overwritten by the aligned goal.
o Attachments - The Attachments are not overwritten by the aligned goal.
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Goal - Create/Edit- Total Goal Weight
With this enhancement, administrators can now configure Goal Preferences so that the total
weight for all of a user's goals cannot exceed 100% for the current goal period. When this
setting is enabled, the total weight of all of a user's goals must be less than or equal to
100%. If a user's total goal weight is at or above 100% and the user creates a new goal, the
user is able to create the goal if the goal weight is set to 0%. This enables the user to save
the goal and then adjust the weights of all necessary goals.
This is enforced when creating new goals and when editing existing goals. The total goal
weight limit is not enforced when a goal is saved as a draft.
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Goal - Manage - Status Drop-down
Prior to this enhancement, if the Progress field was disabled in Goals Configuration and a
goal had no tasks or targets, then there was no way for a user to update the status of their
goal.
With this enhancement, if the Progress field is disabled in Goals Configuration and a goal
has no tasks or targets, then a Status drop-down is available when managing the goal.
Users can select one of the statuses that are configured in Goal Preferences.
Goal status is automatically saved when you select a new status.
To create a goal, go to PERFORMANCE > GOALS. Then click the CREATE button.
To edit a goal, go to PERFORMANCE > GOALS. Click the Actions menu icon
right of the appropriate goal and select Edit.
Permissions
PERMISSION
NAME
Goals - Create

PERMISSION DESCRIPTION

to the

CATEGORY

Grants ability for user to create goals for self (and
Performance
direct and indirect reports if a manager). The
permission constraints determine for whom the user
can create goals. This permission can be
constrained by Employee Relationship, OU, User's
OU, and User Self and Subordinates. This is an end
user permission.
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Goals Redesign Auto-Upgrade
With the February 2016 release, Goals were redesigned for a stronger and more seamless
process.
With this enhancement, all portals using Goals are automatically upgraded with the new
Goals redesign.
o Security roles, permissions, and navigation pages are not impacted by the autoupgrade.

Considerations
The new design applies to both new and in progress goals.
The Administrative pages like Goals Preferences, Configuration, Library, and
Perspectives/Categories are not changed.
Because the goal creation process has changed, it is important that the directions that are
customized in the Goal Creation Administration section of the Goals Configuration page are
updated to reflect the new process.

Implementation
With this release, all portals are automatically upgraded to the new Goals redesign
functionality.
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Goals Team View - Excel Export
Prior to this enhancement, managers were able to export their team's goals to a PDF. This
option only exports the goals that are currently displayed. If the manager has not expanded
any direct reports, then this option is not available because no goals are displayed.
With this enhancement, administrators now have the option to export all of their team's
goals to an Excel (Unicode .csv) file for the time period that is being viewed.
The following option is now available in the Options drop-down menu when viewing the
Team Goals page:
o Download Excel - Select this option to export all of the team goals for the selected time
period to an Excel document. This option exports the goals within the selected time
period for all team members, even if the user's card is not expanded.

Implementation
Upon release, this functionality is automatically enabled in Stage portals.
All organizations using the Goals functionality will be automatically upgraded to the
redesigned Goals functionality with the April 2016 Release.

Security
The following existing permission applies to this functionality:
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Performance Features in Action Items
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Performance Features in Action Items
Prior to this enhancement, a user would have to navigate to multiple places in the system to
complete some of the performance-related tasks and approvals.
With this enhancement, a user can complete Goal, Development Plan, Peer, and Training
Form approvals from the Request tab within Universal Profile: Actions. Also, a user can
view Observation Checklist and Training Form tasks in the Universal Profile: Actions page.
This allows the user to more efficiently complete tasks and provide approvals.

Considerations
Observation Checklist approvals are not included in this enhancement.

Implementation
This functionality is automatically enabled for all organizations using the Performance
module and Universal Profile: Actions.

Security
The following existing permissions apply to this functionality:
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Universal Profile - Actions
With this enhancement, the following actions are now available on the Universal Profile:
Actions page:
o Observation Checklists
o Training Forms
In order to support this, the Action Type filter on the Actions page now contains the
following filter options:
o Observation Checklists
o Training Forms
To access the Action Items, go to HOME > UNIVERSAL PROFILE. Then, click the Actions
tab.
Permissions
PERMISSION
NAME
Action Items - EPM

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view and take action upon
Universal
Performance (EPM) items on the Action Items page
Profile
and in the Your Action Items widget. This permission
can be constrained by OU, User's OU, User's Self,
and User's Self and Subordinates. This is an end user
permission.

440

Cornerstone April 2016 Release Notes: What's New for April 2016

Actions - Observation Checklists
With this enhancement, observation checklist tasks are now available from the Universal
Profile: Actions page.
An observation checklist task appears in the Actions page for users in the following
scenarios:
o If a validator/verifier exists for a checklist, then the checklist is available to validators.
o If no validator/verifier exists for a checklist, then the checklist is available to the
manager who is able to validate/verify.
o When the manager adds a verifier or co-planner, the observation checklist
becomes available in the verifier or co-planner's Actions page and it is no longer
available in the manager's Actions page.
To access the Action Items, go to HOME > UNIVERSAL PROFILE. Then, click the Actions
tab.
Permissions
PERMISSION
NAME
Action Items - EPM

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view and take action upon
Universal
Performance (EPM) items on the Action Items page
Profile
and in the Your Action Items widget. This permission
can be constrained by OU, User's OU, User's Self,
and User's Self and Subordinates. This is an end user
permission.

When an observation checklist action item is displayed on the Action Items page, the
following is displayed for each action item:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to open the Manage
Checklist page with the page filtered so that only checklists from the selected task are
displayed. On the Manage Checklist page, the Checklist search filter is not available
because the page is automatically filtered by the selected checklist.
o Due Date - This displays the earliest due date for any item within the checklist.
o Remaining - This displays the number of checklists within the task that have not yet
been completed.
o Priority Flag - This button allows users to mark action items as high priority. Priority can
be helpful as a visual indicator to users. Also, action items can be filtered by priority
from the Sort drop-down at the top of the page. When the priority flag is not selected, it
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is gray
is red

. When the priority flag is selected, the action item is high priority and the flag
.

The following options are available from the action item drop-down menu:
o Launch - Click this option to open the Manage Checklist page with the page filtered so
that only checklists from the selected task are displayed. On the Manage Checklist
page, the Checklist search filter is not available because the page is automatically
filtered by the selected checklist.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Actions - Training Forms
With this enhancement, training form tasks are now available from the Universal Profile:
Actions page.
To access the Action Items, go to HOME > UNIVERSAL PROFILE. Then, click the Actions
tab.
Permissions
PERMISSION
NAME
Action Items - EPM

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view and take action upon
Universal
Performance (EPM) items on the Action Items page
Profile
and in the Your Action Items widget. This permission
can be constrained by OU, User's OU, User's Self,
and User's Self and Subordinates. This is an end user
permission.

When a training form item is displayed on the Action Items page, the following is displayed
for each action item:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to open the training
form.
o Due Date - This displays the due date for the training form.
o Status - This displays the current status of the action item.
o Priority Flag - This button allows users to mark action items as high priority. Priority can
be helpful as a visual indicator to users. Also, action items can be filtered by priority
from the Sort drop-down at the top of the page. When the priority flag is not selected, it
is gray
is red

. When the priority flag is selected, the action item is high priority and the flag
.

The following options are available from the action item drop-down menu:
o Launch - Click this option to open the Manage Training Forms page.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Universal Profile - Actions - Requests
With this enhancement, the following requests are now available on the Requests tab of the
Universal Profile: Actions page:
o
o
o
o

Goal
Development Plan
Peers
Training Form

In order to support this, the Request Type filter on the Actions page now contains the
following filter options:
o
o
o
o

Development Plan Approval
Form Approval
Goal Approval
Peer Approval

In the Status filter, all pending statuses for goals (i.e., Pending Approval, Pending
Modification Approval, and Pending Cancellation Approval) are included in the Pending
status.
In the Status filter, all pending statuses for development plans (i.e., Pending Acceptance
Approval, Pending Completion Approval, and Pending Cancellation Approval) are included
in the Pending status.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.

CATEGORY

Universal
Profile
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Actions - Requests - Development Plans
From the Requests tab, approvers can access their pending approval requests, view
completed requests, and view approval progress. The tab only displays for users with
permission to view request items.
With this enhancement, approvers can now view development plan approval requests from
the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.
Emails
EMAIL NAME
EMAIL DESCRIPTION

CATEGORY

Universal
Profile

ACTION
TYPE

Development Plan
Approval Denied

This email is triggered when a development plan
Performance
approval request is denied. The user receives the Management
email stating that their Development Plan Approval
Request is denied.

Development Plan
Approval Granted

This email is triggered when a user's development
plan is approved. This email is sent to the user who
submitted the plan.

Performance
Management

When a development plan approval request is displayed on the Requests tab, the following
is displayed for each request:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to view the user's
development plan.
o Date Submitted - This displays the date on which the item was submitted for approval.
o Status - This displays the current status of the request.
o Submitted by - This displays the name of the user who submitted the development plan
for approval.
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Approve
To approve the request, click the APPROVE button
. This commits your approval
decision for that development plan. The development plan's status is updated to Approved.
If the email is configured, then this action triggers an email notification to alert the user that
their development plan was approved.

Deny
To deny the request, click the DENY button
. If the email is configured, then this action
triggers an email notification to alert the user that their development plan was denied.

Options
The following options may be available from the action item drop-down menu:
o View - Select this option to view the user's development plan. After reviewing the plan,
click the BACK button to return to the Requests page.
o Edit - This option may be available depending on the configuration of the development
plan. Select this option to edit the user's development plan.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Actions - Requests - Goals
From the Requests tab, approvers can access their pending approval requests, view
completed requests, and view approval progress. The tab only displays for users with
permission to view request items.
With this enhancement, approvers can now view goal approval requests from the Requests
tab of the Universal Profile: Actions page.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION NAME

PERMISSION DESCRIPTION

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.
Emails
EMAIL NAME
EMAIL DESCRIPTION

CATEGORY
Universal
Profile

ACTION
TYPE

Goal Approved

This email is triggered when a user submits a goal or Performance
requests to cancel a goal and the request is approved Managemen
by the approver.
t

Goal Denied

This email is triggered when a user submits a goal or Performance
requests to cancel a goal and the request is denied by Managemen
the approver.
t

When a goal approval request is displayed on the Requests tab, the following is displayed
for each request:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to open the View Goal
or Edit Goal page. The ability for an approver to edit a user's goal is configured by the
administrator.
o Date Submitted - This displays the date on which the item was submitted for approval.
o Goal Owner - This displays the name of the user who submitted the goal for approval.
o Status - This displays the current status of the request.
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Approve
To approve the request, click the APPROVE button
. This commits your approval
decision for that goal. The goal's status is updated to Approved. If the email is configured,
then this action triggers an email notification to alert the user that their goal was approved.

Deny
To deny the request, click the DENY button
. This opens a Deny Request pop-up, in
which you must provide comments regarding why the goal is denied. Within the pop-up,
enter the reason for denying the goal and click the DENY button. If the email is configured,
then this action triggers an email notification to alert the user that their goal was denied.

Options
The following options may be available from the action item drop-down menu:
o View - This option is available the goal is locked or if managers and approvers are not
allowed to edit an employee's goal. This option opens a read-only version of the user's
goal. The approver is able to add comments and attachments to the goal. The option to
Approve or Deny the goal is available when viewing the goal. See Goal - Approve or
Deny on page 455 for additional information.
o Edit - This option is available if managers and approvers are allowed to edit an
employee's goal. This option opens the Edit Goals page for the goal. See Goal Create/Edit (New Design).

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Actions - Requests - Peers
From the Requests tab, approvers can access their pending approval requests, view
completed requests, and view approval progress. The tab only displays for users with
permission to view request items.
With this enhancement, approvers can now view peer approval requests from the Requests
tab of the Universal Profile: Actions page.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION
NAME
Bio About - View

PERMISSION DESCRIPTION

CATEGORY

Enables user to view the Bio page for users within
Universal
their permission constraints. This permission must be Profile
enabled to view the Transcript page within Universal
Profile. If a user does not have this permission and
they click a person's name or user photo within the
Universal Profile, then the Bio page will not open. This
permission can be constrained by Employee
Relationship, OU, User's OU, User's Direct Reports,
User Self and Subordinates, and User.

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.

Universal
Profile

When a peer approval request is displayed on the Requests tab, the following is displayed
for each request:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to view the Universal
Profile - Bio page for the peer. The user's Bio page cannot be viewed if the approver
does not have permission to view the peer's Bio page or if the peer is an external user.
o Date Submitted - This displays the date on which the item was submitted for approval.
o Group - This displays the peer group to which the peer is being added.
o Submitted by - This displays the name of the user who submitted the peer for approval.
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Approve
To approve the request, click the APPROVE button
. This commits your approval
decision for that peer. If the email is configured, then this action triggers an email
notification to alert the user that their development plan was approved.

Deny
To deny the request, click the DENY button

.

Options
The following options may be available from the action item drop-down menu:
o View - Select this option to view the Universal Profile - Bio page for the peer. The user's
Bio page cannot be viewed if the approver does not have permission to view the peer's
Bio page or if the peer is an external user.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Actions - Requests - Training Forms
From the Requests tab, approvers can access their pending approval requests, view
completed requests, and view approval progress. The tab only displays for users with
permission to view request items.
With this enhancement, approvers can now view training form approval requests from the
Requests tab of the Universal Profile: Actions page.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.
Emails
EMAIL NAME
EMAIL DESCRIPTION

CATEGORY

Universal
Profile

ACTION
TYPE

Training Form
Approved

User's training form marked Approved by an
Approver.

Training Form
Management

Training Form
Denied

User's training form marked Denied by an Approver. Training Form
Management

When a training form approval request is displayed on the Requests tab, the following is
displayed for each request:
o Color Strip - The left edge of the action item icon is color coded to represent proximity to
the due date of the action item. For example, if the action item due date is past due,
then the color strip is red to indicate that action is required immediately. If an action item
due date is not eminent, then the color strip is green to indicate that action is not
required immediately. See the Color Strip Key section below for additional information.
o Title - This displays the action item title. Click the action item title to view the user's
training form.
o Date Submitted - This displays the date on which the item was submitted for approval.
o Status - This displays the current status of the request.
o Submitted by - This displays the name of the user who submitted the training form for
approval.
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Approve
To approve the request, click the APPROVE button
. This commits your approval
decision for that training form. The training form's status is updated to Approved. If the
email is configured, then this action triggers an email notification to alert the user that their
training form was approved.

Deny
To deny the request, click the DENY button
. If the email is configured, then this action
triggers an email notification to alert the user that their training form was denied.

Options
The following options may be available from the action item drop-down menu:
o View - Select this option to view the user's training form. After reviewing the form, click
the BACK button to return to the Requests page.

Color Strip Key
The following colors are available:
o Red - Due today or past due
o Orange - Due within the next seven days, not including today
o Green - Due after seven days
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Goal - Approve or Deny
Approvers can approve or deny a goal from the Requests tab of the Universal Profile:
Actions page. When viewing a goal approval request, users may have the option to view or
edit the goal. The availability of these options is based on whether the goal is locked and
whether the approver or manager is able to edit the user's goal.
When viewing or editing a user's goal from the Requests tab of the Actions page, the user
can approve or deny the goal from this page. The following options are available at the
bottom of the page:
o APPROVE - Click this button to approve the goal. This commits your approval decision
for that goal. The goal's status is updated to Approved. If the email is configured, then
this action triggers an email notification to alert the user that their goal was approved.
o DENY - Click this button to deny the goal. This opens a Deny Request pop-up, in which
you must provide comments regarding why the goal is denied. Within the pop-up, enter
the reason for denying the goal and click the DENY button. If the email is configured,
then this action triggers an email notification to alert the user that their goal was
approved. Note: If the approver edited the goal prior to denying it, then the approver's
changes are discarded.
o CANCEL - Click this button to exit the page without approving or denying the goal and
return to the previous page.
To view approval requests, go to HOME > UNIVERSAL PROFILE > ACTIONS. Then, click
the Requests tab.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.
Emails
EMAIL NAME
EMAIL DESCRIPTION

CATEGORY

Universal
Profile

ACTION
TYPE

Goal Approved

This email is triggered when a user submits a goal Performance
or requests to cancel a goal and the request is
Management
approved by the approver.

Goal Denied

This email is triggered when a user submits a goal
or requests to cancel a goal and the request is
denied by the approver.

Performance
Management
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Performance Rewards and Recognition - Leaderboard
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Performance Rewards and Recognition - Leaderboard
As part of the Learning Reward and Recognition project, users are now able to track their
Feedback and Learning badges via a new My Badges page and engage in competition on a
new Leaderboard page. Rewards and Recognition gives employees the opportunity to
engage in competition and for the organization to motivate their employees to give and
receive feedback, learn, and develop through non-competitive awards. Points need to be
associated with Feedback Badges for users to be tracked on the Leaderboard.
Reporting and Data Load is targeted for a future Release.

Implementation
This functionality is automatically available to all organizations using the Performance or
Learning module. However, the Learning Badges and Points are only available to
organizations using the Learning module.
o For portals using the Learning and Performance modules, the Badges widget is driven
by a combination of Learning and Feedback badges. The Leaderboard widget is driven
by a combination of Learning points and points associated with Learning and Feedback
badges.
o For portals using the Performance module and not the Learning module, the Badges
widget is driven by Feedback badges. The Leaderboard widget is driven by points
associated with Feedback badges.
o Portals that are not using the Performance or Learning module cannot use the Badges
or Leaderboard functionality.
With regards to the Badges Widget on the Snapshot page, this widget is disabled by
default, and must be enabled via Snapshot General Preferences. Also, the Snapshot Badges permission is automatically added to the default System Administrator role and
must be granted to the appropriate users.
With regards to the Leaderboard Widget on the Snapshot page, this widget is disabled by
default, and must be enabled via Snapshot General Preferences. Also, the Snapshot Leaderboard permission is automatically added to the default System Administrator role
and must be granted to the appropriate users.
The Badge Preferences - Manage permission is renamed and is now titled Badge & Point
Preferences. Any users who previously had this permission are not affected. However, the
Badge & Point Preferences permission must be granted to administrators who need the
ability to create and manage badges and configure the Leaderboard.

Glossary
o Badge - A form of employee recognition that can be awarded when a user receives
positive feedback or when a user completes training. Badges may have an associated
point value. Depending on the portal configuration, users may be able to view their
badges via a widget on the Universal Profile - Snapshot page.
o Leaderboard - A user may receive points for completing training. Also, a user may be
awarded a badge by completing training or receiving positive feedback from another
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user. When a user receives a badge, they are also awarded any points that are
associated with the badge. The Leaderboard is a page within the Universal Profile Snapshot that enables users to view their total number of points, their overall points
ranking within the organization, and the top 10 users who have the most points.
o Point - A user may receive points for completing training. Also, a user may be awarded
a badge by completing training or receiving positive feedback from another user. When
a user receives a badge, they are also awarded any points that are associated with the
badge. Depending on the portal configuration, users may be able to view their points
and a points leaderboard via a widget on the Universal Profile - Snapshot page.

Security
The following new permissions apply to this functionality:
The Badge Preferences - Manage permission is renamed and is now titled Badge & Point
Preferences - Manage. This permission is now in the Core Administration category. Also,
the page to which this permission controls access, the Badge Preferences page, is
renamed and is now titled Badge & Point Preferences.
These changes will be reflected throughout Online Help when this functionality is released.
The following existing permissions apply to this functionality:
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Badge & Point Preferences - Badges (Performance)
With this enhancement, the points that are associated with a badge are now utilized
throughout the system. For example, a manager can view a subordinate's total number of
badges and points within the Universal Profile Snapshot and a Leaderboard page displays
employees with the most amount of points across the user's organizational units (OUs).
In order to support this enhancement, the Badge Preferences page is renamed and is now
titled Badge & Point Preferences. This page is accessible via Core Preferences and
Learning Preferences. Also, the Badge & Point Preferences page is divided into two tabs,
Badges and Points.
The Badges tab contains all of the functionality from the previously existing Badge
Preferences page.
See Badge & Point Preferences - Badges on page 312 for additional information.
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Badge & Point Preferences - Points (Performance)
With this enhancement, a new Leaderboard page is now available within Universal Profile:
Snapshot.
In order to support this enhancement, the Badge & Point Preferences page is divided into
two tabs, Badges and Points.
The Points tab of the Badge & Point Preferences page enables administrators to configure
the Leaderboard page that exists within Universal Profile: Snapshot.
See Badge & Point Preferences - Points on page 316 for additional information.
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Snapshot General Preferences (Performance)
With this enhancement, the points that are associated with a badge are now utilized
throughout the system. For example, a manager can view a subordinate's total number of
badges and points within the Universal Profile Snapshot and a Leaderboard page displays
employees with the most amount of badge points across the user's organizational units
(OUs).
In order to support this enhancement, administrators can now configure whether or not a
Badges and Leaderboard widget are available on the Snapshot page.
See Snapshot General Preferences on page 318 for additional information.
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Snapshot - Badges and Leaderboard Widgets (Performance)
With this enhancement, a Badges and Leaderboard widget can be enabled for the
Snapshot page.
See Snapshot - Badges and Leaderboard Widgets on page 326 for additional
information.
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Snapshot - My Badges (Performance)
The My Badges page enables users, managers, and administrators to view all of the
badges that the user has been awarded. This page displays all types of badges such as
Feedback and Learning badges. This page can be filtered by badge type.
See Snapshot - My Badges on page 329 for additional information.
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Snapshot - Leaderboard (Performance)
A user may be awarded a badge by receiving positive feedback from another user. When a
user receives a badge, they are also awarded any points that are associated with the
badge.
The Leaderboard page enables users to view their total number of points, their overall
points ranking within their organizational unit, and the top 10 users who have the most
points. Also, if the user is not in the top 10 ranking, then the user is displayed at the bottom
of the page with the user who ranks above them and the user who ranks below them.
This page can be filtered by organizational unit (OU) and by time frame.
See Snapshot - Leaderboard on page 331 for additional information.
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Structured Feedback
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Structured Feedback Overview
Prior to this enhancement, users were able to request feedback and receive simple
comment-based responses.
With this enhancement, users can add yes/no questions or rating questions to feedback
requests. This allows users to receive clear, quick responses in a more seamless manner.

Considerations
For Rating type questions, administrators cannot configure the rating scale. A 1-5 rating
scale is used.
A maximum of 10 questions can be added to a feedback request.

Implementation
This functionality is available to all organizations using Universal Profile - Feedback.
Upon release, this functionality is enabled in Stage portals, and is disabled in Pilot and
Production portals.
The availability of this functionality is controlled by a backend setting, which is disabled by
default. To enable this functionality, contact Global Product Support. For more information
about this functionality, contact your Client Success Manager.

Glossary
o Structured Feedback - The ability to add yes/no or rating questions to a feedback
request. This allows users to receive clear, quick responses in a more seamless
manner.

Security
The following existing permission applies to this functionality:
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Feedback - Request Feedback
Prior to this enhancement, users were able to request feedback and receive simple
comment-based responses.
With this enhancement, users can add yes/no questions or rating questions to feedback
requests. This allows users to receive clear, quick responses in a more seamless manner.
To request feedback, click the Feedback tab within Universal Profile. Then, click the
Feedback field. The Feedback field expands to display additional options.
Permissions
PERMISSION
NAME
Feedback - Request

PERMISSION DESCRIPTION

CATEGORY

Enables user to request feedback from the Feedback Universal
page of their Universal Profile. Users can only request Profile
feedback from other users within their permission
constraints. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User's Self. This is an end user permission.

With this enhancement, a new ADD QUESTIONS button
requesting feedback.

is now available when
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To add a question to your feedback request, click the ADD QUESTIONS button
.A
blank question is added to the feedback request. Enter the following information for the
question:
o What is your question? - In the text field, enter the question text. Be sure that the
question text matches the selected rating type. For example, if the rating type is
Yes/No, be sure that the question that is being asked can be answered with a yes or no
response. This field is required, and the character limit for this field is 500.
o Select Rating Type - From the drop-down menu, select the type of rating that should
be used with the question. The following rating types are available:
o Rating - Users who respond to this question will provide a rating between one and
five.
o Yes/No - Users who respond to this question will provide either a Yes or No
response.
To remove a question from a feedback request, click the Remove icon
Select Rating Type drop-down menu.

to the right of the

To add an additional question, click the Add another question link. An additional blank
question is added to the page. Up to 10 questions can be added to a feedback request.
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Feedback - Provide Feedback
With this enhancement, users can add yes/no questions or rating questions to feedback
requests. This allows users to receive clear, quick responses in a more seamless manner.
When a user is responding to a feedback request that contains questions, the user is able
to quickly respond to the questions and provide additional comments.
To respond to a request for feedback, click the Options drop-down within Universal Profile
and select View Feedback Requests. Then, click the appropriate request link. This opens
the Feedback page for the user who requested the feedback. Depending on the feedback's
visibility configuration, existing feedback from other users may be visible on the Feedback
Details page. If the user provided anonymous feedback, then the user's name and photo
are not displayed.
To provide feedback, click the text field. If the feedback request contains any questions, the
questions are displayed below the text field.
o To add a feedback comment, enter the feedback in the text field. This is required.
o To respond to a question, click the Select drop-down menu and select the appropriate
rating. The text to the right of the drop-down menu indicates the type of question.
Responses to each question are not required.
After entering your feedback, click SHARE. This adds your comments and question ratings
to the feedback request on the requester's Feedback page. Users are not able to modify
their ratings after the feedback is shared unless they delete their feedback response.
However, the feedback provider is always able to add additional comments to the feedback
request.
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Update Goal Progress from Performance Review
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Update Goal Progress from Performance Review
Goal Rating sections can be added to a performance review, and these sections enable
reviewers to view and rate the reviewee's goal progress for the task review period.
Prior to this enhancement, if a reviewer noticed that the progress of a goal needed to be
updated, the reviewer had to exit the performance review, update the goal progress, and
then return to the performance review.
With this enhancement, Goal Rating performance review sections can be configured to
allow reviewers to access the Manage Goals page directly from the Goal Rating section.
This enables the reviewer to quickly update the goal progress without exiting the
performance review. The updated goal progress is reflected in the performance review.

Considerations
This functionality is only available to organizations using the new Performance Reviews and
Goals functionality.
The option to manage a goal from within a Goal Rating performance review section is never
available to peers and subordinates when they are completing a 360 performance review.

Implementation
This functionality is automatically enabled for all organizations using the new Goals
functionality.
Upon release, the option to allow goal progress updates is disabled for all existing Goal
Rating performance review section. However, this option is enabled by default for all Goal
Rating sections that are created following this release.

Security
The following existing permissions apply to this functionality:

472

Cornerstone April 2016 Release Notes: What's New for April 2016

Goal Rating Section - Goal Progress Updates
With this enhancement, Goal Rating performance review sections can be configured to
allow reviewers to access the Manage Goals page directly from the Goal Rating section.
This functionality is only available to organizations using the new Performance Reviews and
Goals functionality.
To create a performance review section, go to ADMIN > TOOLS > PERFORMANCE
MANAGEMENT > FORM SECTIONS. Then, click the Create Review Section link.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Performance Review Grants ability to create and manage performance Performance Form Sections review questions and sections which are used in
Administration
Manage
performance review tasks. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
The following option is now available in the Goal Settings section:
o Allow goal progress updates in Review - This option is selected by default. When this
option is selected, reviewers can to manage goals directly from the Goal Rating section.
This enables the reviewer to quickly update the goal progress without exiting the
performance review.

473

Cornerstone April 2016 Release Notes: What's New for April 2016

474

Cornerstone April 2016 Release Notes: What's New for April 2016

Performance Review - Goal Rating Section
With this enhancement, Goal Rating performance review sections can be configured to
allow reviewers to access the Manage Goals page directly from the Goal Rating section.
This enables the reviewer to quickly update the goal progress without exiting the
performance review. The updated goal progress is reflected in the performance review.
This functionality is only available to organizations using the new Performance Reviews and
Goals functionality.
Review tasks are available in the Welcome Page - My Tasks section, the Performance
Review Summary page, and the Universal Profile - Actions page.
To open a performance review task, click the performance review task title. The Overview
step opens, displaying a snapshot of the review.
Permissions
PERMISSION
NAME
View Goals

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view own goals and (depending on Performance
role and settings) goals of others (manager's visible
goals, direct subordinate's goals, company goals,
division goals). This permission can be constrained
by Employee Relationship, OU, User's OU, and
User Self and Subordinates. This is an end user
permission.

When the Goal Rating section is configured to allow users to update goal progress, a
Manage Goals option is available in the Options drop-down menu to the right of each goal.
This option is only available if the reviewer has permission to view the goal. This option
opens the Manage Goals page for the goal. When done updating the goal progress, the
user is directed back to the Goal Rating section so they can continue completing the
performance review. See Goal - Manage (New Design).
This option is never available to peers and subordinates when they are completing a 360
performance review.
This option is not available if the performance review is in read-only mode.
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Added Performance Fields
With this enhancement, fields are added to the Competency and Goals sections for custom
reports.

Competency
Goals
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Reports - Performance Review Sign-off Section
With the February '16 release, administrators can configure a Sign-off performance review
section to allow users to decline to sign.
With this enhancement, a new Performance Review Sign-off section is now available when
creating a Performance Review custom report. This section enables administrators to
create custom reports that include information about the Sign-off section. This includes the
decline to sign functionality.
The following fields are available within the new section:

Implementation
This functionality is automatically enabled for all organizations using the Performance
module and Custom Reports.

Security
The following existing permissions apply to this functionality:
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Recruiting
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Broadbean External Sourcing
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Broadbean External Sourcing Overview
The Broadbean External Sourcing integration enables organizations to source applicants
from external job boards in Broadbean. The applicants can be added to talent pools and
invited to apply to the job.

Use Cases
o Sourcing Candidates - Lauren the Recruiter needs to find more candidates to apply for
the requisitions she is responsible for. She wants to source candidates from different
job board platforms.
o Adding to Talent Pools and Inviting to Apply - Once Lauren performs searches and
finds candidates that could potentially fit the open positions, she wants to add those
candidates to talent pools and/or invite them to apply to the requisitions.

Implementation
The Broadbean External Sourcing integration requires Cornerstone Learning and a
Broadbean account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.

Glossary
o External Sourcing - Sourcing applicants from external job boards.

Security
The following new permission applies to this functionality:
The following existing permissions apply to this functionality:

Roles
The following permission is added to the Recruiting - Manager role:
o External Search: Manage
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Requisition Templates - Keywords
With this enhancement, a Keywords field is added to the Description and Qualifications
section for requisition templates. The keywords that are added to the field are used when
the recruiter is accessing Broadbean from the Manage Requisitions page.
Note: The External Sourcing option allows recruiters to search for applicants from
external job boards in Broadbean. The External Sourcing option can be accessed from the
Manage Job Requisitions page and the Candidate Search Query page.
To create requisition templates, go to Admin > Tools > Recruit > Requisition Templates.
In the Options column to the right of the appropriate Position organizational unit (OU), click
the Manage Requisition Template icon .
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition Template Grants ability to access and view Requisition
Recruiting
- Manage
Templates. This permission cannot be constrained. Administration
This is an administrator permission.
Requisition
Template - View

Grants ability to access and view Requisition
Templates. This is an administrator permission.

Recruiting
Administration

OU Hierarchy Manage

Grants ability to create and update/edit
organizational units and custom groups. This
permission grants access to all OU types, both
standard and custom. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

Core
Administration
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Keywords
Enter keywords into the Keywords field, up to 1000 characters. Separate each keyword by
a comma, and then a space.
The keywords can be localized by selecting the desired language from the language dropdown in the upper-right corner of the Description and Qualifications section. Then, enter the
translated keywords in the Keywords field.
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Create Job Requisition - Keywords
With this enhancement, a Keywords field is added to the Description and Qualifications
section for requisition templates. The keywords that are added to the field are used when
the recruiter is accessing Broadbean from the Manage Requisitions page.
to automatically populate the search criteria when searching for applicants through the
External Sourcing option.
Note: The External Sourcing option allows recruiters to search for applicants from
external job boards in Broadbean. The External Sourcing option can be accessed from the
Manage Job Requisitions page and the Candidate Search Query page.
To create job requisitions, go to Recruit > Manage Requisition.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Description

Grants ability to edit the internal and external
Recruiting
descriptions for requisitions. This permission cannot
be constrained. This permission must be used in
conjunction with the Requisition: Manage
permission. Note: For requisition owners and
managers who do not have this permission, when
editing a job requisition, the requisition description
section is read-only.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
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revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
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Keywords
Enter keywords into the Keywords field, up to 1000 characters. Separate each keyword by
a comma, and then a space.
The keywords can be localized by selecting the desired language from the View In dropdown. Then, enter the translated keywords in the Keywords field.
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Manage Job Requisitions - External Sourcing Option
An External Sourcing option is added to the options drop-down on the Manage Job
Requisitions page. This option allows recruiters to open the Broadbean search page and
search for applicants to add to a talent pool or invite to apply to the job.
Error Note: If your Broadbean account is not active, a message displays directing you to
My Account > My Social Profiles in order to activate your Broadbean account.
To manage job requisitions, go to Recruit > Manage Requisition.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting).
This permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a

Recruiting
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reviewer. This permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
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Candidate Search Query - External Sourcing Option
An External Sourcing option is added to the upper-right corner of the Candidate Search
Query page. This applies to the Quick Search and Advanced Search tabs. This option
allows recruiters to open the Broadbean search page and search for applicants to add to a
talent pool or invite to apply to the job.
In addition, when searching for candidates, the system will also use the resume submitted
by external candidates as part of the search.
To access the Candidate Search Query, go to Recruit > Candidate Search Query.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Recruiting: Search
Candidates

Grants ability to access Candidate Search page
Recruiting
for recruiting, which enables searching for internal Administration
candidates and external candidates who have
applied for open positions. This permission also
enables the Invite to Apply action item to appear in
the Actions drop-down on the Search Candidates Search Results page. This permission can be
constrained by OU and User's OU.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting
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Job Boards - Search for Applicants
Recruiters can search for applicants on external job boards in Broadbean. See the following
for the steps necessary to search for applicants via Broadbean:

Broadbean Account Requirements
You must have an account with Broadbean in order to use the External Sourcing feature.
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Email Administration
With this enhancement, a Create Profile Invitation email is added to the Recruitment action
type in Email Administration:
Permissions
PERMISSION
NAME
Global Email
Administration Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to manage email trigger templates
Core
across all active modules in the portal. Enables
Administration
creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.

Global Email
Grants view only access to email
Administration - View templates/triggers and email logs at the global
level for the portal. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User. This is an administrator
permission.

Core
Administration

Create Profile Invitation
Email Tags
The following email tags are available for the Create Profile Invitation email (new tags
appear in red):
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Applicant Profile - Snapshot
When external applicants create a profile on the career site from the email invitation, their
resume is saved on the Applicant Profile > Snapshot page.
With this enhancement, when a resume is sourced from Broadbean, the Title column
displays as "External Sourcing/[Job Board Name - Resume." The Requisition column
displays as "N/A."
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Career Site Profiles
Contact Information and Resume
When applicants are invited to create a career site profile as a result of the ADD TO
TALENT POOL action on Broadbean, the applicant's contact information is automatically
entered on the career site. This saves the applicant from having to re-enter this information
when creating a career site profile.

Creating a Profile
Applicants can create a profile using their email address. This reduces the possibility of
duplicate applicants.
Note: Applicants are required to create a profile if enabled by a backend setting. If the
backend setting is disabled, then applicants are added to the talent pool without needing to
create a profile on the career site.

Delete Temporary Profile
When applicants are invited to create a career site profile as a result of the ADD TO
TALENT POOL action on Broadbean, the applicant can choose not to create the profile
and instead to delete their information from the organization's database.
In the Create Profile Invitation email, if the DELETE.CANDIDATE.INFORMATION tag is
included by the administrator in the email, the tag displays as a link in the email. Applicants
can click the link and choose to remove their temporary profile data from the organization.
This opens a page where the applicant can click YES to delete or CANCEL to keep their
information stored on the database. If they click YES, they are directed to the job search
page of the career site.

Auto-Deletion of Temporary Profile
The external applicant's resume and data will be deleted from the Applicant Profile >
Snapshot page after the set number of days, as defined by the administrator via a backend
setting.
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Career Site Management
With this enhancement, a Set as Default option is added to the Career Site Management
page. This option allows administrators to select which career site they would like to be the
default career site.
To manage career site pages, go to Admin > Tools > Recruit >Career Sites.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Career Site - Manage Grants ability to access and manage Career Site Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
Career Site - View

Grants ability to access and view Career Site
Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.

Set as Default
The Set as Default icon
displays as the far right option in the Options column. Click the
icon to set the selected career site as the default site. This opens a confirmation pop-up.
Click YES to set the career site as the default, or click NO to cancel the action.
The default career site is linked to from the DEFAULT.CAREER.SITE email tag.
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Deactivate Default Career Site
When a career site is defined as the default site, it cannot be deactivated. Only career sites
that are not the default can be deactivated.

Inactive Career Sites
Careers sites that are inactive cannot be defined as the default.

Auto-Designation as Default Career Site
For career sites created after implementation of this enhancement, if the career site created
is the first career site created for the portal in Career Site Management and the career site
is defined as active, then that career site is automatically the default career site.
For current and future career sites, if the portal has no career sites defined as active, then
the first career site created that is defined as active will be the default career site.
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Multiple Language Support for Job Postings - Broadbean
Integration
With this enhancement, the following updates are made to the External Postings tab when
configuring job requisition postings to Broadbean:
o Language Drop-Down - When configuring Broadbean job postings, recruiters can now
select which language to post the job in, based on the languages into which the job
requisition has been translated. A language drop-down has been added to the
Broadbean posting step to allow recruiters to choose the language. The localized job
requisition will render correctly via Broadbean posting.
o Posting Date Column - A Posting Date column is added to the Job Boards section.
This column displays the date on which the job was posted to Broadbean.
o Language Column - A Language column is added to the Job Boards section. This
column displays the language in which the job was posted to Broadbean.

Use Cases
A recruiter created a requisition and localized it in three different languages. He needs to
post the English version of the requisition to one job board and the Spanish version to a
different job board. Therefore, he needs a way to select the language and the job board to
which the requisition will be posted.

Security
The following existing permissions apply to this functionality:
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Data Load Wizard - Support for Keyword and Cost Center
OU in Job Requisition and Job Requisition Templates
This enhancement is in support of the Recruiting Usability Enhancements. See Requisition
Enhancements Overview on page 528 for additional information.
With this enhancement, the Data Load Wizard supports two new fields through the Job
Requisition and Job Requisition Template data loads, Keyword and Cost Center OU.
o Keyword - This field contains all keywords associated with the job requisition or job
requisition template. This is a text field that accepts up to 1,000 characters. Any HTML
is automatically removed. This field is optional.
o Cost Center OU - This field contains the Cost Center OU associated with the job
requisition or job requisition template.

Implementation
The Job Requisition and Job Requisition Template data loads are not available for selfservice.
o For organizations that would like to implement a Job Requisition and Job Requisition
Template data load, please contact your Client Executive.
o For organizations that would like to include these fields in their existing Job Requisition
and Job Requisition Template data load, please contact Global Product Support (GPS).
This functionality is only available to organizations using Recruiting and the Data Load
Wizard.
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Enhanced Job Requisition Web Service (REST)
With this enhancement, the following fields are now included in the Job Requisition web
service response:
o
o
o
o
o
o
o
o
o
o
o
o
o
o

Can Apply
Career Sites
Default Name
Employment Status
External Ad
Ideal Qualification
Internal Ad
Job Responsibilities
Management Group
Management Group ID
Mobile Ad
On Going
Requisition Template
Requisition Template ID

In addition, this web service now supports localization. The default language for the web
service administrator's account is used to determine the localized values for the response
parameters.

Implementation
This Web Service is automatically available to all portals that have purchased it.
If you have purchased Web Services usage, but need access to this specific one, please
contact CSOD via a GPS case to enable.
If you have not purchased Web Services at all, please contact Sales or Client Executive to
purchase.
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FADV Enhancements and Migrate FADV from IUP to Edge
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FADV Enhancements and Migrate FADV from IUP to Edge
Overview
With this enhancement, First Advantage (FADV) integration is migrated to the Edge
Marketplace. This allows organizations to purchase the FADV integration directly from
Edge. Prior to this enhancement, FADV required a custom integration process that was
managed through Global Product Support. After the initial set-up, clients will be able to
make configuration changes to the integration directly within the Integration Center, as
opposed to using GPS.
In addition, permissions are also being added to enable organizations to restrict and limit
user access to initiating a background check, viewing background check results, and
viewing background check details.

Use Case
1. Calvin would like to integrate First Advantage to the Applicant Tracking System (ATS)
by purchasing an integration through Edge Marketplace.
2. Iliana, who is a Recruiter Intern, has the ability to initiate a background check for
candidates, but she cannot see the background check results (whether or not a person
passed/failed) and the details.
3. Roger the Recruiter has the ability to view background check results.
4. Rosanne the Recruiter has the ability to view background check results and the link to
the background check vendor's website that contains additional background check
information.
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New Permissions
Permissions
The following new permissions have been added with this enhancement:
o Applicants: Initiate Background Check - This permission in the Recruiting category
grants access to manage background checks from the Applicant Profile page. This
applies to background checks that have been configured in the Integration Center. This
permission cannot be constrained. Users who have this permission will have an Assign
to Applicant link in the background check status type panel on the Applicant Profile
page. Once the background check is assigned, the page will display "Assigned - [Date
Assigned]." Note: This permission allows users to no longer need to set background
check status as "Sensitive." There is no impact to sensitive statuses that are currently
set.
o Applicants: View Background Check Status - This permission in the Recruiting
category allows users to view the background check status. The user cannot view the
link to the detailed report. This permission cannot be constrained. Note: This
permission allows users to no longer need to set background check status as
"Sensitive." There is no impact to sensitive statuses that are currently set.
o Applicants: View Background Check Status and Details Link - This permission in
the Recruiting category allows users to view the background check status and view a
link to access the background check report, which can be found in the background
check status type panel on the Applicant Profile page. This permission cannot be
constrained. Note: This permission allows users to no longer need to set background
check status as "Sensitive." There is no impact to sensitive statuses that are currently
set.
Upon release, these permissions must be manually enabled by the administrator in Security
Role Administration.

Roles
The following permissions are added to the Recruiting - Admin role:
o Applicants: Initiate Background Check
o Applicants: View Background Check Status
o Applicants: View Background Check Status and Details Link
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Display Account Name and Account Number in Accounts/Packages
Drop-Down
With this enhancement, the account name and account number will now be visible in the
Select Account and Select Package drop-down in the Select Screening Program Option
pop-up. Some organizations may have more than one account with the background check
vendor and different types of background check packages. Being able to view the account
name with the account number allows you to target the background check to the correct
account and type of background check.
The Select Account drop-down values will show "Account_Number - Account Name" (e.g.
342423 - FADV)."
Note: The Select Screening Program Option pop-up is accessed by clicking the Assign to
Applicant link in the First Advantage (FADV) background check status type panel on the
Applicant Profile > Statuses tab. See Applicant Profile - Assign First Advantage Screening
for more information about the Select Screening Program Option pop-up.
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Google Analytics in Applicant Workflow
Organizations can now use Google Analytics to track applicants as they are going through
career sites, job postings, and application workflows.
Prior to this enhancement, organizations had to insert their own custom footers to have
Google Analytics tracking in their applicant-facing pages.

Google Analytics
Implementing Google Analytics in Recruiting can help recruiters figure out which devices
people are using to visit career pages and the source they used to reach the career site or
job posting, such as via a search engine. Google Analytics can also track the time spent on
the career pages and where applicants made it to in the application workflow and more.
Recruiters can then build more targeted campaigns over time to attract the type of
applicants they want, as well as optimize career sites and application workflows to make
sure they are maximizing the number of applications submitted.
When enabled, the recruiter can view analytics information for career sites, job postings,
and application workflows.

Organizations that Currently Have Google Analytics Snippet on ATS Pages
For organizations that already have their own Google Analytics snippet inserted on their
Applicant Tracking System (ATS) pages, it is recommended that the Google Analytics
snippet be removed or that you do not enable the new classic Google Analytics feature for
ATS. It will cause double tracking if the code is for the same Google Analytics account. If
the code is for two different Google Analytics accounts, then the double tracking should not
occur. In addition, if you decide to implement both classic Google Analytics and the new
Universal Analytics on the same page, there should not be double tracking issues.

Use Cases
1. A recruiter is trying to hire social media marketers and lawyers. She has built a career
site with a generic application workflow for social media and law positions.
2. The recruiter notices that she is getting a lot of applications for her law positions but is
not getting very many for her social media positions.
3. She has Google Analytics implemented on the career site, as well as on the application
workflow.
4. The recruiter analyzes the data in Google Analytics and realizes that people interested
in the social media positions tend to access the career site via a mobile device and try
to apply via mobile, but they cannot easily navigate the career site nor get through the
application workflow on a mobile device.
5. The recruiter quickly optimizes the career site and enables the Apply with Mobile feature
with a simpler application workflow. Following this change, she starts to see more social
media marketing applicants.
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Implementation
This functionality is controlled by backend settings, which are disabled by default. To
enable this feature, contact Global Product Support. You will need to provide your Google
Analytics and Google Universal Analytics tracking numbers for the accounts. You will also
need to specify whether you are enabling Classic Analytics or Universal Analytics.
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Inbound Data Feeds for Candidates and Applicants
With this enhancement, the Data Load Wizard now supports scheduling of inbound data
feeds (IDF or recurring loads) for Candidates and Applications.

Implementation
The Application and Candidate data loads and data feeds are not available for self-service.
o For organizations that would like to implement an IDF for applications and candidates,
please contact your Client Executive.
This functionality is only available to organizations using Recruiting and the Data Load
Wizard.
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Multiposting Integration
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Multiposting Integration Overview
The Multiposting integration enables recruiters to post a requisition that has multiple
language translations to multiple job boards that support multiple languages. Through an
integration with Multiposting, recruiters can select the desired job boards from the External
Postings page of the job requisition and post the job to more than one job board that
supports multiple languages.
Recruiters will be able to see the latest statistics for each job board, as well as take actions
such as edit the job posting, delete the job posting, and repost the job when the job posting
expires.

Use Case
1. Peter is a Recruiter at a global organization and needs to recruit Sales Representatives
in Mexico so that the company can expand in Mexico.
2. Peter has created a Sales Representative requisition that has already been translated
into Spanish.
3. Peter needs to post this job to as many job boards as possible so that he can get
maximum exposure to get the best Spanish-speaking sales representatives in Mexico.
4. Peter posts the job to five well-known Mexican job boards, making sure that the
postings are available in English and Spanish.
5. Peter can see the status of his job postings on each of the job boards.
6. Peter can take actions like editing, deleting, or reposting the job depending on how the
job posting does on each of the job boards.

Implementation
The Multiposting Job Posting integration requires Cornerstone Learning and a Multiposting
account.
This integration is available in the Edge Marketplace. Once the integration has been
purchased, the functionality is not available until the integration is configured and enabled
via Edge Integrations.

Security
The following existing permissions apply to this functionality:
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External Postings Page - Updates to Job Boards Section
With this enhancement, a Job Board Vendor drop-down is added to the Job Boards
section on the External Postings page to enable recruiters to select the job board vendor,
such as Multiposting.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
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editing a requisition.

Job Board Vendor Drop-Down
The Job Board Vendor drop-down displays the active job board integrations that are
available to post the requisition. To select a vendor, click the drop-down and select the
vendor from the list.
Once the vendor is selected, the options in the Job Boards section and the columns in the
job boards table will change based on the vendor selected.
Note: The Job Board Vendor drop-down only displays if there is at least one active job
board integration, as configured.
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Multiposting Job Board Postings
The Multiposting integration allows recruiters to post a requisition that has multiple
language translations to multiple job boards that support multiple languages. Through the
integration, recruiters can select the desired job boards from the External Postings page of
the job requisition and post the job to more than one job board that supports multiple
languages.
Note: For requisitions that have an approval workflow, postings cannot be made through
Multiposting until the requisition is approved.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
510

Cornerstone April 2016 Release Notes: What's New for April 2016

the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Post Job
To post a job through Multiposting:
1. Select a default career site in the Career Sites section. This is required in order to post
the job via Multiposting so that the posted jobs will be linked to the default career site.
2. Select Multiposting from the Job Board Vendor drop-down. This updates the options
in the Job Boards section and the columns in the job boards table.
3. Click the CREATE NEW POSTING button. This opens a Multiposting window from
which you can select the job boards and configure the posting. You must have a
Multiposting account in order to post through Multiposting.
Once the job postings are configured, you can submit the requisition on the External
Posting page.

Repost Job
The REPOST JOB button allows recruiters to repost a job posting. The button only displays
if the active postings are in a Deleted, Error, or Expired status or is no longer active on any
job boards.
To repost the job:
1. Click the REPOST JOB button. This opens a Multiposting window.
2. In the Multiposting window, you can edit any of the job details before reposting the job.
Once you have finished making the changes in Multiposting, you will need to manually
close the Multiposting window.
3. Then, click REFRESH on the External Postings page. This updates the job boards table
to display the job boards to which the posting has been reposted. The status of the job
boards changes to Pending or Active, and this enables the EDIT POSTING and
DELETE ALL buttons to display. the REPOST JOB button will no longer display.

Job Boards Table
The following columns display in the job boards table when Multiposting is selected in the
Job Board Vendor drop-down:
o Job Board Posting - This column displays the name of the job board to which the
requisition is posted.
o Status - The following statuses of the job board display in the Status column:
o Active
o Deleted
o Error
o Expired
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o
o
o
o

o

o Pending
Date Posted - This column displays the effective date of the job posting.
Expiration Date - This column displays the date on which the requisition expires on the
job board.
Clicks - This column displays the number of clicks that the job board has received.
Amount - This column matches the data in Multiposting and displays the correct amount
type for the posting cost type entity. The amount displays in the user's language, if
available.
o Credits - This shows the remaining credits for the job board.
o Slots - This shows the remaining/total slots for the job board.
Options - The following options are available in the Options column:
o Delete - You can delete a job posting that is in a Pending or Active status by
clicking Delete from the options drop-down in the Options column. This opens a
confirmation pop-up. Click YES to delete the posting, or click NO to cancel the
delete action. Once the posting is deleted, click REFRESH. This updates the job
board status to Deleted. The options drop-down is hidden when a job board is in a
Deleted status.

Edit Posting
The EDIT POSTING button allows you to edit the posting in Multiposting. When clicked, the
Multiposting window opens, where you can edit the posting. Once the updates are made,
the job boards table on the External Postings page updates to display the latest data.
This button only displays once a job is posted via Multiposting.

Refresh
The REFRESH button updates the job boards table to display the latest data from the job
boards to which the job is posted.
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Delete All
The DELETE ALL button allows you to delete all postings that are still pending and active
on job boards. A confirmation pop-up opens. Click YES to delete the posting, or click NO to
cancel the delete action.
The status for the job boards will change to Deleted when the REFRESH button is clicked.
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Onboarding
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Onboarding Manager Usability Enhancements
With this enhancement, the following Onboarding usability enhancements are made:
o Email User's Future Manager - The Integration Task Completed email can now be
sent to "User's Future Manager." This allows an onboarding user's future manager to
receive email notifications when integration tasks have been completed.
o Integration Task Assigned Email - This is a new email trigger. This email is triggered
when a user is assigned an onboarding task. This email can be sent to Assignee or a
specific user. This email can be configured as a Notification type email. This email is
active by default and can be found in the Employee Onboarding action type section of
Email Management. The following email tags apply:
o ACTION.DATE - Date that the action took place that triggers the email.
o INTEGRATIONTASK.TITLE - Integration task title.
o INTEGRATION.TITLE - Integration title.
o RECIPIENT.DIVISION - Recipient’s division.
o RECIPIENT.FIRST.NAME - Recipient’s first name.
o RECIPIENT.LAST.NAME - Recipient’s last name.
o RECIPIENT.POSITION - Recipient’s position.
o INTEGRATION TASK.DUE.DATE - Integration task due date.
o TASK.START.DATE - Task start date.
o Onboarding Tab Visibility - The Onboarding tab on the Universal Profile > Bio page
will only display if a user is currently or has previously been through onboarding.
o View Forms from Onboarding Tab - Completed forms can now be accessed directly
from a user's Onboarding tab on their Universal Profile > Bio page. Click the form title to
open the form. Previously, forms could only be accessed from Snapshot > Documents.

Use Cases
Onboarding Tab Visibility
A Human Resources Manager is looking through the Universal Profile > Bio pages of
various employees within the company. She can see the Onboarding tab for users who are
currently onboarding or who have previously gone through onboarding. She cannot see an
Onboarding tab for users who have not been through onboarding before.
Clickable Forms in Onboarding Tab
A Human Resources Manager is in charge of the onboarding process for new hires. She
can go to the Onboarding tabs on the new hires’ Universal Profile > Bio page to see the
progress of tasks for new hires. She is able to open the forms that the new hires have
completed and quickly review the information that was entered on the forms.

Security
The following existing permissions apply to this functionality:
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Increase Character Limit for Question User Comment
With this enhancement, when running Form Management Custom Reports or Onboarding
Custom Reports, the character limit for the Question User Comment field is increased
from 500 to 1200. The field appears in the Form Template section of these reports.
Prior to this enhancement, any part of a user's responses that went over 500 characters did
not display in the report output.
Related April '16 Enhancement Note: As part of a separate enhancement for the April '16
release, the name of the Form Template section is changing to Training Form Template. In
addition, the permission names are changing. See Form Management Custom Report on
page 524 for additional information.

Security
The following existing permissions apply to this functionality:
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(missing or bad snippet)(missing or bad snippet)Reports

- Onboarding in Custom

Reports
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Onboarding Custom Report
With this enhancement, an Onboarding Custom Report is now available in custom
reporting. This report allows you to create customized reports on onboarding data. The
onboarding data can be used to make informed decisions about where new hires are
having trouble in the onboarding process.
To create an Onboarding Custom Report, go to Reports > Custom Reports. Then, click
Onboarding Report in the New drop-down.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Custom Onboarding
Report - Create

Grants ability to create and edit custom
Onboarding reports. This permission refers to
creating custom reports for the Onboarding
module. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User's Subordinates.

Custom Onboarding
Report - View

Grants ability to view results of custom Onboarding
reports created by self or shared by others. This
permission refers to viewing custom reports for the
Onboarding module. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User's Subordinates.

Form Approvals Manage

Grants access to manage Form Approvals
functionality. This permission cannot be
constrained. This is an administrator permission.

CATEGORY

Reports Analytics

Reports Analytics

Forms
Management
Administration

Note: This permission enables access to the new
Form Management functionality that is part of the
Onboarding module. This permission does not
grant access to the Old Forms Management
functionality.
The following report sections are available, in addition to the User and Calculated Fields
sections:
Onboarding
FIELD NAME
Onboarding

FIELD DESCRIPTION
Indicates whether or not an onboarding workflow is

FIELD
TYPE
Yes/No
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FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Workflow
Active

active or inactive.

Employer
Assignee
Email

The email address of the user who was assigned the
Employer task for the I-9 integration task. This field
will remain empty if the portal does not have an I-9
integration enabled for Onboarding.

Text

Employer
Assignee ID

The user ID of the user who was assigned the
Employer task for the I-9 integration task. This field
will remain empty if the portal does not have an I-9
integration enabled for Onboarding.

Text

Employer
Assignee
Name

The name of the user who was assigned the
Employer task for the I-9 integration task. The name
is displayed in the format: Last Name, First Name.
This field will remain empty if the portal does not
have an I-9 integration enabled for Onboarding.

Text

Integration
Provider

The integration provider of the integration. This field
will remain empty if the portal does not have an I-9
integration enabled for Onboarding.

Text

Navigation
The navigation tab extension that was associated to
Tab Extension the user's onboarding.

Text

Onboarding
Progress

The onboarding progress of the user. This field
displays the percentage completion of all onboarding
tasks for the user's onboarding.

Numeric

Onboarding
Status

The status of the user's onboarding. This field
displays the overall status of a user's onboarding
process.

Text

Onboarding
Type

The type of onboarding the user is going through,
either External or Internal.

Yes/No

Onboarding
The title of the Onboarding Workflow.
Workflow Title

Text

Start Date

The employment start date of the user. This field
displays the date that the user moves into their new
job. The date displays in the format: MM/DD/YYYY.

Date

Onboarding
The email of the user who was assigned the
Task Assignee onboarding task. This user can be a user other than
Email
the user who is onboarding.

Text
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FIELD NAME

FIELD DESCRIPTION

Onboarding
The user ID of the user who was assigned the
Task Assignee onboarding task. This user can be a user other than
ID
the user who is onboarding.

FIELD
TYPE
Text

Onboarding
The name of the user who was assigned the
Text
Task Assignee onboarding task. The name displays in the format:
Name
Last Name, First Name. This user can be a user other
than the user who is onboarding.
Onboarding
Task
Assignment
Date

The date that the task was assigned. The date
displays in the format: MM/DD/YYYY (00):(00)
(AM/PM).

Date

Onboarding
The date that the task is due. The date displays in
Task Due Date the format: MM/DD/YYYY (00):(00) (AM/PM).

Date

Onboarding
Task ID

The ID of the onboarding task.

Text

Onboarding
Task Status

The status of the onboarding task.

Text

Onboarding
Task Title

The title of the onboarding task.

Text

Onboarding
Task Type

The type of onboarding task.

Text

Onboarding
User Future
Division

The user's future division. The user's future division is Text
the division they will be in once they reach their start
date.

Onboarding
User Future
Location

The user's future division. The user's future division is Text
the division they will be in once they reach their start
date.

Onboarding
User Future
Position

The user's future position. The user's future position
is the position they will be in once they reach their
start date.

Text

Onboarding
The user's future manager's email address. The
Future
user's future manager is the manager they will have
Manager Email once they reach their start date.

Text

Onboarding
Future
Manager ID

Text

The user's future manager's user ID. The user's
future manager is the manager they will have once
they reach their start date.
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FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Onboarding
Future
Manager
Name

The user's future manager's name. The user's future
manager is the manager they will have once they
reach their start date. The name displays in the
format: Last Name, First Name.

Text

Onboarding
Future
Approver
Email

The email address of the user's future approver. The
user's future approver is the approver they will have
once they reach their start date.

Text

Onboarding
Future
Approver ID

The user ID of the user's future approver. The user's
future approver is the approver they will have once
they reach their start date.

Text

Onboarding
Future
Approver
Name
Form

The name of the user's future approver. The user's
future approver is the approver they will have once
they reach their start date. The name displays in the
format: Last Name, First Name.

Text

FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

Document
Folder Name

The name of the document folder in which the
Text
completed form is stored. The document folder name is
the name of the document folder in the Snapshot
Documents widget.

Form Active

Indicates whether a form is active or inactive.

Yes/No

Form
Description

The description of the form.

Text

Form ESignature
Date

The date the form was electronically signed. The date
displays in the format: MM/DD/YYYY (00):(00)
(AM/PM).

Date

Form ESignature
Location

The location from which the form was electronically
signed. The location is the IP address from which the
form was electronically signed.

Text

Form ESignature ID

The user ID of the user who electronically signed the
form.

Text

Form ESignature
Name

The name of the user who electronically signed the
Text
form. The name displays in the format: Last Name, First
Name.
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FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

Form ID

The ID of the form.

Text

Form
Question

This displays as a column in the report output. The form Text
question is the name of the column.

Form
Question
Response

The response to a question.

Text

Form Submit The date that the form was submitted. The date
Date
displays in the format: MM/DD/YYYY (00):(00)
(AM/PM).

Date

Form Task ID The ID of the form task.

Text

Form Task
Instructions

The form task instructions.

Text

Form Task
Title

The title of the form task.

Text

Form Title
The title of the form.
Text
Form Approval
This section only appears if form approvals are enabled in the portal and is only available
for users with permission to manage form approvals.
FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

Form
Approval
Comment

The approval comments that are provided by approvers Text
as they are completing form approval requests. This field
should only display if form approval is enabled in the
portal. Ex: This field is filled out incorrectly. Please
correct.

Form
Approval
Request
Completed
Date

The date that the form approval request was completed. Date
The date displays in the format: MM/DD/YYYY (00):(00)
(AM/PM). This field only displays if form approval is
enabled in the portal.

Form
Approval
Request
Received
Date

The date that the form approval request was received by Date
the approver. The date displays in the format:
MM/DD/YYYY (00):(00) (AM/PM). This field only displays
if form approval is enabled in the portal.
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FIELD
NAME

FIELD DESCRIPTION

Form
The title of the form approval request. This field only
Approval
displays if form approval is enabled in the portal.
Request Title

FIELD
TYPE
Text

Form
Approval
Status

The approval status of a form. The approval status
Text
indicates the overall approval status for a form. This field
should only display if form approval is enabled in the
portal.

Form
Approver
Email

The email of the user that is the approver. This field
should only display if form approval is enabled in the
portal.

Text

Form
Approver ID

The user ID of the user that is the approver. This field
should only display if form approval is enabled in the
portal.

Text

Form
Approver
Name

The name of the user that is the approver. The name
Text
displays in the format: Last Name, First Name. This field
should only display if form approval is enabled in the
portal.

523

Cornerstone April 2016 Release Notes: What's New for April 2016

Form Management Custom Report
With this enhancement, the following changes are made to the Form Management Custom
Report in order to distinguish this report from the new Onboarding Custom Report:

Report Name Change
Section Name Changes
Field Name Changes
Permission Name Changes
Note: The permission changes will be visible in Online Help upon release of this
enhancement.
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On Boarding Custom Report
With this enhancement, the following changes are made to the On Boarding Custom Report
in order to distinguish this report from the new Onboarding Custom Report:

Report Name Change
Field Name Changes
Permission Name Changes
Note: The permission changes will be visible in Online Help upon release of this
enhancement.
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Recruiting Usability Enhancements
With this enhancement, the following usability improvements are made to the Applicant
Tracking System (ATS):
o Application Workflow - Pre-screening questions can now be created from within the
application workflow. A CREATE QUESTION button is added to the Add Question popup when configuring the application workflow in application workflow templates,
requisition templates, default requisition templates, and job requisitions. Clicking the
button opens the Create Question steps within the Add Question pop-up. Once the
question is added, the question is available to select for Prescreen Question sections
on the application workflow. The button only displays with permission to manage the
Pre-Screening Question Bank. New Questions are saved to the Pre-Screening
Question Bank. Best Practice: It is a best practice to search through existing questions
before creating a new question so that similar or nearly identical questions are not
created.
o Candidate Search Opt-Out Prevention* - An Applicant Opt-Out option is added to
the Compliance Preferences section of Requisition and Applicant Preferences. When
this option is unchecked, the opt-out option does not appear on the Applicant Profile
page or the Submit Application step of the application workflow. Any applicants who
opted out before the option was disabled will remain opted out. Any applicants who
previously opted out can decide to opt in on their Career Site > My Profile page (when
the opt-out option is disabled by the administrator, the unchecked box is still visible on
their profile). If the applicant decides to opt in while the administrator setting has been
disabled, the applicant will not be able to change their opt-in selection while the
administrator has the opt-out option disabled in Requisition and Applicant Preferences.
o Career Sites > My Profile Page* - The text for the opt-out option on the Edit Profile
page is updated to clarify the functionality of the option. The text now reads: "Consider
me for other positions and allow my application to be searchable." The option is
checked by default when applicants create an account.
o Career Site > Application Workflow* - The text for the opt-out option on the Submit
Application step of the application workflow is updated to clarify the functionality of the
option. The text now reads: "Consider me for other positions and allow my application to
be searchable." The checkbox is selected by default if the applicant has not opted out in
their most recent (previous) application and if they have not opted out on their My
Profile page.
o Career Site Searching - Applicants can now search for jobs on the career site using
keywords. The keywords are defined when the job requisition is configured.
o Custom Email Message - When configuring the custom message for the
EMAIL.CUSTOM.MESSAGE tag, the Custom Message field is updated to include a full
text editing control with HTML. This applies to creating a custom message for the Send
Email from Template action item on the Manage Applicants page and configuring
disposition emails in Requisition and Applicant Preferences. This does not apply to
the Send Email from Template option on the Applicant Profile > Summary page.
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o Manage Applicants - When vertically scrolling on the applicants table, the column
headers will now remain visible, regardless of whether you are at the top of the
applicants list or at the bottom.
o Manage Job Requisitions - You can now hit the Enter key on your keyboard from the
Job Title and ReqID fields to execute a search on the Manage Requisition page.
o Manage Job Requisitions - The filter selections on the Manage Job Requisitions page
will remain selected, even after you log out of the portal. Upon returning to the page, the
previous filter selections display so that you do not need to reset the selections. Note: If
you deselect all statuses, then the default statuses will be automatically selected upon
returning to the page.
o New Submissions Page - A Total Pre-Screening Score column is added to the New
Submission page. This column displays the applicant's total pre-screening score, which
can help recruiters see how well an applicant scored compared to other applicants. The
score displays the total score out of the total possible score and also shows the score
as a percentage.
o Pre-Screening Questions - Screen Out Option - Administrators can now define more
than one answer as correct when configuring Multiple Choice Single Answer
questions on the Create/Edit Question page for pre-screening questions. The
checkbox in the Correct column can be selected to the right of each answer to indicate
that an answer is correct. If the screening option is enabled for the question in the
application workflow, then when an applicant selects any of the correct answers, they
are not screened out of the application process.
o Resume/CV Review Page - A View Applicant Profile link is added to the upper-right
corner of the page. Click the link to open the Applicant Profile page.
o Resume/CV Review Page - Applicant and Application flags are now visible on the
Resume/CV Review page. The flags display to the right of the applicant rating. Clicking
a flag opens the flag details pop-up. Flags can also be added or removed by clicking
to open the Select Flags pop-up.
the Edit icon
*This functionality will not be available in Stage environments for the April '16 release until
Week 3 of User Acceptance Testing (UAT).

Security
The following existing permissions apply to this functionality:
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Requisition Usability Enhancements
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Requisition Enhancements Overview
With this enhancement, the following requisition enhancements are made:
o Requisition custom fields on the requisition and requisition request can be set as readonly or editable.
o New custom fields can be created in Requisition and Applicant Preferences.
o Cost Center organizational unit (OU) can now be viewed on a requisition, requisition
template, and requisition request.
o Custom field data entered in the Position OU is copied over to the requisition template.

Use Cases
An administrator wants to pre-populate certain custom field values on the requisition
template and does not want recruiters to make edits to the fields when they are creating or
editing the requisition. She configures the fields to be read-only.

Security
With this enhancement, the description for the Application Custom Fields - Manage
permission is modified to indicate that the permission also grants access to the Applicant
Custom Fields and Application Custom Fields sections of the Requisition and Applicant
Preferences page. The permission description will be updated in Online Help upon
implementation of this enhancement.
The following existing permissions apply to this functionality:
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Requisition and Applicant Preferences
With this enhancement, administrators can now create new custom fields directly from the
Requisition and Applicant Preferences page. In addition, a Read-Only column is added to
the Requisition Custom Fields section in Requisition and Applicant Preferences.
To access Requisition and Applicant Preferences, go to Admin > Tools > Recruit. Then,
select Requisition and Applicant Preferences from the General Recruitment section.
Permissions
PERMISSION
NAME
Application Custom
Fields - Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to create and edit custom fields used Recruiting
for Applicant and Application. This permission also Administration
grants access to the Applicant Custom Fields and
Application Custom Fields sections of the
Requisition and Applicant Preferences page. This
permission cannot be constrained. This is an
administrator permission.

Organizational Unit
Custom Fields Manage

Grant Access to create and edit custom fields for
Org Units. This is an administrator permission.

Core
Administration

Requisition
Preferences Manage

Grants ability to access and manage Requisition
Preferences. This permission cannot be
constrained.

Recruiting
Administration

Self-Registration
and User Record
Custom Fields Manage

Grants access to manage custom fields for user
Self Registration and the user record in Custom
Field Administration. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

Core
Administration

Note: The permission description for Application Custom Fields - Manage will be updated in
Online Help upon implementation of this enhancement.

Create New Custom Fields
A NEW CUSTOM FIELD button is added to the Select Requisition Custom Field pop-up for
Applicant, Application, and Requisition custom fields. This option allows administrators to
create new custom fields directly from the Requisition and Applicant Preferences page.
o For Applicant custom fields, clicking the NEW CUSTOM FIELD button opens the
Custom Field Administration > User > Define Field page. See User Record and Self
Registration Custom Fields.
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o For Application custom fields, clicking the NEW CUSTOM FIELD button opens the
Custom Field Administration > Application > Define Field page. See Custom Field
Admin - Application.
o For Requisition custom fields, clicking the NEW CUSTOM FIELD button opens the
Custom Field Administration > Organizational Units > Define Field page. See Custom
Field Admin - Organizational Units.

Read-Only Column
A Read-Only column is added to the Requisition Custom Fields section in Requisition and
Applicant Preferences. This field is unchecked by default. When unchecked, the requisition
custom field can be modified when used in a requisition. When checked, the field cannot be
modified when creating and editing job requisitions and requisition requests.
Note: Even if the custom field is defined as read-only, the value in the field can still be
modified when configuring requisition templates and default requisition templates.
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Requisition Templates
With this enhancement, a Cost Center organizational unit (OU) field is added to the Details
section for requisition templates.
In addition, if the administrator has configured a Requisition custom field as read-only in
Requisition and Applicant Preferences, then the field is designated as read-only on
requisition templates.
To access Requisition Templates, go to Admin > Tools > Recruit > Requisition
Templates.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition Template Grants ability to access and view Requisition
Recruiting
- Manage
Templates. This permission cannot be constrained. Administration
This is an administrator permission.
Requisition
Template - View

Grants ability to access and view Requisition
Templates. This is an administrator permission.

Recruiting
Administration
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Cost Center
The Cost Center field is added to the Details section. This field allows you to select a cost
center for the requisition template. This is not a required field.

Read Only Custom Fields
With this enhancement, administrators can configure requisition custom fields as read-only
in Requisition and Applicant Preferences. If a field is read-only, then "Read Only"
displays in parentheses to the right of the field name. The value in the field can be modified
on the requisition template, but it cannot be modified in job requisitions or requisition
requests.
Note: As with existing functionality, custom fields do not display on default requisition
templates.
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Position Organizational Unit
With this enhancement, custom field data entered in the Position OU is copied over to the
requisition template.
To access the Position OU page, go to Admin > Tools > Core Functions >
Organizational Units > Manage Organizational Unit Hierarchy.
Permissions
PERMISSION
NAME
OU Hierarchy Manage

PERMISSION DESCRIPTION

Grants ability to create and update/edit
organizational units and custom groups. This
permission grants access to all OU types, both
standard and custom. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

CATEGORY

Core
Administration
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Create Job Requisition - Cost Center and Read-Only Custom Fields
With this enhancement, a Cost Center organizational unit (OU) field is added to the Details
section for job requisitions.
In addition, if the administrator has configured a Requisition custom field as read-only in
Requisition and Applicant Preferences, then the field displays as read-only on the
requisition. The value in the field cannot be modified.
To create job requisitions, go to Recruit > Manage Requisition.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting).
This permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a

Recruiting
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reviewer. This permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
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Cost Center
The Cost Center field is added to the Details section. This field allows you to select a cost
center for the requisition. This is not a required field.

Read Only Custom Fields
With this enhancement, administrators can configure requisition custom fields as read-only
in Requisition and Applicant Preferences. If a field is read-only, then the value in the field
cannot be modified.
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Requisition Request Preferences
A Cost Center field is added to Requisition Request Preferences. This field can be
selected as active to display on requisition requests. The field can be selected as required
to be completed on requisition requests.
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Requisition Requests
With this enhancement, administrators can configure requisition custom fields as read-only
in Requisition and Applicant Preferences. If a field is read-only, then the value in the field
cannot be modified on requisition requests. The field will display as read-only.
In addition, a Cost Center organizational unit (OU) field may be available in the Details
section if enabled by the administrator in Requisition Request Preferences. If the field is
designated by the administrator as required, then the field must be completed when
creating a requisition request.
To access the Requisition Requests page, go to Recruit > Requisition Requests.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition Request: Grants ability to select requisition owners, reviewers, Recruiting
Select Users
and interviewers when creating requisition requests.
This permission can be constrained by OU and
User's OU. The constraints define which users are
available when selecting users for requisition
requests.
Requisition Request:
Submit Request

Grants ability to create requisition requests. This
Recruiting
permission can be constrained by OU and User's OU.
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SEO for Career Sites and Job Postings
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SEO for Career Sites Overview
With this enhancement, career sites and job postings can be better optimized for search
engines. Clients will also be able to determine whether specific career sites should be
indexed by search engines. The meta page title and meta page descriptions for career sites
and job postings can be customized to help attract potential applicants that search for jobs
via search engines.
Prior to this enhancement, organizations could not customize page titles and descriptions
for Career Sites and Job Postings. They also could not block search engines from indexing
career sites that were used for internal job postings.

Use Case
1. A recruiter creates two career sites: one for external job postings and one for internal
job postings.
2. The recruiter wants to make sure that the external career site is optimized for search
engines so that external applicants will be more likely to find the external job posting.
3. The recruiter configures SEO settings on the external career site.
4. The recruiter configures a setting on the internal career site to make sure that the
internal job postings will not be indexed by search engines and will be unsearchable by
external applicants.

Security
The following existing permissions apply to this functionality:
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Allow Search Engines to Index Site
A new field, Allow search engines to index site, is added to the Career Site Settings
section on the Create Career Site page. This field is unchecked by the default and allows
administrators to select whether or not to allow search engines to index the career site.
When unchecked, a meta tag is added to the page meta that prevents search engines from
crawling the pages and subpages. When checked, a meta tag is updated to allow search
engines to crawl the page.
To create a career site, go to Admin > Tools > Recruit > Career Sites. Then click the Add
Career Site link.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Career Site - Manage Grants ability to access and manage Career Site Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
Career Site - View

Grants ability to access and view Career Site
Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
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Meta Page Title and Description
With this enhancement, the meta page title and description for job postings can be
customized, which is needed to optimize career sites for search engines. Optimizing career
sites can also help the career site rank higher in search engine results for potential
applicants that search for jobs through search engines instead of by going to an
organization's job page on their website.
The meta page title and description can be defined in the following areas of the Applicant
Tracking System:
o Career Site Administration > Create/Edit/Copy Career Site > Career Site Settings
section
o Manage Job Requisitions > Create/Edit/Copy Job Requisition > External Postings page
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Career Site - Manage Grants ability to access and manage Career Site Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
Career Site - View

Grants ability to access and view Career Site
Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and External Recruiting
Postings tabs when creating, copying, or editing a job
requisition. In addition, this permission enables users
to store user-level credentialing information for job
board aggregation partners on the My Gateways tab
of the My Account page. This permission cannot be
constrained.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants

Recruiting
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for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Meta Page Title
Enter a meta page title, up to 50 characters. On the Create Career Site page, the title can
be defined in the languages available for the portal by selecting a different language in the
Language field and entering the translated meta page title in the field.For job requisitions, if
multiple languages are enabled for the portal, you can translate the title into the available
languages by clicking the Translate icon
and entering the translations for the desired
languages.When applicants search for the job in search engines, the search results will
display the job in the applicant's language, if available.

Meta Page Description
Enter a meta page description, up to 150 characters. On the Create Career Site page, the
description can be defined in the languages available for the portal by selecting a different
language in the Language field and entering the translated meta page description in the
544

Cornerstone April 2016 Release Notes: What's New for April 2016

field.For job requisitions, if multiple languages are enabled for the portal, you can translate
the description into the available languages by clicking the Translate icon
and entering
the translations for the desired languages.When applicants search for the job in search
engines, the search results will display the job in the applicant's language, if available.
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Static URL Enhancement
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Static URL Enhancement Overview
With this enhancement, recruiters will be able to share job search results and lists of
applicant resumes using a static URL that can be sent via email or embedded in a button
on a career site. The URL can be accessed without needing to log in to the career site. The
job sharing URL can be accessed without needing to log in to the career site, and the
resume sharing URL can be accessed via single sign-on (SSO) or normal log-in (if not
already logged in), navigating directly to the Resume/CV Review page.
Prior to this enhancement, applicants were able to search for specific jobs with criteria,
such as job title and req ID, but recruiters could not post a button on their career site,
landing page, job board, or email in order to bring applicants directly to a list of job search
results that the recruiter wanted to feature. Hiring managers were able to review applicants
in the Applicant Tracking System (ATS), but recruiters were not able to send hiring
managers a link to a list of hand-picked applicants so that the hiring managers did not have
to spend time navigating through the system and screening the applicants themselves.

Use Cases
General
o An organization wants to get more out of their career site by featuring certain job types.
o An organization wants its hiring managers to be able to review a short list of applicants
chosen by the recruiters.
Specific
o Brianna is an HR manager at Acme, Inc. and wants to improve visibility for certain highpriority requisitions. She places a highly visible link on the landing page of the career
site, which directs applicants to a pre-configured set of job search results in order to
feature those open positions.
o Summer has an open requisition to fill a vacancy on her team. She is extremely busy,
does not use the ATS frequently, and wants to quickly review candidates that are
recommended to her by the recruiting team.
Veronica, a recruiter at Acme, Inc., chooses some of the high-potential applicants that
she thinks Summer would be interested in and sends Summer a quick email through
the system that contains a link to review the applicants’ resumes. This way, Summer
does not have to search for those high-potential applicants in the system herself.

Glossary
o Static URL - This means that content on the page will be based on the elements
selected at the time the link was created.

Security
The following existing permissions apply to this functionality:
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Manage Applicants - Send Resume Review Link
A Send Resume Review Link action type is added to the Actions drop-down on the
Manage Applicants pages. This option allows recruiters to send an email with a link to
review those applicants.
Use Case
Summer has an open requisition to fill a vacancy on her team. She is extremely busy, does
not use the ATS frequently, and wants to quickly review candidates that are recommended
to her by the recruiting team.
Veronica, a recruiter at Acme, Inc., chooses some of the high-potential applicants that she
thinks Summer would be interested in and sends Summer a quick email through the system
that contains a link to review the applicants’ resumes. This way, Summer does not have to
search for those high-potential applicants in the system herself.
To access the Manage Applicants page, go to Recruit > Manage Requisition. On the
Manage Job Requisitions page, locate the requisition for which you would like to manage
applicants. From there, click the linked number of applicants in the Applicants column.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting).
This permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
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Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.

Send Resume Review Link Action Type
This option allows recruiters to send an email with a link to review a pre-defined list of
applicants on the Resume/CV Review page.
To email a resume review link:
1. Select the applicants on the Manage Applicants page who will be included for review.
Note: External applicants cannot be added.
2. Click the Send Resume Review Link on the Manage Applicants page. This opens the
Send Resume Review Link pop-up.
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3. Complete the following fields and information in the pop-up:
o To - Select the recipients by entering a name in the predictive search field or selecting
users from the Select a user pop-up. Click ADD to add the selections.
o Select Relation - Selecting a relation sends the email to the user or users who are
defined as the applicant reviewer, hiring manager, or requisition owner. You can select
any or all of the relationships in the drop-down. Relations can be selected in addition to
individual users. Click ADD to add the selections.
o Subject - The subject line is pre-populated. Modify the subject line, as needed, up to
255 characters.
o View Tags - Click the View Tags link to view the tags available for the email.
o Message Body - The message body is pre-populated. Modify the message, as needed.
There is no character limit. The message must include the RESUME.REVIEW.LINK tag,
which provides recipients with the link to access the Resume/CV Review page with the
list of applicants.
Once the fields are completed, click SEND. This sends the email to the recipients. The
recipients can click the resume review link in the email to open the Resume/CV Review
page, which will display the list of pre-defined applicants for review. Recipients will not need
to log in to the system from the email link if they are already logged in.
The recipients will only be able to view the resume data for applicants to whom they have
availability access. If a recipient does not have access to any of the applicants, then the
recipient is redirected to an access denied page.
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Applicant Profile Page - History
When an applicant is included in the Send Resume Review Link action type from the
Manage Applicants page, the email event is logged on the History tab of the applicant's
profile.
o Event Title - This column displays the name of the event as "Resume Review Link
Sent."
o Details - This column displays the list of all recipients to who the email was sent.
o User - This column displays the name of the user who executed the event along with
their user name if available, as "<Jeremy Johnson [jjohnson]>."
o Date and Time - This column displays the date and time associated with the event.
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Job Search Widget - Allow Results Sharing
An Allow Results Sharing option is added to the Widget Settings pop-up for the Job
Search widget. When checked, this option enables the Share Search link to display on the
career site. When unchecked, the link is hidden on the career site. The option is unchecked
by default.
Note: Disabling the Share Search link after users have generated and shared a link to job
search results does not disable the shared link. The shared search results can still be
viewed if the Share Search link is disabled.
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Career Site - Job Search Results Link
You can now generate a static link to a list of predefined job search results and can share
the link with others or embed the link in a button on the career site landing page. The link
opens the job search results that you generated so that you can highlight featured jobs.
When the link is accessed, search results are displayed immediately based on the
predefined criteria. Users do not have to click Search in order for the search results to
display.
To generate a link:
1. Conduct a job search on the career site.
2. Once the search results display, click the Share Search link.

3. Clicking the Share Search link opens a Share Search pop-up. The link displays in a text
box in the pop-up. Copy the link in the text box.
4. Click DONE.
You can now share the link or embed it in a button, perhaps on the career site landing page
or another page in order to feature jobs based on the linked search criteria. This can be
done by configuring the HTML on the page to include this link as the target when the button
is clicked. When the link is accessed, the job search results display based on the search
criteria associated with the link.
Note: If the content or status of the jobs changes after the link is generated, the search
criteria associated with the link may not generate the same exact results that were present
when the link was created.
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Talent Pools
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Talent Pools Overview
With this enhancement, the Manage Talent Pools functionality is redesigned with a new
user interface (UI) and the integration of Recruiting features. For portals with Recruiting,
talent pools can now be used to source applicants for job requisitions. Candidates can be
added from Manage Applicants and can be added to job requisitions from within the
Manage Talent Pools page.

Use Cases
o A Human Resources Manager wants to create talent pools of strong candidates to be
developed and promoted within the organization. She wants to be able to share these
pools with hiring managers and recruiters.
o A recruiter wants to develop a short list of internal and external candidates for a highpriority position in order to select the best talent in support of her hiring manager’s
needs. She wants to be able to add high-potential candidates to open requisitions and
communicate with them, if needed.

Considerations
The option to Add to Talent Pool in Search Candidates is being removed with this
enhancement. The option will no longer be available in the ACTIONS drop-down on the
search results page upon implementation of this enhancement.

Implementation
The Talent Pools redesign is enabled for all portals with Succession and/or Recruiting in
Stage environments. The redesign will be enabled by request in Production portals via a
work order. For the July '16 release, the redesign will be automatically enabled for all
portals.
Recruiting and Succession
For portals with Recruiting and Succession, the full Talent Pools functionality will be
available.
Recruiting Only
For portals with Recruiting only, the Succession actions will still display in the talent pools
(Create Groups, Nominations, Development Plans). However, development plans will not
be useable since a development plan would not be set up for portals that do not have
Succession.
Succession Only
For portals with Succession only, the Recruiting actions (Add to Requisition) will not display.

Security
With this enhancement, the Talent Pools - Manage permission description will be updated
to include the ability to add candidates to a job requisition. The permission description
updates will be visible in Online Help upon implementation of this enhancement.
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The following existing permissions apply to this functionality:
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Navigation Tabs and Links
For portals that have Recruiting but that do not have Succession, the Manage Talent
Pools navigation sublink is available to add to a navigation tab in Navigation Tabs and
Links Preferences. Adding the sublink will make the Manage Talent Pools page accessible
from the navigation tab to which it is added.
For portals that have both Recruiting and Succession, the Manage Talent Pools sublink
can only be added to one navigation tab. For example, the link can be added to the Recruit
tab so that recruiters can quickly access the page.
To access Navigation Tabs and Links, go to Admin > Tools > Core Functions > Core
Preferences > Navigation Tabs and Links.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

Navigation Tabs and Grants ability to manage Navigation Tabs and
Links - Manage
Links for the portal. This is an administrator
permission.

CATEGORY

Core
Administration
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Manage Talent Pools
The Manage Talent Pools page displays the talent pools you have created or that have
been shared with you. From here, you can view and edit the talent pool. You can also share
and delete talent pools.
The Manage Talent Pools page can be accessed by selecting Manage Talent Pools from
the sublink in the navigation tab to which the link has been added. Administrators can add
the Manage Talent Pools sublink in Navigation Tabs and Links Preferences.
Permissions
PERMISSION
NAME
Talent Pools Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to create and manage Talent
Talent/Succession Pools. This permission also grants access the Administration
ability to add candidates to a job requisition.
This permission can be constrained by OU
and User's OU. This is an administrator
permission.

Create Talent Pool
The CREATE TALENT POOL option allows you to add a new talent pool. To create a
talent pool:
1. Click CREATE TALENT POOL. This opens the Create Talent Pool pop-up.
2. Enter a name for the talent pool, up to 50 characters.
3. Click SAVE. This adds the talent pool to your list of talent pools.

Talent Pools List
Talent pools display in order of most to least recently added. The following information
displays for the talent pools:
o Name - The name of the talent pool is a clickable link. Click the name to view and edit
the talent pool.
o Date Created - This field displays the date on which the talent pool was created.
o Creator - This field displays the name of the talent pool creator.
o Options - The following options are available from the drop-down to the right of the
talent pool:
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o Edit - Click Edit to view the talent pool and make changes to it, such adding
users, changing the talent pool name, or creating a nomination list. This opens the
talent pools page for the talent pool.
o Share - Talent pools can be shared so that other users can provide their input in
managing and promoting the users in the talent pool. This option does not display
for users with whom a talent pool has been shared.
Click Share to share the talent pool. This opens the Share Talent Pool pop-up.
Search for and select the users with whom to share the pool. Once the users have
been selected, click DONE. This shares the talent pool with the selected users.
o Delete - This option only displays for the talent pool creator. Click Delete to delete
the talent pool. This opens the Delete Talent Pool pop-up. Click YES to delete the
talent pool. This removes it from the creator and any users with whom the talent
pool has been shared. Or, click NO to close the pop-up without deleting the talent
pool.

View Shared Talent Pool Users
To view the users with whom a talent pool has been shared, click the Share option in the
drop-down to the right of the talent pool on the Manage Talent Pools page. This opens the
Share Talent Pool pop-up. The list of users displays in a Shared with section at the bottom
of the pop-up.

View Shared Talent Pools
For users with whom a talent pool is shared, they can view the talent pool by clicking the
Manage Talent Pools sublink from the navigation drop-down. This opens the Manage
Talent Pools page, from which they can see a list of all talent pools that have been shared
with them. They can also see who shared the talent pool with them and view the details of
each talent pool by clicking the name of the talent pool.
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Edit Shared Talent Pool
For users with whom the talent pool is shared, they can edit the talent pool by clicking the
Edit icon in the drop-down to the right of the talent pool name. This opens the details page
for the talent pool.
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View Talent Pool
The talent pool page allows you to view the candidates in the talent pool and perform
actions for the candidates, such as adding them to a job requisition. You can also view their
status in the talent pool and create and manager nomination lists.
The options that are available will differ for portals that only have Succession or only have
Recruiting. For portals that have both Succession and Recruiting, the full functionality of
talent pools will be available.
Users must have permission to manage talent pools in order to view the Manage Talent
Pools page and have access to the features and functionality for talent pools. For portals
with Recruiting and Succession, recruiters and hiring managers must have permission to
manage talent pools in order to access and manage the Manage Talent Pools page.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Applicants: Add/Move Grants ability to add or move applicants to requisitions Recruiting
to Requisition
the applicant did not apply for. This permission can be
constrained by OU, User's OU, and Grade.
Talent Pools Manage

Grants ability to create and manage Talent
Talent/Succession Pools. This permission also grants access the Administration
ability to add candidates to a job requisition.
This permission can be constrained by OU
and User's OU. This is an administrator
permission.
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Add Candidate
The ADD CANDIDATE button allows you to add candidates to the talent pool. To add
candidates:
1.
2.
3.
4.

Click the ADD CANDIDATE button. This opens the Add Candidate pop-up.
Search for candidates using the search option.
Select candidates from the Available Users table.
Click DONE. This adds the candidates to the talent pool. The status of the candidates is
New Candidate.

Add Nominee
The ADD NOMINEE button allows you to add nominees to the nomination list. Nomination
lists allow you to categorize candidates by a certain qualification or skill. When nominees
are added to a nomination list but are not currently in the talent pool, they are only added to
the nomination list and are not also added to the talent pool.
The ADD NOMINEE button only displays if the talent pool is filtered by a nomination list.
Filtering by a nomination list changes the name of the ADD CANDIDATE button to ADD
NOMINEE.
To add a nominee to the nomination list:
1. Click the ADD NOMINEE button. This opens the Add Nominee pop-up.
2. Search for candidates using the search option.
3. Select candidates from the Available Users table.
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4. Click DONE. This adds the candidates to the nomination list. The status of the
candidates changes to Nominated.

Options
The following options are available in the Options drop-down:
o Edit Name - Click Edit Name to change the name of the talent pool. This opens the
Edit Name pop-up. Enter the changes into the text field, and then click SAVE. This
saves the changes to the name.

Filters
The following filters are available:
o Nomination List Status - Select a nomination list status to filter the candidates by their
status in the nomination list. The page is updated to show only the candidates who are
in the selected nomination list status. The filter is disabled if a nomination list has not
yet been created. When filtered by a nomination list, only the Assign Dev Plan, Create
Group/Add to Group, and Remove options are available in the Actions column.
o Succession Metrics - Select a succession metric to filter the candidates by a specific
metric. The metrics that display are the metrics that are available to the user.
o Metric Rating - Once the metric is selected, you can also filter by the metric rating.
Select the rating from the drop-down to the right of the metric. The All option is selected
by default. Only active metric ratings display in the filter. If a candidate does not have a
rating but meets the metric criteria, then the candidate will display in the list.
Once the filters are defined, click SEARCH. This updates the table to display the
candidates who match the criteria.
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Actions
The ACTIONS drop-down allows you to apply actions to candidates, such as adding to
groups and adding to a requisition. You can perform bulk actions by using the Actions
drop-down above the candidates table. Or, you can perform actions on individual
candidates from the drop-down in the Actions column in the table.
Note: The Assign Dev Plan action is only available for portals with Succession. The Add
to Requisition action is only available for portals with Recruiting.
Note: The Create Group option displays if there a group has not yet been created for the
talent pool. Once a group has been created, the Create Group option is replaced by the
Add to Group option.

Nominate
The Nominate action allows you to add candidates to an existing nomination list. Or, you
can create a new nomination list to which to add the selected candidates.
To add candidates to a nomination list:
1. Select one or more candidates.
2. Click the Nominate option from the ACTIONS drop-down. This opens the Nominate
Candidate pop-up.

3.

Create a new nomination list by entering a name for the list in the Create List field, up
to 50 characters.
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4. Or, select the Add to existing list option to add the candidates to an existing list. Then,
select the list from the drop-down.
5. Click SAVE. This saves the new list and adds the candidates to the list. Or, this saves
the candidates to the existing list.
Once a nomination list is created, the list cannot be deleted.
Assign Dev Plan
The Assign Dev Plan option allows you to assign a development plan to candidates in the
talent pool to help candidates move to next level positions in the organization. This option is
only available for portals that also have Succession.
To assign a development plan:
1. Select one or more candidates.
2. Click the Assign Dev Plan option from the ACTIONS drop-down. This opens the Select
Dev Plan Template pop-up.
3. Click the plus icon to the left of the development plan to select the plan. Only one plan
can be selected.
4. Click SAVE. This adds the development for the candidates. The candidates' status in
the talent pool changes to In Development.

Create Group/Add to Group
You can add candidates to a Group organizational unit (OU) so that other actions within the
system can be applied to the OU.

Create Group
The Create Group option displays if at least one group has not yet been created in Manage
Talent Pools. Only one Group OU can be created at the talent pool level, and only one
Group OU can be created per nomination list. For example, if a talent pool has two
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nomination lists, then up to three groups can be created. One group can be created for the
talent pool and one can be created for each nomination list.
To create a group and add candidates to the group:
1. Select one or more candidates.
2. Click Create Group in the ACTIONS drop-down above the candidates table or the
actions drop-down to the right of the candidate in the candidates table. This opens the
Add to Group pop-up.
3. Enter the group name in the Group Name field, up to 50 characters.
4. Click SAVE. This creates the group and adds the selected candidates to the group.

Add to Group
The Add to Group option displays if at least one group has been created in Manage Talent
Pools. To add candidates to an existing group:
1. Select one or more candidates.
2. Click Add to Group in the ACTIONS drop-down above the candidates table or the
actions drop-down to the right of the candidate in the candidates table. This opens the
Add to Group pop-up. When at least one group already exists for the talent pool, you
cannot create another group. The pop-up displays the name of the group to which you
can add the candidates.
3. Click SAVE to add the candidates to the group.

Note: The Add to Group option is hidden if a Group OU that was previously created for the
talent pool or nomination list is inactive.
Add to Requisition
The Add to Requisition option allows you to add candidates to a job requisition. This
option is only available for portals that also have Recruiting.
To add candidates to a requisition:
1. Select one or more candidates.
2. Click Add to Requisition from the ACTIONS drop-down. This opens the Add to
Requisition pop-up.
3. Search for and select the job requisition to which to add the candidates.
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4. Once the job requisition is selected, configure the following options for adding the
candidates:
A. Add As - In the Add As column, select the New Submission option to add the
submission directly to the New Submissions page for the requisition. Select the
Applicant option to add the submission directly to the Manage Applicants page for
the requisition. If the Applicant option is selected, the applicant's status will be the
first status in the status workflow for the requisition, and the date in the Current
Status column is the date on which the applicant was manually added to the
requisition. Note: If the Skip New Submission Status option is enabled by the
administrator in Requisition and Applicant Preferences, then the option to add an
applicant as a new submission does not display for the Add to Requisition and Move
to Requisition action items. The New Submission option in the Add to Requisition
pop-up is hidden. The Applicant option is then selected by default.
B. Send Email To - In the Send Email To column, check the box to send an email to
the requisition owner and/or the potential applicant, notifying them that the applicant
has been added to the requisition. Both boxes are unchecked by default. Note: If
the new requisition requires applicants to complete certain steps prior to submitting
their application, the email can be configured in Email Management to include a link
for the applicant to apply directly to the requisition. Further, the application materials
for the new job are pre-populated with the applicant's existing information.

Delete
The Delete action allows the talent pool creator or a candidate with whom the talent pool
was shared to remove a candidate from the talent pool. To delete a candidate:
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1. Click Delete from the Actions drop-down. This opens the Remove User/Candidate popup.
2. Click YES to remove the candidate. This removes the candidate from the talent pool.
3. Click NO to close the pop-up without deleting the candidate.

Candidates Table
The candidates table lists all users who are in the talent pool. You can perform actions on
an individual user and also change the user's status in the talent pool. You can also access
the user's Universal Profile > Bio page.

Select All Checkbox
Select the checkbox in the header row to perform bulk actions from the Actions drop-down
on all of the selected candidates.

Select Individual User
Select the checkbox to the left of each candidate's name to perform actions from the
Actions drop-down

Table
The following information displays in the table:
o Photo - The candidate's photo displays, if available.
o Name - This column displays the candidate's name as a link. For internal user, clicking
the name opens their Universal Profile > Bio page or My Team page. For portals with
Recruiting, clicking the name of an external candidate opens their Applicant Profile
page.
o User ID - This column displays the candidate's user ID.
o Position - This column displays the candidate's current Position organizational unit
(OU). If there is no value available, then "N/A" displays.
o Division - For internal candidates, this column displays their current Division OU. For
external candidates, this column displays "External."
o Manager - This column displays the name of the candidate's manager. If there is no
value available, then "N/A" displays.
o Added - This column displays the candidate's date on which the candidate was added
to the talent pool.
o [Metric Filter] - The name of this column is the name of the metric selected in the
metric filter. The column displays the rating for the metric. If a candidate has no rating
for the metric, then the column displays "N/A."
o Status - This column displays the candidate's status in the talent pool. You can
manually change the status by selecting a status from the drop-down, which helps you
to better manage the candidate's lifecycle in the talent pool. The following statuses
display:
o New Candidate - This status is assigned automatically when a candidate is added
to the talent pool. indicates that the candidate has been added to the talent pool.
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o In Development - This status is assigned automatically when a development plan
is added for the candidate.
o Nominated - This status is assigned automatically when a candidate is added to a
nomination list.
o Placed - This status is assigned manually and indicates that a candidate has been
promoted or placed in a position.
Note: Changing a candidate's status when viewing the candidate in a nomination list
does not change their status in the main talent pool.
o Comments - The Comments option allows you to add a comment about the candidate,
to open the
as well as view the comments that others have added. Click the icon
Comments pop-up. Enter a comment in the text box. Only one comment can be added
per user, up to 3000 characters. If comments have been added by other users, then the
comments display below the text box. Any comments you enter can be viewed by the
users with whom the talent pool is shared. You can edit your own comment by opening
the Comments pop-up and changing the comment in the text box. To delete your
comment, you can remove all text in the text box and click SAVE.
o Actions - This column displays the actions that can be performed for the individual
candidate. To perform an action, it is not necessary to check the box in the far left
column of the table. The following actions are available from the drop-down:
o Nominate - See the Nominate section above for more information. Note: This
option is not available when the table is filtered by a nomination list.
o Assign Dev Plan - See the Assign Dev Plan section above for more information.
o Create Group/Add to Group - See the Create Group/Add to Group section
above for more information.
o Add to Requisition - See the Add to Requisition section above for more
information. Note: This option is not available when the table is filtered by a
nomination list.
o Remove - See the Delete section above for more information.

Modification History
The Modification History section displays the changes made to the talent pool or the
nomination list. The section is collapsed by default.
The changes that display are based on the user's availability. If a user is not able to view a
specific candidate due to permission constraints, then the change associated with the
candidate does not display in the modification history.
The following changes display in the Modification History section:
o
o
o
o
o
o

Talent Pool Created
Nomination List Created
Candidate Added to Talent Pool
Candidate Added to Nomination List
Candidate Removed from Talent Pool
Candidate Removed from Nomination List
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Manage Applicants
With this enhancement, an Add to Talent Pool option is added to the Actions drop-down.
This option allows you to add applicants to an existing talent pool or create a talent pool to
which to add the applicants.
Note: For portals that have Recruiting but that do not have Succession, you can add
applicants to a talent pool but cannot manage talent pools.
To access the Manage Applicants page, go to Recruit > Manage Requisition. On the
Manage Job Requisitions page, locate the requisition for which you would like to manage
applicants. From there, click the linked number of applicants in the Applicants column.
Permissions
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
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Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
Talent Pools Manage

Grants ability to create and manage Talent
Talent/Succession Pools. This permission also grants access the Administration
ability to add candidates to a job requisition.
This permission can be constrained by OU
and User's OU. This is an administrator
permission.
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Add to Talent Pool
To add applicants to a talent pool:
1. Click Add to Talent Pool from the ACTIONS drop-down. This opens the Add to Talent
Pool pop-up.
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2. Select an existing talent pool from the SELECT TALENT POOL drop-down.
3. Or, create a new talent pool by clicking the Create New Talent Pool option and
entering the name of the talent pool, up to 50 characters.
4. Click SAVE. This opens the Applicant Action Results pop-up to indicate whether or not
the action was successful. If the action is successful, then the applicants are added to
the talent pool. If the action is unsuccessful, then the reason is displayed in the Details
column in the pop-up.
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Applicant Profile - History
When an applicant is included in the Add to Requisition action type from the Manage
Talent Pools page, the event is logged on the History tab of the applicant's profile.
o Event Title - This column displays the name of the event as "Added from Talent Pool."
o Details - This column displays "Source: Talent Pool."
o User - This column displays the name of the user who executed the event along with
their user name if available, as "<Jeremy Johnson [jjohnson]>."
o Date and Time - This column displays the date and time associated with the event.
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Additional Recruiting Fields
With this enhancement, fields are added to the Requisition and User sections for Recruiting
Custom Reports.
Permissions
PERMISSION
NAME
Custom Recruiting
Report - Create

Custom Recruiting
Report - View

PERMISSION DESCRIPTION

CATEGORY

Grants ability to create and edit Custom Recruiting Reports reports. This permission can be constrained by
Analytics
Division, Position, and Location.
Grants ability to view results of Custom Recruiting
reports created by self or shared by others. This
permission can be constrained by Division, Position,
and Location.

Reports Analytics

Requisition
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Succession
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Talent Pools - Succession
The detailed information for the Talent Pools redesign can be found in the What's New for
April 2016 > Recruiting section of Online Help.
When viewing the release notes, the Talent Pools redesign enhancement can be found in
the Recruiting section.
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Custom Reports - Update to Task Status for Launched Tasks
Support Unlaunched Tasks
With this enhancement, statuses for Succession Management Plan (SMP) tasks that have
been started will now accurately reflect in reporting. Prior to this enhancement, statuses for
started tasks were not always reflected accurately, in the custom reports.
This enhancement addresses this design flaw to ensure that any started tasks displayed in
the Succession custom report display the correct statuses.

Task Status Field
With this enhancement, the Task Status field will display the correct status value in the
report output for Succession Custom Reports. Prior to this enhancement, the status field
displayed inconsistent information.

Security
The following existing permissions apply to this functionality:

Custom Onboarding
Report - Create

Grants ability to create and edit custom Onboarding
reports. This permission refers to creating custom
reports for the Onboarding module. This permission
can be constrained by OU, User's OU, User Self and
Subordinates, and User's Subordinates.

Reports Analytics

Custom Onboarding
Report - View

Grants ability to view results of custom Onboarding
reports created by self or shared by others. This
permission refers to viewing custom reports for the
Onboarding module. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User's Subordinates.

Reports Analytics

FIELD
NAME
LO
Possible
Credit

FIELD DESCRIPTION

FIELD
TYPE

Number of credits set for a training for an individual user, Numeric
regardless of the status of the training. This reports on the
individual credit values that have been assigned to
different courses within certifications. These training
579

Cornerstone April 2016 Release Notes: What's New for April 2016

FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

courses can appear in multiple sections, irrespective of
their status.
FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Availability
Type

Drop-down selection set for OUs (organizational unit), Text
groups and users.

Electronic
Signature
Message

Message configured with the electronic signature at
the Course Catalog.

Text

Electronic
Signature
Required

Indicates if an electronic signature is required for a
learning object (LO).

Yes/No

Session Roster The comments entered on the roster for a session.
Comments

Text

Training
Availability

Displays the OUs and users selected in the Availability Text
Selection Criteria for learning objects. Each OU and
user displays in a separate row. Individual users only
display if individually selected in the availability
criteria.

Training
Availability
Include
Subordinates

The boolean field selected for OUs, groups, and users. Text

Training
Availability
Pre-Approved

The boolean field selected for OUs, groups, and users. Text

Training
Availability
Register Upon
Approval

The boolean field selected for OUs, groups, and users. Text

Training
Deactivation
Date

Displays the LO deactivation date.

Date

Training
Purpose

The purpose of the training entered in the Course
Catalog.

Text
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FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Training
Request Form

Drop-down selection set for OUs, groups, and users.

Text

Training
Version
Comments

The comments entered at the time a training is
versioned. This field is only available for Material,
Test, Curriculum, and Online Course LO types.

Text

Training
Version
Effective Date

The date a version is effective.

Date

Training
Version End
Date

The date the version is set to end.

Date

Training
Version Start
Date

The date the version of an LO begins.

Date

FIELD NAME

FIELD DESCRIPTION

FIELD
TYPE

Secondary First
Name

The first name specified for a secondary
address.

Text

Secondary Last
Name

The last name specified for a secondary
address.

Text

FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

Ability to
Select
Session
Admins and
Managers

Indicates whether the Select Session link for an
event is displayed on the user's Universal Profile >
Transcript or Training Details page.

Ability to
Select
Sessions End
Users

The User Session Selection Allowed field is renamed
Yes/No
Ability to Select Sessions End Users. This field indicates
whether the Select Session link for an Event is
displayed on the user's Universal Profile > Transcript
or Training Details page.

Curriculum
Completion

This is an existing field that is now available in the
Learning > Transcript section of the Multi-Module

Yes/No

Numeric
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FIELD
NAME

FIELD DESCRIPTION

FIELD
TYPE

Percentage

Custom Report. There is no change to the data that is
displayed in this field.

Latest
Version

Indicates that a curriculum is the latest version.

User Course Displays the user's course review.
Review Desc

Text
Text

User Course
Review Title

The User's Course Review field is renamed User Course Text
Review Title. There is no change to the data that is
displayed in this field.

User Part
Attendance

Displays the number of parts a user attended for a
specific session.

PERMISSION
NAME

PERMISSION DESCRIPTION

Numeric

CATEGORY

Feedback - View and Enables user to view the Feedback page of the
Universal
Post
universal profile and to post feedback. Users can view Profile
and post feedback on the Feedback page for all users
within their permission constraints. This permission
can be constrained by OU, User's OU, User Self and
Subordinates, User's Self, and Employee
Relationship. This is an end user permission.
Snapshot Competencies

Enables user to view the Competencies widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, User's Self, User's
Manager, User's Superiors, User's Subordinates,
User's Direct Reports, and Employee Relationship.
Best Practice: For most users, this permission should
be constrained by User Self and Subordinates.

Snapshot Development Plans

Enables user to view the Development Plans widget
Universal
and subpage within the Universal Profile - Snapshot
Profile
page for users within their permission constraints. This
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, User's Self, User's
Manager, User's Superiors, User's Subordinates,
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User's Direct Reports, and Employee Relationship.
Best Practice: For most users, this permission should
be constrained by User Self and Subordinates.
Snapshot - Reviews

PERMISSION
NAME

Universal
Enables user to view the Reviews widget and
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission can be constrained by OU, User's OU,
User Self and Subordinates, User, User's Self, User's
Manager, User's Superiors, User's Subordinates,
User's Direct Reports, and Employee Relationship.
Best Practice: For most users, this permission should
be constrained by User Self and Subordinates.

PERMISSION DESCRIPTION

CATEGORY

Create Employee
Goals - Align

When creating a goal for users other than self or
Performance subordinates, this permission allows
Administration
administrators to align the goal with other goals.
The constraints on this permission determine with
which employees the administrator can align the
goal. This permission works in conjunction with
the Create Employee Goals permission. This
permission can be constrained by OU, User's OU,
and User. This is an administrator permission.

Goal Preferences Manage

Grants ability to manage Goal Preferences, where Performance various goal features can be enabled or disabled Administration
according to the needs of the organization. This
permission can be constrained by OU and User's
OU. This is an administrator permission.

PERMISSION
NAME
View Goals

PERMISSION DESCRIPTION

CATEGORY

Grants ability to view own goals and (depending
Performance
on role and settings) goals of others (manager's
visible goals, direct subordinate's goals, company
goals, division goals). This permission can be
constrained by Employee Relationship, OU,
User's OU, and User Self and Subordinates. This
583

Cornerstone April 2016 Release Notes: What's New for April 2016

is an end user permission.
PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Action Items - EPM

Grants ability to view and take action upon
Universal
Performance (EPM) items on the Action Items page
Profile
and in the Your Action Items widget. This permission
can be constrained by OU, User's OU, User's Self,
and User's Self and Subordinates. This is an end user
permission.

Action Items - View

Grants ability to view action items on the Action Items Universal
page and in the Your Action Items widget. Users
Profile
without this permission cannot access the Action
Items page. This permission can be constrained by
Employee Relationship, OU, User's OU, User's Self
and Subordinates, and User's Self. This is an end user
permission.

Bio About - View

Enables user to view the Bio page for users within
Universal
their permission constraints. This permission must be Profile
enabled to view the Transcript page within Universal
Profile. If a user does not have this permission and
they click a person's name or user photo within the
Universal Profile, then the Bio page will not open. This
permission can be constrained by Employee
Relationship, OU, User's OU, User's Direct Reports,
User Self and Subordinates, and User.

Request Items - View Allows user to access the Requests tab on the
Universal Profile > Actions tab. This permission
cannot be constrained.
PERMISSION
NAME
Snapshot - Badges

PERMISSION DESCRIPTION

Universal
Profile

CATEGORY

Enables user to view the Badges widget and subpage Universal
within the Universal Profile - Snapshot page for users Profile
within their permission constraints. This permission
works in conjunction with the Snapshot Main - View
permission. This permission can be constrained by
OU, User's OU, User Self and Subordinates, User,
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User's Self, User's Manager, User's Superiors, User's
Subordinates, User's Direct Reports, and Employee
Relationship. Any user with this permission will always
be able to view their own Badges widget when the
widget is enabled. Best Practice: For most users, this
permission should be constrained by User Self and
Subordinates.
Snapshot Leaderboard

PERMISSION
NAME
Badge & Point
Preferences Manage

PERMISSION
NAME
Course Catalog Update

Enables user to view the Leaderboard widget and
Universal
subpage within the Universal Profile - Snapshot page Profile
for users within their permission constraints. This
permission works in conjunction with the Snapshot
Main - View permission. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, User's Direct
Reports, and Employee Relationship. Any user with
this permission will always be able to view their own
Leaderboard widget when the widget is enabled. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.
PERMISSION DESCRIPTION

Enables user to access and edit preferences on
the Badge & Point Preferences page. The
availability of this permission is controlled by a
backend setting. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
PERMISSION DESCRIPTION

Grants ability to manage/edit learning objects
listed in the Course Catalog. This permission can
be constrained by OU, User's OU, Training Type,
Training Item, Provider, ILT Provider, User's ILT
Provider, User, User Self and Subordinates, and
User's LO Availability. This is an administrator
permission.

Snapshot Main - View Enables user to view the Snapshot page for users

CATEGORY

Core
Administration.

CATEGORY

Learning Administration

Universal
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Snapshot
Preferences Manage

PERMISSION
NAME
Feedback - Request

PERMISSION
NAME

within their permission constraints. This permission
can be constrained by Employee Relationship, OU,
User's OU, User Self and Subordinates, User, User's
Self, User's Manager, User's Superiors, User's
Subordinates, and User's Direct Reports. Best
Practice: For most users, this permission should be
constrained by User Self and Subordinates.

Profile

Enables administrator to access and edit the
Snapshot Preferences page. This permission can be
constrained by Employee Relationship, OU, and
User's OU. This is an administrator permission.

Universal
Profile

PERMISSION DESCRIPTION

CATEGORY

Enables user to request feedback from the Feedback Universal
page of their Universal Profile. Users can only request Profile
feedback from other users within their permission
constraints. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User's Self. This is an end user permission.
PERMISSION DESCRIPTION

CATEGORY

Performance Review Grants ability to create and manage performance Performance Form Sections review questions and sections which are used in
Administration
Manage
performance review tasks. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
View Goals

FIELD NAME

Grants ability to view own goals and (depending on Performance
role and settings) goals of others (manager's visible
goals, direct subordinate's goals, company goals,
division goals). This permission can be constrained
by Employee Relationship, OU, User's OU, and
User Self and Subordinates. This is an end user
permission.
FIELD DESCRIPTION

FIELD
TYPE
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FIELD NAME

FIELD DESCRIPTION

[Name of
Category]
(Category)

This field displays the name of the competency
category and the value selected for the competency.

Competency
Description

The description of the competency.

FIELD
TYPE
Text

o Example of how the selected category appears:
Corporate (Category)
o Example of how the selected competency
appears: Corporate Values

FIELD NAME
Marked As Final

FIELD DESCRIPTION
Indicates whether or not a goal is marked as final.

Text

FIELD
TYPE
Yes/No

Marked As Final - The date/time the goal was marked as final.
Date

Date

Success
Descriptors Title

The title of the success descriptor for a goal. Each
success descriptor appears in a separate row.

Text

Success
Descriptors
Description

The description of the success descriptor for a goal.
Each description appears in a separate row.

Text

FIELD
NAME

DESCRIPTION

Sign-off
Comments

This displays any comments that were added by the reviewer on
the Sign-off step of the performance review.

Sign-off
Declined to
Sign

This displays whether the reviewer declined to add their signature
to the Sign-off step of the performance review.

Sign-off
Signature

This displays the signature text that was submitted on the Signoff step of the performance review.

Sign-off
Timestamp

This displays the date and time at which the reviewer added their
signature to the Sign-off step of the performance review.

Sign-off
Type

This displays the sign-off type that is associated with the Sign-off
Section. This is configured when the review section is created.
The available options are Electronic, Authenticated, or Manual.
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PERMISSION
NAME

PERMISSION DESCRIPTION

Custom Performance Grants ability to create and edit Custom
Reports - Create
Performance reports. This permission can be
constrained by OU, User's OU, User's Self and
Subordinates, and User's Subordinates.

CATEGORY

Reports Analytics

Custom Performance Grants ability to view results of Custom Performance
Reports - View
reports created by self or shared by others.
PERMISSION
NAME
External Search:
Manage

PERMISSION
NAME
Global Email
Administration Manage

PERMISSION DESCRIPTION

Grants access to view and manage the external
sourcing functionality. This permission cannot be
constrained.
PERMISSION DESCRIPTION

CATEGORY

Recruiting

CATEGORY

Grants ability to manage email trigger templates
Core
across all active modules in the portal. Enables
Administration
creating, editing and deleting email message
templates for various system actions and
workflows. This permission can be constrained by
OU, User's OU, User Self and Subordinates, and
User. This is an administrator permission.

Global Email
Grants view only access to email
Administration - View templates/triggers and email logs at the global
level for the portal. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User. This is an administrator
permission.
Recruiting: Search
Candidates

Reports Analytics

Core
Administration

Grants ability to access Candidate Search page
Recruiting
for recruiting, which enables searching for internal Administration
candidates and external candidates who have
applied for open positions. This permission also
enables the Invite to Apply action item to appear in
the Actions drop-down on the Search Candidates 588
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Search Results page. This permission can be
constrained by OU and User's OU.
Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
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associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
Requisition
Template - Manage

Grants ability to access and view Requisition
Recruiting
Templates. This permission cannot be constrained. Administration
This is an administrator permission.

Requisition
Template - View

Grants ability to access and view Requisition
Templates. This is an administrator permission.

GO TO

STEP
1

2

Recruiting
Administration

STEP DESCRIPTION

Manage Job
Requisitions
> Create Job
Requisition

Enter keywords in the Keywords field.

Recruit >
Manage Job
Requisitions

Click the External Sources option in the options dropdown. This opens the Broadbean search page.

The keywords are USED to automatically populate the
search criteria in Broadbean.

or
Recruit >
Candidate
Search Query
3

Broadbean
Search Page

Select the job boards from which to search for
applicants.
The keywords and job title from the job requisition will
be pre-populated so that you do not need to enter search
criteria.

4

Broadbean
Search Page

Search for applicants from the Broadbean search page.

5

Broadbean

Click the Add to Talent Pool option to add the desired
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GO TO

STEP

Search
Results Page

STEP DESCRIPTION
applicants to the talent pool. The talent pools that
display in Broadbean for recruiters are the talent pools to
which they have access to view and edit in the portal.
Note: If an applicant currently has an Applicant Profile
page in the portal, then the applicant is automatically
added to the talent pool.
Note: External applicants can still create a profile on the
career site if the talent pool to which they are added is
deleted before the applicant creates their profile.

ACTION
Create
Profile
Invitation

DESCRIPTION/TRIGGER
This email is triggered when an external applicant is added to a
talent pool via Broadbean. The email should include the
INVITATION.TO.CREATE.PROFILE tag so that applicants can click
the link to create a profile. The email should also include the
DELETE. CANDIDATE.INFORMATION tag so that applicants can
delete their temporarily stored data from the database.
The email can be sent to external candidates that were added to
the talent pool and have created a profile with a valid email
address. This email can be configured as a Notification type email.
This email is active by default and can be found in the Recruitment
action type section of Email Administration.
Use Case: This trigger invites an external applicant to create a
profile on the career site. The email is triggered when the applicant
is added to a talent pool via Broadbean.
Note: This email is not sent to applicants who currently have a
user record in the portal. However, the email is sent to applicants
who are added to a talent pool for a different requisition but have
already created a profile on the career site. In such cases the
applicant will be directed to a page that indicates an account (which
is created using the applicant's email address) currently exists for
the applicant.
TAG NAME

ACTION.DATE

DESCRIPTION
Date that the action took place that
triggers the email.
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TAG NAME

DESCRIPTION

INVITATION.TO.CREATE.PROFILE

Link to the default career site.

DELETE.CANDIDATE.INFORMATION

Link to delete temporary profile data.
Applicant can click the link and choose
to remove their temporary profile data
from the organization. When the user
clicks YES to delete, a confirmation
appears. Click YES to confirm the
deletion, or click NO to cancel the
deletion. If you click YES, the
candidate is directed to the job search
page of the career site.

COMPANY.NAME

Name of the company that sent the
email. (This is your company's name.)

RECIPIENT.FIRST.NAME

Recipient's first name.

RECIPIENT.LAST.NAME

Recipient's last name.

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the

Recruiting
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referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and
External Postings tabs when creating, copying, or
editing a job requisition. In addition, this permission
enables users to store user-level credentialing
information for job board aggregation partners on
the My Gateways tab of the My Account page. This
permission cannot be constrained.

Recruiting

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
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user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Onboarding Manage

Grants ability to manage user onboarding in the
Onboarding Dashboard and the Onboarding tab on
the Universal Profile. This permission can be
constrained by OU and User's OU.

Employee
Onboarding

Onboarding - View

Grants ability to view the Onboarding Dashboard and Employee
the Onboarding tab on the Universal Profile. This
Onboarding
permission can be constrained by OU and User's
OU.

Snapshot Documents Grants ability to view the Documents widget and
Universal
- View
subpage within the Universal Profile - Snapshot page. Profile
This permission can be constrained by Employee
Relationship, OU, User's OU, User's Self and
Subordinates, User, User's Self, User's Manager,
User's Superiors, User's Subordinates, and User's
Direct Reports. This is an end user permission.
PERMISSION NAME

PERMISSION DESCRIPTION

CATEGORY

Custom Onboarding
Report - Create

Grants ability to create and edit custom Onboarding
reports. This permission refers to creating custom
reports for the Onboarding module. This permission
can be constrained by OU, User's OU, User Self and
Subordinates, and User's Subordinates.

Reports Analytics

Custom Onboarding
Report - View

Grants ability to view results of custom Onboarding
reports created by self or shared by others. This

Reports Analytics
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permission refers to viewing custom reports for the
Onboarding module. This permission can be
constrained by OU, User's OU, User Self and
Subordinates, and User's Subordinates.
CURRENT REPORT NAME
Form Management Report

NEW REPORT NAME
Training Form Management Report

CURRENT SECTION NAME

NEW SECTION NAME

Form Template

Training Form Template

Form Task

Training Form Task

REPORT SECTION

CURRENT FIELD NAME

NEW FIELD NAME

Training Form
Template

Form Template Name

Training Form Template
Name

Training Form Task

Task Name

Training Form Task Name

Form Task Status

Training Form Task Status

CURRENT
PERMISSION
NAME

CURRENT
DESCRIPTION

NEW
PERMISSION
NAME

NEW DESCRIPTION

Custom Form
Grants ability to
Management
create and edit
Reports - Create custom Form
Management
reports.

Custom Training
Form
Management
Reports - Create

Grants ability to
create and edit
custom Training Form
Management reports.

Custom Form
Management
Reports - View

Custom Training Grants ability to view
Form
custom Training Form
Management
Management reports.
Reports - View

Grants ability to
create and edit
custom Form
Management
reports.

CURRENT REPORT NAME
On Boarding Report
REPORT SECTION

NEW REPORT NAME
Training Forms - Curricula Report
CURRENT FIELD
NAME

NEW FIELD NAME
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REPORT SECTION
Training Form Template

CURRENT
PERMISSION
NAME

CURRENT FIELD
NAME

NEW FIELD NAME

Form Template Name Training Form Template
Name

CURRENT
DESCRIPTION

NEW
PERMISSION
NAME

NEW DESCRIPTION

Custom On
Grants ability to
Boarding Report create and edit
- Create
custom On
Boarding reports.

Custom Training
Forms Curricula Report
- Create

Grants ability to create
and edit custom
Training Forms Curricula reports.

Custom On
Grants ability to
Boarding Report view custom On
- View
Boarding reports.

Custom Training Grants ability to view
Forms custom Training Forms
Curricula Report - Curricula reports.
- View

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Application Workflow Grants ability to access and manage Application
Template - Manage Workflow Templates. This permission can be
constrained by OU and User’s OU. This is an
administrator permission.

Recruiting
Administration

Application
Grants ability to access and view Application
Workflow Template Workflow Templates.
- View

Recruiting
Administration

Pre-Screening
Question Bank Manage

Grants ability to access and manage Pre-Screening Recruiting
Question Bank.
Administration

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Recruiting

Requisition: Owner

Enables owner to access requisitions and applicants

Recruiting
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for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.
Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
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PERMISSION
NAME
Application Custom
Fields - Manage

Organizational Unit
Custom Fields Manage

PERMISSION DESCRIPTION

CATEGORY

Grants ability to create and edit custom fields used Recruiting
for Applicant and Application. This permission also Administration
grants access to the Applicant Custom Fields and
Application Custom Fields sections of the
Requisition and Applicant Preferences page. This
permission cannot be constrained. This is an
administrator permission.
Grant Access to create and edit custom fields for
Org Units. This is an administrator permission.

Core
Administration

OU Hierarchy Manage

Grants ability to create and update/edit
organizational units and custom groups. This
permission grants access to all OU types, both
standard and custom. This permission can be
constrained by OU and User's OU. This is an
administrator permission.

Core
Administration

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
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be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
Requisition
Preferences Manage

Grants ability to access and manage Requisition
Preferences. This permission cannot be
constrained.

Recruiting
Administration

Requisition Request:
Select Users

Grants ability to select requisition owners, reviewers, Recruiting
and interviewers when creating requisition requests.
This permission can be constrained by OU and User's
OU. The constraints define which users are available
when selecting users for requisition requests.

Requisition Request:
Submit Request

Grants ability to create requisition requests. This
Recruiting
permission can be constrained by OU and User's OU.

Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.
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Self-Registration and Grants access to manage custom fields for user
User Record Custom Self Registration and the user record in Custom
Fields - Manage
Field Administration. This permission can be
constrained by OU and User's OU. This is an
administrator permission.
PERMISSION
NAME

Core
Administration

PERMISSION DESCRIPTION

CATEGORY

Career Site - Manage Grants ability to access and manage Career Site Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.
Career Site - View

Grants ability to access and view Career Site
Recruiting
Management. This permission can be constrained Administration
by OU and User's OU. This is an administrator
permission.

Requisition: Edit
Postings

Grants ability to edit the Internal Postings and External Recruiting
Postings tabs when creating, copying, or editing a job
requisition. In addition, this permission enables users
to store user-level credentialing information for job
board aggregation partners on the My Gateways tab
of the My Account page. This permission cannot be
constrained.

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting). This
permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
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is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Requisition: Manage

Grants ability to access and manage all requisitions
regardless of ownership (constraints permitting).
This permission also grants read-only access to the
Applicant Review tab when creating or editing a job
requisition. This permission can be constrained by
OU, User's OU, and Grade.

Requisition: Owner

Enables owner to access requisitions and applicants Recruiting
for requisitions for which they are an owner. This
permission also grants read-only access to video
interviews that are completed by applicants via
HireVue. For portals with Referral Suite enabled, this
permission also enables requisition owners to edit the
referral source on the Applicant Profile page. This
permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. If the
user is removed as an owner, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned. Also, if a user has both
the permission necessary to manage requisitions and
be a requisition owner, the constraints of the
Requisition: Manage permission overrule those of
the Requisition: Owner permission. For requisition
owners that do not also have permission to manage
requisitions, only certain fields are editable when
editing a requisition.
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Requisition: Reviewer Enables reviewer to access requisitions and
applicants for requisitions for which they are a
reviewer. This permission cannot be constrained.

Recruiting

Note: This is a dynamically assigned permission that
is not available in Security Role Administration. Once
a requisition is in a Closed or Cancelled status or if the
user is removed as a reviewer, the permission is
revoked for the associated requisition. This permission
cannot be manually assigned.
Note: If an applicant reviewer is removed as a
reviewer via the Applicant Profile page, the
Requisition: Reviewer permission is revoked for the
associated requisition. However, if the reviewer was
also added as a reviewer via the General tab when
creating, editing, or copying the requisition, the
reviewer still appears on the In Review panel as a
duplicate reviewer and retains access to the
requisition and applicants from the Requisition:
Reviewer permission. See Applicant Profile Page
Overview for more information about duplicate
reviewer instances.

PERMISSION
NAME

PERMISSION DESCRIPTION

CATEGORY

Applicants: Add/Move Grants ability to add or move applicants to requisitions Recruiting
to Requisition
the applicant did not apply for. This permission can be
constrained by OU, User's OU, and Grade.
Applicants: Add to
Talent Pool
Talent Pools Manage

FIELD NAME
Requisition Cost

Grants ability to add applicants to talent pools.

Recruiting

Grants ability to create and manage Talent
Talent/Succession Pools. This permission also grants access the Administration
ability to add candidates to a job requisition.
This permission can be constrained by OU
and User's OU. This is an administrator
permission.
FIELD DESCRIPTION
The Cost Center entered for the

FIELD TYPE
Text
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FIELD NAME

FIELD DESCRIPTION

Center

requisition.

Requisition Keywords

The keywords entered for the requisition.

PERMISSION
NAME

PERMISSION DESCRIPTION

FIELD TYPE
Text
CATEGORY

Custom Succession
Report - Create

Grants ability to create and edit Custom
Reports Succession Management (SMP) and Custom Job Analytics
Pool Succession Reports reports. This permission
can be constrained by OU, User's OU, User Self
and Subordinates, and User's Subordinates.

Custom Succession
Report - View

Grants ability to view results of Custom Succession
Reports Management (SMP) and Custom Job Pool
Analytics
Succession Reports reports created by self or shared
by others. This permission can be constrained by OU,
User's OU, User Self and Subordinates, and User's
Subordinates.
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